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Getting Started with DME Designer

Thank you for purchasing the DME64N/DME24N/DMESi-C/DME8o-C/DME4io-C, SP2060

Your DMEG4N/DME24N/DMES8i-C/DME80-C/DME4io-C and SP2060 together the DME Designer
software, lets you build a custom audio system installation that can support an incredible variety of
conditions. You can build an entire system from input to output with the DME Designer software, then
send the data from that system to the DME64N/DME24N/DMES8i-C/DME80-C/DME4io-C and SP2060
which becomes an independent processor.

An amazing variety of applications are possible, including audio installations, sub-mixing, speaker
system control, matrix/routing, and multi-effect processing.

In this manual the abbreviation “DME” refers to the DME64N/DME24N/DMES8i-C/DME80o-C/DME4io-C.

Here the abbreviation “DME” does not include the “DME32.”

This manual is based on the English version of the software. lllustrations, command names, window names, and similar
information are from that version. Some items may differ from what you see on the computer screen, depending on which
operating system you are using.

SPECIAL NOTICES

e The software and this Owner’s Manual are the exclusive copyrights of Yamaha Corporation.

e Use of the software and this manual is governed by the license agreement which the purchaser
fully agrees to upon breaking the seal of the software packaging. (Please read carefully the
Software Licensing Agreement at the end of “DME Designer Installation Guide” before installing
the application.)

e Copying of the software or reproduction of this manual in whole or in part by any means is
expressly forbidden without the written consent of the manufacturer.

e Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and the
software.

e This disc is a CD-ROM. Do not attempt to play the disc on an audio CD player. Doing so may
result in irreparable damage to your audio CD player.

e The company names and product names in this Owner’s Manual are the trademarks or registered
trademarks of their respective companies.

e The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may
appear somewhat different from the screens which appear on your computer.

e Future upgrades of application and system software and any changes in specifications and
functions will be announced separately.

e Windows® is the registered trademark of Microsoft® Corporation.
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Getting Started

The DME Audio System Network

In an audio system including one or more DME units and/or SP2060 units, the “control space” is
logically organized using the concepts of “Area”, “Zone”, and “Device Group". The space covered by
the entire system is the “Area”, while independent sonic spaces within that Area are called" Zone" A
group of DME or SP2060 units assigned to the same function are considered a “Device Group”.

An Area is comprised of one or more Zones, and each Zone can include up to 32 Device Groups.

A single Device Group can include as many as 16 devices. Each Device Group has one “Group
Master”.

Meter response may deteriorate as the number of meters displayed in a single device group in DME Designer increases. In
such cases meter response can be improved by dividing the device group.
See “Changing Device Groups” on page 268.

DME and SP2060 units cannot be combined in the same Device Group.

All devices in a Device Group must be on the same subnet.
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The DME Designer Software Application

The DME Designer software application provides a convenient, central interface for the creation and
control of DME-based audio systems.

By connecting the computer on which the DME Designer application is running to a Group Master it
becomes possible to control multiple devices simultaneously.

With DME Designer, DME audio systems can be designed and configured via a comprehensive block-
diagram interface on the computer screen.
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The main concepts used in the creation of DME audio systems are “Components”, “Configurations”,
“Preset Parameters”, and “Scenes”.

m Components

Any independent signal-processing block, such as an equalizer, compressor,
input/output module, or external device control object is a “Component”.

m Configurations

A “Configuration” is group of components, including their placement and interconnections.
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m Preset Parameters

The set of parameters for all components in a Configuration is know as the Configuration's “Preset
Parameters”.

m Scenes
A Configuration and its Preset Parameters are a “Scene”.

Composition of scene
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DME settings as well as Configuration and Preset Parameter settings are sent from the DME Designer
application running on the computer to the Device Master via USB or Ethernet, allowing each device

to function as a separate processor, independently from the computer. It is also possible to keep the

DME Designer application on line and control the devices in real time.

It is possible to use the DME Designer to create Configurations that include multiple devices when the
appropriate devices are connected.

Although it is possible to have multiple Zones in an Area, multiple Device Groups in a Zone, and
multiple Scenes and Configurations in a Device Group, only one Area, Zone, Device Group and
Configuration can be active and editable via the DME Designer at any one time. The active elements
are known as the Current Zone, Current Device Group, Current Scene, and Current Configuration.
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Data Handled by a DME Audio System

m DME Data Structure

Common Overall Data

Scene Link Settings

Settings required for linked scene operation between multiple
groups.

Data for Each Device Group

User Defined Button Settings

Settings required for component parameter control from the
DMEBAN/DME24N or ICP1 panel.
Up to 24 parameters can be registered for control.

Global Parameter Link Settings

Settings required for linked operation of the same types of
parameters between multiple devices.

Data Used by the Scene Manager

MIDI program Change Settings

Settings required to allow scene selection via MIDI commands.

Scenes

The information required to switch audio data processing
setups.

Scenes include configurations and preset data.

The Scene Manager facilitates registration and management of
scene data.

Up to 999 scenes can be registered, and registered scenes are
managed by their scene numbers.

Data for Each Device

Configurations

A combination of the audio signal processing, audio input/
output, and external device control components and their
interconnections, created to create the desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of
internal DME parameters.

Component Link
Settings

Settings that allow linked operation between similar types of
internal DME components.

External Device
Settings

Settings required to allow control of component parameters from
external devices.

Independent settings are required for each device.

The external devices that can be used are as follows:

e MIDI Controller (MIDI Control Change, Parameter Change).

e GPI Controller.

e DAW Controller.

e AMX, Crestron, and other remote controllers.

Preset Parameters

The settings for the components in a configuration.

Audio processing setups can be switched by changing the
preset parameters.

Components included in the preset parameter set are as
follows:

e GEQ, MatrixMixer, and other audio signal processing
components.

e Internal AD/DA (DME24N), Cascade (DME64N), and MY card
I/O components*.

e Components for external devices such as the AD8HR and
AD824 remote head amplifiers.

* Some settings not included.
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m SP2060 Data Structure

Common Overall Data

Scene Link Settings

Settings required for linked scene operation between multiple devices.

Data for Each Device

Scenes

The information required to switch audio data processing setups.

Scenes include configurations and preset data, The last Library name recalled is
specified.

The Scene Manager facilitates registration and management of scene data.

Up to 99 scenes can be registered for 12 preset areas and 87 user areas, and reg-
istered scenes are managed by their scene numbers.

Configurations

A combination of the audio signal processing, audio input/output, and external
device control components and their interconnections, created to create the
desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of internal SP2060
parameters.

Preset Parameters

The settings for the components in a configuration.
Audio processing setups can be switched by changing the preset parameters.
Preset parameters can be recalled by SP2060 units, but not edited.

Data for Each Component

Library

Settings specific to the speakers to be used.
In addition to the preset data provided, settings can be created by the DME
Designer.

DME Designer Owner’s Manual
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M One DME unit/Device Group

Microphone
Mixer

External Head Amp

etc...

Device Group
Input

Output

User Defined Button

[Mfzand Set 1 |"

-

Scene Manager

External Device (MIDI, GPI, DAW, AMX/Crestron)

1
.4

Power Amp

s> Processor
etc...

Notes
- Audio signal
ﬁ Control signal

=i Data explanation

- Setting preset parameters

LCD Display | Assigned Parameter

Dome Low | Crossover: Output Low: Level
=» | Dome Mid | Crossover: Output Mid: Level

Dome Hi Crossover: Output Hight: Level

(No Assign)
(No Assign)
(No Assign)

Specifies the parameter to be changed.

Scene Name

Band Set 1

Confuguration

Specifies the configuration
and preset parameters combination.

Preset Parameters

-
Configuration

Local parameter link settings

External device settings

Set the value

Preset parameters for output processor

AllOn Component value

BGM & MC

\_ J
B Two DME units/Device Group (When one DME unit doesn't provide sufficient processing power, up to 16 DME units can be used)
External Device (MIDI, GPI, DAW, AMX/Crestron)
DME#1 Device Group ‘
Input Output
_ — -
m:igphone Power Amp
External Head Amp Processor Notes
etc... Input Output
— — m=> Audio signal
ﬁ Control signal
=== Data explanation
For DME#1 - - - Setting preset parameters
For DME#2 MBand Set 1" _l
Scene Manager - ~N N
User Defined Button For DME#1 I For DME#2 |

LCD Display | Assigned Parameter
Dome Low | #1: Crossover: Output Low: Level
Dome Mid | #1: Crossover: Output Mid: Level
| Dome Hi #1: Crossover: Output Hight: Level
Hall Low #2: Crpssover: Output Low: Level
—p-| | Hall Mid #2: Crpssover: Output Mid: Level
Hall Hi #2: Crpssover: Output Hight: Level

Selects the parameter to be
edited from two DME units.

Scene Name | Configuration

[ Band Set 1

Configuration Preset parameters

Preset parameters

Specifies the configuration and preset
data combination in each DME

l

e N\ N
DME#1 DME#2
Configuration Preset parameters Configuration Preset parameters
All On All On
BGM & MC BGM & MC
Band 2
Local parameter link settings Local parameter link settings
Band 3
External device settings External device settings
\ J U J
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Separate SP2060 units normally handle scenes independently, but the Scene Link function can be set from the DME
Designer to allow linked scene operation.See “Scene Link Manager” on page 130.

System Requirement

Operating System

Windows® XP Professional/XP Home Edition/2000 Professional

CPU

1 GHz or better Intel® Pentium®/Celeron® family processor

Memory

At least 256 MB

Hard Disk Capacity

At least 300 MB

Display

1,280 x 1,024 pixels or better/High Color 16 bit or better

Other

Mouse, CD-ROM drive, 100Base-TX/10Base-T Ethernet or USB connection
environment.

DME Designer Owner’s Manual
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Main Changes from V1.0 to V1.1

Main Panel Window

e Instead of the former Parameter Link function, there are now two functions: a Global Link function
that links parameters within all DMEs in a zone and a Local Link function that links parameters
within a single DME unit. (page 81)

e The Synchronization function can now not only send data from DME Designer to the DME unit,
but can also synchronize by reading data from the DME unit. (page 83)

e Scene Increment/Decrement and Time Adjustment can now be assigned in the GPI input
function. (page 98)

e DME unit events can now be recorded by the Event Logger function and displayed in the Event
Logger window. (page 154)

e The time for executing an event can now be set by using the Event Scheduler function.
(page 125)

e Parameters in the current configuration can now be listed on the display and printed out by using
the Parameter List function. ( page 126)

e The Wav File Manager can manage Wave files played by the Wav File Player. (page 130)

e Settings can be made by the DAW Control function that are used for controlling DMEs from a
DAW controller. (page 137)

e DME unit data can now be saved as a backup file by using the Backup function. (page 137)

Designer Window

e The port name display can now be switched between long name display and short name display.
(page 179)

e DMEB4N cascade connections can now be set. (page 195)

e Priority items can now be set when compiling configurations by using the [Compile Priority]
function in the “Preferences” dialog box. (page 195)

e Delay time can now be displayed for each component by using the Show Signal Delay function.
(page 281)

e Monitoring points can now be edited by using the “Monitoring Point List” dialog box.
(page 282)

e The status of connections in a configuration can now be analyzed in advance by using the
Analyze function, without connecting the DME unit. (page 284)

e You can now set the action that occurs when you double-click a user module object. You can also
turn user module security ON or OFF, and set a password. (page 286)

e Libraries with component parameters saved in them can now be recalled from the context menu
for a component object. (page 339)

e A new rule for wiring prohibits connections to terminals that would short the terminator.

Component Editor/Component

e A status bar has been added to the component editor. It displays the component name,
component ID, and parameter IDs for parameters that are being edited. (page 295)

e A Snap function has been added that records parameters in the editor temporarily. Parameter
sets can then be switched by using the Snap buttons. (page 335)

e The meter's peak hold function can now be turned ON or OFF. (page 332)
e A Wav File Player component has been added for playing Wave files. (page 398)

e An effect component called SPX has been added that supports many different effect
applications, such as reverb, delay, and modulation effects, along with complex combinations of
multiple effects. (page 435)

e A Slot Out component editor has been added. (page 447)

DME Designer Owner’s Manual
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e An Undo/Redo function is now available when using the design mode. It can undo the most
recent operation (control movement/resize/deletion).

Changes from V1.1 to V1.2

Main Panel Window
¢ The synchronization algorithm has been refined for faster synchronization.

e Synchronization now can be executed from DME to DME Designer without any break in the
sound.

¢ |n the following cases, synchronization can be executed from DME Designer to DME without any
break in the sound:

The second or later synchronization after starting DME Designer* and when differences in data
between the DME and DME Designer are limited to parameters within components, AD824/
AD8HR/DME24N AD/DA setting data, or MY card setting parameters.

* If the file was saved when DME Designer was closed, there will be no break in sound even in the first
synchronization after saving.

e Compile speed has been increased.
Up to three times faster when AutoDelayCompensation is turned On.
Up to two times faster when AutoDelayCompensation is turned Off.

e Synchronization is possible when no MY card or a different MY card is installed in the DME unit
(a confirmation dialog will appear).

¢ An option to automatically close the dialog after synchronization has been added. (page 43)
e A progress bar has been added to the Synchronization dialog. (page 42)
e A message appears to warn when synchronization will cause muting.

¢ The following operations can be performed while on line:
- Scene storage.
- Scene name changes.
- Fade ON/OFF and Fade Mode changes.
- Fade time changes.
- Parameter link setting changes.

¢ \When a scene store is executed, that scene becomes the current scene.

e Wave files can be saved as DME data files, and are included in import/export operations.
(page 37)

e Wave files can be saved in the Wav file library.
e Event Log events can be output via GPI. (page 69)

e The on-line indicator appears as a button which can be used to switch between on-line and
off-line. (page 50)

e Scene edits cause the EDIT indicator to appear. (page 48)
e An auto file save function (Auto Save, post synchronization) has been added. (page 63)
e Different zones can be specified for use by different users. (page 137)

e Scene parameters related to User Defined Button, Program Change, GPI In and GPI Out can be
set via the Scene Manager. (page 70)

e [Select All] and [Clear All] buttons have been added to the Scene Manager Recall Safe dialog.
(page 74)

e User Control can be created for individual users as well as security levels. (page 78)

e A Remote Control Setup List has been added. (page 125)

This list can be used to make detailed settings for a new software protocol that allow the DME to
be controlled from AMX, Crestron, and similar devices.

DME Designer Owner’s Manual
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Refer to the “DME-N Remote Control Protocol Specifications” document for details about the
communication protocol. Information about the “DME-N Remote Control Protocol Specifications”
document can be found at the Yamaha pro Audio website (URL below).

http://www.yamahaproaudio.com/

e |t is possible to specify whether listed events will be executed by the Event Scheduler.
(page 125)

e The order of same-time events can be changed in the Event Scheduler. (page 125)

e Exceptions can be specified for Event Scheduler execution day/time. (page 93)

e Event Scheduler execution times can be specified in 1-second increments. (page 92)

e Head amp gain and MY-Card can be set via GPI, MIDI, User defined Button, DAW Control.

e Parameter values, scene recall, GPI output, Wave file playback, and head amp gain can be set
via the User Defined Buttons. (page 118)

e The Component Lock function dialog is separate from the Parameter List dialog. (page 129)
e Shortcuts can be freely set as required. (page 136)

e Files can be saved in the DME unit. (page 61)

e A [Close All Editor Windows] button has been added to the Window menu. (page 60)

e External head amp parameters will be recognized by the DME unit when either the DME or the
external head amp (AD824, AD8HR) are turned on. Execute a scene recall to send DME settings
an external head amp.

e This manual is now separate from the DME Designer installer, and can not be accessed from the
DME Designer menus.

Designer Window

e The following operations can be carried out via the shortcut keys.
- Navigator
- Activate Navigator
- Activate Toolkit
- Activate Design Window
- Select Left Port and Start Wiring
- Select Right Port and Start Wiring
- Wire Auto Single to Right
- Wire Auto Multi to Right
- Wire Auto Single to Left
- Wire Auto Multi to Left
- Delete Wire

e |t is now possible to simultaneously edit multiple objects of the same type.
Example: Change the thickness or color of multiple wires at once.

e Files related to user modules (user module files, library files, user module editor files) can be
combined and exported/imported as a single file.

e Port colors can be independently specified for each port type. (page 183)

e Default wire thicknesses and types can be independently specified for each port type.
e An automatic hot-spot connection function has been added. (page 260)

e Port display has been added to External Device, Picture, DME, and ICP1 objects.

¢ \WWhen drawing wires the keyboard cursor keys can be used to move the mouse cursor, and the
<Enter> key can be used to create nodes.

e When drawing wires <Shift> key plus < - > key and <Shift> key plus < « > key combinations can
be used to automatically connect horizontally-aligned hot spots.

e DME object ports can be freely specified.

DME Designer Owner’s Manual
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e Compilation of configurations with loop connections is possible when Auto Delay Compensation
is On.

e The name has been changed from “Foot Monitor” external device to “Floor Monitor.”

e Addition External Device types have been provided.

e External Devices can be double-clicked to open a file saved by other applications. (page 206)
e Picture objects can be double-clicked to open a specified editor. (page 222)

e Text objects can be double-clicked to open a specified editor. (page 224)

e User module port labels can be edited. (page 218)

e Graphics can be placed to represent user modules. (page 218)

e The Legend field automatically resizes to accommodate project names and titles of different
lengths.

e A Generic “MY-Others” setting has been provided to accommodate third-party MY cards.

Component Editor Window

¢ Undo and Redo are now shortcut compatible.

e A scroll bar appears when the size of the component editor window is reduced.

e The size and position of the component editor window are memorized.

e An option to allow mouse-over zooming of the edit box has been added. (page 298)

e A [Back] button that allows switching between related parent and child windows has been
added. (page 294)

e A [Close All Editor Windows] button has been added to the contextual menu.

e Source Selector, Speaker Processor, Limiter, Slot In, Cascade In, and Cascade Out components
have been added.

e The Delay algorithm has been revised. (page 368)
- LEVEL and MUTE are effective when Delay is Off for each channel.
- The name of the overall Delay [On] parameter has been changed to [All Bypass].

Input  Input Input Input
Mute Level

Mute Level On Mute Level
e o T e

On Mute Level
>0 oro (S

=

e The bus send level range for Delay, Matrix, and Matrix Mixer components has been changed to
-0 through 0.0 dB.

e Snap copy is possible. (page 336)

Delay All Bypass
Yo ouT

e Snap can be retained until the application is quit or another file is opened.
e Security status is displayed in the user module editor status bar.

e Multiple controllers can be selected by clicking while holding the <Ctrl> key when the editor is in
the design mode. (page 331)

e [Picture], [Text], [Box], [Ellipse], and [Frame] have been added to the tool palette of the user
module editor and user control editor design mode. (page 301)

e Controller properties can be accessed by double-clicking controllers in the user module editor or
user control editor design mode. (page 321)

e Picture and Text objects can be clicked to open a specified editor in the user module editor or
user control editor.

e The User Module Editor and User Control Editor offer a greater range of customization options for
color, size. etc., of the placed controls.

DME Designer Owner’'s Manual 13
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m MIDI Setup

e A MIDI Setup minimize function has been added.

m V1.2 Precautions

e When using project files (*.daf) created by version 1.1.5 or earlier, synchronize from the DME
Designer to the DME unit for the first synchronization.

e Project files (*.daf) created using version 1.2 will not open properly on version 1.1.

Changes from V1.2 to V2.0

m General

e Support added for DMES8i-C/DME80o-C/DME4io-C, SP2060 units and MY 16-CII.

e “Device Groups”, or groups of the same type of device, have been added at the lowest Zone
level.

e |t is now possible to have one master device per device group rather than one master device per
zone. This means that it is possible to have multiple master devices in a single zone.

e Group masters can now be assigned regardless of the IP address. This makes it possible to have
multiple device groups at a single network address.

e Configurations can be created and deleted for each device group.

m Component

e A Feedback Suppressor component has been added. (page 387)
e The Speaker Processor component PEQ “Q” parameter now goes to “63”. (page 427)

Main Panel Window
e Firmware and component data can now be updated simultaneously. (page 160)

¢ A Recovery Update function that allows recovery from program corruption has been added.
(page 162)

e A Component Link function that allows simultaneous linking of all component parameters has
been added. (page 81)

e Scene Link function that allows simultaneous control of multiple devices in different device
groups has been added. (page 130)

e A Protect function has been added to the scene manager. (page 70)

e Card settings are no longer included in scene data.

e A Utility window has been added to allow editing of device utility settings. (page 146)

e The Local Parameter Link display order has been changed. (page 81)

e Parameter Link operation can now be turned on or off for each device group. (page 81)
e Compilation and analysis is now possible even if no connections have been made.

e Navigator window hide/show can now be selected from the main window.

e The Event Logger can now display only the event data for a specified device. (page 65)
e The GPI terminal names have been changed from [CH] to [PORT].

Designer Window

e A hand tool for window movement has been added. The hand tool can be selected via the hand/
arrow icon in the toolbar, or from the [Tools] menu. The hand tool can also be temporarily
selected by holding the spacebar on your keyboard.

DME Designer Owner’s Manual
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¢ \Window magnification and reduction can now be controlled via the mouse wheel while holding
the keyboard “Ctrl” key.

e Horizontal scrolling can be controlled via the mouse wheel while holding the keyboard “Shift” key.
¢ The Edit Mode on/off can now be changed from the tool bar. (page 163)

e Scene information now appears in DME objects, and the Scene Manager can be launched from
the scene information display. (page 70)

¢ An [On-line] button has been added to DME objects, and synchronization is now possible.
(page 50)

e Sampling frequency display has been added to the resource meter window. (page 167)

e Sampling frequency display has been added to the configuration window status bar. (page 277)
e The sampling frequency is now displayed during analysis.

e Double-clicking the component name now opens the properties window.

e Organization of the Tool Kit window has been changed. (page 170)

e A [Draw Image] checkbox that displays or hides the worksheet background image file has been
added to the Sheet properties. (page 235)

e [Configuration Manager] has been added to the contextual menu that appears when a DME or
SP2060 object is right-clicked. (page 191,page 200)

e [Recall Component Library] and [Store Component Library] now appear in the contextual menu
that appears when a component is right-clicked, even when the Edit Mode is OFF.

e The Compile Settings can now be edited for each DME unit. (page 195)

e Only one Zone window is now provided for multiple configurations.

e The [Export DXF] and [Preferences] commands have been moved from the [Print] menu to the
[Tools] menu.

¢ [Configuration] has been changed to [Configuration Manager] in the [Tools] menu.

e When [Prohibit Diagonal Connections] in the [Tools] menu is active it is possible to select 2

diagonal points and those points will automatically be connected by a combination of horizontal
and vertical wires.

m Component Editor Window

e A [Level Meter Enable] command that displays or hides the meter values has been added to the
contextual menu. Hiding the meters can result in increased communication speed in some
cases. (page 333)

e A [Display Order] function that allows the order of the controllers to be changed as required has
been added to the User Control Editor and User Module Editor. (page 301)

e An [Add Component to Component Link] command has been added to the controller contextual
menu.(page 342)

e The registered group is now displayed in the [Add Parameter to Parameter Link] submenu of the
contextual menu of controllers registered for Parameter Link operation.(page 341)

e Increased speed when selecting and dragging a large number of controllers in the User Control
Editor and User Module Editor

e |t is now possible to switch from the Navigator window to Zone display while online.

m V2.0 Precautions
Please use DME Designer V2.0 with DME64N/24N V2.0 or higher, DME8i-C/DME80o-C/DME4io-C
V2.0 or higher, and SP2060 V1.1 or higher.
See the Yamaha Pro Audio website for compatibility details (http://www.yamahaproaudio.com/).
When DMEB4N/24N and DMES8i-C/DME80o-C/DME4io-C are used together in the same device
group, faster communication speed as well as smoother DME Designer meter display can be
obtained by assigning a DMES8i-C/DME8o-C/DME4io-C unit as the device group master.
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Chapter 1 Before Using

Installing DME Designer

To use DME Designer, you must first install the software on the computer. Before you can connect the
DME Designer software to the DME or SP2060 unit, you must first install the USB MIDI Driver or the
DME-N Network Driver, according to how you will be connecting, and then make the appropriate
settings.

For instructions about how to install DME Designer and about the installation and setup method for the
MIDI driver and DME-N Network Driver, see the “DME Designer Installation Guide.”

Initial settings for DME8i-C/DME80-C/DME4io-C units must be transferred via USB-MIDI, so it is necessary to properly set up
the USB-MIDI Driver.

Starting DME Designer

The DME Designer software is started from the [Start] menu. DME Designer is used with one user
logged on. The user logs on when the software is started.

m DME Designer Start Up and Logon (When Auto-Logon Is Not Set)

1 Click [Start] O [All Programs] [ [YAMAHA OPT Tools] [0 [DME Designer] U [DME
Designer].

In Windows2000, click [Start] — [Programs] — [YAMAHA OPT Tools] - [DME Designer] — [DME Designer].

The “Log On” dialog box will be displayed.

Llzer ] Adrninistrator _v__i

Fazzward ]

Exit

Automatic log-on is the default setting. If the automatic logon feature is enabled, the “Log On” dialog box will not be

displayed when the application is started. Instead, the auto-logon user will be logged on automatically. See page 26
for information about auto-logon.

2 Click the [ ¥] at the right of the [User] box, and select the user.

If no user has been created, only [Administrator] will appear in the list. When starting DME
Designer for the first time after installing, select [Administrator].
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3 Enter the password into the [Password] box.
Enter the password set for the user.
If no password has been set, leave the password box blank when you log on.

4 Click the [OK] button.
DME Designer starts up.

"= DME Desiener :

& @R SOy L Zone

Device Group

Scene

User I3 =

BREIODE

¥ Designer

. Mavigator

= I Frea

[+)-EySpeaker Prosessor Y y e

- BxExternal Device e one:
Picturs i

Text

-Box

Ellipze

MIDr
SETUP

m When Automatic Logon Has Been Set (page 26)
If automatic logon has been set, the “Log On” dialog box will not be displayed. The user set for
automatic logon will be logged on.

With automatic log on, even if a password is set for a user, it will not be requested during log on.
This is useful when logging on a specific user.

m Starting by Opening a Project File
DME Designer starts when a project file with a saved configuration is opened. When the project file

is opened, DME Designer is started with the window configuration that was in place when the file
was last saved.
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Closing DME Designer

To close DME Designer, click [Exit] on the [File] menu of the Main Panel window. It can also be closed
by clicking the [Close] button on the Main Panel window.

1 click [Exit] on the Main Panel window [File] menu.
When you try to close DME Designer, “Project File has been modified. Save?” will be displayed in a
dialog box.

Sometimes the “Project File has been modified. Save?” dialog box will not be displayed.

DME Designer

i Project file has been modified.
\“) Save?

Yes Mo I

2 To save the file, click [Yes]. To close without saving, click [No].
If you click [Yes], the File Save dialog box will be displayed.

DME Designer Owner’s Manual
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Names and Functions of the Windows

The DME Designer software has several windows, including the Main Panel window, Designer window,
Component Editor window, Resource Meter window, and others.

Component Editor Window

Main Panel Window

WA W Zoee] )

+ ECreasover Processand
4 mDelay
- Dymamcs
HEQ
4 mFader
+-MFesdhack Supprestor
+ EFiker
4 et
3 BNl
- E M
. . 4-mPan
Designer Window 1 R

+- ExSource Selector

+-mfpesher Processer

- IR

2 Liser Mochile:
Fictan

Tewt
Bax
Eligse

Resource Meter Window

Main Panel Window

Menus and buttons are available in the Main Panel window. The current DME Designer environment,
including the active zone, device group and scene the currently logged on user name, and the
connection status to the DME unit are displayed on the right side of the Main Panel window.
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Designer Window

The Designer window displays several different windows. First among them is the Area window, where
you can manage the entire system. The Area window includes one or more Zone windows, which in
turn include one or more DME or SP2060 units that are used to build a zones within the area. Next is
the Configuration window, where you create the internal configuration of each DME or SP2060 unit.
Within the Configuration window are the User Module windows, where you can assemble often-used
components into templates the Toolkit window, which displays objects used in the other windows as
the basic building blocks for sound designs; and the Navigator window, which lets you grasp the
overall status of the system at a glance.

Zone Window Configuration Window Navigator Window

Toolkit Window

User Module Window

m AreaWindow

The Area window is used for designing areas, which manage the entire system. While at least one
zone is included within an area, multiple zones can be arranged there.

Zones
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m Zone Window

The Zone window is used to design zones within the area. A zone is a more concrete blueprint that
includes at least one DME or SP2060. It shows the DME’s connections with other devices and the
wiring between them. You can create multiple zones.

The DME and SP2060 units and connected devices are arranged in each Zone window, creating
configurations.

Configurations

L1 10

Configuration Window

The Configuration window is used to design the internal configuration of each DME unit contained
in the Zone window. By arranging and connecting components in the Configuration window, you
can create things like complex processors or matrix mixers, that determine the actual internal
structure that operates each DME unit.

| |DMEE4N(Tone1)

Components

m User Module Window

The User Module window is used for designing user modules that can be arranged in the
Configuration window. You can create original modules by combining multiple examples of often-
used components. When you save these modules as templates you can recall them easily
whenever you want.

| {Unsaved User Module(Zane1)

Toolkit Window

The Toolkit window displays the objects that you can use in each window that can be displayed in
the Designer window. Those windows are the Area, Zone, Configuration, and User Module
windows. The Toolkit displays different objects, according to the currently active window. To place
an object in a window, double-click it in the Toolkit window where it is displayed or drag it to the
currently active window.
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m Navigator Window
The Navigator window displays the area, zones, configurations, and components in a hierarchal
fashion that lets you check their status as a whole. When editing offline, you can click an area
name, zone name, or configuration name to make that window active. Clicking a component name
will open the component editor window for that component.

m Resource Meter Window

This window provides an indication of component usage for each DME unit currently placed in the
Configuration window. The usage percentage increases as the number of components increases. The
component usage percentage is shown in graph form for each DME unit.

The window appears simultaneously with the designer window, and can be used as a component
usage guide while creating configurations. The sampling frequency for each DME unit is also
displayed. Please note that the sampling frequency of the DME unit itself will also affect the usage
percentage.

This window is not displayed for SP2060 units.

"™ ResourceM.

SamplingFreque

m Objects and Components
“Object” is the name for the parts that are arranged in the various design windows, such as the
Area, Zone, Configuration, and User Module windows. Objects are always laid out in the Toolkit
window. Only the appropriate objects for each window are displayed. The blocks displayed at the
higher level of the Toolkit window in particular are called “components.” This refers to each type of
processor that operates the DME. “Object” normally refers to Picture, Text, Ellipse and other items
that are used after connecting them by wire to the various components.

Component Editor

The blocks that are arranged in the configuration window are called “components.” When you
double-click on a component block arranged in the Configuration window, the Component Editor
window will open. There you can edit the parameters for that component. The types of parameters
displayed will differ, depending on the component.

Component Editor
(Stereo Compressor)

Component
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Window Operations

Operations in all windows are the same as for normal Windows applications. The windows are
controlled with the [Minimize], [Maximize/Restore], and [Close] buttons at the upper right of the title
bar. DME Designer is closed by clicking the [Close] button on the Main Panel window.

Users and Security

You can create multiple users in DME Designer and set the functions that are available to each user.
Although users who will design and put together installations must be able to use all the functions of
DME Designer, users who will only operate the system can be restricted to functions that will not allow
them to accidentally change the settings.

DME Designer is used with one user at a time logged on. To change the user, click the [File] menu -
[Log Off] command on the Main Panel window.

About Users

To use DME Designer, you must logon when you start the software. Except for the first time the
software is started or when separate settings are made for the first time, you can logon by specifying
the name and password for a user that has been set as the administrator. The administrator can build
the system as a whole, or apply function limitations that let other people edit. Administrators or other
people that can use DME Designer are called “users.” The user name for the currently logged on user
appears below [User] on the Main Panel window.

== DME Desiener - E“: X

L I N R B |
e o @8 0k tf] - .Z':'“e

Scene . Device Group i
: ‘ ' ( Mute [Rx || Tx | | On-line

Currently Logged On User Name

The default user, named [Administrator], is set to use all of the functions. Immediately after DME
Designer is installed, [Administrator] is the only user, and there is no password set.

Multiple users can be created. When the system administrator creates multiple users, restrictions can
be applied separately for each one of them. A user with restrictions applied can edit using only the
functions the administrator enables for him.

The place to create, setup, and delete users is the “Security” dialog box. See “Scene Manager” on
page 70.
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Logging On

The “Log On” dialog box is displayed whenever the application is started or a user is logged off.
Whenever one user is already logged on, another user cannot be logged on. To log on as another
user, first log off the currently logged on user.

If the automatic logon feature is enabled, the “Log On” dialog box will not be displayed when the application is started.
Instead, the auto-logon user will be logged on automatically.

m The“Log On” dialog box

o— -[U el ] Adrministrator

?

-[F'asswnld j

© [User]

From the list, select the user you want to log on as.

@ [Password] Box
Enter the password.

© [OK] Button
Log on as the selected user.

O [Exit] Button

LCancel

I
|

When the application is started, and the “Log On” dialog box is displayed, there is an [Exit]

button. This closes the application without logging on a user.

@ [Cancel] Button

When the “Log On” dialog box is displayed after a user is logged off, there is a [Cancel] button
instead of an [Exit] button. This cancels the logoff. The original user will continue to be logged

on.

m Logon Procedure

1 Click [v] at the right of the [User].
A drop-down list of user names will be displayed.

2 Click the user you want to log on.

3 Enter the password into the [Password] box.
When you type in the password box, the characters you enter will display as asterisks (*).

4 Click the [OK] button.
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Logging Off

Logoff is used when changing users. When you log off, the document currently being edited is closed,
and the “Log On” dialog box is displayed so you can log on the next user. Log off with the [Log Off]
command on the [File] menu in the Main Panel window.

1 Click the [File] menu O [Log Off] command on the Main Panel window.

™ DME Desiener :

Ctrl+N
Ctrl+0

B oo Ty e b
wip @8 Ul ]

Ctrl+s User £

Import Device Configuration

-

Export Device Gonfiguration
DME File Storage
1 G/ Project02 daf
2 G/ Projectl] daf

Preferences

Exit

Log on the next user in the “Log On” dialog box.

Automatic Logging On

With the auto-logon function, you can have a specified user automatically logged on when the
application is started. If you enable the auto-logon feature, the specified user will be logged on when
the application is started, without displaying the “Log On” dialog box.

Auto-logon is set from the “Security” dialog box. See “Scene Manager” on page 70..
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Files Used by the DME DESIGNER

The following files are used by the DME designer application.

Name Description Extension

Project File Stores information relating to the entire project. .daf

DME Data File Stores information for independent DME or SP2060 units. .ddf

Library File Stores component parameters. .cel
Stores user control parameters. .ucl
Stores user module parameters. .uml
Stores user modules. .umf
Stores SP2060 libraries. Af

Wave List File Stores the Wave File Manager list. .dwl

DME Backup File Stores DME or SP2060 backup data to a file. .dbk

Project Files

Systems built with DME Designer are saved as project files. Project files have “.daf” as the extension
for their filenames.
These files include settings for the area, zones, device groups, configurations, and each parameter.

(-~
- -

FILE
projectd3, daf

Since only one project file can be open at a time, before you can open a second file, the first one must
be closed.

The commands for opening project files, creating new ones, and saving them, are found in the [File]
menu of the Main Panel window.

Creating New Project Files
Project files are created using the [File] menu - [New] command in the Main Panel window.

1 Click [File] menu O [New] in the Main Panel window.

Since the currently open project file must be closed before a new one can be created, a “Project
file has been modified. Save?” dialog box will be displayed.

2 DME Designer

- i Project file has been modified,
\) Save?

2 To save the file, click [Yes]. the File Save dialog box will be displayed.
If you click [Yes], the File Save dialog box will be displayed.

A new project file will be created.
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Saving Project Files

Project files are saved using the [File] menu - [Save] and [Save As] commands in the Main Panel
window. The [Save] command overwrites the previously saved version of the file. The [Save As]
command lets you give a new name to the file before saving it. When you save the file with a new
name, you can protect it with a password.

m The*Save As” Dialog Box

When you click the [File] menu - [Save As] command in the Main Panel window, the “Save As”
dialog box is displayed. Except for some [Security] options, this dialog box is the same as the
normal Windows dialog box for saving files.

@ [Up One Level] Button
© [Create New Folder] Button
O [Views] Button

T I )

-Eve in: | £ YAMAHA bldg ||« & ek E-

E123.daf
E asd,daf
i project0l.daf
i project0z. daf
E project03.daf

?

P

e_ +ile name: ] I | — :__®
0_ 'ISG"B as lype: |Project File [* daf) ol — }__@
0_ v Security

© [Save In]

Specify the folder for saving the file. The folder name is displayed in this box. Click the [ ¥] on
the right to move to another folder.
The large box below displays the contents of the folder in this box.

@ [Up One Level] Button
Moves to the folder one level higher in the hierarchy.

© [Create New Folder] Button
Creates a new folder in the folder currently being displayed.

O [Views] Button

Changes the way the folder content list is displayed. If you click this button, a menu appears
that lets you change the arrangement and display format of the files in the list.

O List
This box displays the contents of the folder shown in the [Save In] box. Only files belonging to
the type selected in the [Save As Type] box will be displayed.

O [File Name] Box

Enter the filename. If the currently open file has already been saved, its name will be already
entered in this box. To save using a different filename, change the name here.
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@ [Save as type]

Selects the format for the file you are saving. When saving project files including Wave files set
for Wav File Player, select “Project File with wave (*.daf)”. Otherwise, select “Project File (*.daf)”.

O [Security]

Protects files with a password. If you check here, you will be able to enter settings in the [ID],
[Password], and [Confirm Password] boxes.

© [ID] Box
Enter the ID that has been set for the file. The currently logged on user name will be pre-
entered, but you can change it. This need not be the same as a user name.

Q@ [Password] Box

Enter the password that has been set for the file. You can enter up to 256 alphanumeric
characters. The characters you enter will be displayed as asterisks (*) in the [Password] box.

® [Confirm Password] Box

Enter the password once again to confirm it. Enter the same password as was entered into the
[Password] box. The characters you enter will be displayed as asterisks (*), the same as in the
[Password] box.

When someone attempts to open a password-protected project file, the application will request an ID and password.
If they are not entered correctly, the file cannot be opened. Be careful to avoid mistakes when entering the ID and
password. The password cannot be reissued and the ID and password cannot be changed. Be careful not to forget
them.

@ [Save] Button

Saves the project file.

If the characters entered into the [Password] and [Confirm Password] boxes were not the same,
a “Password is different” dialog box will be displayed. Click the [OK] button and reenter the
correct password in the [Password] and [Confirm Password] boxes.

I E Password is different

® [Cancel] Button
Cancel the file save process.
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m Saving Project Files

1 Click [File] menu O [Save] in the Main Panel window.

= DME Desiener :

Hew

E Oper...
El

Save Az

Impart Device Configuration »
Export Device Gonfiguration
DME File Storage
1 G/ Project02 daf
2 G/ Project0] daf

-

Preferences
Log Off
Exit

If there is a file already saved with the same name, it will be overwritten.

When saving a project file for the first time, you must name the file before saving it. The “Save
As” dialog box will open, the same as when clicking the [File] menu [Save As] command. Enter
a filename and specify the folder where the file will be saved.

m Saving a File with a New Name

With the [File] menu [Save As] command in the Main Panel window, you can save the currently
open file with a new filename. When saving for the first time, this creates a new file. A file that has
already been saved with a name will be saved as a separate file.

1 Click [File] menu O [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

LEVEN E]
Save in | (5 YAMAHA bidg = « & ok E-

BR 123.daf

Easd.daf

!E projectl.daf
'E projectdz, daf
IE project3.daf

File name: ]
Save az type ]Pmiecl File [*.daf] Lj Cancel
I~ Security

D [Ermrnais

Password ]

Confirm Password |

2 Enter a filename into the [File name] box.
3 Specify the folder where the file will be saved.

4 Click the [Save] button.
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m Protecting a Project File with a Password
When you save a project file with a new name, you can set a password and protect the file. If a
password is set, an ID and password will be requested when the file is opened.
The security settings for a file cannot be changed by resaving the file with the same name. They
can only be changed when saving the file with a new name using the [Save As] command. Once
set, the ID and password cannot be changed. To change the ID and password for password-
protected project files, use the [Save As] command to save the file as a new one with a different
name.

1 Click [File] menu O [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

2 Place a checkmark for [Security] in the file save dialog box.

3 Enter an ID into the [ID] box.

The name of the currently logged on user will be automatically entered into the [ID] box. To
change it, enter another ID into the box.

When using [Save As] to save a password-protected file, the dialog box will be displayed with
the ID and password boxes automatically filled in with the ID and password that were assigned
to the original file. To change the ID and password, enter new ones into the boxes.

4 Enter the desired password into the [Password] box.

You can enter up to 256 alphanumeric characters for the password. The characters you enter
will be displayed as asterisks (*) in the [Password] box.

5 Enter the same characters into the [Confirm Password] box as were entered into the
[Password] box.
The characters you enter will be displayed as asterisks (*) in the [Password] box.

6 Click the [Save] button.

Save As @
Save in: | 3 YAMAHA bidg =]+ e E-
B 123.0er
!Easddaf
'E project0l.daf
IEprDjactDZ.daF
IEprDjectDS.daF
File name; |yamaha Save |
Save a3 lype: ]Pmiect File [*.daf] _‘j Cancel
v Security
D ]Administrator
Paszword ] ******
Carfirm Passward [~

When saving a password-protected file without changing the name, the same ID and password
will be set (the ID and password cannot be changed).

Using the [Save] command, you cannot password protect an already saved project file that was
not already password protected. To set a password for a file that is not already password
protected, save it as a separate file using the [Save As] command.
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Opening Project Files

Project files are opened using the [File] menu - [Open] command in the Main Panel window. Since
the currently opened project file must be closed before another one can be opened, a “Project file has
been modified. Save?” dialog box may be displayed.

m [Open] Command
Project files are opened using the [File] menu — [Open] command in the Main Panel window.

1 Click [File] menu O [Open] in the Main Panel window.
A “Project file has been modified. Save?” dialog box may be displayed.

= DME Designer
¢ _i Project: file has been modified,
\) Saver
] Cancel ]
2 Click the [Yes] or [No] button.
The “Open” dialog box will be displayed.
Open @
Lockin: |12 YAMAHA bldg x| = ®E ey B
B B 123.daf
‘_’\.3 Easd.daf
My Recent ﬁprmectm .daf
Documents Epro]ecttlz.daf
?—[ Eprn]ectﬂ&daf
Deskiop
=
My Documents
dy Clomputer
Myprlwlaectlgvsnrk File name: | _:_J Open |
Files of type: IPID\BCt File [*.daf] j_] Cancel

3 Selects the file to be opened.

4 Click the [Open] button.
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m Opening a Project File That Has Security Set

If security is set for a project, the “Enter ID & Password” dialog box will be displayed when you
click the [Open] button in the “Open” dialog box.

™= Enter ID & Password

Pazzword ]

Ok LCancel I

Enter the ID and password for the file into the [ID] and [Password] boxes, and click the [OK]
button.

If you enter an incorrect ID or password and click the [OK] button on the “Enter ID & Password”
dialog box, the “Wrong ID or password!” dialog box will be displayed.

" DME Designer @

& ‘Wrong ID of password!

Click the [OK] button and enter the correct ID and password the “Enter ID & Password” dialog
box.

m Opening a Project File from the “Recently Used Files” List

Recently used project files are displayed on the [File] menu in the Main Panel window. If you click
one of the filenames, you can open that project file.

2 DME Desiener :

Carl+M
Crl+0
Carl+s

Import Device Canfiguration 3
Export Device Configuration

DME File Storage

1 G/ ProjectD2 daf

2 Gi/Projectl daf ]

-

Recently Used Files _[

Preferences
Log Off
Exit

If security is set for a project file, the “Enter ID & Password” dialog box will be displayed if that file is
selected from the recently used files list. Enter the ID and password to open the file.
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m Double-Click the Icon for the Project File

When you double-click the icon for the project file, the file will open. If DME Designer is not started,
it will start. After logon, the project file will open.

Just as when you use the [Open] command, if DME Designer is already started, the currently open
project file must be closed before another one can be opened. Therefore, a “Project file has been
modified. Save?” dialog box will be displayed.

Sometimes the “Project file has been modified. Save?” dialog box will not be displayed.

" DME Designer

Praject file has been modified.
Save?

If security is set for the project file, the “Enter ID & Password” dialog box will be displayed. Enter
the ID and password to open the file.

Closing Project Files

You cannot have multiple project files open simultaneously in DME Designer. To close the currently
open project file, you can create a new project file or open another project file.

DME Data File

You can import or export parameters for a DME or SP2060 that is arranged in a configuration file.
Parameters for a single DME or SP2060 unit in the current configuration (the one being edited) are
saved as a file. Saved parameters can be imported into another project file.

Files with parameters saved in them are called “DME Data Files.” These files have “.ddf” as the
extension for their filenames.

)

FILE
datadl.ddf
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DME Data Import
This imports DME data file settings into a DME or SP2060 included in the current configuration.

1 Activates the DME or SP2060 configuration layout to be imported.
If multiple configurations are available, the DME or SP2060 configuration layout to be imported can
be selected via the Navigator window.

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Import
Device Configuration].
A submenu will be displayed. The DME groups and SP groups included in the current configuration
will be displayed on a submenu.

= DME Designer, -

New Cirl+N
E Open. Ctrl0

H Save Citrl+5

Save fz.

DME Groupl »
SP Groupl 3
DME File Storaee Create New Group
1 G/ Project02 daf
2 G/ ProjectD daf
Preferences

Log Off

Exit

3 Select the device group to which the DME or SP2060 is to be imported from the submenu.
DME and SP2060 units cannot be used assigned to the same device group.

DME and SP2060 units cannot be combined in the same Device Group.

4 On the submenu, click on the DME or SP2060 into which you will import settings.
The “Open” dialog box will be displayed.

X
Laak in: | £ YAMAHA bldg B =l
’E_ &R datant o
My Recent
Documents
=
E
Desktop
Iy Documents

ter

=
o
o v
Y ola
¥l =Y
b=
e

My Metwork File name: | - Open
Places | J \—I
Files of type: IDME File: [*.ddf) lJ Cancel

5 Select the DME data file and click the [Open] button.
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m [Import Device Configuration] Submenu

The device groups included in the current configuration, as well as the DME or SP2060 units
included they contain, will be displayed in the [Import Device Configuration] submenu.

= DME Desiener :

Crl+M = =
] ! ¥
rip) ©© L3 tf] Fart Zone

Citr [+

User 5 Scene

5P Groupl I ! 3

Create Mew Group

Cirl+5

DMEG4N

Export Device Configuration 3
DME File Storage
1 G:/Projectl2 daf
2 G/ Project0l daf

Create Mew

Preferences
Log Off
Exit

Select [Create New Group] to create a new device group
[Create New DME] creates a new DME and imports settings.

Only users for whom the [Operation Security] — [Edit] checkbox in the “Security” dialog box has been checked can
import DME data. For information about user security levels, see “Scene Manager” on page 70.

If DME data file import was not possible, a “DME file import failed.” message will be displayed.
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DME Data Export

This exports parameters from a DME or SP2060 included in the current configuration and saves them
as afile.

1 Activates the DME or SP2060 configuration layout to be exported.
If multiple configurations are available, the DME or SP2060 configuration layout to be exported can
be selected via the Navigator window.

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Export
Device Configuration].
A submenu will be displayed. The DME groups and SP groups included in the current configuration
will be displayed on a submenu.

== DME Desiener :

Ctrl+H

® ez &yt
winy €€ 3 U] L
Crivo :

Port

Ctrks User &

DME Growpl  »
DME File Storaee 5P Groupl 3

1 G/ Projectl2 daf
2 G:/Projectll daf
Preferences

Log Off

Exit

3 On the submenu, click on the DME or SP2060 from which you will export settings.
The “Save As” dialog box will be displayed.

Export DME E]

Saven JID My Documents Lj 4= rj( ,
‘BMV Music
ﬂMy Pictures
Flomans: |
Save as bype: ]DME File with wave [*.ddf] LJ Cancel

I Security

D [t

Password ]

Confirm Password |

4 Enter the filename.
Determines whether a selected file type will be exported along with a wave file.

5 Specify the folder where the file will be saved, then click the [Save] button.

Library data is not contained in the DME data files exported from SP2060.
Refer to “SP2060 Library Manager” on page 133.
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m [Export Device Configuration] Submenu

The DMEs or SP2060s included in the current configuration will be displayed on the [Export Device
Configuration] submenu.

= DME Desiener :

Cirl+N

r-i%l oo (ks 1l e Zone
Crl+O

Port

User Scene
Cirkes &

Export De o ration m— DMEG4N
DME File Storaee 5P Groupl

1 G/ Project02 daf
2 G/ Projectl daf

Preferences
Log Off
Exit

Library Files

Component Editor, User Control Editor, and User Module Editor parameters can be stored to and
recalled from library files. Refer to “Library Files” on page 301.

The library data for a single SP2060 unit can be imported or exported as required. Refer to “"SP2060
Library Manager"” on page 133.
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Configuration Creation Procedure

The configuration is a design diagram that determines the DME configuration. Transferring this data
causes the DME to operate. Follow the procedure below to create a DME Designer configuration.
SP2060 configurations can be selected from scene preset data, but cannot be edited.

Configurations can be created only when the DME unit is offline. To transfer the data, you must first go into online status. The
procedure for going online is given later in this document.

1 Creating a New Project.
When you start DME Designer, a new project is created. If another project file is already open, use
the [File] menu - [New] command in the Main Panel window to create a new file.
“Main Panel Window Menu” — [File] menu — [New] (page 51)

2 Zone Settings.

Zone names are set, and zones are added and deleted using the “Zone Manager” dialog box.
See “Adding, Deleting, and Renaming a Zone” on page 267.

3 DME, ICP, External Device Layout.
Position the required DME, ICP, and other external devices in the Designer window, set the device
groups for the DME and ICP units, and set the properties.
See “Device Group Selection” on page 249,
“Designer Window” on page 164,
“Objects” on page 183,
“Design Window Shared Settings and Operations” on page 241.

4 Configuration Settings.

Zone names are set, and zones are added and deleted using the “Zone” dialog box.
See “Adding, Deleting, and Renaming a Configuration” on page 270.

5 Placing Components.
Place components and user modules in the Configuration window.
See “Configuration Window” on page 277,
“User Module” on page 285,
“Types of Components” on page 344.

6 Component Logical Connections.

Use wires to connect the components and user modules you placed in the Configuration window.
See “Drawing and Editing Wires” on page 253.

7 Setting Parameters.
Edit the component parameters in the component editor.
See “Component Editor Window” on page 294.

8 Setting User Defined Button
Parameters can be assigned to function keys F1 through F6 in the DME unit.
See “User Defined Button (User Defined Parameters)” on page 118.
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9 Storing Scenes.

Store the scene using the [Tools] menu - [Scene Manager] command in the Main Panel window.
See “IP Address Setup” on page 145.

Online

You can connect the DME or SP2060 unit to your computer and transfer configurations, scenes and
parameters created in DME Designer into the DME or SP2060 unit. You can also read data from the
DME or SP2060 unit into DME Designer, synchronizing it with the status of the DME or SP2060 unit.
Because Synchronization presupposes that the DME or SP2060 unit can communicate with the
computer where DME Designer is installed, the necessary drivers (USB-MIDI or DME-N Network
Driver) must be installed, and appropriate settings must be made for each driver and for DME
Designer MIDI port.

Because there are no scene settings when the DME unit is purchased, the configuration and scene information created in
DME Designer must first be transferred.

A maximum of 32 device groups can be online.

1 DME Unit and Computer Connection.

Connect the DME unit and computer using a USB cable or an Ethernet cable.
See separate “DMEG4N/24N Owner’s Manual” for details.

2 MIDI Driver Installation.

Install the USB-MIDI driver or DME-N Network driver in the computer.
See separate “DME Designer Installation Guide” for details.

3 MIDI Driver Setup.
Make the necessary settings for the MIDI driver installed in the computer. If the driver is set up
already, check the settings before going online.
See separate “DME Designer Installation Guide” for details.

4 MIDI Driver Port Setup.
The MIDI Setup dialog will be displayed if you press the MIDI Setup button on the MIDI Setup

toolbar that is displayed when you start DME Designer Set up the In/Out/Thru ports connected to
the DME.
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[ mMDr » MIDI 3

| Device ]

MIDI Setup button In Ot
v USE [N 0-1 ticrozoft G5 W avetable 5w Sunth

Ha USE M 0-2

thu

NONE -
ok | Cancel

A maximum of 32 ports can be set.

Slave DME64N/DME24N units connected via Ethernet and ICP1 units cannot be set.

Only USB 1 is available on DME8i-C/DME80o-C/DME4io-C.

5 Making MIDI Port Settings in DME Designer.

The port for each device group master can be selected via the “Port” dialog box. If the driver is set
up already, check the settings before going online.
“Port” dialog box (page 135)

6 Storing and Checking Scenes.

When moving online, the lowest scene must be stored. You can check if a scene is stored using the
“Scene Manager” dialog box.

Since the SP2060 has scene preset data this confirmation is not necessary.

See “IP Address Setup” on page 145.

7 Recalling Scenes.

When going online, the scene will be recalled. Its scene number must be displayed in [Scene
Number], and its scene name will be displayed in Scene Name. If [-------- ] is displayed of [Scene
Name], the scene will be recalled.

Since the SP2060 has scene preset data this confirmation is not necessary.

When the scene device group display mode is “ALL”" the scene link name will be displayed. Select a DME group to display
the DME group scene name.

Main Panel Window — “Current Scene” (page 48)
See “Scene Manager” on page 70.
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8 Display the “Synchronization” dialog box.
Click [Synchronization] in the [Tools] menu or the large [Synchronization] button on the toolbar.
When the dialog box opens, a list of connected DME and SP2060 units will be obtained.
DMEs and SP2060s connected to the computer are displayed in the [Network] list.

™= Synchronization

" Go Oft-line Close

Group | DME Groupl

DME Degiener Metwork.

TP Address Tupe
n 192168 000,004 DME4i0-C
R 192168 000007 DME24N

Device [1P Address
DMEZio-C 192168000004
DMEZN 192168000007

Message

0%

Iv Cloge this window after synchronization

When requesting the “Synchronization” dialog box, a one-time alert will be displayed if the MIDI Port settings have not
been made. After clicking the [OK] button on the alert, a dialog will open. At this time, you can make the needed settings
in the displayed dialog box, and then again display the “Synchronization” dialog box.

9 Device Group Selection
Select the device group to be synchronized from the [Group] list in the [Synchronization] window.

Only one device group can be online in one operation.

1 0 IP Address Selection
The DMEs and SP2060s included in the current device group are displayed in the [Designer] list in

the “Synchronization” dialog box. Click the [IP Address] box, then select the DME or SP2060 unit IP
address that matches the DME or SP2060 currently in the DME Designer.

Click [ ¥] to display the IP addresses of all similar devices in the area.
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e} Synchronization

Go Off-line Cloze

Group | DME Groupl ﬂ
DME Designer Netwark

| Device |IP Address | IP Address Twpe |
CME4io-GC

192.168.000.004 e | 52.168.000.004 DME4io-C

DME 24M mEEER ] 02162000007 DMEZ4N

Meszage

0%

v Close this window after synchronization

11 Going Online.
Clicking the [Go On-Line] button displays a dialog box where you can decide the synchronization
method.

An alert will be displayed if no scene has been recalled.

@Sync Direction E|

DME Designer —> Device

DME Designer <- Device |

gk ganeet |

Click the [Designer — Device] direction button.

Transfer of the configuration will begin, and DME Designer will be synchronized with the unit.

If there are many zones, this process may take time.

When going online is finished, the [Go On-line] button will be grayed out, and the Main Panel
window [On-Line] button will light up. The dialog box will close automatically if [Close this window
after synchronization] is checked.

It may not be possible to go online if a scene has not been stored when [Recall Safe] is selected.
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Synchronization

&0 Gl | Gio Off-line

Group | DME Groupl j Device Group
DME Desizner Metwork Mute |Rx
Device |IP Address IP Address Tuwpe |
DME4io-C 192168000004 R 192.168.000.004 DME4i0-C
DMEZ4M 192168000.007 aEEzR 192.168.000.007 DME24M
Meszage

CTear Zor:g ID < Success j

Write Zone 1D < Success >
Synchronize Zone. < Success >

Recall Scene Mo, < Success »
Get Word Glock Fz < Sucocess >
Get Word Glock Fs < Success »
Start Event Logger ¢ Success »
Start Event Scheduler < Success >
Start Wave Manager < Success »
Start Monitoring Point List < Success >
Get Component Preset (DME4io-C:Setup) € Success »
Get Gomponent Preset (DME24N:Setup) < Success »

Transmission complete.

-

UL DL L LR DL L]

v Close thiz window after synchronization

To go off line, click either the [ON-Line] button in the main panel window, or the [Go Off-line]
button in the “Synchronization” dialog box.
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Names and Functions of the Windows

The Main Panel window is the main window of DME Designer.

Current Zone Current Device Group

Title Bar = DME Designer :

Menu Bar —|
Tool Buttons (Small) E /™26 ) e |zone
. Scene i Device Group
— - — ser E &
Tool Buttons (Large) : = = i R T
Log On User Current Scene  [Mute] Button Communication
Status

Title Bar
“DME Designer” is displayed on the title bar.

Commands that can be executed in the application are collected into categories on the menu bar.
When you click one of the categories, a list of commands is displayed.

Also, the name of the currently open project file is displayed at the right. When a new project file has
been opened, or has not yet been saved, “Untitled” will be displayed for the file name.

Tool Buttons (Small)

Frequently used commands are arranged here as buttons. When a command cannot be used, its
button will be grayed out.

[Open File] Button
[Save File] Button
[Undo] Button
[Undo History] Button
[Redo] Button

A "N "':"? r-ﬁu ﬁ' G,B Ur.-l #-"

= Fort

[Port] Button
[User Control Manager] Button

[Clock] Button
[Parameter Link] Button
[MIDI] Button
[GPI] Button
[Word Clock] Button
[User Defined] Button
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m [Open File] Button

Opens project files.
- [Open] on the [File] menu (page 51)

m [Save File] Button

Saves the project file currently being edited.
- [Save] on the [File] menu (page 52)

m [Undo] Button

Undoes the most recent edit operation.
- [Undo] on the [Edit] menu (page 53)

m [Undo History] Button

Opens the “Undo History” dialog box. Undoes multiple operations.
- [Undo History] on the [Edit] menu (page 54)

m [Redo] Button

Restores operations undone with the [Undo] button back to their original condition.
- [Redo] on the [Edit] menu (page 53)

m [User Defined] Button

Opens the “User Defined Button” dialog box.
- See “[User Defined Button]” on page 57.

m [Word Clock] Button

Opens the “Word Clock” dialog box.
- See “[Word Clock]” on page 59.

m [GPI] Button

Opens the “GPI” dialog box.
- See “[GPI]” on page 56.

m [MIDI] Button

Opens the “MIDI” dialog box.
- See “[MIDI]” on page 57.

m [Parameter Link] Button

Opens the “Parameter Link” dialog box.
- See “[Parameter Link]” on page 56.

m [Clock] Button

Opens the “Clock” dialog box.
- See “[Clock]” on page 59.

m [User Control Manager] Button

Opens the “User Control Manager” dialog box.
— See “[User Control]” on page 55.
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m [Port] Button

Opens the “Port” dialog box.
- See "Port" dialog box on page 58.

Tool Button (Large)

[Synchronization] Button

[User Control] Button [Event Logger] Button

[Show/Hide Designer] Button [Event Scheduler] Button

[Show/Hide Navigator] Button

m [Show/Hide Designer] Button
Displays or hides the Designer window.

m [Show/Hide Navigator] Button
Displays or hides the Navigator window.

m [User Control] Button

Works the same as the [User Control] command on the [View] menu. Clicking this button displays a
menu.

i k Mew Llser Cankal
A s,

User Control will be display there, the user control window will be displayed.
If you click [New User Control], the “New User Control” dialog box opens.

m [Synchronization] Button

Opens the “Synchronization” dialog box.
- See “Synchronization” Dialog Box on page 84.

m [Event Logger] Button

Opens the “Event Logger” window.
- See “Event Logger” Window on page 65.

m [Event Scheduler] Button

Opens the “Event Scheduler” dialog box.
- See “Event Scheduler” Dialog Box on page 87.
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Current Zone

Displays the name of the active zone. A list where you can select a zone is displayed when you press
the [ v].

Dewvice Group

Mute Rx Tx On-line

Current Scene
Displays information about the current scene. You can switch between scenes.

[Change displayed Scene]
(displays DME groups/SP2060s)

[Scene Number] [Scene Name] [Scene Manager] Button

m [Change Display Scene]
Selects the information to be displayed. When “All” is selected scene link information is displayed
in [Scene Number] and [Scene Name]. When a DME group or SP2060 is selected scene
information is displayed in [Scene Number] and [Scene Name].
Refer to “Scene Manager” on page 70 for information on scenes, and “Scene Link Manager” on
page 130 for information on scene linking.

m [Scene Number]

Displays the number of the current scene or scene link. A list where you can select a scene or
scene link is displayed when you press the [ ¥]. The EDIT indicator will light when a parameter has
been edited after recalling or storing a scene.

_— | Device Group

On-line

v [001:5cene 001
002:5cens 002
003:5cene 003

Seene 100 - 199 !

»
Scene 200 - 209
Scene 300 - 399
Scens 400 - 499 »
Scene 500 - 599 »
Scene 600 - 699
Scene 700 - 799
Scens 800 - 899 »
Scene 900 - 999 »

Press <Ctrl> key and <+> key simultaneously recall the next scene and press <Ctrl> key and <-> key simultaneously
recall the previous scene. These settings can be changed via the Shortcut keys dialog box (page 136).
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m [Scene Name]
Displays the name of the current scene or scene link.

m [Scene Manager] Button
Opens the “Scene Manager” dialog box.

[User] (Logged On User)

Currently Logged On [Security] Button
User Name

m Currently Logged On User Name
Displays the currently logged on user name.

m [Security] Button
Opens the “Security” dialog box.

Current Device Group

Dewvice Group

Mute |Rx On-line

Displays the name of the currently active device group. Click [ ¥] to display a list that allows selection
of a different device group.

Dewvice Group
k DME Groupl

Mute Rx indg 5P Groupl

m [Mute] Button

Mute OFF Mute ON
Turns ON and OFF the DME mute button for the current device group.
To turn it ON, press the <Shift> key while clicking. If you click the button while it is OFF without
pressing the <Shift> key, the following message will be displayed: “Click the Mute Button with the Shift
Key.”
To turn it OFF, click on the button. There is no need to press the <Shift> key.

= DME Designer

\il) lick the Muke Button with Shift Key
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Communication Status

Displays the status of communication between the group master of the current device group and
the computer.

Message Transmit/Receive Indicator Rox Tx On-line ON-line Button

* [On-line] Button
When the group master of the current device group is connected to a computer, clicking this
button alternately switches the unit's on-line/off-line status. The indicator will light when the
DME unit is on-line.

* Message Transmit/Receive Indicators

[Rx]
Lights when MIDI messages from the group master of the current device group are received by DME
Designer.

[TX]

Lights when MIDI messages are transmitted from DME Designer to the group master of the current
device group.
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Main Panel Window Menu

[File] Menu

"= DME Desiener :

Mew = =0
5 oo ORI ;’;ﬂ

E Open..
E Save User E

Save fs.

Import Device Configuration

Export Device Gonfiguration ¥
DME File Storage

1 Gi/Project0l dat

2 Gi/Project02dat

Preferences

Lag Off

Exit

m [New]
Creates a new project. When a new project is created, the current project will be closed.
A confirmation message asking “Project file has been modified. Save?” will be displayed.

= DME Designer

Project file has been modified.
Save?

[Yes] Button

Saves the currently open project.

If the currently open file was already given a name and saved, that saved file will be overwritten.
The “Save As” dialog box will be displayed for files that have not yet been saved. In this dialog box,
you can name the file when you save it.

[No] Button

Closes the project without saving it. If the file has already been given a name and saved, the most
recently saved version will remain as is. If the project has not been given a name and saved, it will
be lost.

[Cancel] Button
Cancels creation of a new project.

m [Open]
Opens saved project files. Because the currently open project will be closed, a confirmation dialog
box asking “Project file has been modified. Save?” will be displayed.

When you select this command, the “Open” dialog box will be displayed. Select the project file you
want to open and click the [Open] button.
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92

Open E]
Lock in: [ [ YaMAHA bidg =l oF Er
My Recent Eproiectol Jdaf
Documents B projectoz.daf
?'[' B project0s.daf
Eproiectm.daf
Desklop Eproiectl‘t.daf
sy
ty Documents
ty Computer
My Metwark — File name: || ﬂ I&l
Flaces
Files of type: |F'roiecl File [*.daf) j m

If security is enabled for the project file, the “Enter ID & Password” dialog box will be displayed.
Enter the ID and password to open the file and click the [OK] button. The project file will open.

M Enter ID & Password fg|

D u

Pazsword |

ak LCancel

[Save]

Overwrites an already saved project file with the current changes. If the file is being saved for the
first time, the “Save As” dialog box will be displayed.
- See “Project Files” on page 27.

[Save as]

Saves the current project file as another file with a new name or in a new location. When you select
this command, the “Save as” dialog box will be displayed.
- See “Project Files” on page 27.

[Import Device Configuration]

Imports parameters for a device that is arranged in a configuration file.
- See “DME Data Import” on page 35.

[Export Device Configuration]

Exports parameters of a device that is arranged in a configuration file.
- See “DME Data Export” on page 37.

DME File Storage

Opens the “DME File Storage” dialog box.
- See “DME File Storage” on page 61.

Recently Used Files
Displays recently saved files. If you click one of the file names, you can open that file.
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m [Preferences]

Opens the “Preferences” dialog box.
- See “Preferences” on page 62.

m [Log Off]
Logs off the currently logged on user. Because the currently logged on user must be logged off
before a new one can be logged on, the “Log On” dialog box will be displayed so you can log on
the next user.
- See “Users and Security” on page 24.

m [Exit]
Closes “DME Designer.” A confirmation dialog box asking “Project file has been modified. Save?”
will be displayed. To save, click [Yes]. To close without saving, click [No.]

Bl DME Designer,

| i ) Project File has been modified.

Save?

Yes Mo

[Edit] Menu

= DME Designer :

do Move Objects  Girl+Z — e o
! o 88 O 1l

User

do History

(Edit

@

Bedo Append Wire  Citrl
ﬂ ln

m [Undo]

Undoes a single operation. The name of the operation that will be undone by [Undo] is displayed in
the command name. You can also select the commands that come after that.
When [Undo] is not possible, the command will be grayed out.

m [Redo]

Returns to the status before the [Undo] command was executed. The name of the operation that
will be restored by [Redo] is displayed. You can [Redo] only as many operations as were undone
with the [Undo] command. When [Redo] is not possible, the command will be grayed out.
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m [Undo History]
Opens the “Undo History” dialog box. Undoes multiple operations. Also deletes the history of
operations.

"= Undo History

° | Move Objects
Append Wire Cloze —
Append Wire = e
Append Object
Append Wire
Append Wire
tove Objects
tove Objects
Append Wire
Append Wire

s

Append Object

Deletztl  H—@

©Q List
Displays all operations performed so far, in order starting with the oldest. You can select an
operation by clicking on it.

@ [OK] Button
Undoes all operations below the one selected on the list. The operation selected on the list does
not get undone.

© [Close] Button
Closes the dialog box.

O [Delete All] Button
Deletes the entire history of operations displayed on the list. When an operation is deleted from
the list, it cannot be undone.

Operations undone from the [Undo History] can be re-executed one-by-one using [Redo].
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[View] Menu

™ DME Desiener -

Deziener

8| Event Logeer  Girl+L

zer Contral

Mavigator Ctr+B

m [Designer]

Displays or hides the Designer window.

[Event Logger]

Displays the network event log.

Not displayed if selected while the network event log is showing.
- See “Event Logger” on page 65.

[User Control]

This opens User Control.

The user controls that can be opened by the currently logged on user are displayed on a submenu.
If you click [New User Control] on the submenu, the “New User Control” dialog box opens.

- See “User Control/User Module Editor” on page 301.

Controls that are not available to the currently logged-on user are not shown in the menu.

The User Controls that are displayed when the DME Designer is launched depend on the security settings. For details
refer to the “Add User” Dialog Box/”Change User Information” Dialog Box (page 142)

[Navigator]
Displays or hides the Navigator window.
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[Tools] Menu

™ DME Desiener :

Cirl+1
Cirl+2
Cirl+3

Syhchranization Cirl+d

| Event Scheduler

Wiray File Manager

E GPI Cirl+G

MICI Citrl+6
Uzer Defined Button Citr[+7
DA Gontral

Bemote Control Setup List
Parameter List
Component Lock

Scene Link Manager
SP2060 Library Manager

m [Scene Manager]

Opens the “Scene Manager” dialog box.
- See “Scene Manager” on page 70.

m [User Control Manager]

Opens the “User Control Manager” dialog box.
- See “User Control” on page 78, page 301.

m [Parameter Link]

Opens the “Parameter Link” window.
- See “Parameter Link” on page 81

m [Synchronization]

Opens the “Synchronization” dialog box.
- See “Synchronization (DME Designer and Unit Synchronization)” on page 83.

m [Event Scheduler]

Opens the “Event Scheduler” dialog box.
- See “Event Scheduler” on page 87

m [Wav File Manager]

Opens the “Wav File Manager” dialog box.
- See “Wav File Manager” on page 94.

m [GPI]

Opens the “GPI” dialog box.
- See “GPI” on page 97.
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[MIDI]

Opens the “MIDI” dialog box.
- See "MIDI” on page 110.

[User Defined Button]
Opens the “User Defined Button” dialog box.

- See “User Defined Button (User Defined Parameters)” on page 118.

[DAW Control]

Opens the “DAW Control” dialog box.
- See “DAW Control” on page 122.

[Remote Control Setup List]

Opens the “Remote Control Setup List” Dialog box.
- See “Remote Control Setup List” on page 125.

[Parameter List]

Opens the “Parameter List” dialog box.
- See “Parameter List” on page 126.

[Component Lock]

Opens the “Component Lock” dialog box.
- See “Component Lock” on page 129.

[Scene Link Manager]

Allows scene link setup.

- See "Scene Link Manager" on page 130.
[SP2060 Library Manager]

Allows setup of SP2060 libraries.
- See “SP2060 Library Manager” on page 133.
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[Setup] Menu

™ DME Desziener :

m [Port]

Opens the “Port” dialog box.
- See "MIDI Port Setup" on page 135.

m [Shortcut Keys]

Opens the “Shortcut Keys” dialog box.
- See “Shortcut Keys” on page 136.

m [Security]

Opens the “Security” dialog box.
- See “Security (Creating Users and Making User Settings)” on page 137.

[Hardware] Menu

== DME Designer :

Metwaork Setup

Wtility
Wierd Glock Crke
EI bl =" Monitor Out Cirl+3
Glock

Laneuaee

Backup

Firmmare Update 3

m [Network Setup]

Opens the “Network Setup” dialog box.
- See “IP Address Serup” on page 145.

m [Utility]

Opens the “Utility” dialog box.
- See “Utility” on page 146.
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[Word Clock]

Opens the “Word Clock” dialog box.
- See “Word Clock” on page 154.

[Monitor Out]

Opens the “Monitor Out” dialog box.
- See “Monitor Out” on page 156.

[Clock]

Opens the “Clock” dialog box.
- See “Clock” on page 157.

[Language]
Opens the “Language” dialog box.
- See “Language Settings” on page 158.

[Backup]

Opens the “Backup” dialog box.
- See “Backup” on page 159.

[Firmware Update]
Updates the DME, SP2060, or ICP1 firmware.

- See “DME Firmware Update” on page 160.
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[Window] Menu

™= DME Desiener -

Cloge All Editor Windows  Gtrl+E

1 Designer scene Numt

2 Compressor

Displays the open windows. Click a window name to bring that window to the front.

m [Close All Editor Windows]
Closes all editor windows.

Each design windows within the Designer window can be switched using the [Window] menu in the Designer window.

[About] Menu

= DME Designer :

Ahout DME Dezigner
Fels SENCTTi T N B

m [About DME Designer]
Displays information about this application.
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DME File Storage

Allows management of DME files. Project files can be managed on the DME, eliminating the need to
manage them on the computer.Project files can be managed on a DME unit without the need for a
computer. Since project files are necessary to allow synchronization of DME and SP2060 units, we
recommend that you save your project files to the DME unit for enhanced reliability.

Click [DME File Storage] in the [File] menu to display the “DME File Storage” dialog.

Does not apply to SP2060 units

Names and Functions

2 DME File Storage

Zone J File Mame ISize ]Date 1 Send.. |

E-Zonel

L. 0 DME4io-C[192168.000.003] Receive
Delete

Femaining Memory
00 KB

Cloze

m Zone List
Select the desired zone and device group and DME from the list.

m File List

A list of the files stored on the selected DME.

[Send] Button
Transfers selected files from the computer to the DME.

[Receive] Button
Transfers selected files from the DME to the computer.

[Delete] Button
Deletes selected files from the DME.

[Close] Button
Closes the dialog box.
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Synchronization may become impossible if the [Remaining Memory] value (the amount of remaining DME memory)
becomes too small. If this occurs, delete unwanted files to increase the amount of available memory.

Preferences

When you click the [Preferences] command on the [File] menu in the Main Panel window, the
“Preferences” dialog box is displayed. Here you can make environmental settings for using DME
Designer.

Names and Functions

m [Application] Tab
Here you can set the general usage environment.

2 Preferences @

Bpplication 1Component Editar ]

-On Startup
IR | 0ad the last file o)

ContentsFolder
s/ YAMAHAOPT Tooks/DME Desiener

—Auto Save -
[~ Enable

Interval in minute 30 =

I~ Gonfirm Scene Store

|~ Save after Synchronization

o] 4 Cancel

On Startup
Selects the action when the application starts up.

* [Load the last file opened]

Opens the last opened file. If the file cannot be found because it was moved, deleted, or its
name was changed, a new project will be opened.

* [Create an empty file]
Opens a new project.

* [Load File & Synchronization]
Opens the last opened file and synchronizes with the DME or SP2060 unit.

Contents Folder

Specifies the folder where the images used by the Design windows and user controls are stored.
Click the [Browse] button and specify the folder.
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Auto Save

Set up the automatic file save feature.
This setting has no effect when the file being worked on has not previously been saved, or the
computer is online.

 [Enable]
Auto save of project files being worked on will occur when checked. The file will be
overwritten, but the Undo history will not be cleared.

* [Interval in minutes]
Specifies the auto-save interval in minutes.

[Confirm Scene Store]
Place a checkmark here to have a confirmation dialog box displayed when storing a scene.

[Save after synchronization]

If a save is performed after the DME Designer is synchronized to the DME or SP2060 unit, the next
synchronization will be significantly faster because one the difference needs to be synchronized.
Check this checkbox to specify auto-save after the DME Designer is synchronized to the DME or
SP2060 unit.

m [Component Editor] Tab
Sets up operation of the Component Editor knobs, sliders, and edit boxes.

" Preferences IEJ
fipplication | Camporent Editor ]
Knab Made *
Slider Mode [ Ramp =l
Edit Box Zoom |On L]
Edit Box Font | M3 UI Gothic Li
oK Cancel

Knob Mode
Sets how the knobs operate.

* Circular
The knob is dragged following its shape, as though you were drawing a circle.

* Linear
As you drag the knob to the upper, the value increases. Dragging it down decreases the value.
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Slider Mode
Sets the action that occurs when you click on the scale located under the sliders.

* Ramp
When the fader bar is clicked the knob will move a preset amount in the corresponding
direction.

» Touch
The slider does not move without directly touching it, even if you click the mouse button.

e Jump
The slider jumps to the location where you click.

Edit Box Zoom
When “On” the edit box will enlarge on mouse-over.

Edit Box Font
When “On” the edit box will enlarge on mouse-over.

This is the font when the box is enlarged, not the font that is used when the box is at it's smallest size. The text may bleed
beyond the box with some fonts.

To make a finer setting, press the <Shift> key while dragging the slider.
If you click a slider while pressing the <Ctrl> key, the setting will return to its default value.

m Common to All Tabs
[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Event Logger

When you click [Event Logger] in the [View] menu while online, the “Event Logger” window is
displayed. This records and displays DME unit events.

When the dialog box is opened while onling, the event log is automatically obtained and displayed as
a list in the Event Logger window.

Events are displayed in realtime as long as the dialog box stays open while online. The information is
also simultaneously recorded in a file if the log function is enabled.

Does not apply to SP2060 units.

Only users for whom the [View Log Window] checkbox in the “Security” dialog box has been turned ON can display the
“Event Logger” window. The default setting for this parameter is OFF.

The events you wish to display in the Event Logger window must be set in advance in the “Event Log List” dialog box.

Names and Functions

™™ Event Loeeer |‘._]|E|r5_(]
Get Log.. ‘ Zohe | All v] \_'5) [(/i\, [9 Glear Screen
Date JTime i Type ]Zone IGroup J DME I Event I
2006-04-20 14:45:45 \i.)Informat ian Log OrcAdministrator
2006-04-20 14:4%:46 |1 }nformation Loe Off:Adminiztrator
2006-04-20 14:4%:46 |1 }nformation Loe Or:Administrator
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m DME List

* [Date]
Displays the date the event occurred. (Example Display: 2004-08-24)
o [Time]
Displays the time the event occurred.
* [Type]
Displays the event type and icon.
There are three event types:
A\ (Warning): Warning event
(%] (Error): Error event
L) (Information): Other events
* [Zone]
Displays the name of the zone in which the event occurred.

* [Group]
Displays the name of the device group in which an event has occurred.

» [DME]
Displays the name of the DME in which the event occurred.

* [Event]
Displays the content of the event.

[Log Setup] Button
Displays the “Log Setup” dialog box. Here you can make Event Log settings.

[Get Log] Button

When you are offline, this selects the DME from which the log will be taken. During online status,
this button is grayed out and cannot be used.
Clicking here displays the “Get Log” dialog box.

[Zone]

Selects the zone, device group and device for which events will be displayed. Only events from the
selected device will be displayed in the window. If [All] is selected, events will be displayed for all.

Display button (Information/Warning/Error)

« 1) [Display Information] Button

Switches between displaying and hiding Information events.

When turned ON, Information events are displayed in the “Event Logger” window.
« /A [Display Warning] Button

Switches between displaying and hiding Warning events.

When turned ON, Warning events are displayed in the “Event Logger” window.
« € [Display Error] Button

Switches between displaying and hiding Error events.
When turned ON, Error events are displayed in the “Event Logger” window.

[Clear Screen] Button
Clears (erases) events.
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“Log Setup” dialog box

Click the [Log Setup] button in the “Event Logger” window to display the “Log Setup” dialog box. Here
you can make Event Log settings. These settings apply to the system as a whole.

= Log Setup

—Digplay Event

e
Becord |7 3: davs per log file W Information
v Warning
[~ fButomatically delete loe files after iSD EI: days

v Errar
Loe file folder:

iquments and Settinez kawazoe/My Documents Browsze..
Log List Setup...

[+ Dizplay Log Buffer Full Mezsage

o] 4 | Cancel

m [Enable Logging]

Turns ON or OFF the function that writes the obtained event log data to a file. When a check is
placed here, the event log is written to a file.
When checked, it is set in the [Enable Logging] frame.

Record __ days per log file

Sets the number of days recorded into a single log file. When the specified number of days is
exceeded, a new log file is created, and future log events are recorded there.

When “1” is set for the number of days at 10:00 AM, information will be recorded in the same file
until the next day at 9:59 AM. The number of days counted are cleared when the “Log Setup”
dialog box is closed by clicking the [OK] button, or when the system goes online.

Automatically delete log files after __ days

When a check is placed here, log files exceeding the specified number of days are automatically
deleted. Specifies the number of days after which log files are automatically deleted.

Log file folder

Specify the folder for saving log files. Clicking the [Browse] button opens the standard operating
system dialog box for specifying folders. Here you can select a folder.

Log files are saved with the following file name: “LOG + Start_Date.txt”.

If there is a file with the same name already in the specified folder, a number will be affixed to the
end of the file name, and it will be saved as a separate file. (Example: LOG20040824-2.txt)

m [Display Event]
Displays events with checks next to them. This operates together with the [Display Information],

[Display Warning], and [Display Error] buttons in the “Event Logger” window. You can place
checks next to multiple events.
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m [Display Log Buffer Full Message]

When a check is placed here, “Log Buffer Full” messages will be displayed on the displays of all
DME units in the zone.

m [Log List Setup] Button
Sets events sent from the DME units. Clicking here displays the “Event Log List” dialog box.

m [OK] Button
Applies any setting changes and closes the window.

m [Cancel] Button
Closes the window without changing any settings.

“Get Log” dialog box
Click the [Get Log] button in the “Event Logger” window to display the “Get Log” dialog box.

Target DME

DME Type |
[ Zore
[ 192 168,000,002 DME 24k
[ 192168.000.003 DMEE4MN
‘e [ 192.168.000.009 DMER4N

Dutput File Marme

| Browsze. .
DME Log Clear 0K LCancel I

m DME List

Displays the IP addresses and types of DME units included in the device group. Click the DME
from which to obtain events by placing a check next to it.

m [Output File Name]

Sets the file name and save location for the log file. Clicking the [Browse] button opens the file
select dialog box, where you can select a file.

m [DME Log Clear]

Clears (erases) logs in the DME checked. When you click this button, a confirmation dialog is
displayed.

m [OK] Button
Applies any setting changes and closes the window.

m [Cancel] Button
Closes the window without changing any settings.
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“Event Log List” Dialog Box

Sets events sent from the DME units. Sends events with checks next to them.

™ Event Loge List

Zone |Zonel -

OME | DME Group/DMEG4N |

Event

Event Twpe GPI Ot -
External device control buffer full. Information -
Communication between external A0 unit and DME ended.  Information  -—-
The power waz turned on, Information ——
Fanel Locked. Information -
Fanel Unlocked. Information -
AN GPT QLT trans mitted.
Fortl Information
Port2 Information -
Port3 Information -
Portd Information ——
Forts Information -
Portd Information -
Port? Information -
Portd Information -
Fortd Information -
Fort10 Information -
Portid Information ——
Port12 Information -
Port13 Information -
Port14 Information —— j
o] 4 Cancel |
m [Zone]
If you click here, a list will be displayed. Specifies a zone.
m [DME]
If you click here, a list will be displayed. Specifies DMEs.
m [Event]
You can turn sending of logs for each event ON or OFF.,
m [Type]
If you click here, a list will be displayed. Select type of event.
[Information], [Warning], and [Error] are displayed in a list.
m [GPI OUT]
Sends GPI output for each event.
m [OK] Button
Applies any setting changes and closes the window.
m [Cancel] Button

Closes the window without changing any settings.
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Scene Manager

Scenes

Configuration contents can be given a name and saved as “Scenes.” Saving scenes is called “Scene
Store.” Parameter settings in the configuration for each site used can be stored multiple times and
recalled and used when needed. There are 999 scene memories available. When a scene is stored,
DME and SP2060 parameters are saved as “preset parameters.” Presets are automatically created
when a scene is stored.

Bringing back a scene (making a scene the current scene) is called “scene recall.” Scenes are
recalled using the [ ¥] button next to the current scene on the Main Panel window or by using the
“Scene Manager” dialog box.

m “Scene Manager” Dialog Box

Click either the [Tools] menu [Scene Manager] item or the “Scene Link Manager” window [Scene
Manager] button to open the “Scene Manager” window that allows editing of scene data. Scene
names, security levels, and presets can be changed and copy/pasted as required. The DME
scene memory is comprised of 999 user memories, while the SP2060 has 12 preset memories and
87 user memories. The preset memories are read-only, while settings and changes can be stored
to the user memories as required.

Security for the Logged On User
The currently logged on user can store, recall, or edit scenes that have a security level equal to or lower than his or her
own. User security levels are set with the [Edit] - [Store/Recall/Edit] item in the “Security” dialog box.
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Names and Functions

[Copy] Button  [Insert] Button

[Cut] Button | [Paste] Button | [Clear] Button

[Recall Safe] Button

2 5cen> Manager

Cut | Copy Paste |  Isert | Glear Recall Safe | Dsl | Store | Mew | Del Unussd |
[T V! [Preset [
: : T DME2AN
Scene Mo, | Mame fieuration | Edit Security | Recall Security | Fade | Fade Mode | Fade Time | Protect 3 50 AD
3 fie Level 1 Level 1 OFF Al 00 OFF 1@ Presetidl

002 [Mo Datal 3 = % - E :

=} O Compaonent
e [Mo Datal 5 = 5 ! E i @ Presetill
004 [Mo Data] - z = 3 Z ® ® E‘ O Slot
006 [Mo Data] = = 5 2 e % = @ Fresetnt
nos [Mo Datal - 2 5 5 & Z = DMERI-G2)
o7 [No Datal - 5 = 7 ! 2 E

&0 AD
008 [No Data] - g = 5 ! % E i @ Presetdll
ooo [Mo Datal - - - 5 5 ) E 5. O G

=8 omponent
010 [Mo Data] - z = 5 & = E i L@ Presetdl
011 [No Datal - N = 57 & 2 E £

= O Slot
02 [No Data] - g = 5 ! % E @ Fresetil
013 [Mo Data] - N 5 = = = E
014 [No Datal - 2 = 7 & g E
ul [No Datal - e = 57 & 2 E
uf3 [No Data] - £ = 5 & % E
017 [Mo Data] - N 5 = = = E
012 [No Datal - 2 = 7 & g E
il [No Datal - e = 57 & 2 E
020 [No Data] - £ = 5 & % E
021 [Mo Data] - g = 7 & % E
022 [No Datal - 2 = 7 & g E
Q23 [Mo Data] = = = < = = k= |
]scene Link ' Becall | [ Detaib>

L

[Scene Link] Button  List

m DME Group/SP2060 Selection
Selects a DME group or SP2060.

m List
Displays the contents of the scene.

Scene No.

[Store] Button | [Detail] Button

[Recall] Button

Displays the scene number. Click here to select a scene.

Name

Displays the name of the scene. Click the [Name] box to enter a scene name. Up to 18 characters

can be entered.

If the scene has not been stored, “[No Data]” will be displayed. A name can be entered when a
scene is stored. The default names are “Scene001,” “Scene002,” etc. The three-digit number is the
same as the scene number (displayed in [Scene Number]) for the stored scene.

The SP2060 display can only display up to 16 single-byte characters. Some characters that appear correctly on the DME

Designer may change when displayed on the SP2060 display. For example, a backslash character will appear as a yen

symbol on the SP2060 display.
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Configuration
Displays the configuration name. If the scene has not been stored, a hyphen (-) will be displayed.

" Scene Manager

Cut Copy Paste Inzert ] Clear Recall Safe
DME Group _:_j

003 [Mo Datal - i T o = = 3

004 [Ma Datal - i = = 5 5 k=

005 [Mo Data] - T = T = = 3

006 [Mo Datal - i T o = = 3

00?7 [Ma Datal - i = = 5 5 k=

00 [Mo Data] - T = T = = 3

ong [Mo Datal - i T o = = 3

010 [Ma Datal - i T = 5 5 = _'_j
Scene Link Store | Becall Detail»> |

Edit Security

Displays the scene edit security levels. Clicking here will display a list where you can change these
security levels. Only levels at or below the security level of the currently logged on user are
displayed in the list. When a user is created, these settings are the same as the new user's security
level, but scene store and edit settings can be set lower.

Recall Security

Displays the scene recall security level. Clicking here will display a list where you can change the
security level. Only levels at or below the security level of the currently logged on user are
displayed in the list. When a user is created, these settings are the same as the new user's security
level, but the scene recall setting can be set lower.

Fade
It sets whether fade is applied (ON) or not (OFF) when a scene is recalled.

When “ON” the faders in fader components will “fade” to their new settings according to the specified fade mode and
fade time when a scene is recalled. This only applies to fader components.

The fade function cannot be simulated in DME Designer.

Fade Mode

Sets the fade mode. You can select “All” or “Selected.”

If you select “All,” all channels using Fader components in their configuration will be affected. Even
when multiple components are used, all channels are targeted. If you select “Selected,” the only
channels affected will be those for which the Fade switch in the component editor has been set to
ON.

The Fade switch for each channel is set to OFF by default. The fade effect will not be applied, even if Fade=ON and
Fade Mode=Selected is selected. To apply the effect, you must set the Fade switch to ON for the channels where you
need it.
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Fade Time

Sets the fade time: i.e. the time it will take fader parameters to reach their new settings when a
scene is recalled. The changes are smooth and continuous. If only the presets in the recalled
scene are set when that scene is recalled, the volume will be adjusted while the sound from the
previous scene is playing, until the new level is reached If the configuration also changes, the
volume will rise from silence until it reaches the new value. This can be set from zero to 60 seconds,
in 0.1 second increments.

Protect

Turns the Protect function ON or OFF.
When ON scene data cannot be deleted, overwritten, edited, or renamed.

Right-click in the list and use the contextual menu that appears to set User Defined Button, Program Change, GPI In, or GPI

Out for the scene.

[Cut] Button

Cuts the scene selected on the list. The button will be grayed out and cannot be used when the unit
is online or when an SP2060 preset is being used.

[Copy] Button

Copies the scene selected on the list. The button will be grayed out and cannot be used when the
unit is online.

[Paste] Button

Pastes the contents of the cut or copied scene into the scene selected on the list. Cuts the scene
selected on the list. The button will be grayed out and cannot be used when the unit is online or
when an SP2060 preset is being used. The selected scene will be overwritten.

[Insert] Button

Inserts the contents of the cut or copied scene into the location of the scene selected on the list.
The selected scene and those below are moved down by one. For example, if “Door_Open” was
stored as scene number “005,” and selected when the [Insert] button was clicked, the inserted
scene would become scene number “005,” and “Door_Open” would be moved to scene number
“006.”

Cut ‘ Copy | Paste | Insert ‘ Clear | Recall Safe LCut | Copy | Paste ‘ Insert | Clear | Fecall Safe
Scene No ‘ Mame | Configuration | Edit Security ‘ Recal Security | i‘ Scene Mo | Mame | Configuration | Edit Security | Recal Security | il
om BGM_Control Configuration]  Lewvel 5 Level 5 o1 BGM_Contral Configuration  Lewvel 5 Lewel 5
ooz Convention_Center Configuration1  Level 5 Level B o0z Convention_Center Configuation]  Level 5 Level 5
ao3 Scene 003 Configuiationl Level 5 Level 5 003 Scene 003 Configuiationl  Level 5 Level 5
aoa Light_On Configuiationl Level 5 Level 5 004 Light_On Configuiationl  Level 5 Level 5

Door_Open Configuiationl Level 5 ) [Mo Data] = s s
00g [Mo Data] - - - Click the [T Door_Open Corfiguration]  Level 5 Level 5
ooy [Mo Data] - - - [lnsert] button ooy [Mo Data] - -
aog [Mo Data] - - - oog [Mo Data]
aong [Mo Data] - - - 009 [Mo Data] - -
oo [Mo Datal - - - ﬂ 010 [Ho Datal - - - j
Store Recal Details> | Stare I Hecall Dietail>> ‘

If a scene is stored in the lowest scene on the scene memory list, the button will be grayed out and
the insert function will not be available. Delete the contents of the lowest scene before attempting
to use the insert function.

Move the scene data to a different scene memory when you don’t want to erase the contents of the lowest scene.
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m [Clear] Button

Deletes the contents of the scene selected on the list. The button will be grayed out and cannot be
used when the DME unit is online or when an SP2060 preset is being used.

If the preset parameters included in a scene are not used in another scene, a “Delete preset?”
message will be displayed.

= DME Designer gl

@ Delete preset?

QK |

If the preset parameters are not needed, click the [OK] button. If you click the [Cancel] button, the
preset parameters will not be deleted. Whichever you click, the scene itself will be deleted.

The [Cancel] button on the “Delete Preset?” message does not cancel the [Clear] for the scene. It merely cancels
deletion of the presets.

[Recall Safe] Button

Before performing a recall, you can check the contents of the scene selected on the list, and set
components that will not be read. This is used when there are components you do not want
changed by the scene recall.

When you click this button, the “Recall Safe” dialog box will be displayed.

2 Recall Safe lzl

Component l

ternal[DMEZ4N DAl
ternal[DMEZ4N HA-AD]

Select All |
Cilear &l

Checkbox Component Name

All components included in the scene will be displayed. There is a checkbox to the left of each
component. Place a check next to the components you do not wish to have read by scene recall
(those you do not wish changed from their current status).

Press the [Select All] button to check all components, or the [Clear All] button to clear the checks
from all components.

Click the [OK] button. The dialog box will close and when the scene is recalled, all components,
except those checked, will be read.

The components checked in the “Recall Safe” dialog box are the components that will not be read (that will be ignored).
If you want to read all components, there is no need to make settings in the “Recall Safe” dialog box.

“Recall Safe” is used when you want to keep some components with their current settings, while there are other
components you want to change according to the scene.
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m [Store] Button

Stores the contents of the current configuration into the scene selected in the list. If an empty scene
is selected and the contents stored there, a new scene is created. If a scene is already stored in
the selected scene number, it will be overwritten. If [Confirm Scene Store] is checked on the
[Application] tab of the “Preferences” dialog box, a confirmation dialog box will be displayed
before the scene is stored.

The currently logged on user can store scenes at a security level equal to or lower than his or her own only.

When the computer and DME64N/24N unit are online, a scene stored in the DME Designer will also be stored on the
DME or SP2060 unit, regardless of the DME or SP2060 settings.

The DMEGB4N/24N utility display Misc. page [Scene Store] setting only affects store operation from the DME panel
controls.

When a scene is stored, the configuration parameters at that time are saved as “preset
parameters.”Preset parameters are created automatically.

m [Recall] Button
Recalls the scene selected in the list and makes it the current scene.

The currently logged on user can recall scenes at a security level equal to or lower than his or her own only.

m [Scene Link] Button

Opens “Scene Link Manager” dialog box.
Refer to “Scene Link Manager” on page 130
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m [Detail] Button

Expands the dialog box and displays a preset parameters list. If you click the preset parameters
list while it is displayed, the preset parameters list will be hidden. When the dialog box is opened,
its status will be the same as the last time it was closed.

Not available for SP2060 groups.

[Del] Button
[Store] Button
[New] Button
[Del Unused] Button

T2 Scene Manager

Cut | Copy Paste |  hwert |  Glear | Recall Safe | Del | Store | Mew | Del Unused |
| DME Group et T )
Scene No. | Name Configwration | Edit Security | Recall Security | Fade | Fade Mode | Fade Time | Protect i{ DMESNAD DME
0 K All 00 s Lk O Prasetna-t
00z Gonvention Center Config Level 1 Level 1 OFF  All 00 OFF L@ Presetins—2
003 [No Data] 5 5 7 5 & & = - O Component
004 [No Data] = = 2 = = o] -_
1-@ Presetl04-1

005 [No Data] o o 7 7 ] L0 PresetlDd-2 e preset parameters
06 [No Data] , 3 2 & - O Slat
007 [No Data] 5 = 7 & = 1@ Preset004-1
ng [No Dats] - o = 5 ® L0 Presstinaz
oos [No Datal 5 = 7 = =

DMEBI-C2)
i [No Data] = = 7 = = ) |£| AD DME
11 [No Data) = = = = = @ Preset00d-1
012 [No Data% o = 2 : ® 1O Presetll4-2 I
o3 [No Data - - E - O Component preset parameters
014 [No Data] = = 7 = = i-@ Preset004-1 I
05 [No Data) = = = = = O Presetlnd-2
k) [No Data] 5 3 7 & ® O Slat
07 [No Data) % = = = = @ Presetdl4-1
o1 [No Datal - % i 5 ® L0 Fresstong-2
of [No Datal 5 = = 5 = = = =
Sl Store | _ Recall | [ Detaib>

1

[Detail] Button

Preset parametersList
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m Preset parameters List

Displays the preset parameters for each DME or SP2060 unit in the scene selected in the list. When
another scene is selected on the list, the contents of the preset parameters list will be changed.
You can change the preset parameters used in the scene by clicking the radio buttons to the left of
the preset parameters names. You can also create, delete, and store preset parameters or change
their names.

DME

Displays the DME and SP2060. Below the DME and SP2060 are [Slot], [Component], and [AD]. If
there are preset parameters below them, a [+] button will be displayed. When you click the [+] it
becomes a [-] and the presets are displayed.

Preset parameters

Displays DME and SP2060 preset parameters.

If you click the preset parameters name, selecting the text that is there, you can change the preset
parameters name. When preset parameters are automatically created when a scene is stored, they
are named “Preset001,” “Preset002,” and so on. preset parameters created with the [New] button
are named “New Preset.”

You can select the preset parameters used in a scene by clicking the radio buttons to the left of the
preset parameters names.

[Del] Button
Deletes the preset parameters selected on the preset parameters list.

Presets used in a scene cannot be deleted.

[Store] Button

Stores the current parameter status in the preset parameters selected in the preset list. The
contents of the selected preset parameters will be overwritten.

[New] Button

Stores the current status and creates a new preset parameters. The newly created preset
parameters is named “New Preset.”

[Del Unused] Button

Deletes unused preset parameters from DME units in the selected device group, or from the
selected SP2060 unit.

There is no [OK] button or [Cancel] button in the “Scene Manager” dialog box. To close the dialog box, click the [Close]
button at the upper-right of the dialog box.

Changes from storing/recalling scenes or editing, such as changing names or contents, will be applied immediately.
With the dialog box open, you can make the Designer window active and add components or change parameters.

DME Designer Owner’s Manual

17



Chapter 3 Main Panel Window

78

User Control

User Controls

You can create an original control by arranging knobs and sliders in the component editor. Controls
you create are called “user controls.”

Those created user controls are displayed in the [View] - [User Control] submenu in the Main Panel
window

Refer to “User Control Editor/User Module Editor” on page 301 for information on user control editing.

“User Control Manager” Dialog Box

When you click [User Control Manager] on the [Tools] menu, the “User Control Manager” dialog box is
displayed. This dialog box displays a list of user controls included in the configuration of the current
device group. There they can be created or deleted. You can also edit the name and security level of
user controls here.

Security for the Logged On User

The currently logged-on user can create and edit the user controls of all users at lower security levels as well as the controls
specified for that user. Available user controls are displayed in the User Control manager dialog box that can be accessed
through the [User Control] sub-menu of the main panel window [View] menu.

The user control security level for each user is set with [Operation Security] - [User Control Level] in the “Security” dialog

box. For information about user security, see page 137.

Names and Functions

™ User Gontrol Manager

Uzer Contral | Security Level | User |
Door Open Level & e
Light Cn e Administratar, morning, Mighti

New Delate ‘ (0] 4 | Gancel

Only controls available to the currently logged on user are shown in the list.

DME Designer Owner’s Manual



Chapter 3 Main Panel Window

m User Control

Displays the names of the user controls. Clicking here will select the characters in the name,
allowing you to change it.

- User, Control Manager,

Uzer Contral |Security Lewel |

Door_Open  Lewel 5

Hew Delete ‘ ok |

LCancel

m Security Level

Displays the security level set for each user control.

Clicking here will display a list where you can change the security level.

m User

™ User Control Manager

Uzer Control | Security Lewel | User

Door Open
Light COn

Level 2
A

Mew Delete ‘ ak |

[Level T JAdministrator, mornine, Night

Cancel

Displays the name of the user specified in User Control.
Clicking here will display a list of the available users.

™ User Gontrol Manager

Uszer Contral | Security Lewel | User

Door Open  Level & S

Light On Administra

User hame

|

morning

Mew Delete J ak |

Administrator

éEDUI"I

oK

Cancel ‘

Levels at or below the security level of the currently logged on user are displayed in the list.
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m [New] Button
Creates new user controls. Clicking here displays the “New User Control” dialog box.

= New User Control EJ

Mame ]\

i User Level Level 1 ¥

Uszer Mame ‘
[ Administratar
5. [ Userl

[ Userz

QK Cancel

Enter the User Control name in the [Name] box.

m [User Level]/[User Name]
Use the radio buttons to the left to select security-level or user dependent control.

[User Level]
Select a security level from the drop-down list.

[User Name]

Check a checkbox.
Click [OK] to create the specified User Control setup.

m [Delete] Button
Deletes the user control selected on the list.

m [OK] Button
Accepts the changed settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without changing the settings.

80 DME Designer Owner’s Manual



Chapter 3 Main Panel Window

Parameter Link

About Parameter Links

You can group parameters of the same type and link them. These groups are called “Parameter
Links.” When one parameter in a parameter link group is changed, all parameters in the parameter link
group will change in the same way.

There are three parameter link types: global links, local links and component links. Global links link
parameters for DMEs within a device group. Local links and component links link parameters that are
included for a single DME.

Parameters can not apply to multiple groups.

Groups can be created and parameters added to groups in the user control/user module control
editor and component editor. For information about creating parameter links, see “Creating Parameter
Links” on page 341.

You can check the status of parameter links and edit them in the Parameter Link window.

Parameter Link Window

When you click [Parameter Link] in the [Tools] menu, the “Parameter Link” window is displayed. You
can also display the window by selecting [Open Parameter Link] from the context menu displayed in
the user control/user module editor and component editor.

Names and Functions

[Global Link] button/[Local Link] /[Component Link] buttons

Campeornnt Lk

= |
0] 1Ene]

uoo{] o]

© [Global Link] button/[Local Link] button/[Component Link] button
Switches the window display.

* Global Link
Links to the parameters of multiple DME units in the zone.

Because there is a large load on the network, the maximum number of Global Links will be limited to eight.

* Local Link
Links to the parameters of one DME unit.

» Component Link
Links component parameters of the same type within a single DME unit.
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Component Link cannot be used with SPX components.

@ Parameter Link Group List

Displays a hierarchical list of parameter link group and the parameters that belong to them.
When a parameter link group name is selected, the controls that belong to that parameter link
group are selected.

Gilobal Link Local Link GCompanent Link

Global [Link [ Keep Offeet [Min [Max |
- T Group m  mE

- Output 1 1-Level -INFINITY[4E1 0.00[dE]
&[T Group? [ on | e
£ BOMESI-GC)
ErOrossover
LiGenter]1:Frequency 200He] 20.0k[Hz]
T ——" 200[He] 200k [He]

* Group Name
You can select a parameter link group name by clicking on it. Clicking the selected parameter
link group name again will select the characters in the name, allowing you to change it.
Clicking the plus (+) or minus (-) sign to the left of the parameter link group name displays or
hides items that belong to that parameter link group.
You can delete a parameter link group by selecting it and pressing the <Delete> key. You can
also delete a parameter link group by right-clicking on the parameter link group name and
selecting [Delete] in the context menu that is displayed.

DME Icon

Displays the DME that includes the parameters that belong to a parameter link group. The
components can be displayed or hidden by clicking the plus (+) or minus (-) signs for the
DME icon. The parameters, Min, and Max can be displayed or hidden by clicking the plus (+)
or minus (-) signs for the component.

* Link
Click to turn ON or OFF. Turn OFF to disable parameter linking.
Component linking for multiple parameters can be turned ON or OFF via the contextual menu
that appears when the group name is right-clicked.

» Keep Offset
Click to urn ON or OFF. When “ON” the parameter offset is maintained so that when any
parameter in the group reaches its minimum or maximum value, further decrease or increase
is not possible.
Keep Offset for multiple parameters can be turned ON or OFF via the contextual menu that
appears when the group name is right-clicked.

* Parameter
Displays the parameters that belong to a parameter link group. You can display or hide
minimum and maximum values for a parameter by clicking the plus (+) or minus (-) signs.
You can delete a parameter from a parameter link group by selecting the parameter name
and pressing the <Delete> key.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

82 DME Designer Owner’s Manual



Chapter 3 Main Panel Window

Synchronization
(DME Designer and Unit Synchronization)

The DME or SP2060 unit and DME Designer are synchronized by Synchronization. The DME or
SP2060 operates according to the configuration and scene information transferred during this
process.

This Synchronization is used when transferring the configuration in DME Designer and when
controlling the DME or SP2060 unit in real time.

Because Synchronization presupposes that the DME or SP2060 unit can communicate with the computer where DME
Designer is installed, the necessary drivers (USB-MIDI or DME-N Network Driver) must be installed, and appropriate settings
must be made for the driver and for DME Designer MIDI IN/OUT (page 110).

For information about driver installation and settings, see the installation guide. For DME Designer communications settings,
see “Online” (page 40).

Because there are no scene settings when the DME unit is purchased, the configuration and scene information in DME
Designer must first be transferred.

For information about the online procedure, see “Online” (page 40).

Online and Offline

When a DME or SP2060 unit is connected to the computer and synchronized with DME Designer, its
status is called “Online.” When a DME or SP2060 unit is not physically connected to the computer or
is not synchronized even when it is connected, its status is called “Offline.” You can check the online/
offline status and message transmission in [Communication Status] in the Main Panel window.

m Online

Sends configurations created in DME Designer to the DME or SP2060 unit and reads data from the
DME or SP2060 unit, so that the DME unit configuration is reflected in the DME Designer
configuration. You can also control the DME or SP2060 in real time from DME Designer. Operations
performed in the DME Designer control editor are reflected in the DME or SP2060 unit, and
operations on the DME or SP2060 side are reflected in DME Designer.

You can not perform configuration editing using the Designer while online.

m Offline
The communication status becomes offline when editing configurations.

m Switching Between Online and Offline
You can switch between online and offline in the “Synchronization” dialog box.

For information about the online procedure, see “Online” (page 40).
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“Synchronization” Dialog Box

When you click the [Synchronization] command on the [Tools] menu, the “Synchronization” dialog box
is displayed. The data from the current device group in the Designer is synchronized with the DME or

SP2060 unit.
Here you can make settings for synchronizing the unit in DME Designer one-on-one with the DME or

SP2060 that actually exists on the network.

Names and Functions

[Go On-line] Button
[Go Off-line] Button

@Synchronizatiun

Go Off-line | Glose
Group | DME Groupl ﬂ
(DME Designer [ Netwark
Device |IP Address IP Address Tvpe |
DME4io—-C 192.162.000.004 e 1 02,1 62,000,004 DME4i0-C
DME24N 192188000007 a1 52,1 69,000,007 DME24H [Network]
[Designer]
Mezzage
Message Area
0%
[Close this window —f— Glose this window after synchronization
after synchronization]

checkbox
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m [Group] List
Allows selection of a device group to be synchronized.

m [Go On-line] Button

This button will be grayed out when the software is online.
Clicking the button displays a dialog box where you can decide the synchronization method.

ﬁ"-.E.Sync Direction E'

DME Degzigner -> Dewvice

DME Desziener <- Device |

Cancel |

[Designer — DME] button

A consistency check is performed between the data in the current device group and the DME or
SP2060 data, then the communication status changes to online. Transmits data from the DME
Designer to the DME or SP2060 unit and synchronizes the two.

[Designer - DME] button

Data from the DME or SP2060 unit is read into DME Designer. Current data stored in the DME or
SP2060 unit, such as scenes, are read into DME Designer. The configurations in the DME unit and
DME Manager must identical to allow synchronization. Even if the basic configurations are the
same, if one has been edited or changed in any way synchronization will not be possible.

SP2060 configurations cannot be edited, so synchronization is always possible.

m [Go Off-line] Button
Clicking this button changes from online to offline. While offline, this button will be grayed out.

m [Close] Button
Closes the dialog box.

m [Close this window after synchronization] Checkbox
When this checkbox is checked the dialog window will close automatically after synchronization.
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m Designer

The Designer list displays DME or SP2060 units arranged in the currently valid device group in the
DME Designer.
The unit in the DME Designer is matched with a recognized IP address, and they are compared

one-to-one.
DME Designer
Device IP Addreszs
DMEdio-C 192168000004
Device Name —nmE24H 102968000007 —— IP Address Select Box
DME Name

Displays the names of DME or SP2060 units included in the project.
When multiple DMEs and SP2060s of the same type are arranged in a zone window, it is a good
idea to change the name of each one.

IP Address Select Box

Matches the units in the Designer with recognized IP addresses. Click the [IP Address] column [V]
button to see a list of the IP addresses of all devices of the same type in the area. If the unitis a
DME24N, IP addresses for all DME24N devices in the area will be displayed on the list.

If you click the title bar with “IP Address” written on it (pale [ A]/[ Y] mark appears), you can line
them up vertically.

m Network

The devices currently connected to the network are displayed in the Network list. To keep
consistency with the Designer list on the left side, the status of DMEs on the network is displayed.

T etk

| IP Address | Type |

Device Icon T'I 92.168.000.002 DMEG4N

* Device Icon

Displays DME, SP2060 and ICP1 devices connected to the network. The device group master
DME or SP2060 icon is red. Icons for slave DMEs and SP2060s are blue. DMEs and SP2060s
and ICP1 devices with no relation to DMEs and SP2060s in Designer have gray icons.

* I[P Address
Displays the DME or SP2060 IP address.

IP Address

m Message Area
Displays a message that synchronization is in progress.
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Event Scheduler

“Event Scheduler” Dialog Box

When you click [Event Scheduler] in the [Tools] menu, the “Event Scheduler” dialog box is displayed.
This sets the scheduling for events. You can schedule events by specifying the date, time, and the
action to execute. You can set up schedules for events to be executed at a specified time, and events
that are to be repeated periodically. Periodic events are those that repeat each year, month, week, or
day. Up to 50 events can be scheduled. Scheduling can be set separately for each device group.
Settings and changes are sent to the DME unit during online status.

Scene changes, parameter changes, GPI output, and WAV file playback can all be scheduled.

Does not apply to SP2060 units

Only users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON can edit scheduling settings.

Names and Functions

"= Event Scheduler k @
| DME Group LJ
Add.. I Edit.. | Bemave I Copy I Paste I
Mo. ] Mame J Ciperation ] Date ]Time
o Opening Scene Change 001:BGM Control 2006-04-20 000000
0z ENding Scene Change 001:BGM Control 2006-04-20 00:00:00
Apply I oK Cancel

m Event View

Displays registered scheduling events. When periodic events (cyclical events) are first displayed
together, they are displayed in order of date.

The order of same-time events can be changed by dragging and dropping.

Click to select an event.

m [No.]
Displays the event number. Numbers are added from the top in order.
This function will not be executed if the checkbox is not checked.

m [Name]
Displays the event names. Clicking an event will select it, allowing you to change its name. There is
no limit to the number of characters.
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[Operation]
Displays the function that will be executed when the event starts.

[Date]

Displays the event start date.
Periodic events are displayed as shown below, with an icon and text that indicate a periodic event.

 [January 1 every year]
Each New Year's Day

* [First Monday of January every year]
First Monday in January each year

 [Day 1 every month]
First day of each month

* [Second Monday of every month]
The second Monday of each month.

* [Monday every week]
Each week on Monday

* [Every day]
Every day

[Time]

Displays the time for starting the event.

Group List

selects the device group for which events are to be specified/displayed. Only events for the
selected device group will appear in the window.

[Enable Event Scheduler]
Enables the scheduled events.

[Add] Button

Adds an event. Clicking here displays the “Add Event” dialog box. If the maximum of 50 events has
already been registered, this button is grayed out.

[Remove] Button
Deletes the event selected on the list. This button is grayed out when no event is selected.

[Edit] Button

Lets you edit the selected event. Displays the “Edit Event” dialog box. This button is grayed out
when no event is selected.

[Copy] Button

Copies the selected event. This button is grayed out when no event is selected.
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[Add Event (Edit Event)] Dialog Box

[Paste] Button
Pastes the copied event. The event is added. This button is grayed out when no event has been

copied.

[Apply] Button

Applies any current setting changes.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.

The dialog box is displayed when you click on the [Add] or [Edit] button in the “Event Scheduler”
dialog box. Here you can add or edit a scheduling event.

== Add Event

Evert Name |

Event Dperation

Operation J Scene Change LJ

Operation Setting

Scene | 001:Scens 001 -

Event Schedule

El oOctober, 2005 [N

Sun Mon Tue wed Thu Fri Sat
2 3 4 5 B 7 8
9 10 11 12 13 14 1§
16 17 18 19 20 21 22
23 24 X5 X T &EhA
a0 A S R
T3 Today: 10/28/2005

[ Eepeating Event

& “ear

" Manth 4Dy

" wlesk

" Day € Day of the week
" Hour

Time
00:00:00 4 (hremincsec)
J.January _'J J 1 ﬂ
J.January L] J First L] ] Sunday ﬂ
Exception
ak Cancel J

m [Event Name] Box
Enter the event name. There is no limit to the number of characters.
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m [Event Operation]
Set the operation that is executed when the event starts.

[Operation]

When you click this button, a list of events is displayed. Specify the operation that is executed
when the event starts.

The following four items are on the list:

* [Scene Change]
Changes the scene.

* [Parameter Value Edit]
Changes a parameter.

If user module security is enabled, the components are not displayed. However, parameters displayed in the user
module editor are displayed here.

» [GPI Out]
Sends GPI output.

* [Play Wav File]
Allows initiation of Wave file playback.

[Operation Setting]
The content changes according to the event selected for [Operation].

* When [Scene Change] is selected:

Event Operation -

DOperation | Scene Change -

— Operation Setting

Scene

Select the scene to be recalled from the [Scene] list. Stored scenes are displayed in the list.

* When [Parameter Value Edit] is selected:

Event Cperation

Operation [JERETHEEINETE ~

Operation Setting -

Scene | 001 Scene 001 =] OME | DME24N |

Gomponent | Gomponert:LUnit Output = Parameter | Out1:Level |

Walug 000 = $4]
[Scene]

Select a scene from the list.

If the DME unit's current scene differs from the scene specified in event scheduling, the scheduled
scene will be recalled. If the DME unit's current scene is the same as the scene specified in event
scheduling, the scheduled scene will not be recalled.

[DME Unit]
From the list, select the DME unit to which this scheduled event will apply. The DMEs included in the
zone are displayed in the list.
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[Component]

Select the component that has the parameter to be changed. The list displays the components
arranged for the DME that is selected in the [DME Unit] box.

[Parameter]
Select the parameter that will change. Parameters for the component that is selected in the
[Component] box are displayed in a list.

[Value]

Set a value for the parameter. Change the parameter using the spin buttons or the slider on the right.

* When [GPI Out] is selected:

~Operation Setting -

DME | DMEGAN

Paortl | Port2 IPortS Portd | Ports | Port6 | Port? | Port8 | Port? | Port10 | Partl

Statuz " il I~ - il i = =

« | 2|

[DME]
From the list, select the DME where you will be making settings.

[Port1]/[Port2]/[Port3] ...

Set [ON], [OFF], or [---] for each port. If it is set to [OFF], the [LOW - HIGH] port outputs
[HIGH - LOW] signal, the [HIGH - LOW] port outputs [LOW - HIGH] signal.

» When [Play Wav File] is selected:

—Ewent Operation

Operation  |JEEREITEN

-Operation Setting

Scene | 001:Scene 001 EZ|

Weve [DMEGANIT Opening

[Scene]
Select a scene from the list.

[Wave]

Select a Wave file from the list.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a Wav
Player is included in the DME configuration.
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m [Event Schedule]
Set the year/month/date to start the event.

Event Schedule

Sun Mon Tue wed Thu Fri Sat
2 3 4 5 B 7 8
9 10 11 12 13 14 15
16 17 18 193 20 21 22
23 24 25 % T EEm2
el 3 | g

T3 Today: 1042872005

Time
000000 5| (heminsec)

—I Bepeating Event
& Year

 Month = Day |.Janua|_u ;J |'I L]
O ‘wleek
€ Day O Day of the week ]Janualy ;i ]Flrst j JSunday __]
¢ Hour
Erception

Calendar

Sets the date the event will start.
Change the year and month using the [<] and [>] buttons. Click on a day to set that date. February
29 can be set on the calendar, where it appears every four years (each leap year).

[Time]
Sets the time the event will start.

Click the hour and minute, then set numerical values using the spin boxes.
Only the time is set for periodic events.

[Repeating Event]
When a check is placed here, the event becomes a periodic event, and the calendar is ignored.

* [Year])/[Month]/[Week]/[Day]/[Hour]
Set the period for the event, using the radio buttons to the left.

 [Day]/[Day of the week]

Set the conditions on the right side. Select [Day]/[Day of the week], and set the date and other
information. The items that can be set vary according to the selected period.

When the event period is [Year]
All settings can be made.

When the event period is [Month]

If [Day] is selected, only the date can be set.
If [Day Of The Week] is selected, the week of the month and day of the week is set.

When the event period is [Week]
Only [Day Of The Week] can be selected. Set the day of the week.

When the event period is [Day]/[Hour]
Condition settings on the area on the right are not needed.

[Exception] Button
Opens the “Event Exceptions” dialog.

[OK] Button
Applies any setting changes and closes the window.
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[Cancel] Button

Closes the window without changing any settings.

m [Event Exceptions]

Specifies “exception” year/month/day and time settings at which events will not be executed.

The available settings will depend on the event cycle.

Bl 2005577
HHAKAS +

= Day 101

=1 O i
&35 H:- 2006/07/12

& Yesr (2005 B
£ Month [[Jaruary -]
£ ek [ First week =]
£ Dav of the wesk [[Sunday -]
¢ Hour | 0o 24

» When the event cycle is [Year]

Only the [Year] setting is available.

When the event cycle is [Month]

Only the [Month] and [Week] setting is available.

When the event cycle is [Week]

Only the [Month], [Week] and [Day] settings are available.

When the event cycle is [Day]

Only the [Month], [Week], [Day], and [Day of the week] settings are available.

When the event cycle is [Hour]

Only the [Month], [Week], [Day], [Day of the week], and [Hour] settings are available.
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Wav File Manager

When you click [Wav File Manager] on the [Tools] menu, the “Wav File Manager” dialog box is
displayed. Here you can manage playback settings for Wave files played in the Wav File Player. This is
set for each DME. The setting can be made only when in offline status. Up to 100 Wave files can be
managed.

Up to a maximum of 12 megabytes of Wave files can be registered for each DME unit. If a Wave file is
added that will exceed this amount, a warning message will be displayed.

Does not apply to SP2060 units

These settings can be edited only by users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON.

Only Wave files with file names of 31 characters or less, (including the extension) can be registered. Check the Wave file
name beforehand. Change the name if it has 32 or more characters, including the extension.

When saving project files including Wave files, select “Project File with wave (*.daf)” in the file save dialog box.

Names and Functions

" Way File Manager

DWE (HIEIEETE -

Library Store | Recall Add. Bemove I

List Mame | File Name Size Repeats | Interval | Auto Start | Mext Mo |« |

El]l]1 Opening Opening.way 660 KB 00s OFF Stop

002 |Ending Ending.wav 660 KB o0s QFF Stop Up

003

004 Down J
005

ang

007

i) ity

ong e

1o ST

maining Memary
0t RAREEAT
6] 4 ] Cancel ]

m [DME]

From the list, select the DME where you will be making settings.

m [Wave File]
Displays the Wave file information. Settings can be made here as well.

[No.]

The Wave file number is displayed in the leftmost column. Numbers are added from the top in
order.

[List Name]

You can set up to 27 characters as a label separate from the Wave file name. The Wave file name is
displayed here by default.
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[File Name]
Up to 31 characters are displayed as the wave file name.

[Size]
Displays Wave file size information. The units vary, depending on the file size. The size is displayed
to the first decimal.

Size Display
Up to 1023 bytes 0.X KB
1024 bytes to 1023.9 kilobytes XXX X KB
1024 kilobytes or more XX MB

[Repeats]

Sets the number of repeats for playback.

Clicking here will display a list where you can select the number of times.
Select [0] to [98] or [INFINITY].

Since external input cannot be edited, [---] is displayed.

[Interval]

Sets the time until the next playback when [Repeats] is one or more. If you click here, a list will be
displayed. You can set [0] to [99].
Since external input cannot be edited, [---] is displayed.

[Auto Start]

Turns automatic playback ON or OFF. If ON is set, playback happens automatically when the file is
selected.
If you click here, a list will be displayed. Select [ON] or [OFF].

[Next No.]

Specifies the number for the Wave file to be played next.
If you click here, a list will be displayed. Select the number for the Wave file to be played next.

* [Stop]
This stops playback after this Wave file is finished playing, without specifying the next wave
file.
Since external input cannot be edited, [---] is displayed.

[Store] Button

Saves the current settings in the “Wav File Manager” dialog box in a file, as a library. Clicking here
displays the file save dialog box.

[Recall] Button

Reads a saved library.
Clicking this button displays a menu. A menu displays library files saved in the folder that has been
set as the Contents Folder. Click the library to be read.
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[Open File Dialog]

Displays the file select dialog box. You can select a library file that is saved in the folder set as the
Contents Folder, and read it.

[Add] Button

When you click here, External Input and the file select list is displayed.

To add a Wave file, select the row to which it is to be added and click the [Add] button.

It is also possible to add Wave files by dragging and dropping the files from the desktop directly
onto the list in the “Wav File Manager” window.

[Wave File]

The file selection dialog box is displayed, where you can select a Wave file.
If the selected table already has data, an overwrite confirmation dialog box is displayed.

[External Input]
Sets [External Input].

You can select multiple Wave files. If multiple files are specified, they are added after the selected
table. If a Wave file is registered to the number being added, it will be overwritten.

The following Wave file formats are supported: 48, 44.1, 24, 22.05 kHz, 16bit/8bit, Mono/Stereo. If a
file is selected with a format different than these, a message is displayed that says the file cannot

be used.

There is an upper limit to size beyond which a file cannot be used. This limit varies according to the
format. If the size of the selected file is beyond the limit, a message is displayed that says the file
cannot be used.

22.05 K Mono 8 bit 1.37 MB 44.1 K Mono 8 bit 2.75 MB
22.05 K Stereo 8 bit 2.75 MB 44.1 K Stereo 8 bit 5.5 MB
22.05 K Mono 16 bit 2.75 MB 44.1 K Mono 16 bit 5.5 MB
22.05 K Stereo 16 bit 55 MB 44.1 K Stereo 16 bit 59 MB
24.05 K Mono 8 bhit 1.5 MB 48 K Mono 8 bhit 3 MB
24 K Stereo 8 bit 3 MB 48 K Stereo 8 bit 59 MB
24 K Mono 16 bit 3 MB 48 K Mono 16 bit 59 MB
24 K Stereo 16 bit 5.9 MB 48 K Stereo 16 bit 5.9 MB

[Remove] Button

Deletes settings from the selected line. This button is grayed out when no Wave file is selected in
the list.

[Up] Button

Moves the selected line up one. It is switched with the line immediately above.
The button will be grayed out if nothing is selected in the list, or if [No. 1] is selected in the list.

[Down] Button

Moves the selected line down one. It is switched with the line immediately below.
The button will be grayed out if nothing is selected in the list, or if [No. 100] is selected in the list.
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[Play] Button
Plays the selected Wave file on the computer. Allows monitoring and checking of the Wave file.

m [Stop] Button
Stops playback of the Wave file.

® [Remaining Memory]
Displays the remaining size that can be added.

m [OK] Button
Updates the settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without changing the settings.

GPI

About GPI

GPl is an abbreviation for General Purpose Interface. Using GPI input and output, DMEs can be
remotely controlled from custom-made controllers or external equipment. The number of GPI ports
depends on the type of device. Sets GPI input/output for each DME.

Using GPI input data, you can switch DME scenes and change component change component
parameters.

Refer to the DME owner’s manual for information on making GPI connections and other hardware-
related issues.

Only users for whom the [Operation Security] — [Edit] checkbox has been checked can make GPI settings.

Does not apply to SP2060 units
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“GPI” Dialog Box

When you click the [GPI] command on the [Tools] menu, the “GPI” dialog box is displayed. Sets GPI
input/output for the DME.

Names and Functions

| Furction | Parameter | Min | M | Termanal

| Portt_[Pacametar Vo Edit_(ComponentCanpre OFF o T
| Port?  |Scone Ghargn (N Eeere 0N T
| Partd | Play Wav File idpene | it
'[ Portd N Assen
[Pors [o Assien
[ Fortt | o Asain

GPI IN | Port] Mo Assien

[Porth [Ho Assier
[Forts_|No Assien
[Pernin [Ho Assur
[ Portil_[Ho Assien
[Ptz [Ho Asaur
[ Portl[Ho Assien
| Forttd |Ho Asan
| Portl5 | No Assien

Ho sagn

GFIOUT
Furction Paramaber | Themehokd | Tormesal | Polarity | Exent Sicheduler | Lisnr Dulned Buthon | Evenl Lopger = |
FPartl Scenn Chargn .I!IS{in-IIII | ._|i .l Operrg 7|:II|-.
Port2  |No Asten n
Portid Ho Asagn .|'
Portd  |No Astun n
Porth  |Ho Asagr .|i
Mﬁi\hﬂnm i
GP| OUT Fort? Ko Asiwn -
::EQ(_IU_NoH:Nn -
Porl) (Mo Assun -
I‘orﬂﬂ o Assien Il
:.I\:IH No Aczgn .|'
| Port12_[Ho Assien I
| Porl1d |Ho Assun -
| Portld_[Ho Assion il &
| Perl15 Mo Assan x -|
T -
[Apply] [Cancel]
Button Button
[OK]
Button
m [DME]
From the list, select the DME where you will be making settings.
m Configuration
The current configuration name will be displayed.
m GPIIN
The DMEG4N has 16 GPI IN channels, and the DME24N/DMES8i-C/DME8o-C/DME4io-C has 8 GPI
IN ports.

These settings determine which DME parameters will be controlled by input received at each
individual GPI IN port. The port numbers are shown in the leftmost column.

[Function]

Specifies the function to be controlled by GPI input. Click to see a list from which you can choose
the function to be assigned to the corresponding GPI IN port.

The nine available functions are: [No Assign], [Parameter Value Edit], [Scene Change], [Scene
Increment], [Scene Decrement], [Mute], [GPI Lock], [Time Adjustment], [Play Wav File].

The [Parameter], [Min], [Max], and [Terminal] items will change according to the selected function.
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Gonfiguration
DME | DME Group/DMEGSN -l (Comﬁg ‘
[ GPIIN |
Function Faramster Min Max Terminal
Portl | Parameter Value Edit »
Port?  [Wo Assien Scens 01 T
Porg | Farameter Vahe Edit oL +
Scene Chanee
Fortd | Scene Increment
Ports | Scene Decrement
ot g:ﬁnck
Part? | Time Adjustment
Fortd
Fortd  [Mo fAssien
Port1l [Mo Assien
Portl1 (Mo Assien
Port12 [No Actien
Port13 [No Assien
Portl4 [No Assien
Fortl5 |Mo fAssien
Portl6 (Mo Assien
Function Farameter Threshold Terminal Folarity Event Scheduler | User Defined Button | Event Logger «
Port]  [Scene Chanee 001:Scene 001 ) 1 : Openine : 2006~
Port2  [No Assien P
Fortd  [No Assien P
Fortd  |MNo Assien P
Portf  [Mo Assien P
Portf  [Mo Assien P
Port?  [No Assien P
Portf  [No Assien P
Fortd  [No Assien P
Fort1l [MNo Assien P
Portl] (Mo Assien P
Port12 (Mo Assien P
Port13 [No Assien P
Portl4 [No Assien P | |
Fortl5 [No Assien P =
Jd0 ) | _'_l_l
aply | oK I Gancel |
- |

¢ [No Assign]
No function assigned. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Min], [Max], and [Terminal] items are not available.
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 [Parameter Value Edit]
Allows component parameters to be changed via GPI input.
In this case [Parameter] is used to select the parameter to be controlled.
[Min] and [Max] specify the range over which the parameter can be changed.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

4 and J- specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
I* and & specify on/off control of 2-state parameters via an external switching device.

T

The parameter value changes in proportion to the voltage applied to the GPI input.

The minimum voltage applied to GPI IN will produce the specified [Min] parameter value, and the
maximum voltage applied to GPI IN will produce the specified [Max] parameter value, with
intermediate voltages produced the corresponding intermediate parameter values.

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

Max. voltage applied to GPI IN —— [Max] parameter value

[Min] parameter value
Min. voltage applied to GPI IN

o

The parameter value changes in inverse proportion to the voltage applied to the GPI input.

The minimum voltage applied to GPI IN will produce the specified [Max] parameter value, and the
maximum voltage applied to GPI IN will produce the specified [Min] parameter value, with
intermediate voltages produced the corresponding intermediate parameter values.

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

Max. voltage applied to GPI IN ~——— [Min] parameter value

[Max] parameter value
Min. voltage applied to GPI IN

N
The specified [Min] and [Max] parameter values are alternately selected each time the voltage
applied to GPI IN rises from below to above the median voltage.”

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

[Max] parameter value [Min] parameter value [Max] parameter value
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1
The specified [Min] and [Max] parameter values are alternately selected each time the voltage
applied to GPI IN drops from above to below the median voltage.*

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.

[Min] parameter value [Max] parameter value [Min] parameter value

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

* [Scene Change]
GPI input can be used to recall a specified scene.
[Parameter] specifies the number of the scene to be recalled.
[Min] and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T
The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN rises
from below to above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

4

The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN drops
from above to below the median voltage.*

Min. voltage applied to GPI IN

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

N

Same as T.

1

Same as 4.
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* [Scene Increment]
GPI input can be used to increment the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T

The scene number will be incremented each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

4

The scene number will be incremented each time the voltage applied to GPI IN drops from above to
below the median voltage.”

Min. voltage applied to GPI IN

Trigger

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

N

Same as T.

1

Same as .
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* [Scene Decrement]
GPI input can be used to decrement the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T
The scene number will be decremented each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

i B
The scene number will be decremented each time the voltage applied to GPI IN drops from above to
below the median voltage.”

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

N

Same as T.

1

Same as 4.
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e [Mute]
GPI input can be used to engage or disengage the DME mute function.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T
Mute will be ON when the voltage applied to GPI IN is above the median voltage*, and OFF when the

voltage is below the median.

Max. voltage applied to GPI IN
I I -_ ~ Median voltage

Mute OFF Mute OFF
Min. voltage applied to GPI IN

i B
Mute will be OFF when the voltage applied to GPI IN is above the median voltage*, and ON when the

voltage is below the median.

Max. voltage applied to GPI IN

Mute OFF
Median voltage

Min. voltage applied to GPI IN

r
Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN drops from

below to above the median voltage.*

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

ON OFF ON

1

Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN rises from above
to below the median voltage.”

ON OFF ON

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN
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* [GPI Lock]
GPI Lock can be turned on or off via GPI input. When GPI Lock is ON, all GPI inputs other than
the one being used for GPI Lock control are locked and input will be ignored.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

T
GPI lock will be ON when the voltage applied to GPI IN is above the median voltage*, and
OFF when the voltage is below the median.

Max. voltage applied to GPI IN
S I -_ _ Median voltage

Lock OFF Lock OFF
Min. voltage applied to GPI IN

4
GPI Lock will be OFF when the voltage applied to GPI IN is above the median voltage*, and
ON when the voltage is below the median.

Max. voltage applied to GPI IN

Lock OFF
Median voltage

Min. voltage applied to GPI IN

I
GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN drops
from below to above the median voltage.*

Max. voltage applied to GPI IN
I I -_ ~ Median voltage

Lock OFF Lock OFF
Min. voltage applied to GPI IN

1
GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN rises
from above to below the median voltage.*

Max. voltage applied to GPI IN

Lock OFF
Median voltage

Min. voltage applied to GPI IN
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* [Time Adjustment]
GPI input can be used to adjust the DME internal clock as follows:

Internal clock time Time after adjustment
0~14 seconds Returned to 0 seconds
15~29 seconds Advanced to 30 seconds
30~44 seconds Returned to 30 seconds
45~59 seconds Advanced to 0 seconds

[Parameter], [Min], and [Max] are not available.

[Terminal] determines how the GPI input voltage will affect the specified parameter.

T and J- specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.

I?* and W5 specify on/off control of 2-state parameters via an external switching device.

T

The internal clock time will be adjusted each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

4

The internal clock time will be adjusted each time the voltage applied to GPI IN drops from above to
below the median voltage.”

Min. voltage applied to GPI IN

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

I

Same as T.

1

Same as 4.
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 [Play Wav File]
GPI input can be used to initiate playback of the specified Wave file.
[Parameter] specifies the Wave file to be played. Files specified by the Wav File Manager can
be selected. Wave files can only be selected if a Wav Player is included in the DME
configuration.
[Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
4 and - specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
JI* and 5 specify on/off control of 2-state parameters via an external switching device.

T

The specified Wave file will be played each time the voltage applied to GPI IN rises from below to
above the median voltage.”

Max. voltage applied to GPI IN

Median voltage

Min. voltage applied to GPI IN

4

The specified Wave file will be played each time the voltage applied to GPI IN drops from above to
below the median voltage.”

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

N

Same as T.

1

Same as .

* “Median voltage” refers to the voltage halfway between the maximum and minimum voltages detectable by the GPI
input terminals. Refer to the DME owner’s manual for details on GPI voltages.
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m GP| OUT

The DMEB4N has sixteen GPI OUT ports, the DME24N has eight, and the DME8i-C/DME80o-C/
DME4io-C have four.

These settings determine which DME parameter values will be output via each individual GPI IN
ports. The ports numbers are shown in the leftmost column.

[Function]

Specifies the function to be transmitted via a GPI output.
The four available functions are: [No Assign], [Parameter Value Edit], [Scene Change], and [GPI

Lock].
The [Parameter], [Threshold], [Terminal], and [Polarity] items will change according to the selected
function.
Function | Parameter Threzhald Terminal Palarity Ewer
Portl |Scene Changs |

Port2 Mo Azzign
Partd Farameter Walue Edit

Portd  TGPI Lack
Ports Mo Assien

Ports Mo Assien
Port? Mo Assien
PartR Mn Az=ien

AL A AL AL

» [No Assign]
No function assigned, and no GPI output will occur. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Threshold], [Terminal], and [Polarity] items are not available.

e [Parameter Value Edit]
Allows component parameter values to be output via GPI.
In this case [Parameter] is used to select the parameter to be output.
[Threshold] specifies the parameter threshold value.
[Terminal] and [Polarity] determine how the GPI voltage will be output in response to
parameter changes.

Terminal Polarity GPI Output

I Ignored When value of the specified parameter is above the threshold level the
output will be high, and when below the threshold level the output will be
low.

Ly Ignored When value of the specified parameter is below the threshold level the
output will be high, and when above the threshold level the output will be
low.

A pulse”! will be output when the value of the parameter changes from
below to above the threshold.

A pulse”! will be output when the value of the parameter changes from
above to below the threshold.

A pulse ™ will be output when the value of the parameter changes from
below to above the threshold.

- =& &« =

A pulse ™ will be output when the value of the parameter changes from
above to below the threshold.
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* [Scene Change]
The recall status of the specified scene is transmitted via GPI output.
[Parameter] specifies the scene for which the recall status is to be output.
[Threshold] and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.

Terminal GPI Output

I? When the current scene is the same as the scene specified by [Parameter] the output will
be high, and when different the output will be low.

Ly When the current scene is the same as the scene specified by [Parameter] the output will
be low, and when different the output will be high.

I A pulse™! will be output when the current scene is the same as the scene specified by
[Parameter].

1w A pulse? will be output when the current scene is the same as the scene specified by
[Parameter].

» [GPI Lock]

The GPI Lock status is transmitted via GPI output.
[Parameter], [Threshold], and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.

Event Scheduler

Terminal GPI Output
I When GPI Lock is ON the output will be high, and when OFF the output will be low.
Ly When GPI Lock is ON the output will be high, and when OFF the output will be low.
*1 Pulse waveform 1 *2-Pulse waveform 2

250msec 250msec

Event Schedule is shown when [GPI OUT] is set in “Event Scheduler.”
See “Remote Control Setup List” on page 125.

User Defined Button

User Defined Button is shown when [GPI OUT] is set in “User Defined Button.”
See “User Defined Button (User Defined Parameters)” on page 118.

Event Logger

Event Log is shown when [GPI OUT] is set in “Event Logger.”
See “Word Clock” on page 154.

[Apply] Button
Applies any current setting changes.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button

Closes the window without changing any settings.
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When you click the [MIDI] command on the [Tools] menu, the “MIDI” dialog box is displayed. Here you
can make remote control and other settings.

Does not apply to SP2060 units

Names and Functions

| DME Group/DIMEB4N |

Gontral Ghange ]Program Change ]Parameter Chanee ]
Clear ] All Glear ]

Mo ] Function J Parameter 1 Mir ] Max ﬂ
[}

o10 =
] |'1_‘

Cancel J

m Common to All Tabs
DME
From the list, select the DME where you will be making settings.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.

[Control Change] Tab

Assigns components to control change for each DME. You can change DME parameters by sending
control change messages from external equipment.
You can assign to control change numbers 1-31, 33-95, and 102-119.

Because control change numbers 0 and 32 are used for bank select MSB, numbers 96-101 are RPN/NRPN related, and
120-127 are used for mode messages, they cannot be used for component assignment.
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| DME Group/DIMEB4N |

Gontral Ghange ] Frogram Change ] Farameter Chanee ]

Clear ] ﬁllCIear]

Mo ] Function J Parameter 1 Mir J Max ﬂ
[}

: o
g GCancel )

m Control Change List
The control change numbers and current settings are displayed in the list in the center.
No.
Displays the control change numbers.
Component

Displays the assigned components. Control changes that have no component assigned to them
are blank. If you click here, a list will be displayed. Usable components are on the list. Click the
component name to select it.

If user module security is enabled, the components are not displayed. However, parameters displayed in the user
module editor are displayed here.
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| DME Group/DMEG4N =]

Gartrol Change | Program Chanes | Parameter Change ]

Glear | ﬂl\OIear|

Ciompo 0
Component:PEQ-Mono k

QK Cancel |

Parameter

Set the assigned component link parameter.

When you click here, a list of parameters included in the component is displayed. Select the
parameter you want to assign.

| DME Group! /DMEG4N =]

Gartrol Change | Program Chanes | Parameter Change ]

Glear | ﬂl\OIear|

Parameter

1:Kewln
Dyr:1:7: Threshold
Dyri11:Ratio
Dyni11:Knee
Dryni1:1:fittack
Dyri1:1:Release
Dynil:1:Gain

QK Cancel |

Min/Max

Sets the range of operation for the parameter. The current values for the [Min] (lower limit) and
[Max] (upper limit) are displayed. If you click here, a slider will be displayed. The range and
parameter units that can be set will vary, depending on the parameter selected in the [Parameter]
box.

You can change the parameter by dragging the slider. To make a finer setting, press the <Shift>
key while dragging the slider. The value for the parameter will be shown while you are dragging the
slider. When you finish dragging and release the mouse button, the slider will disappear.

The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag
the right edge, the [Max] will change.
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| DME Group/DMES4N

Caontrol Change 1 Program Change | Parameter Change ]

Glear J ﬂIIOlearJ

Mo, J Function

i}
o0z
003
004
005
006
oo
ong
ong
(]
011

|

Parameter IMin IMax ﬂ

o

Cancel 1

4

m [Clear] Button

Clears assignments for the selected control change numbers.

m [All Clear] Button

Clears assignments for all control change numbers.
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[Program Change] Tab

Assigns scenes to program control change numbers 1 through 128. Switches scenes when program
changes are received. These settings are shared by all DMEs in the device group. Up to 999
assignments can be made. Scenes above number 128 are assigned by changing banks.

| DME Group/DMEG4N ~|
Control Ghange | Program Change l Farameter Chanee ]
Frogram Change Event all Clear
Mo |Scena | -
001 [Scene001] Scene 001 Clear
002
o0z Al Azzien
004
005
008
oa? Bank Select LSB
o R
002
010
011
012
m3 hd

Gancel

m Program Change Event
Program numbers and the scenes assigned to them are displayed in a list.

No.
This displays program numbers from 1 to 128.

Scene

Displays the scene number and name of the assigned scene. Program changes that have no
scene assigned to them are blank.
When you click here, a list of scenes is displayed. Select the scene you want to assign.

114

| DME Group/DMEGAN =]
Gontrol Change | Program Change ] Parameter Change ]
Program Chanes Event | All Clear
Scene ] -
Clear
Al Assien
[Scene002] Scene 003
005 | [Scene004] Light On
oog | [Scene005] DoorOpen
007 Bank Select LSE
. C—
o0g
010
011
012
m3 B
0] 4 Cancel

m [All Clear] Button

Clears all scene assignments.

m [Clear] Button

Clears the scene assignment for the program number selected in the list, so that no scene is

assigned to that number.
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m [All Assign] Button
Assigns all scenes in order starting from program number 1.

m Bank Select LSB

The bank is changed when assigning scenes numbered 129 and higher. Eight banks can be used,
numbered from zero to seven. Click the [ ¥] and select the bank where you will make settings.

| DME Group/DMEG4N =]

Gontral Chanee | Program Change ] Parameter Change ]

RS TS | Bl Clear
Ma. ]Scena ] ﬁ
001 [[Scene001] BGM Contral v Clear
002
003 All Assien
004
005
006
o7 Bank Select LSB

DDDDDD
SSooog
222228
=3
2
L
ﬂ@mhmm#lzj

[Parameter Change] Tab

Specifies the parameter to be controlled by parameter change commands for each address. Up to

128 can be set.

| DME Group/TIMEG4N x|

Control Change | Program Charee | Parameter Chanee l

Gl | allClear |

Function Parameter

ampanderH Ind:1:0n

oK Cancel ]
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m Parameter Change List
The current settings are displayed in the list in the center.

No.
This displays the parameter change numbers.

Component

Assigns components. If you click here, a list will be displayed. Assignable components are on the
list. Click the component name to select it.

| DME Group/DMESAN =]

Ciontrol Chanee ] Froeram Chanes | Parameter Ghanee \

Glear | All Glear |
| Ma. | Function | Farameter | Min | It i‘
ON

001 OFF

Ciomponent:PEQ-Steren

Parameter

Set the assigned component link parameter.

When you click here, a list is displayed of parameters included in the component selected in the
[Component] box.

Select the parameter you want to assign.

| DME Group/TIMEG4N x|

Contral Chanee ] Program Change | Parameter Chanee ]

Glear ] ﬂIIOlearI

Mo. | Function Parameter Min Mgy

001 Component:Compan..
002  ComponentCompan..

00g Diyred 1 Width
007 D1 :1:Attack.
oog Dwrl:1:Release
009 Dl 1:Gain

ok | Cancel I
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Min/Max

This sets the parameter range. The current values for the [Min] (lower limit) and [Max] (upper limit)
are displayed. The range and units that can be set will vary, depending on the parameter selected.
If you click here, a slider will be displayed.
You can change the parameter by dragging the slider. To make a finer setting, press the <Shift>
key while dragging the slider. The value for the parameter will be shown while you are dragging the
slider. When you finish dragging and release the mouse button, the slider will disappear.

The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag

the right edge, the [Max] will change.

| DME Group/DMEG4N ~|
Contral Chanee ] Proeram Ghange | Parameter Chanee ]
Glear ] All Glear ]
] Ma. ] Function ‘ Parameter ] Min | Ma)ﬂ
Compan... In1:1:0n OFF OFF.
Compan... Dynid 1 Threshald o Max - <27

&
0dE

m [Clear] Button

Clears the assignment for the parameter change selected in the list, so that nothing will be

assigned to it.

m [All Clear] Button

Clears all parameter change assignments.
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User Defined Button (User Defined Parameters)

User Defined Parameters

Parameters that the user can operate using function keys <F1> through <F6> in the DMEB64N/24N unit
or ICP1 are called “User Defined Button.” Frequently changed parameters can be assigned in
advance to any of 24 (four pages times six) presets, and operated on the DMEG4N/24N unit or ICP1
even if DME Designer is not being used.

This function sets parameters in DME Designer that can be called by these function keys <F1>

through <F6>.
In DME Designer, user defined parameter settings are made using the “User Defined Button” dialog
box. The user defined parameter settings are shared between device group configurations.

“User Defined Button” Dialog Box

When you click [User Defined Button] in the [Tools] menu, the “User Defined Button” dialog box is
displayed.

Does not apply to SP2060 units

Names and Functions

2 User Defined Button

‘ DME Graup LJ
LR 3 4
Clear

LGD Displa) Function Parameter Min Max
F1 [CompOn] [CompOn Parameter Walue Edit  |DMES4M:ComponentCompanderH:h1:1:0n |OFF ol
F2 [SceneChal  |SceneChanee |Scene Chanee 001:BEM Contral = £
F3
F4
F&
Fé

8] 4 Cancel
m [Group]

Select the device group to be set up from the list.

m [1]/[2]/[3]/[4] Tabs
Switches the set to which settings will apply. You can set up to six function keys in each set. The
user defined parameters set on a single tab are displayed on one page in the DMEB64N/24N unit or
ICP1 main screen.

Function Keys

The function keys are displayed in the leftmost column of the table. When you enter text for [LCD
Display], a short name with up to eight characters will be created and displayed to the right of the
function key.
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Function

Specifies the function to be assigned to the function keys.

2 User Defined Button lz|
] DME Group Lj
L I - B
Clear
LGD Display | Function Parameter Min Mla

F1 [CompOn] CompOn Parameter Yalue Edit  |DMEG4M:ComponentCompanderHInd:1:0n  |OFF o]
F2 [SceneChal|SceneChange | Scene Chanee x| 001:BGM Gontrol —- =
F3 Mo fecien
F4

Direct Pararmiter Value
F5 Scene Change
Féi GPI Cut

Play “Wav File

oK Gancel
A

* [No Assign]
No assignment. Select this option to clear an assigned function.

 [Parameter Value Edit]
Allows the parameter specified in the [Parameter] field to be changed.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

* [Direct Parameter Value]
Allows the value of a parameter to be set directly. The target parameter is specified in the
[Parameter] field, and the value to be set is specified in the [Max] field.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

 [Scene Change]
Allows scene recall. The scene to be recalled is specified in the [Parameter] field.

« [GPI OUT]

Allows GPI output. The GPI setting is made in the [Parameter] field.

 [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a

Wav Player is included in the DMEG4N/24N configuration.
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Parameter

Sets the parameter assigned to each function key. If you click here, a list will be displayed. This list
displays the parameters that are included in the current configuration. Select the parameter you
want called by the function key.

== User Defined Button

| DME Group Ral
1] e 3 ]
Clear
LCD Display | Function Parameter 1 Miry ] Max 1
F1 [Gompandel|CompanderOn Parameter Walue Edit | DMEG4N-GomponentCampander HI 10 lnec Ifa1Y] 1
F2 [Soenel1]  |Scened Scene Change 001:8GM Contral if:?b"ggg""_‘w) I
F3 £-Component
F4 -l
[ i ri-Internallfnalog]
6 i ri-Internal(CobraNet]
LAD
- DMEB4N
- Component
1
S

el ] Width
vrel::Attack

i yrel:1:Release
¢ LDy

g:;‘. FeedbackSuppressor
"+J PEQ-Stereo

Slot

AD

- DME24N

LCD Display

Sets the text displayed on the DME unit or ICP1. Click the [LCD Display] box and enter text. Up to
23 characters can be entered into the [LCD Display] box.

After you confirm the name by pressing the <Enter> key, a short name will be created and
displayed in the function key area as follows: “F1 [shortnam].” The short name will also be
displayed in the DME unit or ICP1 main display. A short name is automatically created with up to
eight characters for display as the user defined parameter name on the DME unit or ICP1 main
screen

Min, Max
Sets the lower and upper limits for a parameter.

[Clear] Button
Clears assignments for the selected function keys. This is the same as “No Assign.”

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Setting User Defined Parameters

Set the user defined parameter.

1 Create a configuration.

2 Click [User Defined Button] in the [Tools] menu.
The “User Defined Button” dialog box will be displayed.

=2 User Defined Button

] DME Group LJ
1] e 3 4
Glear

LGD Displa) Function Parameter Min Mla
F1 [CompOn] |CompOn Parameter Value Edit  |DMEG4MN.Component:CompanderHIn1:0On  |OFF a]t]
FZ2 [SceneChal  |SceneChanee |Scene Ghanee 001:BGM_Control e ==
F3
F4
ES
Féi

ok | Gancel

3 Click one of the tabs numbered [1] through [4] to select the set of user defined parameters
you will assign your parameters to.
The four tabs correspond to the pages on the DME unit or ICP1 main screen.

4 Click the [Parameter] box for the function key to which you will assign the parameter.
A list of parameters included in the current configuration will be displayed.

5 Select the parameter to assign to the function key.

6 Click the [LCD Display] box and enter text for the user defined parameter name.
The [LCD Display] box can accept up to 23 characters, but only eight characters can be displayed
in the DME unit or ICP1 main screen. When making a user defined parameter name, the first eight
characters should be understandable.

When making multiple registrations, you can save time by first setting just the [Parameter] box for all keys, then setting
the [LCD Display] box names. When you enter a user defined parameter name into an [LCD Display] box and press the
<Enter> key to confirm it, the next [LCD Display] box down will be selected, and you can enter text there immediately.
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DAW Control

When you click [DAW Control] on the [Tools] menu, the “DAW Control” dialog box is displayed. Here
you can make settings for when the DMEG64N/24N is controlled from a DAW controller. This is set for
each zone configuration. The setting can be made only when in offline status.

DAW Control can be set on DME64N/24N units only.

DAW control editing can be performed only by users for whom the [Edit] security checkbox has been checked.

Names and Functions

" DAW Control

D& Type | OF -

Function Contraller Label Fararneter j

Chl  NoAssign
Ch2 |MoAssign
Ch3 |NoAssign
Chd  |MNoAsszign
ChS  |No Assign
ChE |MoAssign
Ch7?  |NoAssign
ChE |MoAssign
Ch9  |NoAssign
Ch10 |MoAssign l.j

m [DME]
From the list, select the DMEG4N/24N where you will be making settings.

m [DAW Type]
Select the DAW type. The following choices are in the list: [Off], [Type1], and [Type2].

m DAW Control Table
The following can be set for each channel from 1 to 64: [Function], [Controller], [Label], [Parameter].

122 DME Designer Owner’s Manual



Chapter 3 Main Panel Window

[Function]
Selects the function that will be changed by the DAW controller. If you click here, a list will be
displayed.

= DAW Control

DME | DMEZ4N =

DAY Type | Off V1

Function Controller Label Parameter o
Chl | Mo Assien hd

Ch2 M
Parameter Value EB

Ch3

Scene Chanee
Ch4  |Scene hcrement
ChE  |Scene Decrement

Mute
o GPI Lock

Ch? 1 Play Wav File
Che  [Mo Azsien

Ch3  |MNo Assien -
o I;l_‘|

» [No Assign]
Makes no assignments. Select this when you are erasing an already set assignment.

* [Parameter Value Edit]
Allows the parameter of the component specified in the [Parameter] field to be changed.

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

 [Scene Change]
Recalls a scene. The scene is recalled even if the current scene, and the one changed by the
DAW controller, are the same.
When a selection has been made, [SCENE] is displayed in the [Label] field. The last scene is
set in the [Parameter] field.

* [Scene Increment]
Sets the scene increment. Recalls the next valid scene after the current scene.
When a selection has been made, [SINC] is displayed in the [Label] field.

* [Scene Decrement]
Selects the scene decrement. Recalls the next valid scene before the current scene.
When a selection has been made, [SDEC] is displayed in the [Label] field.

e [Mute]
Sets all mute. Mute is set ON and OFF by the DAW controller.
When a selection has been made, [MUTE] is displayed in the [Label] field.

e [Component]
Changes the component parameters. Selectable component names that are arranged in the
configuration are displayed in a list.
When selected, the first parameter included in the component is set in the [Parameter] field.

* [GPI Lock]
Assigns GPI Lock. GPI Lock is set ON and OFF by the DAW controller.
When a selection has been made, [LOCK] is displayed in the [Label] field.

 [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a
Wav Player is included in the DME configuration.
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[Controller]

Selects a controller from the list when [Parameter Value Edit] is set in [Function]. [Switch], [Fader],
or [Knob] can be selected.

[Label]

Enter a label. Double-click to enter the text. You can enter up to 16 characters of text. Set the value
with the <Enter> key, or cancel it with the <ESC> key.

If [Scene Change], [Scene Increment], [Scene Decrement], [Mute], or [GPI Lock] is selected for [Function], the label
name is fixed.

[Parameter]

If [Scene Change], [Parameter Value Edit] or [Play Wav File], is set in [Function], set the
parameters.
If you click here, a list will be displayed.

* When [Scene Change] is set in [Function]
Displays scenes that can be selected.

* When [Parameter Value Edit] is set in [Function]
Selectable parameters are displayed.

» When [Play Wav File] is set in [Function]
Selectable Wave files are displayed.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Remote Control Setup List

When you click the [Remote Control Setup List] command on the [Tools] menu, the “Remote Control
Setup List” dialog box is displayed.

Registers the parameters to be controlled from an external controller. Refer to the “DME-N Remote
Control Protocol Specifications” document for details about the communication protocol. Information
about the “DME-N Remote Control Protocol Specifications” document can be found at the Yamaha pro
Audio website (URL below).

http://www.yamahaproaudio.com/

Does not apply to SP2060 units.

Names and Functions

" Remote Gontrol Setup List

Parameter Change |Gomponent:MYy=Ot -INFINITYdB 0.00de dB

Level Meter Component:Cascad|—— o4 m

Function Parameter Min Ma Twpe j

MNa fesien

Mo Assien

Mo Assien

MNa fesien

Mo fzsien

Mo Assien

Mo fesien

Mo Assien

Mo Assien _.'_J

2| =lwo|lo|-a|m|m| ==

= =

[DME]
From the list, select the DME where you will be making settings.

[Function]
Select [No Assign], [Parameter Value Edit] or [Level Meter].

[Parameter]

Specifies the parameter to be controlled. A list of parameters will be displayed according to the
selection of [Function].

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

[Min}/[Max]
Displays the minimum and maximum values for the parameter.

[Type]

Selects a fader curve when level, etc., is select for [Parameter].

Select [dB] to directly control the level in dB, or [Curve Table] to use one of the DME fader curves
for level adjustment.
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[Clear] Button
Clears the selected row.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.

Parameter List

When you click [Parameter List] in the [Tools] menu, the “Parameter List” dialog box is displayed. A list
of parameters in the current configuration of the current zone are displayed. Here you can check
things like the parameter IDs. You can also print the list of parameters.

When the dialog box is opened or when a DME is selected from the [DME] list, the parameter values
are displayed.

Does not apply to SP2060 units

Names and Functions

™ parameter List

Component | jin} i Walue tin | Max -
e A0
- Component
- Analog Output 10001
o Ot Leve| C:0:0:0:0 0 -138m 0
e Ot1:1:0n 00010 1 a 1
... Out1:1:Phagze 0:0:0:2:0 0 a 1
Ot 1sampleDelay 0000230 0 0 24
o Out2 Leve| 0:3:0:0:0 0 -138m 0
o Ot2:1:00 0:3:0:3:0 1 a 1
... Out:2:1:Phagze 0:3:0:2:0 0 a 1
o Out2SampleDelay 010230 0 0 24
o O3 Leve| 0:2:0:0:0 0 -138m 0
o Otd ] :0n 0:2:0:3:0 1 a 1
. DUt 1:Phase 0:20:20 0 0 1 hd

Prewvien.., | Save.. Cloze

m [DME]
From the list, select the DME where you will be making settings. Components in the selected DME
are displayed in the component list.

Component List

The components and user modules included in the DME, their IDs, and the component parameters
are displayed in hierarchal list. The AD and slot are also displayed.
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Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

[1D]
Displays the component or parameter ID.

The following is displayed for the parameter ID: “Element No. : X : Y : Parameter No. : Index No.”

[Value]
Displays the value for the parameter.

[Min]/[Max]

Displays the minimum and maximum values for the parameter.

The displayed parameter values are those that were in effect when the dialog box was opened or when the displayed
DME was selected from the [DME] list. They cannot be changed here.

m [Preview] Button

Prints a list of parameters. When you click this button a preview screen is displayed.

m [Save] Button

Saves the parameter list as a CSV file. When you click this button, the standard operating system

save dialog box is displayed.

The CSV format is a comma delimited text file that can be read by many types of software, such as word processor,

spreadsheet, or database programs.

m [Close] Button
Closes the dialog box

Printing a List of Parameters

Prints all parameters for the component selected in the list, all parameters for the selected DME, or all

parameters for all DMEs.

When you click the [Preview] button, the dialog box display will change, and the print preview will be
displayed in the center. Buttons will be added to the upper part of the dialog box.

== parameter List

Euint. Setup,

Erev

Hext

Close |

Ereview... | Save. |

cd
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m [Print] Button

Prints a list of parameters. Clicking here displays the “Print” dialog box. When you click the [Print]
button, printing begins.

The displayed [Print] dialog box will vary according to the connected printer.

m [Setup] Button

Clicking here displays the “Print Setup” dialog box.
Here you can set the paper size, paper orientation, and font.

" Print Setup

Paper Size: | &4 x oK
Orientation Lancel

& Partrait
" Landscape

Font
|MS Shell Dig

Target-
(~ Selected Component
(+ Selected DME
Al DME

[Paper Size]
Select the paper size from the list.

[Orientation]
Set the orientation of the paper by clicking one of the radio buttons.

o [Portrait]
Prints on the paper with it oriented vertically.

 [Landscape]
Prints on the paper with it orientated horizontally.

[Font]

Displays the set font. Clicking the [Font] button displays the “Font” dialog box, where you can
change the font.

[Target]
Set the parameters to be printed by clicking one of the radio buttons.

* [Selected Component]
Prints all parameters for the component selected in the list.

* [Selected DME]
Prints all parameters for the selected DME.

* [All DME]
Prints all parameters for all DMEs.

[Close] Button
Ends the preview and returns the screen to the original dialog box.
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[Prev] Button/[Next]

Button

Switches the page being previewed when there are multiple pages. The [Prev] button goes to the

previous page. The [Next] button goes to the next page.

Component Lock

Click [Component Lock] in the [Tools] menu to display the Component Lock dialog.]

Does not apply to SP2060 units

Names and Functions

" Go mponent Lock

Component

OMEZ4M
L 4D
amponent
¢ [ Analoe Output
5-5lat
i [ Internal[DME24M DA]
o [ Internal [DME24M HA-AD]

i [0 Crossover Processzor I
O EQ-Comp-Compreszor
i [0 EG@-Comp:PEG-Steren
f [0 MY-Others
[J Speaker Processar

¢ s

- Shot

L [ SLOT 1 [MY=Others]

oK Cancel

Cilear All

Select All

The component/user module names included in the DME will be displayed. AD and Slot will also be

displayed.

When the checkbox to the left of the component name is checked, the component is locked so that it
is not possible to change parameters from a PM5D or other external device controlling the DME unit
via the RS-422 interface. The lock settings will be transferred to the DME when the unit is placed on-
line. The settings can only be changed while off-line.

If user module security is enabled the components will not be displayed. Components displayed by the User Module Editor

will be displayed.

Only users who's [Edit] box is checked can edit the lock status.
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m [Select All] Button
Checks all component checkboxes.

m [Clear All] Button
Clears all component checkboxes.

m [OK] Button
Enters the settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without entering the settings.

Scene Link Manager

Either click the [Scene Link Manager] item in the [Tools] menu, or the [Scene Link] button the “Scene
Manager” window to open the “Scene Link Manager” window.

“Scene Link Manager” Window

This window allows setup and recall of scene linking between DME groups and SP2060 units. Scene
linking makes it possible to simultaneously recall scenes on multiple DME groups and/or SP2060
units. Up to 999 scene link setups can be specified.

Only users with security status in which [Edit] is checked can edit this feature.

This is a DME Designer feature and it does not affect scene recall or store operations carried out from the device panel or
external devices.
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Names and Functions

" Scene Link Manager

Scene Link Scene Mo, | Hew
=007 : Scenelink 001
. Delet
£-SP Groupl &

L..5P2060 M3 : Scens 013 Copy

L.SP2080 013 : Scene 013

=-S5 Group2 m
L.5P2080(3) 013 : Scene 013 T

L.SP2080) 013 : Scene 013

. DME Giroupl 001 - Scene 001 Ihzert

.. OME GiroupZ 002 : Scene 002
=002 : Scenelink 002

[2-5P Groupl
£..5P2060 014 : Scene 014
- SP2060E) 014 : Scene 014
[=-5F GroupZ fove LIP
L SP2060(3 014 : Scene 014
L.SP2060M) 014 Scene 014 | Iz (i

DME Groupl ] 002 : Scene 002

Recall

m Scene Link Tree View

Displays the scene link name, DME group and/or SP2060 scene number, and scene name for each
Scene Link setup. Clicking on scene number or scene name opens a list from which a new
selection can be made. Click on the scene link name to edit it.

m [New] Button

Creates a new scene link setup. Enter a name and click the [OK] button to add a new scene link
setup.

m [Delete] Button

Deletes the scene link setup currently selected in the scene link tree view. When clicked an “Are
you sure?” dialog will appear. Click the [Yes] button to delete the selected scene link setup.
Click the [No] button to abort the scene link delete operation. The [No] button will be grayed out
and inoperable if a scene link setup is not selected.

m [Copy] Button

Copies the selected scene link setup. The [Copy] button will be grayed out and inoperable if a
scene link setup is not selected.

m [Paste] Button

Pastes a cut or copied scene link setup to the currently selected scene link setup in the scene link
tree view. The selected scene link setup will be overwritten. The [Paste] button will be grayed out
and inoperable if no scene link setup has been cut or copied.
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Scenes can only be recalled in real time for DME and SP2060 units in an online device group.

m [Cut] Button

Cuts the selected scene link setup. The [Cut] button will be grayed out and inoperable if a scene
link setup is not selected.

[Insert] Button

Inserts a cut or copied scene link at the currently selected scene link position in the scene link tree
view. The selected scene link setup and all others below it will be moved down one position. The
[Insert] button will be grayed out and inoperable if no scene link setup has been cut or copied.

[Move UP] Button

Moves the currently selected scene link setup up one position in the scene link view. The [Move
UP] button will be grayed out and inoperable if a scene link setup is not selected.

[Move Down] Button

Moves the currently selected scene link setup down one position in the scene link view. The [Move
Down] button will be grayed out and inoperable if a scene link setup is not selected.

[Recall] Button

Recalls the scene number specified for the currently selected scene link setup in the scene link
view to the corresponding devices. The [Recall] button will be grayed out and inoperable if a scene
link setup is not selected.

m [Scene Manager] Button

Opens the “Scene Manager” window.

m [Close] Button

Closes the window.
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SP2060 Library Manager

Click the [SP2060 Library Manager] item in the [Tools] menu to open the “SP2060 Library
Manager” window.

“SP2060 Library Manager” Window

Allows editing of SP2060 Speaker Processor component libraries. Up to 60 libraries can be stored
for each component, and up to 360 libraries can be stored for each SP2060 unit

Only users with security status in which [Edit] is checked can edit this feature.

m Names and Functions

T2 SP2060) Library Manager

Device Library List Library File = Add File
=-Zonel IF2108 Ci/Frogram Files/YAMAHAOPT Tools/DME De
5-5P2080423[192.165000.013] IF2108_moni Gi/Program Files/YAMAHASOPT Tools/DME De M
- Speaker Processor IF2108 sub C:/Program Files/YAMAHAOPT Toole/DME De Mave UP
) IF211245 pa C:/Program Files/YAMAHAOPT Toole/DME De
IF2112645 pa_moni  Gi/Program Files/YAMAHACOPT Tools/DME De Move Dawn
IF2112A5 pasub  Ci/Program FilesYAMAHASOPT Tools/DME De
IF2112M54 pa C:/Program Files/YAMAHAOPT Toole/DME De
IF2112M64 pa sub  Ci/Program Files/YAMAHAOPT Tools/DME De
o O 6 Way IF2112M95 pa C:/Program Files/YAMAHAOPT Toole/DME De
2)-3P2060[192.169.000012] IF2112M95 pa sub  G:/Program Files/YAMAHAOPT Toals/DME De :
2 Speaker Processor IF2112M99 pa C:/Program Files/YAMAHAOPT Toole/DME De Dupligate
O 1 Way IF2112M39 pa sub  Gi/Program FilesYAMAHAOPT Tools/DME De
o O 2 Way IF211545 pa C:/Program Files/YAMAHAOPT Toole/DME De
. O 3 Way IF2115A45 pa_moni - Ci/Program Files/YAMAHAOPT Tools/DME De
o O 4 Way IF2115A5 pasub  Gi/Program Files Y AMAHASOPT Tools/DME De—
. [ 5 Way IF2115M54 pa C:/Program Files/YAMAHAOPT Toole/DME De
o O 6 Way IF2115M54 pa sub  Gi/Program FilesYAMAHAOPT Tools/DME De Import List
IF2115M35 pa C:/Program Files/YAMAHAOPT Toole/DME De .
IF2115M35 pa sub  Gi/Program FilesYAMAHASOPT Tools/DME De M
IF2115M39 pa C:/Program Files/YAMAHAOPT Toole/DME De
IF2115M39 pa sub  Gi/Program FilesYAMAHAOPT Tools/DME De
IF2205 Ci/Frogram Files/YAMAHAOPT Tools/DME De
IF2205 sub C:/Program Files/YAMAHAOPT Toole/DME De
IFzz03 Ci/Frogram Files/YAMAHAOPT Tools/DME De
IF2208_moni C:/Program Files/YAMAHAOPT Toole/DME De - M
o | o

m SP2060 List
Displays a list of the SP2060 units connected to the specified port.

Only SP2060 units for which a port has been set via “MIDI Setup” can be edited.

m Library List

Library titles and library file names are displayed in this list. The default titles are the file names
minus the file extension. Click a title to edit it. Titles can be up to 23 characters in length, but the
SP2060 display will only show 16 characters. 2-byte characters can also be used, but they will not
appear on the SP2060 display.
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m [Add File] Button

Adds a library file saved by the component editor (.cel extension) to the SP2060 selected in the
SP2060 list. When the [Add File] button is clicked the “Open” window will appear. Select a library
file and click the [Open] button to add the library.

The [Add File] button will be grayed out and inoperable if no SP2060 is selected.

Refer to the “Libraries” section on page 337 for information on component editor libraries.

[Delete File] Button

Deletes the selected library from the library list. When this button is clicked an “Are you sure”?”
dialog box will open. Click the [YES] button to delete the selected library.

Click the [NO] button to abort the library delete operation.

The [Delete] button will be grayed out and inoperable if a library is not selected.

[Move UP] Button

Moves the currently selected library up one position in the library list. The [Move UP] button will be
grayed out and inoperable if a library is not selected.

[Move Down] Button

Moves the currently selected library down one position in the library list. The [Move Down] button
will be grayed out and inoperable if a library is not selected.

[Duplicate] Button

Copies the library from the SP2060 selected in the SP2060 list to a different SP2060. When the
[Copy] button is clicked the “Duplicate” window will open. Select the destination SP2060 and click
the [OK] button to copy the library. Multiple destination SP2060 units can be selected.

Click the [Cancel] button to abort the library copy operation.

The [Copy] button will be grayed out and inoperable if no SP2060 is selected.

[Import List] Button

Imports a library file (.IIf extension) to the SP2060 selected in the SP2060 list. When the [Import List]
button is clicked the “Open” window will appear. Select a library file and click the [Open] button to
import all libraries included in the library file.

Click the [Cancel] button to abort the import operation.

The [Import List] button will be grayed out and inoperable if no SP2060 is selected.

[Export List] Button

Exports and saves the library of the SP2060 selected in the SP2060 list as a library file (.lIf
extension). When the [Export List] button is clicked the “Save As” window will appear. Select a file
format and click the [Save] button to save the library file. If you select the “Library List File” format
only the paths will be saved, and if you select the “Library List File with data” format the actual
library data will be saved to the file.

Click the [Cancel] button to abort the export operation.

The [Export List] button will be grayed out and inoperable if no SP2060 is selected.

[Upload List] Button

Sends the SP2060 library to an SP2060 unit. When the [Export List] button is clicked the “Select
Device” window will open. Select an SP2060 and click the [OK] button to send the library. Multiple
destination SP2060 units can be selected.

Click the [Cancel] button to abort the send operation.

[Close] Button
Closes the window.
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MIDI Port Setup

Click the [Port] item in the [Setup] menu to open the “Port” window. In this window you can set the
MIDI port of the master current device to be used by the DME Designer.

Only USB 1 is available on DMES8i-C/DME80-C/DME4io-C.

“Port” Dialog Box

Tx R Group
1 SP2060%#202 SP2060%#202 5P Group
2 |DMEdio#1 DME4io#11 DME Group
2]
« | 2]
(0] 4 | Cancel |

Selects the MIDI driver used for transmitting and receiving MIDI messages.

[Tx]

Selects, from a list, the MIDI driver used for transmitting MIDI messages.

[Rx]

Selects, from a list, the MIDI driver used for receiving MIDI messages.

[Group]

Select the device group to be set up from the list.
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Shortcut Keys

Click [Shortcut Keys] in the [Setup] menu to display the “Shortcut Keys” dialog.

Names and Functions

™ Shortcut Keys

Command I Key ] =]
21-Main Panel
E1-File
T 1
.. JIpen.., Citrl+0
o DAVE Cirl+5
gave fis.
- Import DME configuration -l
L.Create Mew DME
..[IME File Storage Enter new key
.. Preference
Log Off [otrbsn
. Exit Clear
=-Edit
.. Undo Cirl+Z
.. Redo Cirl+Y
. Undo Higtory
= Wi
i Deziener
zer Control
i fMew User Control
‘Event Logeer Cirl+L
= Toolz
Legcene Manager Cirl+1
iwelzer Control Manager Citrl+2 Lj ak Gancel

Click to select the desired shortcut item.

m [Enter New Key]

If assigned, the current shortcut will be displayed.
A shortcut entered via the computer keyboard will be displayed.

m [OK] Button
Enters the settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without entering the settings.
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Security (Creating Users and Making User Settings)

When you click the [Security] command on the [Setup] menu, the “Security” dialog box is displayed.
Here you can create and delete users. You can also set the security level for each user. Users are
saved as DME Designer settings. You don'’t need to create users for each file.

= Secur ity
v Enable Auto Log On l[P.dministrator
~Uszer List
Mame | Startup User Contral
Administrator 0N i

e MORINE
-Might
- MHoon

~Pml
3
L.Pm330
L.PmB

Add User.. Bemave Lzer

Charee..

I

~Operation Security

v Edit

v iew DME Design Window
¥ Control Component Editor
v “iew Component Editor
v Change Configuration

¥ Synchronization

[ Wiew Log Window

Scene Store/Recall Level [1 %

Uszer Control Level 11 5

Wiew Zone ]
Zonel
O Zone2?

oK Cancel

X

~/—— Auto-Logon User

m User Setting Restrictions

Various restrictions apply, depending on the security level of the user that is currently logged on.
e The currently logged on user can edit only users at a security level lower than his or her own.
® The currently logged on user cannot raise his or her own security level.

m [Administrator] User

The [Administrator] user is registered by default, and can use all functions. Immediately after DME
Designer is installed, there is no password set for the [Administrator] user.

m Security Level

User security levels are set with the [Operation Security] item at the right of the “Security” dialog

box.
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@Security

Iv Enable Auto Log On

—User List

] Adminiztrator

MName ‘Startup Uzer Control
dministrator ON

~Cperation Security

E dit Security User Level
Level T =

High

Level 1 User | ) Iv Edit
Level 2 User A _‘ Lii-'}-nght ] ¥ View DME Design Window
%NDDH ¥ Control Component Editor
Level 3 User - —' i ] W View Component Editar Low
Level 4 User 4— ) ¥ Change Configuration

¥ Synchronization
I~ View Log Windaw

Scene Store/Pecall Level 1 3:
Uzer Contral Level 11 :‘Cj

Security Level Settings

Wiew Zone ]
Zonel
[0 Zone2

Add User... Bemave lser Chanee... I

oK | Cancel I

You can allow or disallow editing and the ability to open windows or set controls.

Ten levels, 1 through 10, are set for scene storage/recall and user controls. Level 1 is the highest
level and 10 is the lowest. By default, level 1 is set for the [Administrator] user. Level 1 can be set
for the [Administrator] only. Users created by the [Administrator] directly below itself can be set at
levels 2 through 10. New users created subordinate to users at level 2 can be set at levels 3
through 10. New users can be created no higher than one level below the user that created them.
Scene sets the level for storing and recalling scenes. The logged on user can store or recall scenes
at levels equal to or lower than his or her own level. For example, a user at level 3 can recall scenes
set for scene recall at levels 3 through 10.

Levels are also set for user control. The logged on user can display or edit user controls at levels
equal to or lower than his or her own level.

The log-on user can use zones that are checked in the [View Zone] field.

Users with security level lower than level 2 form groups with a level-2 user as the leader.

Regardless of user security level, user controls and scenes created by users of a different group
cannot be used or edited.
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Names and Functions
[Enable Auto-Log On]

Enables auto-logon. If this checkbox is selected, the user displayed in the box to the right will be
logged on automatically when DME Designer is started. Auto-logon logs on the user without any
password entry.

Click the [ ¥] at the right of the box, and select the user for auto-logon from the displayed user list.

If auto-logon is turned OFF, the “Log On” dialog box will be displayed whenever the DME Designer is
started. Each time a user must be selected and a password entered in order to log on.

If auto-logon is changed from ON to OFF, “Confirmation of Current User” dialog box will be displayed.

"= Confirmation of Current User fg|

Lzer | Adrninistrator ﬂ

FPazzward |

LCancel

Enter the user’s password into the [Password] box, and click the [OK] button.
If you click the [Cancel] button, auto-logon will remain ON.

m Auto-Logon User
Selects the user for auto-logon when [Enable Auto Log On] is checked.

Iv Enable Auto Log On | Adrinistrator
User List
wamaha
Mame Startup User Contral [ T

Administrator DM Iv Edit

~yamaha - ON [v Wiew DME Design window

v Contral Component E ditor

The currently logged on user can set this command for users at a security level equal to or lower
than his or her own. If a user at a higher level is selected, a message that warns “Cannot access
higher user level.” will be displayed. Click the [OK] button.

=2 DME Designer

e Cannat access higher user level,

To set auto-logon for a user at a security level higher than the currently logged on user, first log off
as the current user, then logon as a user at a higher security level.
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User List

The registered users are displayed here. The currently logged on user is displayed in bold text. Click
the name of the user whose settings you want to edit.

Uzer L\stl |
Name Startup User Control Operation Security
Administrator |[OM 7 Edit
- MOrning ) )
- Might v View DME Design Window

¥ Control Component Editor

¥ \iew Gomponent Editor

v Change Configuration
¥ Synchranization

I~ Wiew Log Window
Scene Store/Recall Level |1 3

User Control Level 1 :l

Wiew Zone I
Zonel
[ Zonez

[ Add User... ] [Bemove Uzer ][ Chanee... ]‘

(4]
The [Administrator] is the user set by default, and it is used for administering the system. The
[Administrator] user has the highest level and can use all functions.

All new users are created at a level lower that the [Administrator] user, and are displayed below the
[Administrator].

If a user at level 2 and below has other users subordinate to him or her, a [+] or [-] button will be

displayed to the left of higher level user's name on the list. Clicking the [+] or [-] buttons displays or
hides the users subordinate to that higher user.

The currently logged on user can create multiple users at lower levels.
© Name

Displays the user names. The currently logged on user is displayed in bold text.

@ Startup User Control

Displays “ON” to automatically open the user control and make settings when the user is logged
on.

© [Add User] Button

Adds a user subordinate to the user selected on the list. Clicking here displays the “Add User”
dialog box. Select the user that will be superior to the new user, then click this button.

If a user higher than the currently logged on user is selected, the button will be grayed out and
no user can be added.
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O [Remove User] Button

Deletes the user selected on the list. Only users at levels lower than the currently logged on user
can be deleted.
Furthermore, the currently logged on user cannot delete himself.

@ [Change] Button

Changes settings for the user selected on the list. Opens the “Change User Information” dialog
box. The contents of the dialog box are the same as the “Add User” dialog box.

@ Operation Security

Sets the functions that can be used by the user selected on the [User List] to the left. Selecting
a checkbox enables use of the corresponding function.

* [Edit]
You can change the following settings: editing in the Designer window, user control edit, user
defined parameter edit, word clock, scene edit, GPI and MIDI.

* [View DME Design Window]
Allows display of the Designer window.

* [Control Component Editor]
Allows parameter editing in the component editor.

* [View Component Editor]
Allows display of the component editor.

 [Change Configuration]
Allows switching between configurations.

* [Synchronization]
Allows synchronizing with the DME or SP2060 unit.

* [View Log Window]
Displays the “Event Logger” window.

 [Scene Store/Recall Level]
Sets the level at which scenes can be stored and recalled. Click the [ A] and [ ¥] buttons or
enter a number into the box to set the level. While levels 1 through 10 are available, the range
of levels that can be actually set varies according to the level of the user doing the setting.
When a user is created, automatically this is set to “One level lower than the user above.” The
initially set level is the highest level that can be set for that user.

* [User Control Level]
Sets the user control level. Click the [ A] and [ ¥] buttons or enter a number into the box to set
a level from 1 through 10. While levels 1 through 10 are available, the range of levels that can
be actually set varies according to the level of the user doing the setting.
When a user is created, automatically this is set to “One level lower than the user above.” The
initially set level is the highest level that can be set for that user.

© [OK] Button
Applies any setting changes and closes the window.

@ [Cancel] Button
Closes the window without changing any settings.
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“Add User” Dialog Box/“Change User Information” Dialog
Box

When you click the [Add User] button in the “Security” dialog box, the “Add User” dialog box is
displayed. If you click the [Change] button in the “Security” dialog box, the “Change User Information”
dialog box is displayed.

The “Add User” dialog box is for setting a user name and password when adding a new user. You can
change user settings in the “Change User Information” dialog box. The contents of the dialog boxes
are the same.

=2 Add User §| T2 Ghanee User Information §|
Name Mame
Password Password
Gonfirm Pazsword Contirm Password
[~ Startup User Contral v Startup User Control
oK Cancel | QK GCancel ‘
“Add User” dialog box “Change User Information” dialog box
[Name] Box

Enter the user name. Enter a name different than other existing user names.

[Password] Box

Enter the password. When you type in the password box, asterisks (*) will be displayed instead of
the characters you enter. If you do not want to set a password the user, leave the box blank.

[Confirm Password] Box

Enter the password once again to confirm it. When you type in the password box, asterisks (*) will
be displayed instead of the characters you enter. If you do not want to set a password the user,
leave the box blank.

[Startup User Control]

When a user logs on the user controls of all users in the current device group with a lower security
level as well as the user-specified user controls will be opened automatically. If “OFF” only the
previously opened controls will open.

In the “Security” dialog box [User List], [User Control] will be “ON” for users for whom this option
has been turned on.

[OK] Button

In the “Add User” dialog box, this creates new users according to the settings made there. In the
“Change User Information” dialog box, this applies the dialog box settings and changes the user
settings.

[Cancel] Button
Cancels user creation or setting changes, and closes the dialog box.
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Creating Users

Users are created as follows:

1 Click [Security] on the Main Panel window [Setup] menu.
The “Security” dialog box will be displayed.
You can open the “Security” dialog box by clicking the [Security] button in the Main Panel window.

2 Select a user from the [User List] in the “Security” dialog box.

A user will be created subordinate to the selected user. [Administrator] can be selected only if the

logged on user is the [Administrator]. If there are multiple users, select the user that will be above
the new user.

Multiple users can be created subordinate to a single user.

e Security E'
¥ Enable Auto Log On [ Administrator |
~User List
MName I Startup User Control I ~Operation Security
Administrator ON v Edit
o MG ; : ;
- Night v Wiew DME Design Window

¥ Control Gomponent Editar

W View Component Editor

[ Chanee Gonfiguratian
¥ Synchronization
[ Wiew Log Windew

Scene Stores/Recall Level [1 =

User Contral Level I'I E.

Wigw Zone 1
Zonel
O Zone2

Add User... Eemove Lser Change.. ‘

Ok Cancel

3 Click the [Add User] button.
The “Add User” dialog box will be displayed.

4 Enter the user name into the [Name] box.

5 Enter the password into the [Password] box.

You can also create users with no password. If you do not want to set a password for the user,
leave the [Password] box blank.

6 Enter the password into the [Confirm Password] box also.
If you do not want to set a password for the user, leave the [Confirm Password] box blank also.
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7 Set the [Startup User Control].

P Add User X
Marme ]F'rnE
Pazzward ]

Cormfirm Password ||

[~ Startup User Contral

Ok Cancel

If the text entered into the [Password] and [Confirm Password] boxes is not the same, a “Different password!” message
will be displayed. Click the [OK] button and reenter the correct password in the [Password] and [Confirm Password]
boxes in the “Add User” dialog box.

" DME Designer fg|

& Different password!

8 Click the [OK] button.
This closes the “Add User” dialog box. The new user will be added to the “Security” dialog box list.

—User List

— Operation Security

Mame I Startup User Contral I

Administrator 0N [~ Edit

i+ Marni

s Ni::t'g [ “iew DME Design Window

El-Moon ™ Control Companent Editor
£ P
a st ™ Wiew Component E ditor
- Prn330 ™ Change Configuration

™ Synchrorization
™ Wiew Log ‘window

Scene Store/Recall Level |3 £

User Control Level 13 Ev

g Set the security level for the user, using [Operation Security] in the “Security” dialog box.
When creating a new user, all the checkboxes in [Operation Security] will be turned OFF. Click and
turn ON the functions you want to permit the new user to use. [Scene Store/Recall Level] and [User
Control Level] will be set to one level lower than the user above the newly created user. The initially
set level will automatically be the highest level that can be set for that user. To lower the level, enter
a larger number in the box.

Click the [OK] button and the dialog will close. You can continue creating new users without
closing the dialog box.
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Network Setup

Click the [Network Setup] item in the [Hardware] menu to open the “Network Setup” window.
This window can be used to set the IP address and device group master/slave status of DME and
SP2060 units.

These settings can be edited regardless of the current settings of the DME and SP2060 units. The DME Utility screen
Lock page and SP2060 Utility screen User Lock settings only apply to the device panels.

DMEB64N/24N slave devices will not be displayed.

The settings cannot be changed for devices in a device group that is online.

“Network Setup" Window

Names and Functions

2 Network Setup X

MIDT Part List (TP Netwark Setup

YaAMAHA USE OUT 0-1/YAMAHA USE TN 0-1

Device Group + Master " Slave

IP Address 182 ] 188 o, 3
Master ID EN oo, 2

Link Mode & 10Base-T ¢ 100Base-TH

MAG Address |00 AD DE 25 03 18

Gorce

m MIDI Port List (Tx/Rx)
Selects the device to be set up.

m Device Group

Displays and sets whether the DME or SP2060 unit connected to the port specified by Port Select
is the device group master or slave.

m |IP Address

Displays and sets the IP address of the DME or SP2060 unit connected to the port specified by
Port Select.

If the device group master IP address is changed and you are using the DME-N Network Driver, quit the DME Manager
and then restart it after changing the DME-N Network Driver settings.
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m Master ID

Utility

Click the [Utility] item of the [Hardware] menu to open the “Utility” window.

If the DME or SP2060 unit connected to the port specified by Port Select is a slave device, the
fourth octet of the of the device group master IP address is displayed and can be edited here. This
parameter is display only if the device is the device group master.

Link Mode

Displays and sets the link mode of the DME or SP2060 unit connected to the port specified by Port

Select.

MAC Address

Displays the MAC address of the DME or SP2060 unit connected to the port specified by Port

Select.

“Utility” Window

This window provides a variety of utility settings for DME and SP2060 units. These settings can only be
made when the target unit is online. A password will be required to open this window if the DME64N/

24N Utility screen is locked.

Only users with security status in which [Edit] is checked can edit Utility parameters.

Names and Functions

Device Lavel

Version

Battery

Date Time

Display | Lock | Mise | MIDI | GFI |

|DME4\D-C |

[0a2 |

lox |

20080420 ] [142180 |

Aoply ok Gancel

Device Select Field

Select the DME or SP2060 to be displayed or edited from the list.
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m Info Tab

Displays basic information for the selected DME or SP2060 unit.

Label

Displays the names given to the DME and SP2060 units.

Version

info | Metwark

Device Lavel

Battery

Date Time

Display }Ln:k lMlsc }MIDI \GPI }

|DME4\D*O

|O4S

[ox

|2006/O4/20 | |1421 58

Aoply oK

Cancel

Display the firmware version numbers of DME and SP2060 units that are online.

Battery

Displays the battery status of DME and SP2060 units that are online

Date

Displays the date and time of the internal clocks of DME and SP2060 units that are online.

m Network Tab

IP Addresz

Link Mode

MAC Addrecs

Info | Metwork }D.splay }Luck lMlsc }MIDI \GPI }

Group Master/Slave |Master’

[132168.000002

|1 00Base-TX

[po o pE2s 1508

Apply J oK ]

Gance

Displays DME and SP2060 network information.
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Group Master/Slave
Displays the device group master and slave.

IP Address
Displays the IP address.

Link Mode
Displays whether the network connection is via 10Base-T or 100Base-TX.

MAC Address
Displays the MAC address when online.

m Display Tab

Info | Network | Display ]Lock | Mise | MIDL | GPL |

LOD Gontrast |

LGD BackLight & ON i OFF

Meter Fall Time @& Slom O Fast

Aoply ok Gancel

Displays and allows editing of the DME64N/24N panel display.

LCD Contrast
Displays and sets the display contrast. The parameter range is 0 ... 100%.

LCD Backlight

Displays and sets the display backlight status. The settings are “ON” or “OFF”.

ON: The display backlight is continuously on.

OFF: The display will light when a panel control is operated, but will go out 10 seconds after panel
operation stops.

Meter Fall Time

Displays and sets the meter fall time. The settings are “Slow” and “Fast”.
Slow: Slow meter fall time.
Fast: Fast meter fall time.

148 DME Designer Owner’s Manual



Chapter 3 Main Panel Window

m Lock Tab

Wfo | Metwork | Display | Lock | Misc | MIDI | aPL |

Utility: | User Lack
@& Unlack @ Linlock
£ Lok € Lock

Panel Lock Boot Panel Look Tareet
@ Unlock & Key Only
 Lock € Key +GFI

User Defined Lock
Page 1 Page 2 — Page & —— Page 4
& Unlock & Unlock. & Unlock & Unlock
¢ Lock i Lock £ Lock  Lock

Apply oK Gancel

Displays and allows editing of the DME64N/24N and SP2060 panel lock parameters.
Only the User Lock parameter is displayed and can be edited for SP2060 units. All other
parameters are displayed and can be edited for DMEG4N/24N units.

Utility

Displays and sets the Ultility screen lock status. The settings are “Unlock” and “Lock”.
Unlock: The Utility screen can be opened without a password.

Lock: An 8-character password is required to open the Utility screen.

The password is also required to switch from “Unlock” to “Lock” status.

Panel Lock Boot

Displays and determines whether the panel lock will be automatically engaged when the unit is
turned on. The settings are “Unlock” and “Lock”.

Unlock: The panel will not be locked when power to the unit is turned on.

Lock: The panel will be locked when power to the unit is turned on.

Panel Lock Target

Displays and sets the panel lock target. The settings are “Key Only” and “Key+GP!I”.
Key Only: Only input via the panel controls will be locked.

Key+GPI: Input via the panel controls and GPI inputs will be locked.

User Defined Page Lock

Displays and sets the User Defined Button lock status for each page. The settings are “Unlock
and “Lock”.

Unlock: The corresponding User Defined Button page will be displayed.

Lock: The corresponding User Defined Button page will not be displayed.

”
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User Lock

Displays and sets the panel lock status. The settings are “Unlock” and “Lock”.
Unlock: Panel not locked.

Lock: Panel locked.

The following operations cannot be performed when the panel is locked:

e Parameter changes.

e Scene recall/store.

e Scene title editing.

e Scene protect changes.

e Library recall.

m Misc Tab

2 iility X

DMEdi0-C

Wfo | Metwork | Display | Lock | Mise | MDD | aPL |
Scene Store ( Enable & Disable
Last Mem. Resume  ON & OFF

Event Scheduler @ ON  OFF

Remote Gantrol HA Control (422} b

fpply 0K Gancel

Displays and sets parameters not provided in the other tabs.

Scene Store

Displays and sets whether scene store operations can be performed on a DMEG4N/24N unit. The
settings are “Enable” and “Disable”.

Enable: Scene store possible.

Disable: Scene store not possible.

Last Mem. Resume

Determines whether the scene number that was selected when the power was last turned off will
be recalled when the power is turned on, or whether the overall status of the unit when the power
was last turned off will be recalled when the power is turned on. The settings are “ON” and “OFF”.
ON: The status of the unit when the power was last turned off will be recalled.

OFF: The scene number that was selected when the unit was last turned off will be recalled.

The default setting is “ON”, but will be set “OFF” when a file (.daf/.ddf) created by a version of DME Designer prior to
V1.2 is loaded.

Event Scheduler

Displays and sets whether the DME unit's Event Scheduler function is active or not. The settings
are “ON” and “OFF”.

ON: The Event Scheduler is active.

OFF: The Event Scheduler is not active.
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Remote Control

Displays and allows editing of the DME unit [REMOTE] terminal. The following seven settings are
available:

HA Control: External head amplifier control (RS-422 only).

COM(232C): Control using DME Communication Protocol via RS-232C.

COM(422): Control using DME Communication Protocol via RS-422.

MIDI(232C): Control using MIDI commands via RS-232C.

MIDI(422): Control using MIDI commands via RS-422.

Remote Ctrl (232C): Remote control using DME Communication Protocol via RS-232C.

Remote Ctrl (422): Remote control using DME Communication Protocol via RS-422.

MIDI Tab

Info | Metwork | Display | lock | Misc | MIDI ]GPI |

Fart UsB-2 =
D& Type OFF =
MIDI Ghannel
Tx 1 2
Rx 1 -

QNI Echo

Tx 333
Program Change ON ON OFF ‘ QFF ‘

Control Change OFF | OFF | OFF ‘ QFF ‘

Parameter Change N ON OFF

Apply [9]4 Cancel

Does not apply to SP2060 units.

Port
Selects the MIDI port to be set up.

Only USB 2 is available on DMES8i-C/DME80o-C/DME4io-C.

DAW Type
Selects the DAW type when a DAW controller is to be used.
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MIDI CH
Sets the MIDI channel. This number is also used as the Parameter Change Device ID.

* [TX]
Select the MIDI transmit channel from the list.

* [RX]
Select the MIDI receive channel from the list.

Program Change/Control Change/Parameter Change

Sets transmit (Tx), receive (Rx), OMNI, and Echo for program change/control change/parameter
change. When ON, clicking turns this OFF. When OFF, clicking turns this ON. When OMNI is [ON]
channel messages are received regardless of the receive channel setting. When ECHO is [ON] the
input data is “echoed” (re-transmitted) via the output port that corresponds to the input port via
which it was received.

Program change, control change, and parameter change details can be set up via the “MIDI”
window [Program Change], [Control Change], and [Parameter Change] tabs, respectively.

Program Change/Control Change/Parameter Change

Sets transmit (Tx), receive (Rx), OMNI, and Echo for program change/control change/parameter
change. When ON, clicking turns this OFF. When OFF, clicking turns this ON. When OMNI is [ON]
channel messages are received regardless of the receive channel setting. When ECHO is [ON] the
input data is “echoed” (re-transmitted) via the output port that corresponds to the input port via
which it was received.

Program change, control change, and parameter change details can be set up via the “MIDI”
window [Program Change], [Control Change], and [Parameter Change] tabs, respectively.

m GPITab

Info Metwork Display M.uck IMISD IMIDI GPI ]

All Ports 2

1 3
r r r
‘ ‘1 ‘1
] 1 2 3 4 5

g
r r r r r r r r

Reset
fpply | oK | Cancel |

7
r

__|cn

4 5
r r

=

Calibrates the input voltage detection range for a DME unit GPI terminal.

[ALL] Checkbox
Automatically checks all channel checkboxes.
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[Ch] Checkbox
These checkboxes specify the channels to be calibrated.

Calibration Information
Displays the input voltage in real time.

[Reset] Button
Resets the calibration of checked channels.

[Max] Button

Sets the current input voltage as the maximum input voltage for checked channels.

The specified maximum voltage is indicated by a red bar.

[Min] Button

Sets the current input voltage as the minimum input voltage for checked channels.
The specified minimum voltage is indicated by a blue bar.

Common to All Tabs

[Apply] Button
Applies any current setting changes.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.

DME Designer Owner’s Manual

153



Chapter 3 Main Panel Window

Word Clock

The signal that synchronizes all devices connected to the DME or SP2060 is called the “Word Clock.”
It uses the same frequency as the sampling frequency. The word clock is set for each DME or SP2060
in the “Word Clock” dialog box.

When you click [Word Clock] on the [Hardware] menu, the “Work Clock” dialog box is displayed.

Names and Functions

™= Word Glock

(X

ENLER DME Groupl /DMEESH |4

D:H E D ﬂ j © = Unlock @ =Llock @ = Lock, But Not Sync'ed (O = Unknown
a M

Gard

Clock Information

SLOTT Q cHi/2 |Q cHi/d QO cHi/s O CHIAR
Mo Gard O cHio O cHI1AZ O CHIEA4 O CHIEAE
. sLoTz Q cH/2 |Q cH/4 |Q ocHsss O GHIAE
Slot Information
Mo Card QO cHAo JQ cHI1AZ QO cHIEA4 O CHISAE
sLoT 3 Q cH/2Z |Q cH/4 |[Q cHs/s O cHiAE
Mo Gard QO cHAo O cHI1AZ O CHIEA4 O CHISAE
sLOT 4 QO ocHi/2 QO ocHI/4 QO oHs/6 O CHYE
Mo Gard QO cHiAo O cHI1A1Z O CHIZA4 O CHIBAE

Internal

O #k  |Of 4 O % |O %k

Wiord Glock
Clock Status o won
Gascade Digital
(o] I ] ot | Q I |

Close

¥ The number of channels varies according to the card inserted into the slot.

m DME
From the list, select the DME or SP2060 where you will be making settings.

m Clock Information
Displays the word clock frequency for the DME or SP2060 selected in [DME].
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m Card (Slot Information)
Displays the name of the card inserted into the slot.

m Clock Status

Slot Number

Card Name

Gard

SLOT 1

MY 16-AE

5LOT 2

MY 16-C

SLOT 3

My4-a0

SLOT 4
Mo Card

The clock status is displayed using a color code:

Status Meaning
© = Unlock Indicates that there is no input signal.
Indicates there is an input signal and sync is possible with the current
O =Lock word clock.

0 =Lock But Mot Sync'ed

Indicates there is an input signal but cannot sync with word clock (clocks
are different).

0 =Unknown

Indicates that there is no DME or SP2060 unit information.

m Internal/Word Clock/Cascade
You can select one of the following for the word clock:

Device Name | Slot Internal Word Cascade Digital
Clock

DME64N 1~4 44.1kHz/A8KkHz/88.2kHz/96kHz WC IN IN/OUT —

DME24N 1 44 1kHz/48kHz/88.2kHz/96kHz WC IN — —

DMESI-C,

Bmgj%_% — | 48KkHz/96KHz — — —

SP2060 — 96kHz — — IN(*)

(*)This settings can only be made when the target unit is online.
Clock buttons that are grayed out cannot be selected.

m [Close] Button
Closes the dialog box.

You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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Monitor Out

When you click the [Monitor Out] command on the [Setup] menu, the “Monitor” dialog box is
displayed. Sets the monitor output destination.

Monitor Out can be set on DMEG4N/24N units only.

™= Monitor Out

DME |{afil=Eis]

| Cascads Chi/2 |

[DME]
From the list, select the DME64N/24N where you will be making settings.

m Drop down list
From the list, select the card that will be the destination for the monitor output.

m [OK] Button
Accepts the changed settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without changing the settings.
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Clock

When you click the [Clock] command on the [Hardware] menu, the “Clock” dialog box is displayed.
Here you can set the DME internal clock. This can be set only when online. The default is the computer
date and time.

Set the date in the left box and the time in the right box. You can change the numbers using the [A]
and [ v] at the right of the boxes.

Does not apply to SP2060 units

m [OK] Button
Applies any setting changes and closes the window.

m [Cancel] Button
Closes the window without changing any settings.

You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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Language Settings

When you click the [Language] command on the [Hardware] menu, the “Language” dialog box is

displayed. This sets the DME64N/24N unit language.

Language Settings can be set on DME64N/24N units only.

Names and Functions

e Language

Language

ak. LCancel

m [Language]
Select the language. [English/German/French/Spanish] and [Japanese] are in the list.

= Language &|

Language |Endhhfﬁenﬂanfﬁenchfﬁpanhh

Englizh/German/Franch/Spanish

| T I e |

m [OK] Button
Accepts the changed settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without changing the settings.

You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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Backup

When you click the [Backup] command on the [Hardware] menu, the “Backup” dialog box is
displayed. Data in the DME or SP2060 is gathered in the computer and saved as a file. Backup files
are created for each DME or SP2060. You can also send the information saved in a file to a DME or
SP2060. Backup can be performed only when in offline status.

Backup operations can be performed only by users for whom the [Edit] security checkbox has been checked.

Twpe

92.168.000.010] SP2060
DME4ic~C[192168.000.004] DME4io-C
DMESo-C[192.168.000009] DMESo-C

Load | Save Cloze

[Target DME]

Displays DME or SP2060, IP addresses, and DME or SP2060 types for each device group. Check
the DME or SP2060 from which you want to obtain data. You can place checks next to multiple
DMEs and SP2060s.

m [Folder] Box

Specifies the folder that will be the destination for saving and reading operations. Clicking the
[Browse] button opens the folder select dialog box, where you can specify a folder.

The backup file name will be the DME’s IP address. If the folder is specified when sending DME
data, the file sent to the DME will be the file in the folder whose file name that matches the DME’s IP
address.

m [Load] Button
Sends the backed up file to the specified DME or SP2060.

m [Save] Button
Obtains data from the specified DME or SP2060, and saves it as a backup file.

m [Close] Button
Closes the dialog box.
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DME Firmware Update

You can update the DME or SP2060 unit, ICP1 firmware using the [Firmware Update] command on the
[Hardware] menu. When you move the mouse cursor over the [Firmware] command on the [Tools]
menu, a submenu is displayed.

=2 DME Desiener :

IF Address
Utility

Yiord Glack Cirkg
Monitor Qut Cirl+g Mute Rx

Clock

Language

.. ||Device Group

Backup

Becovery Update

When you select [Program+Component] or [Recovery Update] on the submenu, the “Open” dialog
box will be displayed.

When performing a firmware update, connect the DME or SP2060 unit, ICP1 and the computer.

When the DME or SP2060 unit, ICP1 update is finished, the DME or SP2060 unit, ICP1 will be
automatically restarted. You also need to restart DME Designer.

When performing the DME or SP2060 unit firmware update, connect the DME or SP2060 unit and the computer by USB or
Ethernet. The USB-MIDI or DME-N Network Driver must be installed in the computer.

To perform the ICP1 firmware update, the ICP1 and the device group master DME unit must be connected by Ethernet. In
addition, the device group master DME unit must be connected to the computer as described above.

If the DMEB4N/24N has been updated from V1.07 or lower to V1.10 or upper, perform the update twice. Because the text
display data in the DME64N/24N unit is changed, text display for Japanese is not possible with one update only.

Firmware Update may become impossible if the [Remaining Memory] value (the amount of remaining DME memory)
becomes too small. If this occurs, delete unwanted files to increase the amount of available memory.
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m [Program+Component]
Updates the DME/SP2060/ICP1 unit firmware.

1 Select [Firmware Update] 00 [Program+Component] in the [Hardware] menu.
The folder select dialog box will be displayed.

2 Select the folder that contains the update file, then click the [OK] button.

The “Firmware Update” window will open. The names, firmware version numbers and IP
addresses of DME, SP2060 and ICP1 units in the current device group will be displayed in a list.

™= Firmware Update

Selected Folder [Firmware

Fleaze do not discannect cable
or turn off any device while updatine.

Device ‘Vers\un |IP Address |Slatus |
[+ b DME24N 192 192.168.000.002

Select Al Clear All Status Details
N Close

3 Check the DME, SP2060, or ICP1 unit you wish to update.

Clicking the checkboxes alternately turns the check mark on and off. The [Select All] button can
be used to check all DME, SP2060, and ICP1 units. The [Clear All] button removes the check
marks from all DME, SP2060, and ICP1 units.

4 When the DME, SP2060, and ICP1 units to be restored have been checked, click the
[Update] button.

The firmware update will begin.

During the restore process do not disconnect any USB or Ethernet cables, or turn the DME, SP2060, or ICP1 power
off. Doing so can result is loss of the DME Designer MIDI settings.

When the restore update is complete the DME, SP2060, and ICP1 units will restart automatically.
It is also necessary to restart the DME designer.
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m [Recovery Update]
Restores the DME, SP2060, or ICP1 firmware.

When performing a firmware recovery operation on a DME unit, disconnect from the network and carry out the operation
with the DME unit directly connected to the computer via USB.

1 Select [Firmware Update] -> [Recovery Update] from the “Hardware” menu.
The folder select dialog box will be displayed.

2 Select the folder that contains the recovery file, then click the [OK] button.
The “Firmware Update” window will open.

™= Firmware Update

Selected Folder [Firmware

Fleaze do not discannect cable
or turn off any device while updatine.

Device |Vsrs|un ‘IP Address ‘Stalus |
- ] DME24N

Select All Glear Al Stats Delails
Update Close

3 Check the DME, SP2060, or ICP1 unit to be restored.
Clicking the checkboxes alternately turns the check mark on and off. The [Select All] button can
be used to check all DME, SP2060, and ICP1 units. The [Clear All] button removes the check
marks from all DME, SP2060, and ICP1 units.

4 When the DME, SP2060, and ICP1 units to be restored have been checked, click the
[Update] button.
The firmware restore process will begin.

During the restore process do not disconnect any USB or Ethernet cables, or turn the DME, SP2060, or ICP1 power
off. Doing so can result is loss of the DME Designer MIDI data.

When the restore update is complete the DME, SP2060, and ICP1 units will restart automatically.
It is also necessary to restart the DME designer.
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Editing Configurations

Configurations

Information about inputs/outputs, along with the arrangement of components and how they are
connected, is called a “configuration.” Configurations are created in the Designer window and sent
to the DME unit.

In the Designer window, configurations are designed using various design windows, such as the Area,
Zone, Configuration, and User Module windows. In each window a sheet is displayed, on which
objects can be arranged.

New Configurations

Multiple zones can be created for an area, multiple device groups can be created for a zone, and
multiple configurations can be created for a device group.

Zones can be added via the “Zone Manager” window, device groups can be added via the “Device
Group and Sampling Frequency Settings” window, and configurations can be added via the
“Configuration manager” window. Information about the “Zone Manager” window can be found in the
“Adding, Deleting, and Renaming a Zone” section on page 267, information on the “Device Group and
Sampling Frequency Settings” window can be found in the “Device Group Selection” section on
page 249, and information on the “Configuration Manager” window can be found in the “Adding,
Deleting, and Renaming a Configuration” section on page 270.

Security

Editing in the Designer window can be restricted based on the user security settings. Only users for
whom the [Operation Security] — [Edit] checkbox in the “Security” dialog box has been checked can
display the Designer window and edit configurations.

For information about the “Security” dialog box, see “Security (Creating Users and Making User
Settings)” on page 70.

Edit Mode

There is an “Edit Mode” in the Designer window. When the Edit Mode is ON, configurations can be
edited. When it is turned OFF, the DME is controlled by DME Designer.

SP2060 configurations cannot be edited.
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m Edit Mode ON/OFF

The edit mode can be turned on or off via the [Edit Mode] command in either the [Tools] menu or the
contextual menu that appears when you right-click on the worksheet. You can also use the [Edit Mode]
button in the menu bar. To turn Edit Mode ON click the command, placing a checkmark to the left of
the command name. When there is a checkmark next to the command (when Edit Mode is ON),
clicking the command again removes the checkmark and turns OFF the Edit Mode.

Edit Mode=ON

When Edit Mode is ON, you can do configuration editing tasks such as arranging objects, making
connections, and changing properties.

Edit Mode=OFF

When Edit Mode is OFF, you cannot arrange objects, make selections, or display “Properties”
dialog boxes for objects. You can display the component editor.

Only users for whom the [Operation Security] — [Edit] checkbox in the “Security” dialog box has been checked can turn
the Edit Mode ON.

Designer Window

You can display or hide the Designer window using the [Designer] command on the [View] menu in
the Main Panel window.

Navigator Window

Title Bar
Menu Bar
Toolbar
§ Ko trveammd
- =iy
i Bl aman
+ mlZ
i
o mRfan | pamad
- Bl
i B
:::-\‘-“‘-J
s By
P
i Blmesor
= mivar & e,
+ B
3 Pl Ay
Toolkit Window—4 .5~
[ -
L8]
Design Window Resource Meter
Window
Title Bar

“Designer” is displayed on the title bar. You can move the window by dragging the title bar. There are
[Minimize], [Maximize]/[Restore], and [Close] buttons at the right edge of the title bar.
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Menu Bar

Commands that can be executed in the application are collected into categories on the menu bar.
When you click one of the categories, a list of commands is displayed.

Toolbar

Frequently used commands are arranged here as buttons.

[Redo] Button [Navigator] Button [Probe Monitor] Button [Arrow] Button
[Print] Button [Copy] Button [Analyze] button [Zoom In] Button [Edit Mode] Button

S el &> E'_D % [H O f= 2 @ & [ 4 d

[Undo] Button [Paste] Button [Show Signal Delay] button [Actual Size] Button [Zoom To] Button
[Cut] Button [Resource Meter] Button [Zoom Out] Button [Hand] Button

[Print] Button (page 176)
Prints the active design window.

m [Undo] Button (page 177)
Undoes the most recent edit operation.

m [Redo] Button (page 177)
Restores operations undone with the [Undo] button back to their original condition.

m [Cut] Button (page 177)
Cuts the selected object from the screen and moves it to the clipboard.

m [Copy] Button (page 177)
Copies the selected object to the clipboard.

m [Paste] Button (page 177)
Pastes data from the clipboard.

m [Navigator] Button (page 168)
Displays or hides the Navigator window.

m [Resource Meter] Button (page 167)
Displays or hides the Resource Meter window.

m [Analyze] Button (page 181)
Displays the “Analyze” dialog box, and analyzes the configuration.

m [Show Signal Delay] Button

The digital signal delay value is displayed in the Configuration window.
- "Show Signal Delay (Delay Display Value)" in "Configuration Window" (page 281)

m [Probe Monitor] Button

Turns the probe monitor ON or OFF.
- “Probe Monitor” in “Configuration Window” (page 279)
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m [Zoom Out]/[Zoom In]/[Actual Size]/[Zoom To] Buttons

These buttons correspond to the commands on the [View] menu with the same names. Changes
the magnification of the display on the screen.
- “[View] Menu” in “Designer Window Menus” (page 178)

m [Arrow] Button
The mouse cursor appears as crosshairs, and can be used to select objects.

m [Hand] Button
The mouse cursor appears as a hand shape, and can be used to click and “grab” the worksheet
for scrolling.

m [Edit Mode] Button

Turns the edit mode ON or OFF.
- "Edit Mode” (page 166) in the “Configuration Editing” section.

Status Bar

IO-::mpl:nnent ID : 10003 {00002713H Sampling Frequency 48.0kHz Sheet Size 800 X 200 ®o22a Yy 156 I

DME ID/Component ID Sampling Frequency Sheet Size Coordinates

m DME ID/Component ID

When the mouse pointer is moved over a DME device in the Zone window, the ID for that DME
device is displayed. When the mouse pointer is moved over a component in the Configuration
window, the ID for the component is displayed.

m Sampling Frequency
Displays the sampling frequency in the configuration window.

m Sheet size
Displays the size of the sheet in the active design window.

m Coordinates
Displays the coordinates of the mouse pointer any time it is within the design window. When
dragging an object, the coordinates displayed here refer to the upper left corner of the object
being dragged.
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Resource Meter Window

The Resource Meter can be displayed or hidden via the [Navigator] command in the [View] menu.
The Resource Meter window is displayed only when the Configuration window and User Module
window are active. Meters for the DSP memory usage percentage and the SPX resource usage
percentage are in the Resource Meter window. The sampling frequency of each DME unit is also
displayed.

Not displayed in the SP2060 configuration window.

m DSP Memory Usage Percentage

When you are designing in the Configuration window, it gives you a yardstick for judging the total
usage percentage for DSP memory in the DME unit. In addition, the usage percentage varies
depending on the sampling frequency, even for the same component.

When the configuration is synchronized with the DME unit during online status, checks of
connections and component information begin automatically (this is called compiling). The actual
total usage percentage is calculated after this compiling operation. The usage percentage will vary
according to the number of connections and components. The Resource Meter window gives you
a precompile guideline for use while designing your configuration. An error may occur even when
the meter shows less than 100 percent, based on conditions such as the number of connections,
and type and number of components used.

If a configuration is compiled at fs=44.1kHz or 48kHz, and the sampling frequency is then changed to 88.2kHz or 96kHz, it is
necessary to recompile at 88.2kHz or 96kHz. If this is not done some configurations may produce no sound. In such cases a
“DSP Power Shortage” message will be displayed on the DME unit.

m SPX Resource Usage Ratio

Displays the resource usage ratio for SPX components and Feedback Suppressor components
arranged in the configuration.

"™ ResourceM...

SamplingFrequen:

If the [Matrix Mixer 64 input 64 output] or the [Matrix Mixer 64 input 32 output] components are placed in the DME64N
configuration window, you will not be able to use other components, even though the window does not reach 100 percent.
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Navigator Window

The Navigator window can be displayed or hidden via the [View] menu [Navigator] or the tool button
(large) [Show/Hide Navigator] button in the main window, or via the [View] menu [Navigator]
command in the designer window.

Gives a hierarchical display of the area, zones, and configurations, along with the DME devices, user
modules and components arranged within the configurations. This allows you to check the overall
status of your setup.

When doing offline editing, you can click the icon or name for an area, zone, configuration, DME
device, user module, or component to make each design window active.

For user modules with security enabled, a password is requested when displaying the hierarchical display shown below.

% Mavieator

Area —t -0 New Area

Zone —f— -2 Zonel
Device Group — =~ [EIE DME Group
Configuration —j———— = [EEI Sonfie
Device —f————— =l
User Module (- WOnsaved User Modum
Components included iggﬁ_mﬁ i l
in the User Module o ~Zamp e
- LFOSES0VEN FrOCessor
.. Delay-Laong
.. Compressor
Components - Fader
- futo Mixer
- CompanderH
-.Compandar HZ)
. Compander HI3)
- Ducking )
. PECI-Mario
.. PEGI-Mano2)
.. PEG-Mono (3}

m [+]/]
The subordinate items are displayed or hidden using the [+]/[-] buttons to the left of the area,
zones, configurations, user modules, or DME devices. When the subordinate items are displayed,
the button changes to [-]. If you click this button, the subordinate items will be hidden. When the
subordinate items are hidden, the button changes to [+]. If you click this button, the subordinate
items will be displayed.
Subordinate items are also displayed and the button changes to [-] when you click on an area,
zone, configuration, user module, or DME device.
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Area
If you click the area while doing offline editing, the Area window becomes active.

Zone

If you click a zone while doing offline editing, the Zone window becomes active. If another Zone
window is open, it will be closed.

When there are multiple configurations in a zone, click a configuration to switch configurations, not the zone.

Device Group

If a group is clicked during offline editing, the zone window of the clicked group will become active.
If a window for another zone is open at the time, it will be closed.

Configuration
If a configuration is clicked during offline editing, the clicked configuration will be selected.

Device

If you click a device, a Configuration window will be opened for that unit. If that window is already
open, it will be displayed on top of any other windows.

Component
Click a component and the component editor will open.

User Module
The window specified by “User Module Properties [Double Click Action]” will open when clicked.

Components Included in the User Module
Click a component in the user module and the component editor will be displayed.
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Toolkit Window

The Toolkit displays objects that can be arranged in each design window. The displayed contents vary
according to which window is active.

- See “Objects” on page 183.
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Displaying the Toolkit Window

You can display or hide the Toolkit window using the [Toolkit] command on the [View] menu. The
Toolkit displays objects that can be arranged in each design window. You can arrange objects in each
design window by dragging them from the Toolkit window or by double-clicking them in the Toolkit
window.

The objects are categorized by type and displayed here in a hierarchy. You can use the [+]/[-] buttons
to display or hide items below a particular level in the window. Click the [+] button to display the items
on the next level down, and the [-] button to hide them.

Moving the Toolkit Window

You can move the Toolkit window by dragging it. If you drag the window to right or left side, it will
remain fixed. If you drag it to other locations, it will float independently. When DME Designer is started,

the Toolkit window is displayed at the left side of the Designer window.
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Toolkit Window Types

The contents of the Toolkit window will vary, depending on which window is active.

Active Design Window

Toolkit Window

Area Window

Area Parts List

Zone Window

Device List

Configuration Window

Component List

User Module Window

Component List

The following objects are displayed in each window:

Component List Component List
Area Parts List Device List (Configuration (User Module
Window) Window)
DME 0
ICP O
SP2060 O
External Device d d
Component O O
SPX Component a O
User Module O
Pictures ad ad ad ad
Text 0 0 0 0
Boxes O d d d
Ellipses ad ad ad ad

[Area Parts List]

The [Area Parts List] displays objects that can be arranged in the Area window. The same objects are
displayed in the [Area Parts List] submenu on the [Tools] menu or on the context menu that appears
when you right-click on the sheet.

172

K Desiener.

* Ellipse

¥ Desiener

Picture
Text
Box
Ellipse

BExternal De

e List

Component List

Zone Manaeger...
Device Group Managsr..

Configuration Manager,

Save User Module.

Usger Module Manager.

Show Signa] Delay

Analyze
Frobe Monitor

External Device  » BRAEES

Picture
Text
Eox
Ellipse

You can create multiple zones in an area. They are added using the menu bar [Tool] menu - “Zone” dialog box.
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[Device List]

The Device list displays objects that can be arranged in a Zone window (configuration). The same
objects are displayed in the [Device List] submenu on the [Tools] menu or on the context menu that
appears when you right-click on the sheet.

i Desiener

#DMER-C
#0MEdio-C
FICH
[+-ESpeaker Processor
- EExternal Device
-~ Picture
- Tet
Eox
- Ellipse

Toolkit window

el Deves
Petes

[Tools] menu

,55" Faste
Start Wire e
DME
[ v Edit Mode P
Sheet.. External Device
.......... i Ficture
Text
Box

Ellipse

[Device List] submenu on the [Tools] menu or
on the context menu

Configurations are added using the menu bar [Tool] menu - “Configuration Manager” dialog box.

[Component List] (Configuration Window)

The Component List displays objects that can be arranged in Configuration windows. The same
objects are displayed in the [Component List] submenu on the [Tools] menu or on the context menu
that appears when you right-click on the sheet.

# Designer

EiCrassover
FiCrossover Frocessor
EiCrassover Processorll
EDelsy

= Dynamics

2EG

B Fader

FiFeedback Suppressor
EFilter

B Meter
EiMiscellaneous

B Mixer

#-EPan

= Router

EiSource Selsctor
FiSpeaker Processor
BEPK

Bilser Module

Picture

Text
Box
Ellipse

Toolkit window

Cascate Input

I Desiener

H-ECrossover
- ECrozsover |
- EiCrossover |
i Delay

- EEQ

- B Fader
- EiFeedback §
- EFilter

B Meter

- EiMiscellanes
i EiMixer
+-EPan

- B Router

i ErSource S

£-BSPX
- Eillzer Modul
Picturs
- Text
-..Box
Ellipse

#-EDynamics  —

+-Ei5peaker Pro

Area Parts List

Device List

Crossover 3
Zone Manager Crossover Frocessar b
Device Group Manager. Crossover Processarll b
Configuration Manager.. Delay »
Save User Module. Dynamics 3
User Module Manazer EQ 3
B Show Sienal Delay Eader k
Feedback Suppressor b
m Analyze.
Filter 3
- |
BB Frobe Monitor ki 5
Monitoring Point List T — ¥
Edit Mode Mixer »
Pan 3
Prahibit Diaganal Gannections o '
Source Sslsctor »
Grid..
— Speaker Processor »
v Arron
SPX »
Hand
— User Madule 3
Export DiF. )
EE.. i Picture
Preferences By
Box
Ellipse

Start Wire

v Edit Mode

Sheet..

- Compressar(2) -

Unzawec

[Tools] menu

Revisions . .

Crozzover 3
Crozzover Processor
Crossover Processorll
Dielay 3
Dynamics 3
EQ 3
Fader 3
Feedback Suppressor  »
Filter 3
Meter 3
Mizcellaneous 3
Mixer 3
Fan 4
Fouter 3
Source Selector 3
Speaker Processar 3
P 3
Uszer Maodule 3
Picture

Text

Box

Ellipse

[Component List] submenu
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[Component List] (User Module Window)

The Component List displays objects that can be arranged in the User Module window. The same
objects are displayed in the [Component List] submenu on the [Tools] menu or on the context menu

that appears when you right-click on the sheet.

0 Desiener

EiFeedback Suppressor
EFilter

mSource Selectar

mSpesker Frocessor

DEPK

Picture

- Text
Box

~Ellipse

Toolkit window
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Four Design Windows

The following design windows are available: the Area window, Zone window, Configuration window,
and User Module window. In each window there is a single sheet on which objects can be arranged.
Within the Designer window, you can simultaneously open and edit in the Area window, Zone Window,
Configuration window, and User Module window.

Configuration Structure and Four Design Windows

Area Window

- Campresso OF
. ~ PEQ-Dg1e0
Zone Window PEC-Siensctz}

I

Cielay Watic

Matix Moy

Configuration Window

Component Editor

=1 User Module Window

m AreaWindow

Used to design areas.
- See “Area Window” on page 272.

m Zone Window

Used to design zone configurations.
- See “Zone Window” on page 274.

m Configuration Window

Used to design configurations for DME units arranged in a zone.
- See “Configuration Window” on page 277.

m User Module Window

Used to design user modules configurations. A module that combines a number of other
components, yet is treated as a single component, is called a “user module.” It is arranged in the
Configuration window.

- See “[Component List] (User Module Window)” on page 174.
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Designer Window Menu

[Print] Menu

This menu provides commands for exporting configurations and printing windows.

3 Designer

Export DEF...
Print Setup...

Print Preyiew

@ Brirt... Chrl+p

Preferences...

m [Print Setup]

When you select this command, the “Print Setup” dialog box will be displayed. Sets the paper size
and orientation.
- “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 247)

m [Print Preview]

Displays a print preview of the active design window.
- “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 247)

m [Print]
Prints the active window. When you select this command, the “Print” dialog box will be displayed.
- “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 247)

[“Print” dialog box]
Enter the number of copies to print into the [Number of Copies] box, and click the [Print] button.

& Print
General l
Select Printer
Add Printer
Status: Ready ™ Prirttofile  Preferences
Location:
B Find Printer...
Fage Range
@ Al Murnber of copies: |1 El:
f"' C
" Pages 1] W~
Enter either a single page number or a single
page range. For example, 5-12
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[Edit] Menu

This menu provides edit commands.
& Designer

Ch+Z
Chrl

cut Chri+

Copy Chrl+C

Paste ey

Delete Del

Select all Chrl+a
Duplicate Chr+D
Display Order

Edit Legend...

Properties...

m [Undo]
Undoes the most recent edit operation. Repeatedly clicking this button will delete multiple
operations. When [Undo] is not possible, the command will be grayed out.
m [Redo]
Returns to the status before the [Undo] command was executed. If you repeatedly click this button,
it will redo multiple operations. If redo is not possible, the command will be grayed out.
m [Cut]
Cuts the selected object. Moves the selected object to the clipboard.
m [Copy]
Copies the selected object to the clipboard. The selected object remains as is.
m [Paste]
This command pastes the object on the clipboard into the active window. If there is no data on the
clipboard or if the object on the clipboard is not a type that can be pasted into the active window,
this command cannot be used.
m [Delete]
Deletes the selected object. The data on the clipboard does not change.
NOTE
There are some objects that cannot be deleted with the [Delete] command.
m [Select All]

Selects all objects in the active design window.

m [Duplicate]
Duplicates the selected object. The data on the clipboard does not change.
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m [Display Order]
Changes the display order (in front or behind) of the selected objects.
- “Changing the Order” in “Design Window Shared Settings and Operations” (page 252)

m [Edit Legend]
This command can be selected when an Area window, Zone window, or Configuration window is
active. It lets you edit the descriptive text (legend) displayed on the sheet in the Area window, Zone
window, or Configuration window. When this command is selected, the “Edit Legend” dialog box
will be displayed.
- “Legend (Descriptive Fields)” in “Objects” (page 232)

m [Properties]
Opens the “Properties” dialog box for the selected objects.
- See “Object Types” on page 183.

[View] Menu

Displays or hides the windows.

3% Designer

T Skatus Bar
|T Area
T Toolkit
T Resource Meter
T Mavigakor

Full Screen

Port Long Marne

S Zoom In Chrl++
E Zoom Qut Chrl+-
Zoom To |
Actual Size
Fit in Window
m [Toolbar]
Displays or hides the toolbar. A checkmark appears beside this menu item when the toolbar is
displayed.

m [Status Bar]

Displays or hides the status bar. A checkmark appears beside this menu item when the status bar
is displayed.

m [Area]/[Toolkit]/[Resource Meter]/[Navigator]

Displays or hides the Area window, Toolkit, Resource Meter, or Navigator window. A checkmark
appears to the left of the command name when a window is displayed.

The Resource Meter window is displayed only when the Configuration window and User Module
window are active.
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m [Full Screen]

Displays in full-screen mode. Displays the active design window (Area, Zone, Configuration, or
User Module window) exclusively, with it covering the entire screen.

R Component List  k L
----FEditMode

A context menu appears wherever you right-click on the screen, containing the commands that are
needed at that location.
To return from the full-screen mode to the original display status, press the <Esc> key.

m [Port Long Name]

Switches the port name display of the slot components. When you select this command, a
checkmark appears next to it and long names are displayed. If you select this command when a
checkmark is next to it, the checkmark disappears and short names are displayed.

v

v Resource Meter
¥ Mavigator

-

Long name

~— Short name

Zoom In Chrl++

S Zoom Qub Chrl-

=]
=]
=]
=]
=]
=]
=]
=]
=]
L

m

Zoom To

Ackual Size

Fit in Window

B [Zoom In]
Gives a closer view of an area displayed on the screen.

m [Zoom Out]
Widens the area displayed on the screen.

m [Zoom To]
Selects the display magnification from a submenu.

1 25%

Actual Size 2 B0%
Fit in Window 375%

|7 4 100%
5 125%
£ 150%
T 200%

m [Actual Size]
Returns the display to normal dimensions.

m [Fitin Window]

Increases or decreases the display magnification so that the sheet exactly fits the current window.
The entire sheet will be visible.
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[Tools] Menu

fF Desiener

Tools |
= Area Parts List »
Device List »

Component List »

=-EDME
- JEDME24h
. BOMEB4N
- FDMESF(
‘.. ZDMESo-
. BOMEdio-
L-FIGF
[+-E15peaker Prc
- External De
Picture
- Text
. Box
Ellipze

Zone Manager...

Device Group Manager...
Confieuration Manager..
Save Uzer Madule..
User Maodule Manager..
Show Signal Delay

m Analyze..

B Frobe Monitor

Manitoring Point List

'E!Zh Edit Mode
Sheet.
Prohibit Diagonal CGonnections
Grid...
v Arrow
Hand
Export DXF.

Preferences..

[Area Parts List]

This command can be used only when the Area window is active. A submenu displays the same
objects that are in the Toolkit window displayed while the Area window is active. Clicking an object
on the submenu, then clicking the Area window, places that object in the Area window.

- [Area Parts List] in “Toolkit Window” (page 172)

[Device List]

This command can be used only when the Zone window is active. A submenu here displays the
same objects as the Toolkit window. Clicking an object on the submenu, then clicking the Zone
window, places that object in the Zone window.

- [Zone Device List] in “Toolkit Window” (page 173)

[Component List]

This command can be used only when a Configuration window or User Module window is active.
A submenu here displays the same objects as the Toolkit window. Clicking an object on the
submenu, then clicking the Configuration/User Module window, places the object in that window.
- “Component List (Configuration Window)” in “Toolkit Window” (page 173), “Component List
(User Module Window)” in “Toolkit Window” (page 174)

[Zone Manager]

Displays the “Zone Manager” dialog box. Here you can add, delete, or rename a zone.
- See “Adding, Deleting, and Renaming a Zone” on page 267.

[Device Group Manager]

Displays the [Device Group Manager] window, allowing the device group to be changed.
- “Changing the Device Group” (page 268).

[Configuration Manager]

Displays the “Configuration Manager” dialog box. Here you can add, delete, or rename a
configuration.
- See “Adding, Deleting, and Renaming a Configuration” on page 270.
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[Save User Module]

This command can be used only when a User Module is selected in the Configuration window.
Saves a template for the selected user module.
- “User Module Manager” Dialog Box in “User Modules” (page 287)

[User Module Manager]

Displays the “User Module Manager” dialog box. Changes the settings of, renames, or deletes a
user module saved as a template.
- “User Module Manager” Dialog Box in “User Modules” (page 290)

[Show Signal Delay]

The digital signal delay value is displayed in the configuration window with sample units.
- "Show Signal Delay (Delay Display Value)" in "Configuration Window" (page 281)

[Analyze]

Displays the “Analyze” dialog box, and analyzes the configuration.
- "Analyze (Configuration Analysis)" in "Configuration Window" (page 284)

[Probe Monitor]

Turns the probe monitor ON or OFF. This command can be selected only when a Configuration
window or User Module window is active while in online status.
- “Probe Monitor” in “Configuration Window” (page 279)

[Monitoring Point List]

Opens the “Monitoring Point List” dialog box. Registers points for monitoring with headphones.
- "Monitoring Point List" in "Configuration Window" (page 282)

[Edit Mode]

Turns the edit mode ON or OFF.
- “Edit Mode” in “Editing Configurations” (page 163)

Only users for whom the [Operation Security] — [Edit] checkbox in the “Security” dialog box has been checked can
select this command.

[Sheet]

Opens the “Sheet” dialog box. Sets the sheet size and background.
- “Sheet” in “Objects” (page 234)

[Prohibit Diagonal Connections]

All connections will be drawn with horizontal and vertical wires only. Diagonal wires cannot be
drawn.
- “Drawing Settings” in “Drawing and Editing Wires” (page 257)

[Grid]
Opens the “Grid” dialog box. Displays or hides the grid and sets the grid spacing.
- “Grid” in “Design Window Shared Settings and Operations” (page 243)

[Arrow]
The mouse cursor appears as crosshairs, and can be used to select objects.
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m [Hand]

The mouse cursor appears as a hand shape, and can be used to click and “grab” the worksheet
for scrolling.

m [Export DXF]

Exports the information in the active window and saves it as a DXF file, which is compatible with
CAD software sold by other companies.
- “Exporting the Design Window” in “Design Window Shared Settings and Operations” (page 244)

m [Preferences]
Displays the “Preferences” dialog box. Sets the line thickness and the design window edit
operations.
- “Preferences” in “Design Window Shared Settings and Operations” (page 241)

[Window] Menu

Arranges multiple windows. The lower part of the menu displays the names of currently open
windows. A checkmark appears next to the active window. When you click the name of a window, that
window becomes active.

I Designer

Gazrcade
Tile

w 1 Zonel

2 Mew Area

i EOMEZ4N

m [Cascade]
Displays the windows overlapping one another.

m [Tile]
Displays the windows arranged side-by-side.
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Objects

Object Types

The devices, shapes, and wires that can be arranged in each design window are called “Objects.”
The following objects are available:

Window Where It can be

Nt Placed/Displayed SplenEEm
Zone Area Zones
DME Zones DME and any cards inserted into its slots
ICP Zones User defined parameter control
SP2060 Zones Speaker Processor
External Device Area, Zones External Device

Component Configuration User Module, Audio processor, Control parts
User Module

SPX Component Configuration SPX components
User Module

User Module Configuration Combination of components

Slot Component

Configuration

Internal DME 1/O or installed 1/O cards.

Pictures All Image

Text All Text box

Boxes All Box shape

Ellipses All Circular shape

Wires All Connecting wire, straight line shape

Legend Area An area displayed on the sheet where descriptive
Zones information is presented.
Configuration

Sheet - One sheet per design window.

Various design elements, such as name, color and size, can be set in the “Properties” dialog box for

each object.

Size is set using the [Width] and [Height] boxes in the “Properties” dialog box. The maximum size
values that can be set may vary according to the sheet size and object position. You can set a size
that allows the object to fit in the sheet.
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Zone

There must be at least one zone in the Area window. Zones are added and deleted using the “Zone”
dialog box. Zones are not displayed in the Toolkit window or in the [Area Parts List] submenu in the
[Tools] Menu

If you right-click on the name of a zone object located in the Area window, a context menu will be
displayed.

m Zone Context Menu

Delete
Cuplicate
Digplay Qrder  » | -

Properties...

[Cut]
Cuts the selected object and places it on the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object currently on the clipboard.

[Delete]
Deletes an object.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Zone Properties” dialog box.
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m Zone Object Properties
When you select a zone in the Area window, then click the [Properties] command on the [Edit]
menu, the “Area Properties” dialog box is displayed. Here you can set properties for zone objects.
The [Properties] command is also located on the context menu for zone objects.

3% Area Properties

Fant...
LI A (DM E G4M Zone Master] Eeriee]
Calor
Tesxt Pogition: Top - Left - Background Image
Caolor...

Widh: 200 3
Image... |

Height: [50 2] Stle: | Plain |

[Text] Box

You can enter up to 100 English characters for the object name.
The object name is displayed in the rectangular box for the object. If there is a large number of
characters and the object’s shape is too narrow, all characters might not be displayed.

[Font] Button

Clicking here displays the “Select Font” dialog box. This sets the font used to display the object
name.
For information about the “Select Font” dialog box, see page 236.

[Color] Button

Clicking here displays the “Select Color” dialog box. This sets the color of the object name text.
For information about the “Select Color” dialog box, see page 237.

Text Position

Sets the location of the text. The list to the left sets the vertical position of the text. The list to the
right sets the horizontal position.

* Vertical Position
Select [Top], [Center], or [Bottom].

» Horizontal Position
Select [Left], [Center], or [Right].

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.
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[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

Raised Sunken

Background Image
Sets background effects for the object.

* [Color] Button

Sets the color. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 237.

* [Image] Button
Displays an image inside the object. You can use image files in the following formats: BMP
(.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Clicking here displays the “Select Image”
dialog box. Specify an image file and set its display method.
For information about the “Select Image” dialog box, see page 239.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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DMEs are arranged in the Zone window. If DME properties settings have been made for an expansion
card installed in one of the DME slots, the card will be displayed automatically.

DME24N

DME24N with no 1/O card installed. DMEZ24N with an 1/O card installed in
its expansion slot.

DMEG64N

T
ETHERNET

DMEG64N with no I/O cards connected in slots. DMEG64N with I/O cards installed
in expansion slots 1 and 4.
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DMESI-C

DMES8o-C

ETHERNET
R

DME4io-C
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When I/O Cards Are Installed in DME Expansion Slots

When an I/O card is selected for an expansion slot in the DME properties, an 1/O port is added for
the DME arranged in the Zone window. An I/O component block will be added to the configuration
window.

If [None] is selected for I/O cards in the DME properties, any /O component blocks will also be
deleted automatically from the Configuration window. (Even if the I1/O components are deleted, the
wiring will remain.)

5 Desisner

- ExCrossover
- ECrossover Processor
ECrossover Processorl
- EDelay

B Dynamics
-BEQ
- EsFader
B Feedback Suppressor
- EFitter
- EaMeter
- EMiscellaneous

DME64N(Zone2)

- Mixer
- EPan
- Router
- ESource Selector
- ESpedker Processor
L BEPX
- ElUser Module
Picture
Teut
~Box
Ellipse

DMEG64N block with card inserted in a slot and the Configuration window

When the DME64N Cascade Setting is Turned ON

When [Show Cascade Port] is checked in the DME64N “DME Device Properties” dialog box, the
cascade /O components will be displayed in the Configuration window.

If “Show Cascade Port” is turned OFF in the DMEG64N “DME Device Properties” dialog box,
cascade /O components will also be deleted automatically in the Configuration window. (Even if
the Cascade I/O components are deleted, the wiring will remain.)
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Compile Priocity. Cancade
= Fesource ¥ Ehow Cascade Port on Configuration Window

T Fooed Delny

r e Sorin |
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CobraNet Card
If the I/O card is a CobraNet card, a CobraNet icon will be displayed in the DME object.

DME block with CobraNet card inserted

m Object Selection

To open a configuration window for a DME object arranged in the Zone window, first select it by
clicking on it, then double-click on it. If you right-click on the object, a context menu will be

displayed.

Dirplar Order
Bl Scrre
Flach Unt LEDs

Cutgut Level

Progeer

m Scene Info and [On-line] Button

DME objects include an object that provides scene info and an [On-line] button.

001 Scene 001

Scene Info [On-Line] Button

The scene info area displays the current scene number and name. Click the scene info area to

open the “Scene Manager” window.
The [On-Line] button has the same function as the [On-Line] button in the main panel window.
- “[On-Line] Button” (page 50).
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m DME Object Context Menu

[Open Configuration Window]

Opens the Configuration window.
- See "Configuration Window" on page 277.

[Configuration Manger]

Opens the Configuration Manager window.
- See "Configuration Manager" on page 270.

[Device Group Manager]

Opens the Device Group Manager window
- See "Device Group Manager" on page 268

[Synchronization]

Opens the Synchronization window
- See "Synchronization
(DME Designer and Unit Synchronization)” on page 83

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the DME object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Scene]
Selects and recalls a scene from the submenu.

[Flash Unit LEDs]

When selected the DME front panel will flash, and will continue flashing until selected a second
time.
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[Output Level]
When you select this command, the “Output Level” dialog box will be displayed. This sets the DME
master volume.

[Properties]
Displays the “DME Device Properties” dialog box.

m DME Properties
To display the “DME Device Properties” dialog box, select a DME object, then click the [Properties]
command on the [Edit] menu. Here you can set DME properties.
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# DME Device Propertics

Label 500 kel |
vt fieo 2] [adei T
Sty [Pan =] ook |

¥ Show Scene Display and On-line Tndicator

Fart Style on Zone Window

& Gustomize Port Style
Edit Port

" Audio Port (Glassic Styls)

Left: Right:

DME: R .

Edit Port Label and Type.

Gompile Priority
@ Resource
¢ Fixed Delay
I~ fute Delay Campensation

Gancel

DMES8o-C

@ DME Device Properties

Label:  [BEIRS Label Font
vt fieo 3] [aes T
beight [0 2  Port Label Calor.. |
Style [Plain  v] Galo..

¥ Show Scene Display and On-line Tndioator

Part Style an Zane Windaw

& Gustomize Port Style
Edit Port

" Pudio Port (Glassic Style)

Left: Right:

OME: BoH o4

Edit Port Label and Type.

Gompile Priority
& Resource
¢ Fixed Delay
I~ Auts Delay Campensation

DME4io-C

[Label] Box

You can enter up to 100 English characters to display over the object.

The name set in the [Label] box will be displayed on the list in the Toolkit window, [Import]/[Export] menu commands,
and on the list in the dialog box. If there are multiple examples of the same DME, set different names for each so that you

can distinguish one from the other.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]

Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] Button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

Show Scene Display and On-line Indicator

When checked the current scene number and name and on-line indicator are displayed in the zone

window.
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[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Port Label Color] Button
Sets the color for the 1/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see page 237.

I/0 Card

Allows /O card setup. [Slot1] ~ [Slot4] can be set up for a DMEG64N, while only [Slot1] is available
for a DME24N. No I/O card setup is provided for the DME&i-C/DME8o-C/DME4io-C.

* [Select I/O Card]
Specifies the type of I/O card.

 [Card Label]
I/O card names having up to 100 characters can be entered here.

Port Style On Zone Window
Specifies how the DME ports appear in the zone window.

e [Custom Port Style]
Customizes the port display.

[Left]

Sets the number of ports to be displayed on the left.
[Right]

Sets the number of ports to be displayed to the right.

* [Audio Port (Classic Style)]
Displays all audio ports.

* [Edit Port Label and Type]
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.
- See "Edit port Label and Type" dialog box on page 197.
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Compile Priority
Here you can make compile settings for the configuration.

These compile settings are reflected in online status. If you change the settings in offline status, it will be enabled when
going online after going offline once.

» [Resource]
Compiles arrangable components in order based on their component numbers. The Delay
values differ depending on the signal lines.

* [Fixed Delay]
Fixes the Delay value (number of Samples) for the signal lines. However, it also reduces the
number of components that can be arranged.

[Auto Delay Compensation]
This turns ON or OFF a function that automatically corrects the component delay when
[Fixed Delay] is selected.

Auto Delay Compensation will not function properly in configurations that have a loop connection.

Cascade
Turns the DME 64N cascade ON or OFF.

» Show Cascade Port on Configuration Window
Checking this enables cascade.

» [Cascade Setting]
Here you can make settings that apply when cascade is enabled. Clicking here displays the
“Cascade Setting” dialog box.
- See "Cascade Setting" dialog box on page 196.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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m “Cascade Setting” Dialog Box

Clicking the [Cascade Setting] button displays the “Cascade Setting” dialog box. Here you can
display DMEG4E cascade connections and make settings related to them. These settings are
common to the cascaded DMEs in the same zone.

M| Cascade Setting

Uit Ma: 1 =
Head targin: Odb il
Mixer 140
[~ Portdl [~ Port17
[~ Port02 [~ Port18
[~ Port03 [~ Port13
[~ Part04 [~ Part20
[~ Port0s [~ Port21
[~ Port0g [~ Port22
[~ Portd? [~ Port23
[~ Part08 [~ Part24
[~ Port03 [~ Port25
[~ Port10 [~ Port26
[~ Port1l [~ Part2?
[~ Pam12 [~ Port28
[~ Port13 [~ Port23
[~ Port14 [~ Port30
[~ Port15 [~ Port31
™ PatlE [~ Part32
Lancel

Unit No. (Cascade Connection Number)

All DME units other than the first unit (default “1”) are assigned automatically, and are grayed out
after connection indicating that the settings cannot be changed.

Head Margin

Here you can display and set the head margin for the Cascade connection audio signal. Select [0
dB] or [-18 dB]. All DME Unit No. settings for DME units other than the first unit will be automatically
set to the same value as the first unit when connected. These settings are grayed out after
connection indicating that they cannot be changed.

Mixer 1/0 Channel

Here you can display and set the channel used for audio input/output to a mixer. If the checkbox is
turned ON, the channel for the Cascade connection with the mixer is set. If turned OFF, the channel
for connecting with the DME is set.

[Check All] Button
Checks all checkboxes.

[Clear All] Button
Clears all checkboxes.

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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m Edit Port Label and Type Dialog Box

The Edit Port Label and Type dialog box will appear when the [Edit Port Label and Type] button is
clicked. Specifies the port labels and types to be displayed to the left and right of DME and

SP2060 objects.

To set labels enter the [Port Name] for [Left] and [Right]. Each name can be up to 100 characters in

length.

To set the port type use [Port Type] to select the [Left] and [Right] types.

¥ Edit Port Label and Type

Left: Right:
Part Mame Part Type Part Name Part Twpe (0] 4
1 CAs N Cascade il GCas ouT Caszcade Gancel ]
2 Elank. 2 Blank.
3 WG IN Wiord Clock 3 ETHERMET Ethernet
4 WG ouT Word Clock 4 |USE UsE
5 |MIDIIN MIDT 5 |REMOTE Remate
6 |MIDIOUT MIDL
7 |MIDI THRU MIDI
8 |GPIIN GPL
9 |GPIOUT GP1
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ICP

You can arrange DME Device objects in the Zone window. These can be controlled using User
Defined Button.

First click on an ICP object arranged in the Zone window to select it, then double-click the label. This
opens a “Control Panel Properties” window. If you right-click on the object, a context menu will be

displayed.
T I D &
. : .[E.C.ué .......
2 P ol

....... Delete
s Cuplicate

Display Order  »

Propetties. ..

m |ICP Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]

Pastes the control panel object that is on the clipboard. If the same control panel object exists on
the sheet where you are pasting, a new ICP object will be created.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the properties dialog box.
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m ICP Properties

To display the “DME Device Properties” dialog box, select a ICP object, then click the [Properties]
command on the [Edit] menu.

i DME Device Properties

ik

Label: l::::F'1 Label Font.. ‘
Cancel

widthe a0 = Label Golor.. |

Height [0 = Back Color.. |

Stle: Plain -

Ethernet Port

[v Show Port (™ Left Side (s Right Side
[Label] Box

You can enter up to 100 text characters to display above the object. Labels for identical ICP
objects that exist in other configurations will also be changed.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.

[Style]
Sets the object style. Select [Plain], [Raised], or [Sunken] from the list.

[Label Font] Button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

[Label Color] Button

This sets the color of the label text. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 237.

[Back Color] Button
Sets the object color. Click to display the Select Color dialog box.

Ethernet Port

Turns Ethernet port rendering on or off. Ethernet port display will appear when the checkbox is ON.
The radio buttons can be used to specify whether the display is on the left or right side.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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SP2060

SP2060 objects can be placed in the zone window.
When clicked an SP2060 in the zone window will be selected, and when double-clicked the
configuration window will open. A contextual menu will appear if the object is right-clicked.

5 mOME
|-mOmERan
- ADMEsN
AIMESC
ROMESC

m Scene Info and [On-line] Button
SP2060 objects include an object that provides scene info and an [On-line] button.

001 Scens 001

Scene Info [On-Line] Button

The scene info area displays the current scene number and name. Click the scene info area to open
the “Scene Manager” window.

The [On-Line] button has the same function as the [On-Line] button in the main panel window.

- “[On-Line] Button” (page 50).

m The SP2060 Object Context Menu
[Open Configuration Window]

Opens the Configuration window.
- “Configuration Window” (page 277).

[Configuration Manager]
Not available for SP2060 objects.

[Device Group Manager]

Opens the Device Group Manager window
- See "Device Group Manager" on page 268

[Cut]
Cuts the selected object and places it on the clipboard.
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[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the SP2060 object currently on the clipboard.

[Delete]
Deletes an object.

[Duplicate]
Creates a duplicate of an object.

[Display Order]
Changes the display order according to the selected submenu command.

[Recall Scene]
Selects and recalls a scene from the submenu.

[Flash Unit LEDs]

Select to flash all indicators on the SP2060 panel. Flashing will continue until this command is de-
selected.

[Output Level]
Not available for SP2060 objects.

[Properties]
Opens the “SP2060 Device Properties” window.
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m SP2060 Properties

Select an SP2060 object and click [Properties] in the [Edit] menu to open the “Speaker Processor
Device Properties” window. The SP2060 properties can be edited here.

- Speaker Processor Device Properties

Label:

SP2060 Label Font.. o
Width:  [160 = Label Color... %
Height: m Port Label Colar...
Style: ,m Calat..

v Show Scene Display and On-line Indicator

Fort Style on Zone Window

{* Customize Fort Style " Audio Port (Classic Stylel
Edit Port
Left: Right:
Speaker b= 3: ] 3: Edit Port Label and Twpe..
Processor
[Label] Box

Up to 100 single-byte characters or 50 two-byte characters can be entered for display on the
object. One two-byte character is equivalent to two single-byte characters. Single-byte and two-
byte characters can be mixed.

The label specified in the [Label] box will appear in the Toolkit window, the [Import] and [Export] menu commands, and
window lists. When multiple SP2060 units are used they can be given different labels for easy identification and
differentiation.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.

[Style]
Specifies the object style: select [Plain], [Raised], or [Sunken] from the list.

Show Scene Display and On-line Indicator

When checked the current scene number and name and on-line indicator are displayed in the zone
window.

[Label Font] Button

Specifies the label font. The “Select Font” window will appear when this button is clicked.
See “The Select Font Window” on page 236 for details on using the Select Font window.

[Label Color] Button

Specifies the color of the label characters. The “Select Color” window will appear when this button
is clicked.
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[Port Label Color] Button

Species the color of the I/O port label characters. The “Select Color” window will appear when this
button is clicked.
[Color] Button

Specifies the color of the object. The “Select Color” window will appear when this button is clicked.

Port Style on Zone Window
Species how ports will be displayed on SP2060 objects in the zone window.

[Audio Port (Classic Style)]
Displays all audio ports. This command grayed out and cannot be selected for SP2060 objects.

[Custom Port Style]
Customizes the port display. This setting is always used for SP2060 objects.

* [Left]
Specifies the number of ports to be displayed on the left side of the object.

* [Right]
Specifies the number of ports to be displayed on the right side of the object.

* [Edit Port Label and Type]

Edits the label and type for each port.
The “Edit Port Label and Type” window opens when clicked.
- “Edit Port Label and Type” window (page 197).

[OK] Button
Applies the setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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External Device

Arranges external device objects in the Zone window. These objects can be added by plug-in
functions. External applications can be linked to the devices arranged in the window. These links to
external applications are set using the “External Device Properties” dialog box.

To start the application linked to an external device object arranged in the Zone window, first click on
the object to select it, then double-click it. If you right-click on the object, a context menu will be
displayed.

If no external application is linked to the an object, no application will start when the object is double-clicked.

CPASE =+ s - CRASA - o - rEFESIT NG il AVCOLIE 11CL
B | Pk h
CP4sF| CPasw| [+ s - = cpag L] o
aae . TSR NEI Thac E copy
ADEHR D1 000 Condenser Microphone - - Paste
p e Delete
""" Duplicate
ADBHR DMi00D! omtergr i

Display Order  »

Properties...

m AD824/AD8HR

The AD824 is an eight-channel analog-to-digital converter. The AD8HR is an eight-channel analog-
to-digital converter that features a head amp with high quality sound.

You can connect Yamaha AD824 and AD8HR A/D converters to a DME unit and control them
remotely from DME Designer. DME Designer has a component editor for controlling [AD824] and
[AD8HR] units.

If you arrange an [AD824] or [AD8HR] from [External Device] in the Zone window, select the
connected DME unit in the properties dialog box, and double-click on an [AD824] or [AD8HR]
block, the component editor is displayed.

If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click.
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m External Device Object Context Menu

[Open Component Editor]

Starts the application assigned to the object.
For the [AD824] and [AD8HRY], it opens the component editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]

Displays the “External Device Properties” dialog box.

At the lowest position below [External Device], [AD824] and [AD8HR] display the “Serial Controlled
Device Properties” dialog box. The other objects display the “External Device Properties” dialog
box.

m External Device Properties

To display the “External Device Properties” dialog box, select any external device object besides
AD824 or AD8HR, then click the [Properties] command on the [Edit] menu.

% External Device Properties >

|
(- (ircless Receiver] Label Fonit
— Cancel

Width: 60 = Label Golar
Height: a0 3: Fort Label Golor.
Style Plain hd Back Calor..
Launch Application
= Application: | Browse.
 File: [ Browse.
Part

Lett: 0 E: {Max 64}

Edit ort Label and Type |
Right o 2 Max 60

[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.
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[Style]
Sets the object style. Select [Plain], [Raised], or [Sunken] from the list.

[Label Font] Button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Port Label Color] Button
Sets the color of the I/O port label. Click to display the Select Color dialog box.

[Back Color] Button
Sets the object color. Click to display the Select Color dialog box.

For information about the “Select Color” dialog box, see page 237.

Launch Application
The radio buttons determines whether an application or file will be linked to an external device.
* [Application] Box
The linked application will be displayed. Click the [Browse] button to locate and select an

application. Specifies the path to an application to be launched when an External Device
object is double-clicked.

* [File] Box

The linked file will be displayed. Click the [Browse] button to locate and select a file. Specifies

the path to a file to be launched when an External Device object is double-clicked.

Port
Specifies the number of ports displayed for an External Device object.

o [Left]

Sets the number of ports to be displayed on the left.
* [Right]

Sets the number of ports to be displayed to the right.

* [Edit Port Label] Button
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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m External Device Properties (AD824, AD8HR “ Serial Controlled Device

Properties” Dialog Box)

To display the “Serial Controlled Device Properties” dialog box, select AD824 or AD8HR, then click

the [Properties] command on the [Edit] menu.

This dialog box is the same as the “External Device Properties” dialog box, except for [Remote].

i Serial Gontrolled Device Properties

|

Cancel

Label: Label Font...
Width: |60 = Label Calar..
Height: |60 = Port Label Colar..
Style: Plain -]

-Launch Application

&+ Application: |

Browse..
Browse..

¢ iEile: |

Part

Left: 0 E: {Max 64
Right: 0 3: (Max 647

Edit Port Label and Type..

Back Color..,

-Femate
DME Unit: fone x
L B
Remote
Select the DME you will control remotely from AD824 and AD8HR.
* [DME Unit]

The DMEs in the current configuration will be displayed in a list. Select the DME you will

control remotely.

- [ID]
Selects an ID from 1 to 8. The default is 1.
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Component

Components are arranged in the Configuration window and the User Module window. They include
audio processors like mixers and compressors, and control parts like switches and sliders. They can
be added by plug-in functions. Component objects arranged in a configuration are displayed in block

form.

To open the component editor for an arranged component, first select it by clicking on it, then double-
click on it. If you right-click on the object, a context menu will be displayed.
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The amount of DSP memory used is not displayed for SP2060 units.

m Component Object Context Menu

[Open Component Editor]
Opens the component editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]

Changes the display order of the objects, according to a command in the submenu.

[Recall Component Library]

Recalls libraries with component parameters saved in them. Clicking here displays the submenu.
When a library is selected from the submenu, the library is read and the component parameters are

changed.

For more information about libraries, see “Library” (page 337).

Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is
grayed out for users for whom [Control Component Editor] is turned OFF.
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©* Unsaved User Modulg
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[Store Component Library]

Saves the component parameters. Click to display the Store dialog. If you then save without
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 337 for more information.

[Add Component to Component Link]

Creates component link.
Refer to "Creating Component Links" on page 342 for more iformation.

[Properties]
Displays the “Component Properties” dialog box.

Component Properties

Here you can set properties for each component. If multiple examples of the same component type
are arranged on a single sheet, changing the properties of a single component does not change
the others.

To display the “Component Properties” dialog box, select a component object, then click the
[Properties] command on the [Edit] menu.

T Com ponent Properties

Compressar Label Fort
Laber | EET [ ]
Cancel
Label Calor...
width: BT 2 Inputs/Dutputs Labels Calor... |
Height [0 2] L
Style: | Plain -

[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] Button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.
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[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the 1/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see page 237.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

SPX Component

SPX components are arranged in the Configuration window and the User Module window. Component
objects arranged in a configuration are displayed in block form.

Clicking on a positioned SPX component will select it, and right-clicking will display a contextual
menu.

Unlike normal components, SPX components use SPX-specific resources and therefore the usage
percentage display that appears to the lower right of normal components will not appear. Check the
SPX resource usage percentage via the SPX meter in the Resource Meter window.
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Duplicate
Display Order » i

Recal Companent Library

Froperties...

m Context Menu for SPX Component Objects

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.
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[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Component Library]

Recalls libraries with component parameters saved in them. Clicking here displays the submenu.
When a library is selected from the submenu, the library is read and the component parameters are
changed.

For more information about libraries, see “Library” (page 337).

When you will change the effect type for the SPX component, select the desired type from the
[Effect Type] displayed in the submenu.

Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is
grayed out for users for whom [Control Component Editor] is turned OFF.

[Store Component Library]

Saves the component parameters. Click to display the Store dialog. If you then save without
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 337 for more information.

[Add Component to Component Link]

Creates component link.
Refer to "Creating Component Links" on page 342 for more iformation.

SPX components components do not support component linking.

[Properties]
Displays the “SPX Component Properties” dialog box.

SPX Component Properties

SPX component properties are set for each component. If multiple examples of the same
component type are arranged on a single sheet, changing the properties of a single component
does not change the others.

To display the “SPX Component Properties” dialog box, select a component object, then click the
[Properties] command on the [Edit] menu.

&% Component Properties rzl
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[Label] Box
You can enter up to 100 characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].
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[Label Font] button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see “Select Font” dialog box (page 236).

[Label Color] Button
Sets the color for the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the 1/O port label text. Clicking here displays the “Select Color” dialog box.
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[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see “'Select Color' Dialog Box” (page 237).

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

Slot Component

If an inserted 1/O card is selected in the DME properties settings, it will be displayed in the
Configuration window as a Slot component.

Slot component objects arranged in a configuration are displayed in block form.

If you select an arranged component by clicking on it, then double-click it, the component editor
opens. If you right click on the object, a context menu will be displayed.

© Slot Ingut © Slotl Output

Open MY-Card Editar
Open Slot n Gomponent Editar

. Gut
GCopy

Paste

Delete

Duplicate
Display Order &

Properties..

m Slot Component Object Context Menu

[Open MY-Card Editor]/[Open HA Editor]/[Open CobraNet Editor]
Opens the editor for Slot components.

[Open Slot In Component Editor])/ [Open Slot Out Component Editor]/[Open Input
Component Editor]/[Open Output Component Editor]
Opens the component editor.

[Cut]/[Copy]/[Paste]/[Delete])/[Duplicate]
The functions cannot be used with Slot components.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Component Properties” dialog box.
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m Slot Component Properties

To display the “Slot Component Properties” dialog box, select a Slot component object, then click
the [Properties] command on the [Edit] menu.
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[Label] Box
You can enter up to 100 characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see “'Select Font' Dialog Box” (page 236).

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the 1/0 port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see “'Select Color' Dialog Box” (page 237).

[Edit I/O Port Label] Button
Specifies the 1/O port label. The “Edit Port Label” window opens when this button is clicked.

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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m “Edit Port Label” Dialog Box

When you click the [Edit I/O Port Label] button, the “Edit Port Label” dialog box is displayed. Here
you can set the port labels displayed for components. Enter a [Short Name] and [Long Name] for

[Inputs] and [Outputs]. You can enter up to 100 English characters for each name.

You can switch between long and short port names displayed in the configuration window with the

[Port Long Name] command in the [View] menu. When you select this command, a checkmark

appears next to it and long names are displayed. If you select this command while a checkmark is
next to it, the checkmark disappears and short names are displayed.

Labels specified here are always displayed in the Configuration Window.
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User Module

A user module combines a number of other components into a module that is treated as a single
component. It can be arranged in the Configuration window. A user object arranged in a window is
displayed as a single block. The User Module Design Window or User Module Window will open,
according to the “Double Click Action” setting of “User Module Properties” dialog box when you
double click the user module (page 290).

If you right-click on the object, a context menu will be displayed.

Cpen User Module Design Window t
Open User Module Editor
P cut
EEY Copy
Faste
Delete
Duplicate ) l
Dizplay Order (3 . ]
Recall CGompanent Library i |.
Store Gomponent Library
Save Uszer .r.\'lodule.. - . }

Properties..

m User Module Object Context Menu

[Open User Module Design Window]
Opens the User Module Design Window.

[Open User Module Editor]
Opens the User Module Editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Component Library]

Recalls a library into which component parameters have been saved. Click to display a sub-menu.
Select a library from the sub-menu to load the parameters into the component.
Refer to “Library” on page 337 for more information.
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Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is
grayed out for users for whom [Control Component Editor] is turned OFF.
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©pen File Dialog. ..

* [Open File Dialog]
Displays the file select dialog box. You can recall libraries saved in folders other than the user
module “Library” folder.

[Store Component Library]

Saves the component parameters. Click to display the Store dialog. If you then save without
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 337 for more information.

[Save User Module]
Saves the selected user module. See “Saving User Modules” on page 287.

[Properties]
Displays the “User Module Properties” dialog box.

User Module Properties

To display the “User Module Properties” dialog box, select a user module object, then click the
[Properties] command on the [Edit] menu.

The “User Module Properties” dialog box is also displayed when a [Blank User Module] is arranged in the configuration
window.

i User Module Properties
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[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]

Sets the style of the object. From the list, select [Plain], [Raised], [Sunken], or [Image]. When
[Image] is selected the Open dialog will appear. Select an image file and click [Open] to place the
selected image as an object.

[Label Font] Button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Labels Color] Button
Sets the color for the 1/0 port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see page 237.

Inputs/Outputs Sets

Sets the number of input/output ports. Enter a number into the [Inputs] box and [Outputs] box, or
set a value using the [ A] and [ ¥] buttons at the right of each box. The maximum of both input and
output ports is 64.

Edit I/O Port Label
Input and output port names up to 100 characters in length can be entered.

Double-Click Action
Sets the action that occurs when you double-click on a user module object arranged in the
Configuration window.

» [Open User Module Design Window]
Opens the User Module window.

* [Open User Module Editor]
Opens the User Module editor.
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Security Settings
Turns user module security ON or OFF, and sets a password.

 [Enable Security]
Enables user module security. If you turn this function ON when no password is currently set,
the “Set Password” dialog box appears. Enter a password, then click the [OK] button.

I Set Password |E] |EJ

Password: 1

Confirm Pazsward: ]

% LCancel I

If you change the setting from OFF to ON, the “Input Password” dialog box appears. You
cannot turn Security OFF until you enter the correct password.

3 Input Password

Pazzword: ||

gk LCancel I

When security is active the editor cannot be opened unless the appropriate password is entered. Once the
password has been entered security is temporarily disabled until the DME Designer is quit, or a different file is
opened.

* [Set Password] Button
Changes the password for user modules. Clicking this button displays the “Input Password”
dialog box. Enter the current password and click the [OK] button. The “Set Password” dialog
box will be displayed, and you can set a new password.
This button will be grayed out when [Enable Security] is turned OFF.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Open

Picture

An image can be arranged as an object on a sheet. This specifies a file for this purpose. You can use
image files in the following formats: BMP (.bmp), PNG (.png), XBM (.xbm), XPM (.xpm), and JPEG
(Jpg).

Before placing a picture object, prepare an image file. Copy the image file to the folder specified in the
“Preferences” dialog box — [Application] tab — [ContentsFolder] in the Main Panel window.

In the project file, the location and name of the image file are registered in an relative path below the
[ContentsFolder] and the linked image file is read and displayed. If the image file is moved, renamed,
or the [ContentsFolder] is changed, the image cannot be displayed.

The default for the “Preferences” dialog box — [Application] tab — [ContentsFolder] in the Main Panel window is
“C:\Program Files\YAMAHA\OPT Tools\DME Designer.” The [Designer] folder is located in the [DME Designer] folder. Within
that folder, there is an [Images] folder prepared for saving image files.

Background images for sheets are specified in the “Sheet” dialog box. Pictures are arranged as objects on the sheets.

m Placing Pictures
There are three picture placement methods:
e You can drop the [Picture] item from the Toolkit window into each design window.
¢ You can double-click [Picture] on the Toolkit window.
e You can click [Picture] in the [Area Parts]/[Device List]/[Component List] on the [Tools] menu,
then click each design window.

When you place a picture object, the “Open” dialog box is displayed. Select the image file and
click the [Open] button. The picture will be placed in the design window.
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m Picture Object

When you click a picture object that is located in each design window, handles (small squares)
appear at the corners and sides of the object. You can expand or reduce the picture’s size by

dragging a handle.

AES/EBL 815 Mg gtare

If you double-click on the object, the “Open” dialog opens. There you can change the image file.

If you right-click on a picture object, a context menu will be displayed.
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m Picture Module Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Picture Properties” dialog box.
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m Picture Object Properties

To display the “Picture Properties” dialog box, select a picture object, then click the [Properties]
command on the [Edit] menu.

I Picture Properties

Label: F'in::ture Label Font..
Cancel
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Edit Port Label and Twpe..

[Label] Box

You can enter up to 100 English characters to display over the object.
If the box is left blank, the label will disappear.

[Draw Picture Border]
Displays a border around picture objects.

[Label Font] Button

Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

[Label Color] Button

This sets the color of the label text. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 237.

[Port Label Color] Button
Sets the color of the I/O port label. Click to display the Select Color dialog box.

[File Name] Box
Displays the path to the graphic file.

[Browse] Button
Selects a graphic file.

[Link Component Editor]

When On a Picture object can be double clicked to open the component editor specified by the
[Select Component] button.

[Select Component] Button

Specifies the component editor to be opened when a Picture object is double clicked. Only
effective when [Link Component editor] is On.
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Port
Specifies the number of ports to be displayed for a picture object.
* [Left]
Sets the number of ports to be displayed on the left.
* [Right]
Sets the number of ports to be displayed to the right.

* [Edit Port Label] Button
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

Text Box

Text objects can be arranged in all design windows. Text is entered into the “Text Properties” dialog
box. When first placed in the design window, the word “Text” is entered into the box.

If you click the text object, handles (small squares) appear at the corners and sides of the object. You
can adjust the size by dragging the handles. You can open the “Text Properties” dialog box by double-
clicking the box. If you right-click on the object, a context menu will be displayed.
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m Text Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Text Properties” dialog box.
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m Text Object Properties

To display the “Text Properties” dialog box, double-click on a text object, or select a text object,
then click the [Properties] command on the [Edit] menu.

I Text Properties

|
Text: | text Text Font..
Cancel
Text Color...
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[Text] Box
You can enter up to 10,000 English characters to display in the text object box.

[Text Font] Button

Sets the font. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

[Text Color] Button
Sets the color of the text. Clicking here displays the “Select Color” dialog box.

[Background Color] Button
Sets the color of the background. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see page 237.

[Draw Text Border]

Displays a frame around the text object. If this is not checked, only the text will be displayed on the
sheet.

[Text Border Style] Box
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Link Component Editor]

When On a Text object can be double clicked to open the component editor specified by the
[Select Component] button.

[Select Component] Button

Specifies the component editor to be opened when a Text object is double clicked. Only effective
when [Link Component editor] is On.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Box (Rectangle)

You can arrange rectangles on the sheet.

If you click the box, handles (small squares) appear at the corners and sides of the object. You can
adjust the size by dragging the handles. You can open the “Box Properties” dialog box by double-
clicking the box. If you right-click on the object, a context menu will be displayed.
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m Box Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]

Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Box Properties” dialog box.
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m Box Object Properties

To display the “Box Properties” dialog box, double-click on a box object or select a box object,
then click the [Properties] command on the [Edit] menu.
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[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Round Corner]
Creates a rectangular box with rounded corners.

[Color] Button

Sets the color of the box. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 237.

Line
Sets the line that frames the box.

* [Type]

Displays a list where you can select the type of line to frame the box. The following types are

available: [Solid], [Dash], [Dot], [DashDot], and [DashDotDot].

* [Size] Box
Sets the width of the line that frames the box. This setting can range from 1 to 100 pixels.

* [Color] Button

Sets the color of the line that frames the box. Clicking here displays the “Select Color” dialog

box.
For information about the “Select Color” dialog box, see page 237.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Ellipse

[Ellipse] in the Toolkit window places a elliptical shape on the sheet.

When you click an Ellipse object that is located in the sheet, handles (small squares) appear at the
corners and sides of the object. You can adjust the size by dragging the handles. You can open the
“Ellipse Properties” dialog box by double-clicking the ellipse. If you right-click on the object, a context
menu will be displayed.

w Cut
% Copy
Paste

Delete

........ Duplicate
powdaeoe Display Order » | -

........ Properties...

m Ellipse Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Ellipse Properties” dialog box.
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m Ellipse Object Properties

To display the “Ellipse Properties” dialog box, double-click on an ellipse object, or select an ellipse
object, then click the [Properties] command on the [Edit] menu.

3% Ellipse Properties

Wwidth: :

Height: |80 3:

Line

Type: | Salid j Size: |1 il Calor...

Calor... Cancel

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.

[Color] Button

Sets the color of the ellipse. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 237.

Line
Sets the line that frames the ellipse.
* [Type]
Displays a list where you can select the type of line to frame the ellipse. The following types
are available: [Solid], [Dash], [Dot], [DashDot], and [DashDotDot].
* [Size] Box
Sets the width of the line that frames the ellipse. This setting can range from 1 to 100 pixels.
* [Color] Button
Sets the color of the line that frames the ellipse. Clicking here displays the “Select Color”

dialog box.
For information about the “Select Color” dialog box, see page 237.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Wire

Draws lines (wires) for connecting components and creating shapes. For instructions on drawing
wires, see “Drawing and Editing Wires” on page 253.

First click on an wire object arranged on the sheet to select it, then double-click the object. This opens
a “Wire Properties” window.

© Slotd nput Slotd Input

[The=3

Termination

If you right-click on a wire object, one of three types of context menus will be displayed, depending
where you clicked.

m Wire Object Context Menu (Line Segment)

TR TR Start Wire |- .-

Dilete Wire

e ffffow |

...... - [Ef Copy

______ . m~

""" ¥ L= Dilete

Duplicate |, . . . ..

Colar (3 DLl b

Properties.. |- - - - -

Line Segment Context Menu
[Start Wire]
Begins drawing a line segment from the location where you clicked.

[Delete Wire]
Deletes the entire wire.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the line segment where you right-clicked.

[Duplicate]
Duplicates the wire object.
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[Wire Color]
Specifies the wire color.

[Properties]
Displays the “Wire Properties” dialog box.

m Wire Object Context Menu (Node)

Start wire

Delete Wire

Delete

Froperties...

Node Context Menu
[Start Wire]
Begins drawing a wire segment from the location where you right-clicked.

[Delete Wire]
Deletes the entire wire.

[Delete]
Deletes the node. The nodes before and after will become directly connected.

[Properties]
Displays the “Wire Properties” dialog box.

m Wire Object Context Menu (Termination)

Q Continue Wire
Start Wirs ATINA L+ AN

Delete Wire

Properties...

Termination Context Menu

[Continue Wire]
Begins drawing wire from a termination node.

[Start Wire]
Begins drawing a wire from the location where you right-clicked.

[Delete Wire]
Deletes the entire wire.

[Properties]
Displays the “Wire Properties” dialog box.
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m Wire Object Properties

To display the “Wire Properties” dialog box, double-click on a wire object. You can also select a
wire object, then click the [Properties] command on the [Edit] menu.

B Wire Properties

Lire “Width: 3: Line Color... C |
ancel

Line Type: Solid = Selected Colar...

[Line Width] Box
Set the line width. This setting can range from 1 to 10 pixels.

[Line Type]
Displays a list where you can select the type of line. The following types are available: [Solid],
[Dash], [Dot], [DashDot], and [DashDotDot].

[Line Color] Button
Sets the color of the line. Clicking here displays the “Select Color” dialog box.

[Selected Color] Button
Sets the color of the selected line. Clicking here displays the “Select Color” dialog box.

For information about the “Select Color” dialog box, see page 237.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Legend (Descriptive Fields)

Displays a legend for all sheets except the User Module window.

When you click the [Edit Legend] command on the [Edit] menu or double-click on one of the Legend
fields displayed on the sheet, the “Edit Legend” dialog box is displayed. If you right-click on the
Legend, the displayed context menu will have the [Edit Legend] command only. If you click there it will
display the “Edit Legend” dialog box.

The “Edit Legend” dialog box is used to enable/disable Legend display and to set the contents
displayed there. You can display the [Edit Legend] command from the [Edit] menu.
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m “Edit Legend” Dialog Box

3 Edit Legend

Date Revizions

Project: ||

Title:

No.

Authar:

| | o |
[ [
[ [ _ Cored |
[ [
[ [

Carmpany:
Legend Base Font Style ¥ Show Legend

Avial Black - [ Sawe as Default Legend
™ Change for Al Legends In Area

Address:

AddressZ:

[Project] Box, [Title] Box, [No.] Box, [Author] Box, [Company] Box, [Addressl1] Box, and
[Address2] Box

Used to enter the Project, Title, Number, Author, Company, Address1, and Address2. You can enter
up to 100 English characters for each field.

[Date] Box and [Revisions] Box

You can enter up to five dates and five revisions. You can enter up to 100 English characters for
each field.

[Legend Base Font Style]
Displays a list where you can select the font.

[Show Legend]
Place a checkmark here to display the legend on the sheet.

[Save as Default Legend]

Saves this legend as the default legend used when a new sheet is created. When a new
configuration is created, it will have a legend with the same contents as this one.

[Change for All Legends In Area]

Place a checkmark here to have the changes made here reflected in sheets in all design windows
included in the area.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Sheet

There is one sheet in each design window for arranging objects. The size of the sheet and its
background image are specified with the “Sheet” dialog box. This dialog box is displayed using the
[Sheet] command from the [Tools] menu.

Make the window where you are going to change sheet settings active, then click [Tools] menu -
[Sheet].

m “Sheet” Dialog Box

& Sheet le
| 800« 1200 A4 Portrait 600dpi Ed|
Cancel
(" Custom Sizes
Horizantal 200 = [800-2420) v Firxed Aspect Ratia
Vertical: 1200 = (500 - 2420 I~ Save As Default Sheet Size

—Background Effect -

Color...
[~ Change for &l Sheets
Image...

[Preset Size]

Displays a list where you can select preset paper sizes.
When you select a paper size, numerical values are set for [Horizontal] and [Vertical].

[Custom Sizes]
Set a custom size by specifying the vertical and horizontal sizes of the sheet.

* [Horizontal] Box
Sets the horizontal width of the sheet.

* [Vertical] Box
Sets the vertical height of the sheet.

* [Fixed Aspect Ratio]
When this is checked the relationship between horizontal and vertical is fixed. When the value
for [Horizontal] or [Vertical] changed, the size of the other direction changes so that the
proportions of the paper remain the same.

* [Save As Default Sheet Size]
When turned ON, the current values will become the default for creating sheets. New sheets
will be created at the same size.

The upper left is the starting point for measuring sheet size. Therefore, in the [Horizontal] box set the number of
pixels to the right edge, and in the [Vertical] box, set the number of pixels to the lower edge. The boundaries in
which items are already arranged on the sheet will form the minimum sheet size.

Because any objects that are moved, cut, or deleted will return to the same location if the [Undo] command is
used, the minimum sheet size will be determined by the boundaries in which any objects were located, now or in
the past.
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Background Effect
Sets the background for the sheet.

* [Color] Button
Sets the color of the background. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 237.

* [Image] Button
Displays an image as the sheet background. You can use image files in the following formats:
BMP (.bomp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Clicking here displays the “Select
Image” dialog box.
For information about the “Select Image” dialog box, see page 239.

* [Change for All Sheets]
Changes all sheets so that they are the same.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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“Select Font” Dialog Box

When you click the [Font] or [Label Font] button in an object’s properties dialog box, the “Select Font”
dialog box is displayed. Sets the font.

3F Select Font

Font Font style Size

’E Moimal

8

Marrmal & -
Arial Black Italic: 7
Carmic: Sans MS Bald a8

Courier Buold Italic: 9

Courier New o
DHE Dat Font 1 11
Finedsys 12
Franklin Gothic Medium 14

GRnmia j 1R j

Effects Sample
[~ Strikeout
[~ Underine

AaBbYyIz
Serpt

| Latin ﬂ

Ok | Cancel

m Font

Selects the font. The currently selected font name is displayed in this box. Select a font by clicking
its name on the list.

Font Style

Sets the style of the text. The currently selected style is displayed in the box. Select a style by
clicking its name on the list below.

e Normal.......... Standard style
e |talic.............. [talic or slanted text
e Bold.......... Bold text

e Bold ltalic...... Bold italic text

Size
Sets the text size. The currently selected size is displayed in the box. Select a size by clicking it in
the list below.

Effects
Sets effects for the text. Check the effects you wish to set.
e Strikeout........ Adds a strikeout line through the center of the text.

e Underline....... Adds an underline to the text.

Script

From the list, select the script (language) for the text. There is no need to change the language
setting unless you want to specify a specific language.

Sample
Displays an example of the current settings.
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“Select Color” Dialog Box

When you click the [Color] or [Label Color] button in an object’s properties dialog box, the “Select
color” dialog box is displayed. Sets the color of objects and text.

I Select color

Basic colors

111 8 0w
EEEEEE
TI1 1L i
“TI1 1 i
EEEEETE
EEEEEC T

LCustom colors

O O O
O O

Define Custom Colors »»

oK | Cancel ] Add to Custom Colors ]

m Setting Basic Colors

There are 48 basic colors provided in the [Basic colors] section. When you select a basic color by
clicking on it, the position of that color in the color palette to the right is indicated by a cross (+).
Information about the selected color is displayed below the color palette.

Click the [OK] button to set the color you selected.

m Setting Colors That Are Not in the [Basic colors] Section.

You can select any color in the color palette displayed at the upper-right of the dialog box by
clicking on it in the palette. Color information is displayed below the color palette. If you like the
color you selected, click the [OK] button. If you don't like the color, you can select a new color by
clicking in another location in the color palette, or by dragging the cross symbol to another location
there.

Grey colors can be selected on the tall, thin chart to the right of the palette.

Click the [OK] button to set the color you selected.

m Saving Colors You Have Created

In the custom color section, you can save up to 16 colors you have created. When you save a
custom color, it can be selected by clicking on its color button, in the same way as for the [Basic
colors].

Even if you open the “Select color” dialog box from the Properties of another object, any custom
color you save will be displayed and you can use that same color for the other object.
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1 Click the [Custom colors] box where you will save the color you create.
The box you clicked will be selected and a frame will appear around it.

I Select color

Basic colors

NN NENT
0 B 0 § Qheie
L 0 0 0 § ke
0 0 0 § Neheie
0 B 0§ i
0 B N e
Custom colors -
!_l_l_l_l_l_l_ 7Hu§.-1 ﬁed.lﬁ
. sat [0 Green 255

Wal: {255 Bl :|255
Diefine Custom Colors > | = o

oK I Cancel | Add ta Custom Colors |

2 Set the color on the color palette.

3 Click the [Add to Custom Colors] button.

The selected color will be added to [Custom colors].

B Select color

Easic: colors

L 0 0 0 0 I
L 0 0 0§ il
L 0 0 0 i i
L0 0 0 0 i
NN
EEENNTTT

LCustom calars

W rrrrrr
AR Sat [0 Green 55

Wal: 285 El :|255
Define Custam Calors > | £a e

ok I Cancel | Add to Custom Colors [: |

Hue: 247 FRed: ITE

You can save another color in a box that already has an original color saved in it. Just click on the box to select it.
The new color will overwrite the previous color, which will be lost.
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“Select Image” Dialog Box

You can display an image for the background of sheets or objects. You can use image files in the
following formats: BMP (.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg).

In the project file, the location and name of the image file are registered in an relative path below the
[ContentsFolder] and the linked image file is read and displayed. If the image file is moved, renamed,
or the [ContentsFolder] is changed, the image cannot be displayed.

The default for the “Preferences” dialog box — [Application] tab — [ContentsFolder] in the Main Panel window is
“C:\Program Files\YAMAHA\OPT Tools\DME Designer.” The [Designer] folder is located in the [DME Designer] folder. Within
that folder, there is an [Images] folder prepared for saving image files.

If you click the [Image] button in the properties dialog box for an object that can display a background
image or in the “Sheet” dialog box, the “Select Image” dialog box will be displayed. Specify an image
file and set its display method.

U Select Image
Image Lapout
" Center L
" Tile
& Fi Cancel

File: |F./aMAaHA blda/Picture/0574.jpg

Image Layout
Selects the manner in which the image file will be displayed.

 [Center]
Centers the image in the object or sheet.

* [Tile]
Displays multiple copies of the image side-by-side until the available space is filled. If the
image file is smaller than the sheet, it will be displayed repeatedly like tiles on a wall.

o [Fit]
Expands or reduces the size of the image to match the size of the sheet where it will be
displayed.

[File] Box

Specifies a path for the image file. A path can be directly entered in the box. You can also click the
[Browse] button and select the image file. It will be entered automatically.

To stop display of an image, delete all characters in the box, leaving the field blank.
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[Browse] Button
Specifies a path for the image file. Clicking here displays the “Open” dialog box. Select a file with

» o » o

one of the following extensions: “.bmp,” “.png,” “.xpm,” or “.jpg,” then click the [Open] button.

Look in: ‘E}F’icture ﬂ il
2 P 01x.jpg
| 53 P 0574.5pg

Bfly Recent Emutif_es_?.jpg
acuments E; i
550.jp9
?-[-':

Desktap

.L-/

Iy Documents

ter

=

=

o g
4] o
1 5 &

k=]

=

My Metwork — File name: ﬂ Iﬂl
Places
Files of lype: |Images [* bmp * png *.4pm * jp) | ﬂ

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Design Window Shared Settings and Operations

Preferences

You can set the operating environment for the Designer window in the “Preferences” dialog box. This
dialog box is opened using the [Preferences] command in the Designer window [Tools] menu.

f= Preferences

t+ Infinite Crosshairs

Auto Suffix Mumber

W Show Crasshairs While Dragging
Select Grosshair Leneth

~ Arbitrary Crosshair Leneth

100 =] Horizontal Pixels

Offzet Paste/Duplicate From Original By..

v Auto-zize thased on original object?

|v DME/IGP1/SP2060 |w Component

100

100

Graphics
Partz & Wires; Calar Width Twpe o
Ethernet [rmm 1 s [Solid =] el |
Remote [ 4 [Sold |
Network Audio m| [ Z [ =]
Cazcade [ ] |‘I jl | Solid j
Digital Audio | F 3 e =]
fnalog Audio _ 1 F 4 [Sold |
GPI I 4 [Sold |
MIDI I 4 [Sold |
tiord Glock I 4 [Sold |
USB I 4 [Sold |
Normal N 4 [Sold |
Crosshairs:

= “ertical Pixels

[ Other Objects

m Graphics

Ports & Wires

Specifies wire color, thickness, and type for each port type.

* [Color]

Sets the default color for the port and wire.

. [Width]

Sets the default wire width from a range of 110 5.

* [Type]
Sets the port type.

The initial color and thickness of the wires produced when drawing connections are specified here. The color and
thickness of drawn wires can be changed via the Wire Properties dialog box.
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Crosshairs

* [Show Crosshairs While Dragging]
Place a checkmark here to have crosshairs displayed for guidance when dragging the wire
endpoint.

* [Select Crosshair Length]
Specifies the length of the crosshair lines.
Enter a number into the [Arbitrary Crosshair Length] box to specify the length in pixels.
[Infinite Crosshairs] causes the lines to go all the way to the edge of the window.

INg ouTe
2%

Offset Paste/Duplicate from Original By
Sets the position when pasting or duplicating objects.

* [Auto-size (based on original object)]
If you place a checkmark here, the paste/duplicate position will be automatically adjusted so
that the object does not overlap the original object.

* [Horizontal Pixels] Box
Sets the horizontal distance.

* [Vertical Pixels] Box
Sets the vertical distance.

Auto Suffix Number
Turns automatic appending of sequentially-numbered suffixes to the names of placed objects on or
off.

» [DME/Speaker Processor]
When ON numbered suffixes will automatically be appended to added DME, SP2060 and ICP
objects.

e [Component]
When ON numbered suffixes will automatically be appended to added SPX and user module
objects.

* [Other Objects]
When ON numbered suffixes will automatically be appended to added objects not covered by
the above two categories.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Grid

Displays a grid on the sheet in each design window to guide the placement of objects. You can also
have the objects “snap to” (automatically align with) the grid when dragging them. When you click the
[Grid] command on the [Tools] menu, the “Grid” dialog box is displayed. Here you can enable or
disable display of the grid and set the grid interval and form.

Spacing

¥ Enap fo Grid R —— oK

v [l ] 2w Cancel

[ Show Grid " Line
& Dot [ Save As Default Setting

[Snap to Grid]
Makes objects align the grid when dragging them.

Spacing
This sets the spacing of the grid. This setting can range from 2 to 99 pixels.
 [X:] Box
This sets the spacing of the grid in the horizontal direction.
* [Y:] Box
This sets the spacing of the grid in the vertical direction.
[Show Grid]
Displays the grid. Place a checkmark here to enable display and select the type of grid.
e [Line]
Displays the grid using lines.
* [Dot]

Displays the grid using dots.

[Save As Default Setting]
Place a checkmark here to make the current grid settings the default when a new sheet is created.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Exporting Each Design Window

Instead of saving projects in their entirety, you can output the information contained in the active
window using the Designer Window [Print] — [Export DXF] command and save it in a DXF format file.

These files have “.dxf” as their flename extension.

Because the DXF format uses the standard CAD file format, it can be opened using CAD software.
DXF format files can also be opened by graphics software that support vector graphics, such as
Adobe lllustrator®.

Configurations are saved in project files. This is done using the [File] menu - [Save] and [Save As] commands in the Main
Panel window. For information about saving project files see “Project Files” on page 27.

e Symbols are substituted for external devices in the following three types of folders.
Microphone — mike symbol
Power Amp - amp symbol
Speaker - speaker symbol

s Desiener

-EiExternal De
Picture
- Text
. Box
Ellipze

fArea Parts List

Device List

GComponent List

Zane Manager..

Device Group Manager...
Gonfieuration Manager..
Save User Module.

Uszer Module Manager.
Show Signal Delay
m Analyeze
BER Frobe Monitor

Monitoring Point List
Edit Made

Sheet...

Prohibit Diagonal Gonnections

Grid..

v Arrow

Hand

Preferences..

»
»
»

e Text decoration except for size will be eliminated.

e Picture objects and background images for the sheet or objects will all be eliminated.

[Style] attributes for boxes will be eliminated.

When you select this command, the “Export DXF” dialog box will be displayed.
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“Export DXF” dialog box

¥ Export DXF X
[F File Mame: WSP duil J 0K
Scale 171 - _ Cancel |
Text Style: [Ter
Elack: Elack b
Paper Size
+ Preset Size
AZ: 4206297 [16.54¢11.69 in) Landscape j
" Custom Sizes Unit
Horizontal: |1 oo & mm
. " inch
Wertical |1 oo

m DXF File Name

Enter a filename for the DXF file. The default file name entered here will vary according to the
currently active window.

If you click the [...] button at the right of the box, the “DXF File Name” dialog box is displayed.
Specify the DXF file filename and the folder where the file will be saved.

DXF File Name 23

Savein [ (L3 TAMAHA bidg e @mckE-

7.2. BPicture

My Fecent
Documents

e

Iy Metwork File namme: 1SPOT. s ﬂ Save |
Flaces
Save as type: |D><F File [*.dwf) j Cancel

Enter the filename, specify the folder where the file will be saved, then click the [Save] button.
When you return to the “Export DXF” dialog box, the specified filename will be displayed in the
[DXF File Name] box.

When you click on the [Save] button in the “DXF File Name” dialog box, the DXF file is not saved. Only when you click on
the [OK] button in the “Export DXF” dialog box, does the DXF file become saved.

m Scale
Sets the reduction ratio. When the size of the sheet is large, you can reduce it before exporting it.

m Text Style
Specifies the text font for output in DXF format. The default is the “TXT” (drawing font used in CAD).
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m Block

Sets the block form used in the sheet. Displays a list where you can select the form.

[Block]
Makes the blocks rectangular and groups the text in the port icons and port names.

[Explode]
Makes the blocks into sets of four lines, and does not group the text in the port icons and port
names.

[Paper Size]
Sets the size of the paper.

[Preset Size]

Displays a list where you can select preset paper sizes. When you select a paper size, numerical
values are set for [Horizontal] and [Vertical].

[Custom Sizes]
Set a custom size by specifying the vertical and horizontal sizes of the sheet.

* [Horizontal] Box
Sets the horizontal width of the sheet.

* [Vertical] Box
Sets the vertical height of the sheet.

[Unit]
Selects the unit used for setting the sheet size.

[OK] Button
Saves the DXF file according to the settings in the dialog box.

[Cancel] Button
Cancels the DXF file export process.
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Printing Each Design Window

You can print out the content of each design window just as it appears on the screen. The content in
the window will be expanded or reduced in size as necessary to match the size and orientation of the
paper, and printed onto a single sheet of paper. Commands related to printing are found on the
Designer Window [Print] menu.

#i: Desiener

Print Setup..

Print Prewiew

=i Print.. Ctrl+P

m [Print Setup]

When you select this command, the “Print Setup” dialog box will be displayed. Sets the paper size
and orientation.

3% Print Setup

Orientation: %

" Partrait
" Landscape

[Paper Size]
Displays a list where you can select the paper size.

3 Print Setup

Cancel

Paper Size: oK

Origntation:

Al
&+ Po
" La|

Orientation
Sets the orientation of the paper.

* [Portrait]
Prints on the paper with its long sides vertical.

» [Landscape]
Prints on the paper with its long sides horizontal.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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m ["Print Preview” window]

Displays a print preview of the active design window. You can check the appearance of the page
before printing it.

O Designer E]@ .

Print... ‘ Close ‘

[Print]
Displays the “Print” dialog box.

[Close]
Closes the print preview window.

Arranging Objects

Multiple object placement methods are available.

Dragging from the Toolkit Window

You can drag items from the Toolkit window to the location where you want to place them in each
design window.

Double-Clicking an Object in the Toolkit Window
You can double-click an object in the Toolkit window to place it in each design window.

Selecting from the [Tools] Menu

Available objects are displayed on the [Area Parts List]/[Device List]/[Component List] submenus
which are accessed from the [Tools] menu. When you click an object name, the mouse pointer
changes shape. Click the location on the sheet where you want to place the object.

Selecting from the Context Menu

If you right-click on the sheet, you will see the [Area Parts List]/[Device List]/[Component List]
commands displayed on the context menu that appears. When you click an object name on the
submenu, the mouse pointer changes shape. Click the location on the sheet where you want to
place the object.
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Device Group Selection

When laying out DME, SP2060, and ICP1 objects the “Select Group and Sampling Frequency” will be

showing.

m “Device Group and Sampling Frequency Settings” Window

Group azzignment

Device Group and Sampline Frequency Settines

 Existent Group: |

I~

v Mew Group: [er-.-1E Giroup

|| Select Colar..

Sampline Frequency
~ 44.1kHz

{+ 48kHz
(" B8.2kHz
" 896kHz

Mote:

‘fou can chanee this setting in “Word Clock” dialog box later.

Select Group

Selects a device group.

» Existent Group

Allows an existing group to be selected from a list. If a group does not exist it will be grayed out
in the list and cannot be selected.

* New Group

Creates a new group. The initial color of the new group's name and added devices can be
edited as required.

Select Sampling Frequency
Specifies the sampling frequency.

The sampling frequency can be changed from that specified in the “Word Clock” window. Refer to “Word Clock” on
page 125 for information on the “Word Clock” window.

A sampling frequency cannot be set for ICP1 units.
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Selecting Objects

Objects can be selected when the mouse cursor appears as crosshairs.

Selecting with a Click

You can select an object by clicking on it. If you click another object or an empty location on the
sheet, it will cancel selection of the object you previously clicked.

Selecting with Click + <Ctrl> Key

When you want to select multiple objects, hold down the <Ctrl> key as you click each new object
you want to select. If you hold down the <Ctrl> key and click again on one of the objects that is part
of the multiple selection, it will cancel selection of that single object.

Selecting by Dragging
If you position the mouse in an empty location on the sheet and start dragging from there, a frame

will be displayed as the pointer moves.
Any objects within this frame will be selected.

Changing the Selected Object Using the <Tab> Key

When a single object is selected, you can change the selection to the next object by pressing the
<Tab> key. If you press <Shift> + <Tab>, the selection moves to the previous object. The selection
order moves from left to right.

Wires cannot be selected with the <Tab> key.
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Editing Objects

Objects that have been arranged on the sheet can be edited using the [Cut], [Copy], [Paste],
[Duplicate], and similar commands in the [Edit] menu. These edit commands will also appear in the
context menu displayed when you right-click an object in the design window. Buttons for [Cut],
[Copy], and [Paste] are also available on the Designer window toolbar.

Some objects cannot be edited.

m Undoing and Redoing Operations

You can undo operations using the [Undo] command on the [Edit] menu. You can use the [Redo]
command to redo operations that have been undone.

m Deleting Objects
Objects can be deleted by selecting them and pressing the <Delete> key.

Some objects cannot be deleted. With some other objects, you must first make appropriate settings in a dialog box
before you can delete them.

m Moving Objects
You can move objects by dragging them with the mouse. If [Snap to Grid] is ON in the “Grid” dialog
box, the dragged objects will automatically align with the grid.
You can also move a selected object using the arrow keys. If [Snap to Grid] is ON in the “Grid”
dialog box, the selected object will move from grid line to grid line. If [Snap to Grid] is OFF, the
object will move pixel to pixel.

DME Designer Owner’'s Manual 251



Chapter 4 Designer

Changing the Order

Objects newly placed on the sheet will be displayed above any previously placed objects they
overlap. You can change this behavior using the [Display Order] command on the [Edit] menu. Select
the object for which you want to change the display order, then select the appropriate command from
the [Display Order] submenu on the [Edit] menu.

¥ Designer

Chl4Z
Chel+

Chrl43

Chrl4+C
Chel4y
|

el

Chrl+A

Duplicate Chrl+D

Edit Legend...

Properties...
LMD

i Switching HUB
~Wireless Antenna

[Top]

Moves the selected object to the top of the stack.

[Bottom]
Moves the selected object to the bottom of the stack.

[Front]
Moves the selected object up one level in the stack.

[Back]
Moves the selected object down one level in the stack.

- 3 o ageeancess
Uppermost Object s [ paste r  IDM
L —— Delete SEREEEEEE

...................... Duplicate
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Drawing and Editing Wires

Wire

Objects that are arranged on sheets in the Configuration or User Module windows can be connected
to each other by wires. Not only does this let you logically connect signal sources (output side) and
destinations (input side), it also lets you draw connections and independent lines on the display. Each
wire has at least two wire nodes. Between the nodes are line segments.

B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B
B

O Wire Node [ Line Segment

m Selecting Wires and Canceling Selection

You can select a line segment by clicking on it.
If you hold down the <Alt> key while clicking, you will select the entire wire.

The color used when a wire object is selected can be set with [Selected Color] in the “Wire Properties” dialog box.
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m Line Segment

The line width default value is set from one to five pixels in the Designer window “Preferences”
dialog box. In the “Wire Properties” dialog box, the line thickness and color can be adjusted as
required for the various wires arranged on the sheet.

Line Segment Selection

When you select a line segment by clicking on it, only that line segment is selected. If you hold
down the <Ctrl> key while clicking, you can select multiple line segments. Furthermore, if you drag
the mouse from an empty location on the sheet so that nodes are enclosed by a box, line segments
between those nodes will be selected.

.................. b

Canceling Line Segment Selection
If you select another object or an empty location on the sheet, it will cancel selection of the object

you previously clicked.
You can also cancel selections by holding the <Ctrl> key while clicking.

<Ctrl> + Click Canceling Selection of a Line Segment
Selected with <Ctrl> + Click
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m Wire Nodes

Both ends of a wire, the location where wires bend, and the location where wires diverge are called
“Nodes.” When a wire object is not selected, its nodes are not displayed. When a wire is selected,
the nodes are displayed with a red circle.

Cazcace Input

© - PEQ-Stereo - -

Node Selection

When you click on a node, only that node itself is selected. You can select multiple nodes by
holding down the <Ctrl> key while clicking. Furthermore, if you drag the mouse from an empty
location on the sheet so that nodes are enclosed by a box, the enclosed nodes will be selected.

C Castadelnputs o e [ ———

Canceling Node Selection

If you select another object or an empty location on the sheet, it will cancel selection of the object
you previously clicked.

You can also cancel node selections by holding the <Ctrl> key while clicking. With this technique,
you can cancel only the node you clicked on when multiple nodes are selected.

Tazcade Iipot’

©oDeldy Matrix 0
& Input3 Outy

© Deldy Matfie
. [T 2 Inputs Outplit.

. <.C.t.rl>. + C|ICk Canceling Selection of a Node Selected with
<Ctrl> + Click
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Hotspot
The small white rectangles at the edge of objects are called “Hotspots.” Wires usually connect to
hotspots.
C L DelayMatibe T Desiia L -

2 Input 2 Outy Mono -5

N2 ours BiTH——— Hotspots

VE] ouTs 1% .

MG ouT4

MNE ouTsC- - - - - - - - e

HE outellll- - - - - - - - e e e

N7 ouTAC: - - - s e e e e

Ng  OUTS © Reuter

12}

. [ Zinputz Outplt.

Ml ouTiCd] -
|cwz - ouTza0])- -
d 1% W

e Some hotspots do not have a connection to a logical signal within the hardware.
e Component and user module hotspots normally include logical connections.
e External device hotspots do not include logical connections.

m Selecting Hotspots

If you click a hotspot, drawing will start. To select, press <Shift> + click.
You can select multiple hotspots as follows: Select a hotspot with <Shift> + click, then select
additional hotspots using <Ctrl> + <Shift> + click.

Deldy Matfi:
 Input s Out
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Drawing Settings

Several functions are available to help ensure accurate wire drawing.

m Grid
To accurately draw in relation to the grid, turn ON [Snap to Grid] in the “Grid” dialog box.

m Draw Exact Vertical and Horizontal Lines
When [Prohibit Diagonal Connections] in the [Tools] menu is turned ON, wires will be drawn using
horizontal and vertical lines only. Diagonal wires cannot be drawn. To activate this function, select it
from the menu so that a checkmark appears next to the command name in the menu. Selected the
command again to remove the checkmark and deactivate the function.
You can also limit wire drawing to horizontal and vertical lines by holding the <Shift> key while
drawing the wires.

You can change the positions of existing components or nodes while converting the existing wires to wires composed only of
horizontal and vertical lines by activating the [Prohibit Diagonal Connections] function. You can draw diagonal lines holding
the <Shift> key while dropping the objects.

¥ Designer

Area Parts List
Device List

Component Lisk

ZOne...

Configuration...

Save User Module. ..

User Module Manager ...

B Frobe Monitor

| v Edi Mode

| "B Frohibit Diagonal Connectio
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Wire Drawing

Wire drawing starts at the positions shown in the following table:

Drawing Start Location

Start Method

Hotspot

Click

Wire End Terminal

Right-click - click [Continue Wire] on the menu

Node

Start Wire] on the menu

Line Segment

Right-click — click [Start Wire] on the menu

Anywhere on the Sheet

[
Right-click - click [
[
[

Right-click - click [Start Wire] on the menu

When creating diagrams the keyboard cursor keys can be used to move the mouse cursor, and the <Enter. Key can be used

to create nodes.

m Connecting Hotspots with Hotspots

Method 1 Clicking

Click the hotspot where the connection originates to begin drawing, then click the destination

hotspot. The two hotspots will be connected by a wire.

A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME

object's Cascade port.

When creating diagrams horizontally aligned hot spots can be automatically connected by pressing the <Shift> + < - >
keys or <Shift> + <« > keys.

Method 2 Dragging

Drag from the origin hotspot to the destination hotspot.

A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME

object's Cascade port.
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m Connect with Bent Line

Method 1 From Hotspot to Hotspot

Click the hotspot where the connection originates to begin drawing, then click the location (which
will become a node) where you want the line to bend. Finally, click the destination hotspot to
complete the connection.

Casc.

Method 2 From Hotspot to Node or Line Segment

Click the hotspot where the connection originates to begin drawing, then click the location (node)
where you want the line to bend. Click an already drawn wire node or line segment to complete the
connection. If you connect to a line segment, a node will be created there.

A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME
object's Cascade port.

* Cascadelmput oo o Compressor(s) © - - Cascade Input
& ; ; N C 1

L as

Compressord) ©
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© Taseadelnputs oo v ot e Dalay tathi=(2)

m Connect Multiple Hotspots in a Single Operation

Method 1 <Ctrl> Key Combinations

If you hold down the <Ctrl> key when finishing dragging, a wire will be drawn at all origin hotspots.
The wire will be connected to the destination hotspot you dragged and those that come after.

Begin dragging from the connection origin hotspot, then press the <Ctrl> key after aligning the
mouse pointer with the hotspot you will connect too. A wire will be displayed below the destination
hotspot. Finish dragging while holding the <Ctrl> key down.

Press <Ctrl> Key

Method 2 Connect Multiple Selected Hotspots

Select multiple hotspots using <Shift> + <Ctrl> + click or <Shift> + drag, then drag from one of the
selected hotspots to the destination hotspot. The selected multiple origin hotspots will all be
connected.

............. 2 Input # Ouf

- Tastade Inpit

Casc JESIEIICK. %ZZ
NE o

e
= =
z
o
2
E
oy

8%

ultiple Hotspots Selected

Method 3 Using Shortcuts

Press the [F2] key to select the uppermost open hot spot to the right of the selected object and
begin drawing a wire.

Press <Shift> + [F2] to select the uppermost open hot spot to the left of the selected object and
begin drawing a wire.
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Press the [F4] key to connect the uppermost open hot spot to the right of the selected object and
the uppermost open hot spot to the left of the object on the right.

Press <Shift> + [F4] to connect the uppermost open hot spot to the left of the selected object and
the uppermost open hot spot to the right of the object on the left.

St mgtoMigere - v 0o - [IINAZoOUTAEOT - -

Press the [F5] key to connect the uppermost open hot spot to the right of the selected object and
the uppermost open hot spot to the left of the object on the right, and continue automatically
making sequential connections until no more open ports are available on either object. Automatic
connections will not be made over other objects.
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Press <Shift> + [F5] to connect the uppermost open hot spot to the left of the selected object and
the uppermost open hot spot to the right of the object on the left, and continue automatically
making sequential connections until no more open ports are available on either object. Automatic
connections will not be made over other objects.

Press the [F8] key to clear all wires connected to the selected object.

When multiple objects are selected these operations apply to the first object selected.

These shortcuts can be changed as required.
- See Chapter 3 Main Panel Window, “Shortcut Keys” on page 136.
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m Starting Drawing from the End Point/Node/Line Segment of an Existing Wire

You can draw from the end or midway point of an existing wire. If you start from a node or line
segment, a branch line will be created.

Method 1 Continue Drawing from a Wire End Point

When continuing an existing wire, right-click on the wire end point, then click [Continue Wire] on
the displayed context menu.

© TCaseadelrpots © o0ttt ot Delay Matia2)
. rCS11I1C1 ZZISInpuMDut ]

= ouT1 )
A" !Start Wire

Delete Wire

T~ O s 0 ha

Properties. .. 8%

Method 2 Start Drawing from a Node

Right-click on a wire node, then click [Start Wire] on the displayed menu. You can start a branch
wire from the node you clicked on.

 Castadellrputs ot C C ot DeldayMatiing)

Lo [TEnputd out
N1 auT1
N2 ouTz2
INZ ouT3

Delete wire :NS

=
T
[=}
=
per}
I
o

Delete INT

8%

Properties. ..

Method 3 Start Drawing from a Line Segment

Right-click on a wire line segment, then click [Start Wire] on the displayed menu. A node will be
created at the point you right-clicked, and you can start a branch wire from that node.

Delete sooaoad

Duplicate | 0 0

Display Order  » .

Properties. ..

m Drawing from Anywhere on the Sheet

Right-click the start position for drawing, the click [Start Wire] on the context menu that is
displayed. Click the location where the line should bend, then double-click at the end location to
finish drawing.

Component Lisk e oo - o

| v EdtMode R e B BN

Sheet...
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m Finishing Drawing
When the hotspots or already drawn wires are connected, drawing is finished.
To finish drawing without connecting to a hotspot, use one of the following methods:
¢ Right-click the mouse
¢ Double-click
e Press the <Esc> key
Drawing also finishes if another window is made active.

Wire Editing

You can delete wires, change node positions, connect to other wires, and perform other wire edit
operations.

m Delete

Deleting an Entire Wire
Right-click the wire then click [Delete Wire] in the context menu

Deleting Nodes

Nodes can be deleted by selecting them and pressing the <Delete> key. Nodes on both sides of
the deleted node will become directly connected.

Selected Node
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m Editing by Dragging

Moving Nodes
You can move nodes by dragging them with the mouse.

When multiple nodes are selected and dragged with the mouse, you can move all selected nodes
simultaneously.

Moving Line Segments

To move a line segment, select the nodes on both sides of the segment, and drag one of the
nodes.

m Connecting to Other Wires

If you drag a node and lay it over another wire, the two will be connected at that position. If you
drag it to a line segment, a node will be created.

Created Node
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Logical connection

A connection from a source (output side) signal to a destination (input side) signal is called a “logical
connection.” If a logical connection is present in a configuration, the actual hardware signal will be
connected. A single wire can make a single logical connection.

Logical connections are possible only in the Configuration window and the User Module window.
Wires in the Area window or Zone window can be drawn for display only. Even in the Configuration
window and User Module window, you can also draw wires for display only.

Window Wire
Area Window Drawing for display only
Zone Window Drawing for display only
Configuration Window Logical connection and drawing for display only
User Module Window Logical connection and drawing for display only

m Situations Where No Logical Connection Is Created
e Both sides are source (output side) signals
e Both sides are destination (input side) signals
e Two source (output side) signals are connected to a destination
e There are two destination (input side) signals, and the wire is not connected to a source (output
side) signal.
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Adding, Deleting, and Renaming a Zone

At least one zone is included within an area. In the default Area window that zone will be named
[Zone1]. Multiple zones can be arranged in an Area.

When you click the [Zone Manager] command on the [Tools] menu, the “Zone Manager” dialog box is
displayed. Here you can add, delete, or rename a zone.

“Zone Manager” dialog box

i Zone Manager

Zone List

Add
Lelete
Bename...

Zone List
Lists the zones included in the project. To change settings for a zone, select it by clicking it in the
list.

[Add] Button

Adds a zone. Clicking here displays the “Please enter new name” dialog box. Enter a new name,
then click [OK]. A zone will be added.

¥ Please enter new name

oK | Cancel |

[Delete] Button

Deletes the zone selected on the list. Clicking here displays the “Are you sure?” dialog box. Click
the [OK] button, and the zone will be deleted. Click the [Cancel] button, and the deletion will be
cancelled.

% DME Designer E|

@ Are yOu suFe?

Cancel |

A minimum of one zone is required. When only one zone remains, deletion is impossible.
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[Rename] Button
Changes the name of the zone selected on the list. Clicking here displays the “Enter new name for

the current zone name” dialog box. Enter a zone name, then click the [OK] button.

The current name of the zone you will be renaming is displayed in the “Current Zone Name” box of the “Enter new name

for current zone name” message.

I Enter new name for ‘zone2'

[Close] Button
Closes the “Zone Manager” dialog box.

Changing Device Groups

A zone can include up to 32 device groups, and all devices will belong to one of those groups.
Click [Device Group Manager] in the [Tools] menu to open the “Device Group Manager” window, via

which device groups can be changed as required.

“Device Group Manager” Window

i Device Group Manager

Device Group

MHame Attribute | Default Color |
DME Groupl DME Group | ]
DME Group? DME Group

SP Groupl  ElgNeall] [ | Delete

Bename...

Color..

[~ #pply Default Color to &Il Exizting Devices

Device Group
All device groups in the zone being edited appear in the list. Click the Slick a device group to

select it for editing.

* Name
The name of the device group.

* Attribute
The type of device group.

* Default Color
The default color for devices that are added to the group.
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* [Delete] Button

Deletes the device group currently selected in the list. An “Are you sure” confirmation box will
appear when this button is clicked. The selected device group will be deleted when the [OK]
button is clicked. Click the [Cancel] button to abort the delete operation.

& DME Desiener r>__<|

@ fre wou sure?

Cancel |

Device groups cannot be deleted when they include assigned devices.

[Rename] Button

Renames the device group currently selected in the list. The “Enter new name for current device
group” window will appear when this button is clicked. Enter a new name for the device group and
click the [OK] button.

The current name of the selected device group will appear in the name entry window, in place of “current device group”
in the window name: “Enter new name for current device group”.

ik Enter new name for "DME Group' E”zl

(8] 2 Cancel ‘

[Color] Button

Species the default color for new devices added to the currently selected device group. The
“Select Color” window will appear when this button is clicked.
Refer to “The Select Color Window” on page 237 for information on the “Select Color” window.

Apply Default Color to All Existing Devices

When checked the color of all existing devices will change accordingly when the initial default
device color is edited.

[OK] Button
Closes the “Device Group Manager” window.
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Adding, Deleting, and Renaming a Configuration

A device group will include at least one configuration, and others can be added as required.
When you click the [Configuration Manager] command on the [Tools] menu, the “Configuration
Manager” dialog box is displayed. Here you can add, delete, or rename a configuration.

“Configuration Manager” dialog box

#it Confieuration Manager

Device Group: | DME Graup ﬂ

Configurations

Add..
Delete
Rename...

Close

Device Group
Select the device group to be edited from the list.

Configurations

Lists the configurations included in the device group being edited. To change settings for a
configuration, select it by clicking it in the list.

[Add] Button

Adds a configuration. Clicking here displays the “Please enter new name” dialog box. Enter a
configuration name, then click [OK]. A configuration will be added.

i Please enter new name

[Delete] Button

Deletes the configuration selected on the list. Clicking here displays the “Are you sure?” dialog
box. Click the [OK] button, and the configuration will be deleted. Click the [Cancel] button, and the
deletion will be cancelled.

OF DME Designer E|

@ Are you sure?

A minimum of one configuration is required. When only one configuration remains, deletion is impossible.
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[Rename] Button

Changes the name of the configuration selected on the list. Clicking here displays the “Enter new
name for the current configuration” dialog box. Enter a configuration name, then click the [OK]
button.

The current name of the configuration you will be renaming is displayed in the “Current Configuration Name” box of the
“Enter new name for current configuration name” message.

i Enter new name for ‘Config2'

[Close] Button
Closes the “Configuration Manager” dialog box.
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Area Window

In the Area window, the area is designed by arranging objects on a design sheet, When you click
“Area” in the Navigator window, the Area window becomes active. You can also open the Area window
using the [Area] command in the [View] menu.

The following objects can be arranged in the Area window:

e Zone

e External Device

e Picture

e Text

e Box

e Ellipse

e Wire

e | egend

Title Bar
Menu Bar
Tool Bar

-~ Text (Text Object)

: éf-Q -

U Eliipse (Gircle)

Toolkit Window

i (Rec’teingle)'[-/’_,

| T —— :

Sheet

m Title Bar
You can move windows by dragging the title bar.

m Zone

Zones are added and deleted using the “Zone” dialog box. You cannot perform operations such as
deletion, cut, or copy. You can change the position and design of zone objects in the Area window.
Double-click to open a Zone window.

m Objects

You can perform edit operations such as arrange, cut, copy, paste, delete, and move on all objects
except zones.
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Arranging Objects

Objects other than zones can be placed in the window by dragging them from the Toolkit window. You
can also place objects by double-clicking them in the Toolkit window. You can also display the [Area

Parts List] from the [Tools] menu or from the context menu that appears when you right-click on the
sheet.

4 BExternal Deven
|- Pt
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Zone Window

In the Zone window, the zone configuration is designed by arranging zone devices on a design sheet,
A zone configuration can be created that is the same as the actual hardware arrangement.

To display the Zone window, double-click in the Area window. When you click a configuration in the
Navigator window, it becomes active.

The following objects can be arranged in the Zone window:

e DME

e |CP

e SP2060

e External Device

e Picture

e Text

e Box

e Ellipse (Circle)

e | egend

Title Bar
Menu Bar
Tool Bar

3
WCMENN
WCMELN
WOMER-C

WOMER-C
BCNE o
1

(Text Object) e

Box fRectanflef

Ellipse (Circle)

Sheet

Toolkit Window

! - External Device
_mf‘.‘::':-.":.:r.‘tt:"‘.‘l*“‘-‘““'_"""_"'"'“_“-'-‘:-- o

Legendv

m Title Bar

Displays the zone name you have in the “Zone” dialog box. There is always one zone named
[Zone 1] in a newly created project.

m Configuration
You can create multiple configurations within a zone, but they cannot be arranged within the Zone
window. There is a Zone window for each configuration where devices can be arranged. To switch
configurations, click the desired configuration in the Navigator window.
You can add, delete, and rename configurations in the “Configuration” dialog box.
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m Objects

You can perform edit operations such as place, cut, copy, paste, delete, and move to devices and
shapes. If you double-click on a device arranged in the window, a Configuration window or dialog
box will open.

Device Action When Double-Clicked
DME/SP2060 Displays Configuration Window.
ICP Displays “Control Panel Properties” dialog box.
(Double-click the label)
External Device Opens external application linked to the device.

Arranging Objects

You can place objects by dragging them from the Toolkit window. You can also place objects by
double-clicking them in the Toolkit window. The same objects are displayed in the [Device List]
submenu on the context menu that appears when you right-click the [Tools] menu or on the sheet.
For information about the “Device List,” see page 173.

i Desiener
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-~ FOMESI-G
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Placing DME or SP2060

In the Toolkit window [DME24N], [DME64N], [DMES8i-C], [DME8o-C], and [DME4io-C] icons are
located in the [DME] folder, and an [SP2060] icon is located in the [Speaker Processor] folder.
These icons can be dragged to the zone window.
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m ICP Placement

Just like for a DME or SP2060, placing an ICP is to drag the icon from the Toolkit window. If there
are multiple ICPs in a hardware configuration, create an equivalent number of ICP objects.
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In the Toolkit window [ICP1] icons are located in the [ICP1] folder. This icons can be dragged to the
zone window.
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Configuration Window

The Configuration window is used for arranging components on the sheet and making logical
connections. It is displayed when you double-click on a DME or SP2060.

SP2060 configurations cannot be edited.

3 Designer

Tool Bar
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m Title Bar

Displays “Device Name (Zone Name).” The configuration window for a DMEG64N placed in [Zone1]
will be “DMEG4N (Zone1).” The device name is set in the properties for the device placed in the
Zone window.

m Objects

Objects such components, user modules, and shapes are arranged in the Configuration window.
When you double-click a component placed in the window, the editor set in “Double Click Action”
in “User Module Properties” will open.

m |/O Component

Depending on the settings for the DME placed in the Zone window, 1/O components will be

automatically placed or added.

e |/O components can be arranged in the DME24N/DME8i-C/DME80o-C/DME4io-C and SP2060
configuration window.

e When “Show Cascade Port” is ON in the DME64N “DME Device Properties” dialog, Cascade 1/O
is added automatically.

e When you set a slot in the properties for a DME placed in the Zone window, Slot 1/O will be
automatically added.

You cannot apply edit operations like cut/copy/paste/duplicate to /O components, Slot 1/O, and
Cascade /0.
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Placing Components

You can place objects by dragging them from the Toolkit window. You can also place objects by
double-clicking them in the Toolkit window. The same objects are displayed in the [Component List]
submenu on the [Tools] menu or on the context menu that appears when you right-click on the sheet.
For information about the [Component List] in the Configuration window, see page 173.
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If the [Matrix Mixer 64 input 64 output] or the [Matrix Mixer 64 input 32 output] components are placed in the DME64N
configuration window, you will not be able to use other components, even though the window does not reach 100 percent.
The [Matrix Mixer 64 input 64 output] or [Matrix Mixer 64 input 32 output] components cannot be used in the DME24N.

m Arranging a Number of Components of the Same Type

You can arrange a number of components of the same type. If there are two or more of the same
component, numbers will be attached to their names as follows: “Compressor (2),” “Compressor
(3)” and so on. Multiple components placed in the configuration are independent, and you can set
different parameters for each of them.
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m SP2060 Configuration Window
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[Input A/B Link] Button

Although SP2060 configurations cannot be edited, the [Input A/B Link] status can be changed.
Clicking this button alternately turns INPUT A/B linking ON and OFF. When switched ON the input
level, EQ, and Delay component parameters are copied from Input A to Input B, and are thereafter
linked.

Probe Monitor

Probe monitor is a function that lets you monitor output ports in your configuration with headphones.
You can turn it ON or OFF using [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on
the toolbar. The probe monitor can be set to ON or OFF for each DMEG64N/24N.

The probe monitor can be used only when online with the DMEB4N/24N and Configuration window or
user module active. When the probe monitor is ON, no editing is possible except in the Component
Editor.

DMES8i-C/DME8o-C/DME4io-C and SP2060 do not support the probe monitor.

m Probe Monitor Procedure

1 Turn the probe monitor ON.
Click [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on the toolbar.
The shape of the mouse pointer changes.

The output port you clicked will be selected and monitoring will begin.
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Monitor object

If you click another output port, the location being monitored will change.

m L/R Selection
To monitor the left channel and right channel simultaneously, <Shift> + click on the left channel,
then do the some for the right channel.

m Exiting the Probe Monitor

Click [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on the toolbar to turn OFF
the probe monitor. When probe monitor is turned off, the mouse pointer returns to its normal shape.

m Monitoring the Second or Later Time

The software remembers the location being monitored even when probe monitoring is turned OFF.
The next time probe monitoring is turned ON, the location that was being monitored previously will
be selected.

If the configuration is edited after turning monitoring OFF, the monitor location will not be selected.
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Show Signal Delay (Delay Display Value)

The signal delays according to the processing time in the audio processor. The [Show Signal Delay]
command from the [Tools] menu calculates a delay value and displays it for the component. Selecting
this command switches delay value display between ON and OFF. A checkmark appears when
display is turned ON.

When turned ON, the settings are compiled to obtain a delay value, which is displayed for
components and lines. The delay value obtained through compilation remains valid until the
configuration is edited. Sample units are used to display the delay value.

This corresponds to the [Show Signal Delay] button on the toolbar.

ON and OFF settings for [Show Signal Display] are saved for each configuration window. Switching
the setting between ON and OFF in another configuration window has no effect on the current window.
You can edit the configuration while [Show Signal Delay] is turned ON.

64N(2)(Zone1)

© Coscatdelmpt - Compressor PEG-Sleren Caseade Output
2 : ad 8P R

i L. Zsample . . .
Fesample
550r(2) ¢ © ot PEGESteren(Z) ¢ -

u ¢ 2 £ Z-sample &
BLI ¥ ... 3-sample . . soiia

When you turn ON [Show Signal Delay], the delay value appears
above the object.

Delay values for components and 1/O components are displayed at the lower center of the object.

- PEG:Sterso 0 - -

i . 2-zample . . :

Delay values for wires are displayed beside the input port of the connected object.

Delay values for SPX components vary depending on the Bypass ON/OFF status, because SPX components add the effect
signal to the original signal. When [Show Signal Delay] is turned ON, the delay value for the Bypass ON status will be
displayed.

Delay values for Wav File Player components are displayed for external inputs. Delay values for local Wave files cannot be
displayed.
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Monitoring Point List

When you click [Monitoring Point List] in the [Tools] menu, the “Monitoring Point List” dialog box is
displayed. Here you can register or edit points for monitoring with headphones.

Monitoring points can be edited only by users for whom the [Edit] security checkbox has been turned ON.

B Monitoring Point List

Cut Copy ] PBaste ‘ Insert Clear I
Mo i Label | Companent L i Port L | Companent B | Port B i o
ol - Compressar OUT1  Compressor ouT1 f
oz - - 5 k -
003
004
oos
00g
007
oog
003
010
o1
01z
013
014
015
016
017
018
019
020 -
021 : i
oK LCancel I

[Cut] Button

Cuts the selected monitoring point information. When monitoring point information is cut,
information below that point moves up.

m [Copy] Button
Copies the selected monitoring point information.

m [Paste] Button
Pastes the copied monitoring point information at the selected line.

m [Insert] Button
The copied monitoring point information is inserted at the selected point.

m [Clear] Button
Deletes the selected monitoring point information.
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m Monitoring Point List
Displays and allows editing of monitoring point information.

[No.]
Displays the numbers for monitor link points. Numbers are assigned in order from the top.

[Label]

Displays and allows editing of monitoring point names. Clicking here selects the text. You can then
enter a new name.

[Component L]

Sets the monitoring point L channel component. Clicking here displays a list of components
arranged in the active configuration window. You can then select components for monitoring.

Components arranged in user modules are also displayed in the list. However, components for user modules for which
security is set will not be displayed.

[Port L]

Sets the monitoring point L channel port. Clicking here displays a list of ports for the component
selected in the [Component L] field. Click the port you want to monitor.

If you click a port in the designer window while the “Monitoring Point List” dialog box is displayed, the port will be
registered to the monitoring point of current selected row. If you will register the monitoring points as stereo, click a port
while holding down the <Shift> key to register Component L and Port L, then click a port again while holding down the
<Shift> key to register Component R and Port R.

[Component R]

Sets the monitoring point R channel component. Clicking here displays a list of components
arranged in the active configuration window. You can then select components for monitoring.

Components arranged in user modules are also displayed in the list. However, components for user modules for which
security is set will not be displayed.

[Port R]

Sets the monitoring point R channel port. Clicking here displays a list of ports for the component
selected in the [Component R] field. Click the port you want to monitor.

m [OK] Button
Updates the settings and closes the dialog box.

m [Cancel] Button
Closes the dialog box without changing the settings.
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Analyze (Configuration Analysis)

When you click the [Analyze] command on the [Tools] menu or the [Analyze] button on the toolbar, the
“Analyze” dialog box is displayed. The wire connections in the currently active configuration window
are analyzed, and the results are displayed in the “Analyze” dialog box.

Because this function allows you to make sure there are no problems with component arrangement
and wires without connecting to the DME unit, it is useful for eliminating complier errors before
executing Synchronization.

The [Analyze] command on the [Tools] menu can be selected only when a configuration window is active.

Message

Compile Options
Delay Compenzation = OFF
Fired wire Delay = OM

Analyzing....
oKl

m Message Box
Displays the progress of the analysis operation. When the analysis finishes, the results are
displayed.
If errors are detected during analysis, they will display as shown below.

Message

Compile Options
Delay Compengzation = OFF
Fized \Wire Delay = OM

Analyzing

Emarl

Slatin/Cascadeln cannat be directly connected to
SlatOut/Cascade0ut when using a B4 Input b atrix Miser.

m [Close] Button
Closes the dialog box.
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User Module

User Modules

A module treated as a single component that combines a number of other components is called a
‘user module.” A user module can be arranged in the Configuration window just like any other
component. User module editing consists of placing the component and making logical connections
with wires, the same as for configurations.

Saved user modules are displayed in the Toolkit window and can be used as templates. User modules
are saved in project files, but user module templates can also be exported as files and used in other
projects.

A “User Modules” folder will be created in the folder specified in [Contents Folder] in the “Preferences”
dialog box in the Main Panel window. User modules will be saved there. If you do not change the
setting in the “Preferences” dialog box, the location will be “C:\Program Files\YAMAHA\OPT Tools\DME
Designer\User Modules.”

Refer to “The User Module Editor” on page 173 for information on editing user modules.

The Main Panel Menu “Preferences” dialog box is displayed using [Preference] in the [File] menu.
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Creating User Modules

When you place a blank user module in the Configuration window, a new user module is created.

1 Make the Configuration window active.

2 Click the [+] next to [User Module] in the Toolkit window.
The items in the level below the [User Module] folder will be displayed.

3 Drag the [Blank User Module] to the Configuration window.
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-2 Output
34 Output
38 Output
312 Output
- 316 Output
=-EaUzer Module
.- FBlank User Module
- Picture
o Tt

When you release the mouse button at the location where you will place the user module, the “User
Module Properties” dialog box is displayed.

% User Module Properties

ak
Label  [Unsaved User Module Label Font
Cancel
Width: [0 3 Label Golor
Height: [40 2] Tnputs/Outputs Labels Color..
Style: [ Plain =] Colar..

Inputs/Outputs Sets

Inputs: Il E: Max 64}
Quiputs: [ 3: (Max 64)

Double Click Action Security Settings

o Open User Module Desien Window

I™ Erabls Security Set Password..
¢ Open User Module Editor —

4 Here you can set object properties.
[Inputs/Outputs Sets] is set to 1. Set the required number of ports.

D Click the [OK] button.

A user module will be created, and placed in the Configuration Design window.

| -BELRA
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B Input
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E-E16 Input
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- % Blank User Module

- Picture
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The user module properties can also be changed later. For information about the “User Module
Properties” dialog box, see “User Module” on page 216.
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Saving User Modules

Saved user modules are displayed under [User Module] in the Toolkit window, and can be used as
templates.

User modules placed in the component editor are saved in the project file. When you want to use a user module in another
configuration in the same project, save it using the “Save User Module” command.

Save the User Module using the [Save User Module] command on the [Tools] menu. The [Save User
Module] command can be used only when a user module is selected in the Configuration window.
When you select the command, the “Save User Module” dialog box will be displayed. Enter a name for
the User Module, then click the [OK] button.

¥ Save User Module Ellz'

Uszer Modules

EQ-Caomp

~Double Glick Action
(¢ Open User Module Dezign Window
¢~ Open Uger Madule Editor

—Security Settings

[~ Enable Security Am‘l

—Default Library -

] Mone LJ

Lzer Modules Name

(8] 4 Cancel

Set [Double Click Action] and [Security Settings] at the lower part of the “Save User Module” dialog
box.

They correspond to the same items in the “User Module Manager” dialog box. When saved with
different settings than the “User Module Manager” dialog box, the saved settings are immediately
applied.

m Double Click Action

Initial setting of the window that opens when you double-click on a user module placed in the
component editor.

[Open User Module Design Window]
Opens the User Module Design window.

[Open User Module Editor]
Opens the User Module editor.
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m Security Settings

Initial settings of user module security.

[Enable Security]

Enables user module security.

If you place a checkmark here, the “Set Password” dialog box appears. Enter the same password
into the [Password] box and [Confirm Password] box, and click the [OK] button.

I Set Password E] |gj

Password: ﬂ

Confirm Pazsword: ]

oK LCancel

[Set Password] Button

Changes the password. Clicking here displays the “Input Password” dialog box. Enter the current
password and click the [OK] button. The “Set Password” dialog box will be displayed. Enter the
same password into the [Password] box and [Confirm Password] box, and click the [OK] button.

& Input Password

Password: |

gk LCancel I

If you try to save a user module with the same name as an already saved user module, a message
asking “This file already exists. Overwrite?” will be displayed. To overwrite, click the [Yes] button. To
change the name, click the [No] button, and change the file name in the “Save User Module”
dialog box.

¢ DME Designer

When the “Save User Module” dialog box is displayed, the name set in the user module’s “User Module Properties”
dialog box will be entered into the [File name] box. If you change the name of a user module and save it using the “Save
User Module” dialog box, the filename in the user module and the user module name displayed in the Toolkit window will
also change.

The [Label] box displayed in the “User Module Properties” dialog box will not change.

If characters not usable in file names are used in the file name set in the “User Module Properties” dialog box, an error
message will be displayed at the same time as the “Save User Module” dialog box. Delete the unusable characters
before saving.

M Critical Error,

e Cannot open file f"72:= H{}.umf
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Editing User Modules

User modules can be edited in the User Module window. Components layout and logical connections
are set up in the design worksheet. The design worksheet can be opened by selecting [Open User
Module Design Window] from the contextual menu of user modules in the configuration window. If
[Open User Module Design Window] is selected as the [Double Click Action] in the “User Module
Properties” window, the design worksheet can also be opened by double-clicking a user module.

- “User Module Properties” (page 217).
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m Title Bar

The user module names are displayed on the title bar. User module names are set in the “User
Module Properties” dialog box.

m Objects

You can place, cut, copy, paste, delete, and move component and shape objects. When you
double-click an object placed in the window, the component editor will open.

m Placing Components

Components are placed the same as in the Configuration window.

You can place objects by dragging them from the Toolkit window to the User Module window. You
can also place objects by double-clicking them in the Toolkit window. The same objects are
displayed in the [Component List] submenu on the [Tools] menu or on the context menu that
appears when you right-click on the sheet.

For information about the User Module window [Component List], see page 174.

{ Unsaved User Module(3)(Zone1) nsaved User Module{3)(Zone1)
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m Placing a Number of Components of the Same Type

You can arrange a number of components of the same type. If there are two or more of the same
component, numbers will be attached to their names as follows: “Compressor (2),” “Compressor
(3)” and so on. Multiple components placed in the configuration are independent, and you can set
different parameters for each of them.

i IDME64N(Zone1)
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BB ader IN1R OUT1R
[+ ExFilter KEYIN o
[+-EiMeter
[-EiMizcellansous ¢ o Compressor(4) -
[ Eiizer g lStereU I -
TR

User Module Manager

When you click [User Module Manager] on the [Tools] menu, the “User Module Manager” dialog box is
displayed. Edits, renames and deletes user module templates.

i User Module Manager

User Modules

Double Click Action
{* Open User Module Design Window
+ Open User Module Editor

~Security Settines

¥ Enable Security M]

Default Library

5
Bename. J Delete J
Export..
Import Library... I Export Library... I
Import Cancel

m User Modules

User modes saved as templates are displayed in the list. Select the target user module by clicking
on it.

Only user modules saved can be displayed. User modules placed in the component editor are saved in project files, and
can be used without being saved as files. However, they will not be displayed in the “User Module Manager” dialog box
list.
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m Double Click Action
Specifies the default action when user modules in the configuration window are double-clicked.

[Open User Module Design Window]
Opens the User Module Design window.

[Open User Module Editor]

Opens the User Module editor. The user module editor is a window where controls for components
that are placed in a user module can be laid out and their parameters changed. For more
information about the user module editor, see “User Control Editor”’/User Module Editor” on

page 301.

m Security Settings
Makes security initial settings for the user module selected on the list.

[Enable Security]

Enables user module security. If security is enabled, a password is requested when attempting to
open the User Module window. If the correct password is not entered, the window will stay closed.
When you place a checkmark here, the “Set Password” dialog box appears. Enter the same
password into the [Password] box and [Confirm Password] box, and click the [OK] button.

T Set Password

Password: ||

Confirm Password: |

ok Cancel |

To disable user module security, turn OFF the checkbox. If you click the checkbox when it already
has a checkmark, the “Input Password” dialog box appears. Enter the password set for this user
module, and click the [OK] button. You can disable security in this way. If you do not enter the
correct password, you will not be able to disable security.

[Set Password] Button

Changes the password. Clicking here displays the “Input Password” dialog box. Enter the current
password and click the [OK] button. The “Set Password” dialog box will be displayed. Enter the
same password into the [Password] box and [Confirm Password] box, and click the [OK] button.

& Input Password

Password: ||

oK | Cancel

m Default Library

Specifies the default library file for newly-created user modules.
Refer to “Library” on page 70 for information.
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m [Rename] Button

Changes the name of the user module selected on the list. Clicking here displays the “Rename
User Module” dialog box. Enter a name into the user module name box, and click the [OK] button.

i Rename User Module

The user module name also becomes the file name. When naming a user module, do not use characters that cannot be
used for filenames.

[Delete] Button
Deletes the user module selected on the list.

[Import] Button
Imports the user module settings and library from the user module export file.

[Export] Button

Saves the user module settings and library to the user module export file.

Click to display the Export dialog, All features of this dialog window are the same as the standard
Windows file save dialog, except for the [Export Library] option.

[Export Library] can be sued to select the library to be saved.

& Export

Lock in: 3 [r/Talisman/src\1.2/DESIGNER/DESIGNER/ x| 4= ck

. Didesien  Ciope Ciwideet
) Adaptor  (Didran ([Chsetting axml
Dicale Ehd<t Chtestlibrary [ 3umsx
Cicom Chimages  [CitranslatelF
C1Common  (Cymdi Sui

[)Debug  (Shobject  [Sjundo

o |
File type: | Export File Sumsx! =l Cangal
Export Library
[B T230ml
Add Library File..

m [Import Library] Button

Loads a file from the specified folder into the library.
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m [Export Library] Button

Saves the library to a file.

m [OK] Button

Look i [¢3 C/Program Files/YAMAHA/OPT Tools/DME Designer,’

x| 4= ek

(= imaze () UserModule
ChCampiler () Library  [23)Wav
| Designer  |)Splash
I Editor =ur
File type: | User Module Export File kums) = Cancel
Export Library
123uml
Add Library File..

Accepts the changed initial settings and closes the dialog box.

m [Cancel] Button

Closes the dialog box without changing the settings.

Settings in the “User Module Manager” dialog box are changed when you click the [OK] button. If you mistakenly set

security, change the password, or delete a user module, you can click the [Cancel] button to close the dialog box and
return to the original unchanged settings.
Please note that [Import], [Export], [Import Library], and [Export Library] will be applied even if the [Cancel] button is

clicked.
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Chapter 5 Editor Window

Component Editor Window

Component parameters are edited in the component editor. The same component can be placed
multiple times on the same sheet in a Configuration or User Module window. If there are multiple
examples of the same component in a configuration window or user module window, each component
is independent and its parameters are set individually in a separate Component Editor window.

When you double-click on a component located in a Configuration window, the Component Editor
window will open. There is not just one window that is called the component editor. The contents of the
editor and the name on the title bar will differ according to type of component for which the window
was opened.

Names and Functions

The contents of the Component Editor window vary according to the component.

Library ~ Back Button

Title Bar = Sposker, Procassor
Snap T
Graph
Meter
[ON] Button e
Slider
Edit Box
m Title Bar

Displays the label. Label settings are made in the “Component Properties” dialog box. For
information about component labels see “Component” (page 208) in “Objects.”.

m Back Button

This button appears in the child window of windows that have a parent-child relationship, and can
be clicked to return the parent window.
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m Status Bar
Component ID

Matriz Mizer 18 InPut 16 Outrut 1BE1a C271aH»  1AALA

Component Name Parameter ID

Component Name
Displays the component name.

Component ID
Displays the component ID.

When controlling the DME64N/24N by connecting an RS-232C compatible controller to the [REMOTE] terminal, a
component ID is required for distinguishing the same components in the DME64N/24N. The component ID is included in
the signal that controls the component parameters. For details about control methods, contact your nearest Yamaha
representative or the authorized distributor at the end of the DME64N/24N Owner’s Manual.

Parameter 1D
Displays the parameter ID for controls that are being operated.

® Snap

Up to four component editor parameter sets can be recorded temporarily. You can switch between
parameter sets using buttons.

Parameter sets can be copied by dragging and dropping a button onto any other button. Copy can
also be carried out from the contextual menu that appears when a button is right-clicked.

- See "Snap"on page 335

m Library

Saves and recalls component editor parameter sets as files.
- See “Library” on page 337.

The operation of component editor knobs and sliders, etc., can be specified the [Component Editor]
tab of the “Preferences” window in the main panel window. Refer to “Preferences” on page 62
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m Knob

Drag to adjust the parameter.

You can change the way knobs operate, using the [Component Editor] tab - [Knob Mode] setting
in the “Preferences” dialog box.

“Preferences” dialog box
- "Component Editor" tab (page 63)

To make a finer setting, press the <Shift> key while dragging the knob when [Knob Mode] is "Linear".
If you click a knob while pressing the <Ctrl> key, the setting will return to its default value.

m Slider

Slider

Scale

You can change the parameter by dragging the slider.
You can set the action that results from using the mouse on the scale area with [Component Editor]
tab — [Slider Mode] in the “Preferences” dialog box.

“Preferences” dialog box - “Component Editor” tab (page 63)

To make a finer setting, press the <Shift> key while dragging the slider.
If you click a slider while pressing the <Ctrl> key, the setting will return to its default value.
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m Buttons
There are several types of buttons.

e Switches between ON/OFF. When turned on, the button lights up. The color depends on the button’s
function.

When turned ON When turned OFF

¢ |n button sets of this type, you can select one of several buttons. When you do all other buttons in the
set turn off.

e Click here to execute a command.

=% Delay Matrix{6) : CrossPoint...

Click this button

to switch all channels
in the block.

e Displays a menu.

Thru
GdB/Oct
12dBjOct AdjustGe

12dBjOct Butrwrth
12dBjOct Bessel

12dBfOck Linkwitz
18dBfOct Adjustae
18dBfOck Butrwrth
18dBfOct Bessel
24dB{Oct Adjustae
24dB/Oct Butrwrth

i

f

4

i

i

4

i

i

24dBfOct Bessel
24dB{Oct Linkwitz
36dBfOct AdjustGe
36dB/Oct Butrwrth
36dBfOct Bessal
48dB{0ct Adjustse
48dB/Oct Butrwrth
48dBfOct Bessel

i

v 48dBfOct Linkwitz
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¢ Displays another window.

™ Crossover Processor (=] (B ™ Crossover Processor : Compressor(High) E

SnarF

W E

m Edit Box

Displays current values for settings. You can modify values by typing from the keyboard or using
the mouse. When a value is changed, the knob or slider moves.

Mouse-over

When [Edit Box Zoom] in the [Component Editor] tab of the “Preferences” dialog box is checked,
the edit box will zoom when the mouse is positioned over it (mouse-over).

“Preferences” dialog box
- "Component Editor" tab (page 63)

Click

Text in the selected edit box will turn red. Values can be entered and edited via the keyboard. It is
not necessary to enter the unit. Press the <ENTER> key to confirm the entry and display the unit.

Level

)

Changing Values Using Spin Boxes

When the mouse pointer is placed over an edit box, a spin box appears. Clicking the up arrow
button [ A] increases the value, while clicking the down arrow [ ¥] decreases it.
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Double-click

Selects a number. You can change the selected number using the keyboard. There is no need to
enter units. When you press the <Enter> key, the numbers you entered will be set and the units
displayed.

Set the value with
the <Enter> key.

Enter a number from
the keyboard.

Moving with the <Tab> Key
If you press <Tab> key while an edit box is selected, the selection will move to the next edit box.
If you press <Shift> + <Tab>, the selection moves to the previous edit box.

Changing Selections with the Key/Mouse Wheel
You can modify values in selected edit boxes using the direction keys or the mouse wheel.

* Up and Down Arrow Keys
Increases or decreases number settings.

» <PageUp> Key/<PageDown> Key
Increases or decreases number settings in large increments. The <PageUp> key increases
and the <PageDown> key decreases the setting.

* <Enter> Key
When you press the <Enter> key, the numbers you entered will be confirmed.

o <Ctrl> Key + <Enter> Key
When you press the <Ctrl> + <Enter> key, the setting will return to its default value.

* Mouse Wheel
Rolling the mouse wheel upward (away from you) increases the value. Rolling it down
(towards you) decreases the value.
» Dragging
Dragging upward increases the value, while dragging downward decreases it.
* <ESC> Key
The <ESC> key can be used to cancel a value being entered.
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m Graph

Control Point

Displays parameters graphically. When parameters are changed, the graph also changes.

In graphs that have control points, you can adjust parameters by dragging the points. On graphs
with control points that are limited to movement in one direction only, aligning the mouse pointer
with the control point and pressing the mouse button causes the mouse pointer to change to a
double-headed arrow pointing in both directions of movement. Change the parameter by dragging
in the directions of the arrow.

Control points that can be dragged in any direction usually have their position determined by
multiple parameters in the component editor. These multiple parameters can be adjusted by
dragging the point.

When there are multiple control points in the graph, they are identified by their colors. A bar with the
same color as each control point can be found below the corresponding knob or edit box.

When a graph that has control points is copied to the User Control Editor or User Module Editor, the controls points will
not be displayed. The controllers assigned to the corresponding parameters must also be copied to display the control
points.
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User Control Editor/User Module Editor

User Control Editor

The user control function lets you lay out a set of component controls in the Configuration window or
User Module window, and create a control window with them. The controls in the user control editor
are linked to the controls for the original component. If the parameters are changed in the user control
editor, the parameters will change in the same way in the component editor. If parameters are
changed in the component editor, the controls in the user control window will also change in the same
way.

You can create a compact control window by only including controls for parameters that are used
frequently.

You can also lay out controls for multiple components, so that you can adjust parameters for them from
a single window.

User Control Editor Component Editor

™ Master Yolume

Laid Out Controls — e [ R

Controls Laid Out
in the User Control

Edit Palette

There is also a [Library] button in the user control editor, which you can use to save parameters to the
library.

User controls are created by selecting [View] menu — [User Control] — [New User Control] in the
Main Panel window. Created user controls are displayed in the [View] menu — [User Control]
submenu. If you select one, a window will open for it. The controls which can be opened by the user
control editor are automatically set according to the user security settings of the currently logged in
user.
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m [User Control] Menu

User controls are displayed in the [View] - [User Control] submenu of the Main Panel window. If
you click the [User Control] button in the Main Panel window, you will display the same menu as the
[View] menu — [User Control] submenu.

"2 DME Desiener :

@ = . 8
mo @€ 418 'L.“ . ] Zone

Scene i Device Group

Mazter Volume
Mute Rx Tx On-line

d v Navigator Cir+B Mew Uszer Control

User Control Name

Displays a menu of user controls included in the current configuration of the current zone. Clicking
one of the user controls opens the user control editor. A checkmark appears next to already open
windows.

New User Control

When you select the “New User Control” command, the “User Control Manager” dialog box will be
displayed. Here you can create, delete, rename, and otherwise manage user controls. For
information about the “User Control Manager” dialog box, see page 78.
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m Creating New User Controls

New user controls are added in the “User Control Manager” dialog box.

1 click [User Control Manager] on the Main Panel window [Tools] menu.
The “User Control Manager” dialog box will be displayed.

You can also display the “User Control Manager” dialog box by clicking the [View] menu - [User Control] — [New User

Control] command.

2 Click the [New] button.
The “New User Control” dialog box will be displayed.

3 Enter the name for the new user control into the [Name] box.

= User Gontrol Manaeer EI
Uger Control ]Sacurity Level ]Usar J
masier Level 1 Ty
Master Yolume Level 1 R
HNew Delete J [8]4 Cancel
= New User Gontrol IE]

Hame ]|

& User Level

Level 1 x

Uszer MName |
[ Administrator
[ User2

- L] Userl

Cancel

4 sets security for User Control.

Different settings are provided for individual security levels and users.

Security cannot be set higher than the user security level.

Click the [User Level] [ ¥] button to select a security level.

™= New User Gontrol

X

Hame [High Gut

& User Level

User Mame |
[ Administrator
i [ User2
o Usent

Level 1 vi

Cancel
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Use [User Name] to select a user.

22 New. User Gontrol

Hame [High Cut
i User Level m
User Name |
2 Administrator
[ User2
i
oK GCancel

9 Click the [OK] button.
The user control will be created and displayed on the list in the “User Control Manager” dialog box.

™ User Gontrol Manager

User Control | Security Level | User |
High Gut S Administrator, Userl
Mmazter Level 1 o H
Mazter Volume Level 1 s

New ‘ Delete ‘ oK LCancel ‘

6 click the [OK] button in the “User Control Manager” dialog box.

When a new user control is created, it will be displayed in the [View] menu - [User Control]
submenu in the Main Panel window. If you click the control, it will be displayed in a user control
editor window.

[Snap] and [Library] appear appears in a new user control.

Grid: [T0_J5a
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m User Control Security

Security can be set independently for each User Control. User Control levels higher than the user
security level will not be displayed in the menu or the User Control Manager dialog box.

The security level settings for both the user control and the user affect editing and display of user
controls.

m User Control Security Level

Security 1 ~ 10 can be set for each level or user. Level 1 is the highest level and 10 is the lowest.
If the security level for a user control is set to 2, only users at level 1 or level 2 can display or edit it
Security levels for user controls can be changed in the “User Control Manager” dialog box by a
user who has logged on at a security level equal to or higher than the user control.

1 Click [User Control Manager] on the Main Panel window [Tools] menu.
The “User Control Manager” dialog box will be displayed.

2 Changing User Control Security

» To Change the Security level
Click the [Security Level] box of the User Control to be changed.
The security level list will appear.

™= User Gontrol Manager lzl

‘ User Contral {Security Level J Usger
High Cut i Administrator, User

HMew Delete J oK Cancel

The levels displayed on the list will differ according to the security level of the user.

Click the level to be set for the User Control.
The selected level will be displayed in the [Security Level] box.
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 Setting Security for Individual Users
Click the [User] box of the User Control to be changed.
The user list will appear.

™ User Gontrol Manager

Uzer Control | Security Level | User
HighCiut Level 2 R

Mazter Yolume ——-

hame

O Usert
[Prstdministrator

QK

Hew Delete ‘ OF | Cancel

The users that can be selected will depend on the user security level.

Click the user to be set for the User Control.
The selected user name will be displayed in the [User] box.

3 Click the [OK] button.

m User Security Settings

In the “Security” dialog box in the Main Panel window, you can set the user control levels at which
to allow or disallow editing and display.

A user can edit user controls if a check has been placed for that user in the [Operation Security] -
[Edit] checkbox. User controls at a level equal to or lower than the level set in [Operation Security]
- [User Control Level] will be displayed in the menu.

Using user security, you can set whether user controls will open at logon or when a file is opened.
If [Startup User Control] is turned ON, the user control editor will be automatically displayed when
files that include user controls are opened.

For information about the “Security” dialog box, see “Security (Creating Users and Making User
Settings)” on page 70.
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User Module Editor

The user module editor lets you make a layout of controls for components arranged in the user module
window. For each user module there is one user module editor. The name of the user module is
displayed in the title bar. Only components that are arranged in a particular user module can be laid
out in the specific control window that is associated with that user module. Both the user module and
the control window will have the same name.

Refer to “User Modules” on page 285 for more information about user modules.

You can copy controls from a user module to the user control editor.

User Module Editor Component Editor

E Unsaved User Module

Laid Out Controls

L A Controls Laid Out
T in the User Control

Edit Palette

m Opening a User Module Editor Window
In the designer window, the user module editor can be opened by selecting [Open User Module
Editor] from a user module contextual menu. User modules for which [Open User Module Editor] is
selected as the [Double Click Action] in the “User Module Properties” window can be opened by
double clicking. For information about the “User Module Manager” dialog box, see page 290. For
information about the “User Module Properties” dialog box, see page 216.
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Names and Functions

m Status Bar

The lock icon will appear in the User Module when security is active.
- User Module properties (page 216).

- User Module (page 285).

The lock icon will appear locked when the password has not been entered, and layouts edited in the
Design Mode cannot be saved.

K. EQ-Comp

1 UzerModule

When the password is entered it becomes temporarily possible to save the layout.

[ UserModule

The lock icon will not appear if the [Enable Security] checkbox in the “Properties” dialog box is not
checked.

E. EQ-Comp

Snar

Ll ]

UserModule
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m Edit Palette

The edit palette is automatically displayed whenever the user control editor/user module editor is
active in design mode. Whenever you move the user control editor/user module editor, the edit palette
moves together with it. When you turn OFF design mode, the palette disappears.

Commands for editing in the user control editor/user module editor are provided on the edit palette.

[Design Mode Off] Button
[Undo] Button Control Alignment Grid Setting
[Redo] Button

@ B | crid: |00_]5a

[Paste] Button
[Copy] Button
[Cut] Button

m [Design Mode Off] Button
Turns OFF the design mode.

m [Undo] Button/[Redo] Button
Used to undo/redo operations.

m [Cut] Button/[Copy] Button

Cuts or copies the selected controls.
- See “Cut/Copy/Paste Controls” on page 321.

m [Paste] Button

Pastes cut or copied controls.
- See “Cut/Copy/Paste Controls” on page 321.
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m Alignment of Controls
Aligns the positions of multiple controls.

[Picture] Button

[Align Left] Button [TEXT] Button
[Align Right] Button [Box] Button
[Align To Top] Button [Ellipse] Button
[Align To Bottom] Button [Frame] Button

i@ B oM

[Vertical/Center Align] Button
[Horizontal/Center Align] Button

[Align Vertically] Button
[Align Horizontally] Button

[Align Left] Button
Aligns all selected controls with the left edge of the leftmost selected control.

[Align Right] Button
Aligns all selected controls with the right edge of the rightmost selected control.

[Align To Top] Button
Aligns all selected controls with the top edge of the uppermost selected control.

[Align To Bottom] Button
Aligns all selected controls with the bottom edge of the lowermost selected control.

[Align Horizontally] Button

This button can be used only when three or more controls are selected.

It arranges the controls in a uniform horizontal line. Without changing the position of the leftmost
and rightmost control, this button arranges the controls between them at uniform intervals. It puts
the same amount of space between each control and its neighbor.

[Align Vertically] Button

This button can be used only when three or more controls are selected.

It arranges the controls in a uniform vertical line. Without changing the position of the uppermost
and lowermost control, this button arranges the controls between them at uniform intervals. It puts
the same amount of space between each control and its neighbor.

[Horizontal/Center Align] Button
Aligns the selected controls horizontally with the center position.

[Vertical/Center Align] Button
Aligns the selected controls vertically with the center position.
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[Picture] Button
Places a graphic file.

[TEXT] Button
Places a text box.

[Box] Button
Places a square.

[Ellipse] Button
Places an ellipse.

[Frame] Button
Places a frame.

Grid Setting

When arranging controls, you can align them along the grid. This menu sets the spacing of the
grid.

Grid=10 Grid=20

Clicking the [ ¥] button displays a menu. Click the menu to set the grid spacing. Select [OFF] to
turn OFF the grid.

When the grid is turned ON (when any grid item besides OFF is selected), clicking any control that is not aligned with the
grid position, will cause it to align with the nearest grid.

Please note that after copying multiple controls in one operation from the component editor and adjusting their positions
manually, their positions could become disarranged when you select them by clicking on them, if they do not already
align with the grid interval.

Furthermore, if you change the grid spacing after aligning the positions of controls in the user control editor/user module
editor, the controls will be placed into positions that do not align with the grid even if they are arranged using the align
buttons. When there are controls that do not align with the grid, turn the grid OFF.
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Changing the Window Size

In design mode, you can change the window size of the user control editor. If you align the mouse
pointer with a side or corner of the window, its shape will change into a double-headed arrow. When
the arrow is shaped like this, dragging it will change the size of the window.

E. Unsaved lser Module

Snar
‘wEw

Even if you change the width of the window, the library button will remain where it is, in the upper right
corner.
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Setting Background Images for Windows

The default color for the user control editor/user module editor window background is black, the same
as for the component editor window. However, you can change the color or display an image in the
background. These settings are made in the “Background Image” dialog box. To display this dialog
box, right-click in the user control editor window while in design mode, then click [Set Background
Image] on the displayed context menu.

Background Image

—Backgraund Imags

@ {Default!

i Color [ | Select Color... I

" Image Select Image... I
Layout: ICenlel—Ll
T

oK LCancel |

m [Default]

Sets the background color to black, the same as the component editor. Select this if you have set
the background with [Color] or [Image], and you want to return to the original background.

m [Color]

Sets the color of the background. Use the [Select Color] button to select a color.

[Select Color] Button

Clicking here displays the “Select color” dialog box. This sets the color of the background. For
information about the “Select color” dialog box, see page 237.

"= Select color

Easic: colors
HEENNNT
L B 0 0 Il
| B 0§ Il
L B 0§ Ieieip
EEEENTE
EEEENTT

LCustam colars

O O
l—l_i—l_i—l_i—l_ Sat 0O Graenm

Wal 128 Blu IT 28
Define Custom Calors 5> | 2 ==

ok l Cancel I Add to Custom Colors I

Hue = Red:

If you select a light color, it may be difficult to see the grid.
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m [Image]
Displays an image for the background. You can use image files in the following formats: BMP

(.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Use the [Select Image] button to select an
image file.

[Select Image] Button

Clicking here displays the “Select Image” dialog box. Here you can select an image file to be
displayed as the window background.

Select Image E]

Laokin | ) image -] o5 B

My Recent
Documents

=
L
Desktop

£

Iy Documents

by Computer

Iy Network File name: | ﬂ Open |
Places
j Cancel

Files of type: |Images [*.bmp *.png *.xpm *.jpg]

[Layout] Box
This box displays a list where you can select how the image file will be displayed.
* [Center]
Centers the image in the window.
* [Tile]

Displays multiple copies of the image side-by-side until the available space is filled. If the
image file is smaller than the window, it will be displayed repeatedly like tiles on a wall.

o [Fit]
Expands or reduces the size of the image to match the size of the window where it will be
displayed.

[File] Box

Specifies a path for the image file.
Click the [Select Image] button and select an image file. The path will be automatically entered.
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Placing Controls

Controls can be placed when you are in the design mode. You can turn the design mode ON and OFF
by right-clicking in the user control editor/user module editor, or component editor, then clicking the
[Design Mode] command in the context menu that is displayed.

You can place controls by dragging them from the component editor or by using the copy and paste
commands.

Knob Edit Box Text Solid Frame

Slider Buttons Graph [Library]

™ Mas er Volume

B Grid:

Edit Palette

m Selecting Controls
If you click a control in the component editor while in design mode, the control will be selected and
a red frame will be displayed around it. Controls like knobs, sliders, edit boxes, and labels are all
separate objects. Only the item clicked will be selected.

If you hold down the <Ctrl> key while clicking, you can select multiple controls and labels. If you
use <Ctrl> + click on a selected control, it will cancel that control’s selection.

If you position the mouse in an empty location on the sheet and start dragging from there, a frame
will be displayed as the pointer moves. All controls enclosed by that frame will be selected.
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If you drag controls like knobs and sliders, edit boxes and labels that show parameter types, and place them one-by-one
in the user control editor, they must be arranged in the user control editor. If you select multiple items and drag them, you
can copy them as a group into the user control editor, keeping their original arrangement.

When copying multiple controls from a single component editor, if you select all the controls you want copy and drag
them together as a unit, their original positional relationship and tab order will be maintained.

m Placing Controls by Dragging Them (User Control Editor)

You can drag the controls you want to copy from the component editor to the user control editor.

1 Open the component edit window that has the controls you will be placing in the user
control box.

2 Open the user control editor.
User control names are displayed in the [View] - [User Control] submenu in the Main Panel
window Click a user control name to open its window.

3 Right-click in the component editor or the user control editor.
The context menu will be displayed.

4 Click [Design Mode] on the menu.

K Master Wolume

nde
k Module As Master Layout
Peak Hold 3
Level Meter Enable
Close All Editor Windows

Open Parameter Link

Design mode will be turned ON.

5 Drag the controls from the component editor to the user control editor.

™ Master Volume
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Arrange the controls in the user control editor.

=X Master Volume

m Placing Controls by Dragging Them (User Module Editor)

You can drag the controls you want to copy from the component editor window in the user module
to the user module editor.

1 Create a user module, then arrange and connect the components for it.

2 Store the user module by checking [Double Click Action] O [Open User Module Editor]
in the Store dialog box (see “Saving User Modules” on page 285 for details about
storing user modules).

I Save User Module El@

User Madules

EQ-Comp

Double Click Action
@ Open Uzer Module Desien Window
¢~ Open Uzer Module Editor

—Security Settings

¥ Enable Security M

Default Library

| None LJ

User Modules Mame

3 Double-click a user module in the Configuration window.
The user module editor and edit windows for the components arranged in the user module will
be displayed.

4 Right-click in the component editor or user module editor, then click the [Design Mode]
command in the context menu.
Design mode will be turned ON.

5 Drag the controls from the component editor to the user module editor.
Arrange the controls in the user control editor.
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m Placing Controls Using Copy and Paste

Copy the controls in the component editor and paste in the user control editor or user module
editor.

To copy controls in the component editor, press the [Copy] command shortcut keys, <Ctrl> + <C>.
To paste in the user control editor or user module editor, press the [Paste] command shortcut key,
<Ctrl> + <V>, or the [Paste] button on the edit palette.

1 Click on the source component editor window to make it active, then select the control
or controls you want to copy.

2 Press the <C> key while holding down the <Ctrl> key.
The selected controls will be copied to the clipboard.

3 With the target user control editor or user module editor active, press the <V> key while
holding down the <Citrl> key.
You can also paste by clicking the [Paste] button on the edit palette.
The controls will be copied.

AAA (1] AAA_ | | B
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m When You Cannot Copy

Regardless of whether you drag or use copy and paste, you cannot create multiple copies from the
same single component. If you drag controls that are already copied into the user control editor or
user module editor, the mouse pointer will change into the “unavailable” mark (a circle with a
diagonal slash), indicating that you cannot copy.

You can copy more than one component of the same type into the user control editor, as long as
they come from different components located in the configuration or user module.

Controls for components arranged in the configuration can be copied only to the user control

editor.

Controls for components arranged in a user module can be copied to both the user control editor
and the user module.

m Order of Controls

Controls newly pasted in the user control editor will be displayed above any previously pasted
controls they overlap. The tab order for edit boxes will be the order in which they were pasted.

In the component editor, you can select multiple controls using <Ctrl> + click or by dragging. Once controls are copied,
they will be pasted in the order in which they were copied.
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Moving and Aligning Controls

In the user control editor or user module editor, you can move or align copied controls.

m Selecting Controls

In the user control editor or user module editor, controls are selected in the same way as in the
component editor. Click a control to select it, or press <Ctrl> + click to select multiple controls. If
you use <Ctrl> + click on a selected control, it will cancel that control's selection. If you position the
mouse in an empty location in the user control editor or user module editor and start dragging from
there, a frame will be displayed as the pointer moves. All controls enclosed by that frame will be
selected.

A red frame will be drawn around the selected controls.

Moving Controls

Move selected controls by dragging them or by pressing the arrow keys on your keyboard. When
you select multiple controls using <Shift> + click, you can move all of them at the same time.

Dragging

When grid is ON, the upper left of the dragged controls will automatically align with the grid. When
dragging, the coordinates displayed here refer to the upper left corner of the object being
dragged. The “Distance to Right” and “Distance to Bottom” are displayed in pixel units, using the
upper-left of the window as a reference point.

i -:130311 .

When multiple controls are selected and dragged, the coordinates are those of the upper-left
corner of the control where the mouse is aligned.

Arrow Keys

When the grid is ON, the arrow keys move controls a grid unit at a time. When the grid is OFF,
controls are moved one pixel at a time.

Alignment

You can align controls using the following alignment buttons on the edit palette: [Align Left], [Align
Right], [Align To Top], [Align To Bottom], [Align Horizontally], [Align Vertically], [Horizontal/Center
Align], and [Vertical/Center Align].

You can only use the [Align Horizontally] or [Align Vertically] buttons when three or more controls
are selected.
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Cut/Copy/Paste Controls

You can edit controls arranged in the user control editor or user module editor using the [Cut], [Copy],
and [Paste] commands in the edit palette.

m Cut

Cuts controls arranged in the user control editor. Select one or more controls, then press the [Cut]
button on the edit palette

m Copy

Copies controls arranged in the user control editor or user module editor. Select one or more
controls, then press the [Copy] button on the edit palette.

m Paste

Pastes cut or copied controls. Click the [Paste] button on the edit palette. If you cannot paste, the
button color turns pale.

m Delete
Controls can be deleted by selecting them and pressing the <Delete> key.

Undo and Redo Commands During Editing

The [Undo] and [Redo] commands in the main panel window [Edit] menu, and the [Undo] and [Redo]
commands in the editing palette, can be used to undo or redo controller move, size change, or delete
operations.

If you close an editor window, you will no longer be able to undo and redo operations performed there.

Control Properties

A properties dialog box will open when you either double click a controller in the User Control Editor or
User Module Editor, or right-click the controller and select [Properties] from the contextual menu. Here
you can specify a design for the controller.

Multiple properties of the same type can be set at the same time by clicking the controllers while
holding the <Ctrl> key and then opening the properties dialog box.

Edited items are shown in bold text until you either click [OK] or [Cancel].

Sliders have no property settings.
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m “Knob Properties” Dialog Box

When you right-click on a knob, then select [Properties] from the context menu, the “Knob
Properties” dialog box will be displayed. This dialog box sets the size of the knob.

™ Knob Properties

~Knob Size
Sioe Miade B
| Cancel
~Calor

Color: 1 el low i ]

[Size]
Displays a list where you can select the knob size. Select [Large], [Medium], [Small], or [Very
Small].

You can change the size of a knob by dragging one of the marks at the four corners (top, bottom, left, right) of the knob
in the user control editor.

[Color]
Select a color from the list: [White], [Red], [Yellow], [Green], [Blue], or [Violet].

m “Toggle Button Properties” Dialog Box

The Toggle Button Properties dialog box will appear when you either double click the ON/OFF
button or right-click it and select [Properties] from the contextual menu. This sets the text displayed
by the button, along with the color of the button.

" Togele Button Properties

Gaolor: T vellow -
Size: Small371? - Cancs)
~Text: - Q

| ] Mute
| Mute

Text Font..

[Text] box

Enter the text to be displayed by the button. You can set different text for when the button is ON and
for when it is OFF.

[Size]

Select a button size from the list: [Small (37x11)], [Small (51x11], [Medium (74x11)], [Medium
(74x22)], or [Large (111x33)].
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[Color]

Displays a list where you can select the color of the button. If you click the [ ¥], a list of button
colors will be displayed.

@Toggle Button Properties

Color:

Size:

~Text:

—
e [Mute

Text Font..

[Text Font] Button

Sets the font, size and style. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.

m “Radio Button Properties” Dialog Box
The Radio Button Properties dialog box will appear when you either double click a radio button or
right-click it and select [Properties] from the contextual menu. You can set the button's color, size,
and font.

™2 Radio Button Properties

Color: o rellow

“
Size: [SmallETs 1) ~] Conee!

Text: Eﬁle—
Text Font..

[Color]
Select a color from the list: [White], [Red], [Yellow], [Green], [Blue], or [Violet].

[Size]
Select a button size from the list: [Small (37x11)], [Small (44x11], [Medium (75x11)], [Medium
(74x22)], or [Large (111x33)].

[Text] Box
Enter the text to be displayed by the button.

[Text Font] Button

Sets the font, size and style. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 236.
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m “Edit Box Properties” Dialog Box

The Edit Box Properties dialog box will appear when you either double click an edit box or right-
click it and select [Properties] from the contextual menu. Here you can set the edit box size.

[Size]

Select an edit box size from the list: [Large], [Medium], or [Small].

m “Level Meter Properties” Dialog Box

The Level Meter Properties dialog box will appear when you either double click a level meter or
right-click it and select [Properties] from the contextual menu. Here you can specify the number of
meter segments and scale.

[Segment]

Select a number of meter segments from the list: [2], [6], or [60].

[Scale]

Select the type of scale to be displayed beside the meter from the list. This option is only available
when [Segment] is set to 60.

m “Solid Frame Properties” Dialog Box

The Solid Frame Properties dialog box will appear when you right-click a solid frame and select
[Properties] from the contextual menu. Here you can enter the text to be displayed. Here you can
set the frame size and divider location.

"2 Solid Frame Properties

Partition Line

™= Master Yolume

Sub-Partition Line

Frame Size
Width: =
Height: 178 =
Fartition Line -
Direction: Wertical ol
Position:  |175 #Add ] *
Delete
Sub-Partition Line
Position: 160 Add 0 3:
120
100 Delete
Frame Size

The width is set using the [Width] and the height is set using [Height]. The units are pixels.

You can change the size of a frame by dragging one of the marks at the four corners (top, bottom, left, right) of the frame
in the user control editor.
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Partition Line/Sub-Partition Line

Sets partition lines within the frame. [Partition Line] is a long partition line displayed from end to
end, and [Sub-Partition Line] is a short partition line.

* [Direction]
Select the direction of a partition line from the list. [Vertical] inserts a vertical partition line and
[Horizontal] inserts a horizontal partition line. When [None] is select, partition lines are not
displayed.

* [Position]
Displays the currently set line position. Displays the number of pixels from the top of the solid

frame when [Vertical] is selected for the [Direction], and the number of pixels from the left of
the solid frame when [Horizontal] is selected.

You can change the position of a partition line by dragging one of the marks on the line in the user control editor.

 [Add] Button
If you set the position of the partition line in the box on the right and click the [Add] button, the
partition line will be added and displayed in the [Position] list.

* [Delete] Button
Deletes the partition line selected in the [Position] list.

m “Color Frame Properties” Dialog Box

The Color Frame Properties dialog box will appear when you right-click a solid frame and select
[Properties] from the contextual menu. Here you can enter the text to be displayed. Here you can
set the frame size and divider location.

=2 Golor Frame Properties

Frame Size
widh i :
Height: a0 z ﬂ
Line Widths Frame Caolor
Top: 3 EI: . Select Calor..
Left: 3 EI:
Rent o 4
Eottam: i 3: Select Calor..
Arrows
Top Line: Left: | Arrow - Right: | More -
Left Line: Top: | Mone - Eottom: | More -
Right Line: Top: | More - Bottom: | Mone -
Battam Line: Left: | Mone - Right: | Mane x

Frame Size

The width is set using the [Width] and the height is set using [Height]. The units are pixels and the
minimum value is 3.

You can change the size of a frame by dragging one of the marks at the four corners (top, bottom, left, right) of the frame
in the user control editor.
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Line Width
Sets the thickness of the lines at [Top]/[Left]/[Right]/[Bottom]. Set “0” to display no lines.

Frame Color

Sets the color of the color frame.
Click this button to display the “Select color” dialog box. For information about the “Select color”
dialog box, see page 237.

Fill Color

Sets the frame fill color.
Click the [Select Color] button to display the “Select color” dialog box. Refer to “Select Color”
Dialog Box in the Object section on page 237 for information on this dialog box.

Arrows

Specifies the shape of line endpoints (terminals).
The [Left] and [Right] endpoints of [Top Line] and [Bottom Line] lines, and the [Top] and [Bottom]
endpoints of [Left Line] and [Right Line] lines, can be set independently.

None: No endpoint shape.
Arrow: Arrow-shaped endpoint.
Circle: Circle-shaped endpoint.

User Picture Properties Dialog Box

Right-click the image and select [Properties] from the contextual menu to display the User Picture
Properties dialog box.

™ User Picture Properties

-File Path

&
]plcture.]pg
Seleot File. | | _ Carcel |
—Size
Width: a0 S
=
Height: 50 S

W Stretch

Select Component...

[File Path] Box
Displays the path to the graphic file.

[Select File] Button
Selects a graphic file.

Size
 [Width]
Specifies the width in pixels.
* [Height]
Specifies the height in pixels.

* [Reset] Button
Click to display the graphic at it's original size.
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* [Stretch]
When ON, the graphic will be enlarged when a size that is bigger than it's original size is
specified.
[Link Component Editor]

When ON, clicking the [Select Component] button selects the editor that is opened when the
graphic is clicked.

Text Properties Dialog Box

Right-click the text box and select [Properties] from the contextual menu to display the Text
Properties dialog box.

2 Text Properties

-OK
Text: [Text
Cancel
Text Font.. ‘ Text Calar.. ‘
Alienment: ]T_:j
Fotate: a0 vi

[~ Link Component Editar

Mame: Select Component.. ‘

[Text] Box
Displays and edits the text to be displayed.

[Text Font]

Selects the font. Click to display the Select Font dialog box.
Refer to “Select Font” Dialog Box on page 236 for more information on the Select Font dialog box.

[Text Color] Button

Sets the text color. Click to display the Select Color dialog box. For information about the “Select
color” dialog box, see page 237

[Alignment]
Selects [Left], [Center], or [Right] text alignment.

[Rotate]
Rotates the text box.

[Link Component Editor]

When ON, clicking the [Select Component] button selects the editor that is opened when the text
box is clicked.
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m Box Properties Dialog Box
Right-click the box and select [Properties] from the contextual menu to display the Box Properties

dialog box.
= Box Properties
—Box Size !
s :
Heieht:  [50 = Gaice!
Box Style -
Style: Plain v]
[™ Pound Corner
Curye: mm
: Line
Type: | m— Solid |
Size: 2 =
Select Calor..
™ Filline Galar
Select Color..
Box Size
. [Width]
Specifies the width in pixels.
* [Height]
Specifies the height in pixels.
Box Style
. [Style]

Sets the style of the object. Select [Plain], [Raised], or [Sunken] from the list.

e [Round Corner]
Turn ON to produce a round-cornered box. Use [Curve] to select the degree of roundness.

Line
* [Type]
Select a type of frame line from the list: [Solid], [Dash], [Dot], [Dash Dot]. Or [Dash Dot Dot].
* [Size]
Sets the thickness of the frame line in pixels. The range is from 1 to 100.

* [Select Color] Button

Sets the color of the frame line. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 237 for more information on the Select Color
dialog box.

Fill Color
* [Select Color] Button

Sets the frame fill color. Click to display the “Select color” dialog box.

Refer to “Select Color” Dialog Box on page 237 for more information on the Select Color
dialog box.
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m Ellipse Properties Dialog Box

Right-click the ellipse and select [Properties] from the contextual menu to display the Ellipse
Properties dialog box.

e Ellipee Properties

—Ellipze Size - |
Width: 50 =
Height: 50 B Cancel

Line

Twpe: J — Solid - i

Size: 2 =
Select Color..
Select Color..
Ellipse Size
* [Width]
Specifies the width in pixels.
* [Height]
Specifies the height in pixels.
Line
* [Type]
Select a type of frame line from the list: [Solid], [Dash], [Dot], [Dash Dot]. Or [Dash Dot Dot].
* [Size]

Sets the thickness of the frame line in pixels. The range is from 1 to 100.

* [Select Color] Button

Sets the color of the frame line. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 237 for more information on the Select color dialog
box.

Fill Color
Sets the ellipse fill color when ON.

* [Select Color] Button

Sets the ellipse fill color. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 237 for more information on the Select color dialog
box.
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Changing the Tab Order

The tab order for controls is determined by the order in which they were pasted into the user control
editor or user module editor. If you right-click the user control editor or user module editor, you can
check or change the tab order using the [Tab Order] command on the context menu.

If you select the [Tab Order] command, tab order numbers will be displayed at the upper-left of each
edit box. Clicking the displayed numbers changes the order.

1 Right-click in the user control editor or user module editor.
The context menu will be displayed.

v Design Mode
Glose All Editor Windowes

Open Parameter Link

Parameter Link Mode

Set gackground Image.. LN

2 Click [Tab Order] in the context menu.
Numbers for the current tab order are displayed to the upper-left of each edit box.

3 Click the tab order numbers in the order in which you want to set the tab order.

Even if you do not want to change tab order number 1, click all the numbers in the order you desire,
starting from number 1. When you click on each number, it will change to the number that reflects
the order in which it was clicked.

4 once you have finished specifying the order, click somewhere within the window
where there is no tab number.
The tab order numbers will disappear.

The changed tab order will apply the next time DME Designer is started.
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Operation Mode and Design Mode

There are two modes for the user control editor/user module editor and the component editor:
‘operation mode” and “design mode.” In operation mode you adjust parameters, while in design
mode you lay out controls.

You can switch between operation mode and design mode using the context menu that is displayed
when you right-click in the user control editor/user module editor or component editor.

K Unsaved User Module ed User Module

Switches
between
operation mode
and design
mode

The [Design Mode] command switches the design mode between ON and OFF. A checkmark
appears when the design mode is turned ON. If you click in the context menu when the checkmark is
present, design mode will turn OFF, and the edit window will return to operation mode.

Only users for whom the [Operation Security] - [Edit] checkbox in the “Security” dialog box has been checked can turn the
design mode ON.

You can select controls in the component editor so that you can copy them into the user control editor/user module editor.
When you want to select multiple objects, hold down the <Ctrl> key as you click each new object you want to select.
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Context Menu

The context menus that appear when you right-click in a window will differ in operation mode and in
design mode. In design mode, other commands will be added, depending on where you click.

m Operation Mode Context Menu

Some commands that are displayed in the context menus for operation mode will also be
displayed in design mode.

! Pesk Hold 3

Level Meter Enable

Eeak Hold 3

v Level Meter Ensble

Glose All Editor Windows Cloge All Editor Windows

Open Parameter Link Open Parameter Link

[Design Mode]
Switches between design mode and operation mode. When you are in design mode, a checkmark
will appear to the left of the command name.

[Peak Hold]
Turns the peak hold meter ON or OFF and performs a reset. The ON or OFF setting for peak hold
applies to the whole zone.

' Master Wolume

Snar
mE T

Design Mode

v Level Meter Engle

Cloge All Editor Windows

Open Parameter Link

* [On]
When you select this, peak hold is turned ON, and a checkmark appears next to it. If you
select this item while it is checked, peak hold is turned OFF.

* [Reset]
Resets peak hold.

Peak hold is a function that makes it easy to see the maximum signal value by lighting up at the level of the
maximum value as the signal peak comes in.
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[Level Meter Enable]
Specifies whether the level meters will be enabled or disabled.

[Close All Editor Windows]
Closes all component editor windows.

[Open Parameter Link]

Opens the “Parameter Link” window. For information about the Parameter Link window, see
“Parameter Link” (page 81).

The Context Menu Displayed in Design Mode When You Right-Click an Empty
Location

w Detign Mode
Set Uger Modle Az Master Layout
Close Al Editor Windewes

Opeons Paramater Lk

[Tab Order] (User Control Editor and User Module Editor only)

When using user control editors or user module editors, this function displays the order in which
you move through them by pressing the <Tab> key. When you select this command, numbers are
displayed next to the edit boxes. A checkmark appears next to [Tab Order] in the context menu. To
exit tab order settings, click [Tab Order] the context menu or click anywhere besides a tab order
number in the user control editor.

Clicking the displayed numbers changes the order. The numbers are changed in the order that
they are clicked. To exit tab order settings, click [Tab Order] the context menu or click anywhere
besides a tab order number in the user control editor.

- See “Changing the Tab Order” on page 330.

[Set Background Image] (User Control Editor and User Module Editor only)

Sets a background image for a window. Clicking here displays the “Background Image” dialog
box.
- See “Setting Background Images for Windows” on page 313.
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m The Context Menu Displayed in Desigh Mode When You Right-Click a Control

¥ Desien Mode
Set User Module As Master Layaut
Open Original Gomponent Editor
Glose Al Editor Windows

Open Parameter Link
Add Parameter to Parameter Link

Display Crder ’

Properties..

[Open Original Component Editor] (User Control Editor and User Module Editor only)
It opens the component editor for the control you clicked.

[Display Order]
Specifies the vertical display order of the controllers.
It opens the component editor for the control you clicked.

[Properties]
Opens the properties dialog box for the control.
— See “Control Properties” on page 321.

There some controls, such as sliders, that do not display the [Properties] command.

m The contextual menu that appears in when a controller is right-clicked in the
design mode.

[Properties] (User Control Editor & User Module Editor only)
Opens the controller properties window. Refer to “Control Properties” on page 321.
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Snap

The Snap function records parameters for the component editor, user control editor, and user module
editor temporarily. Clicking a button switches the parameter set, setting all parameters in the editor to
the status that existed when the parameters were recorded in the memory. You can record the current
values for parameters. Furthermore, when you recall a library, it is recorded to the Snap button that is
on at that time. For more information about libraries, see “Library” (page 337).

= Crossover Processor

Snar

Snap Buttons o T

m Snap Buttons ([A] through [D])

The Snap buttons allow you to switch between parameter sets. The buttons change in appearance
according to their ON/OFF status and to whether or not there were changes to the parameter set
from when the editor was started.

When there has been no change to the parameter set since the editor was started
When a button is selected it lights up.

ON OFF

When a parameter set that is different than when the editor was started has been recorded
to a button

The color of the button name changes on buttons for which the parameter set has changed. When
a button is selected it lights up.

ON OFF
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m Recording Parameter Sets

Recording parameters from the current window

The parameters present when the snap button is switched are recorded to the snap button before
the switch.

1 Click the snap button ([A] through [D]) that will record the parameter set. This turns it
ON.

2 Set the parameters in the editor to the settings you want to record.

3 Click another snap button.

Recalling a Library
1 Click the snap button that has recorded the parameter set. This turns it ON.

2 The library is recalled.

Switching Parameter Set

If you click a snap button that has a parameter set recorded, the system switches to the parameter
set recorded there.

Copying Parameter Sets
Parameter sets can be copied between snap buttons [A]~[D].
e Select from the contextual menu.

¢ Drag and drop.
Drag-and-drop copy will also work between components of the same type.
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Library

Component editor, user control editor, and user module editor parameters can be saved as library
files. By reading back a saved library file, you can reset all the editor parameters to the status they had
when the file was saved. Saving in a library file is called “storing,” while bringing back the settings is
called “recalling” them.

Library files have the following file name extensions: “.cel” for component editors, “.ucl” for user
control editors, and “.uml” for user module editors.

[Store Library] Button
[Recall Library] Button

= Compressor

[Recall Library]
Menu

If you store library files in folders that conform to the following path, they will be automatically
displayed in the component editor [Recall Library] menu: “C:\Program Files\YAMAHA\OPT Tools\DME
Designer\Editor\Library\Component Group Name\Component Name.”

The dialog box used for storing items in the library opens with the library folder displayed.

Store @
Save in: | I Programmable LFF Stersa «KJ & % -
) “y My Recant Documents &
T Desktop
:a -
Iy Recent = :y Eocumtents
Documents -J 4 LompLter
. A 3% Flappy (8]
f “ee HAMINZO000 JP (C:)
Doek “ae HAMWANKPAIP (D)
esklop e HAWIP/ENG (E:]
1) Program Files
.,7 1) YakaHA
1) OPT Tools
My Documents ) DME Designer
- I Library
:135 | Programmablel PF
[S}Froorammable LPF Stereof
T Y —
i | -
My Metwork File name: - Save |
Flaces
Save as type: |L|hra|y File [".cel] ﬂ Cancel

If you save like this without changing the folder, the item you saved will be displayed on the [Recall
Library] menu. When a library is saved, it can be displayed in the component editor for other project
files besides the currently open one, and also in new project files.
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If you change the [Contents Folder] in the “Preferences” dialog box in the Main Panel window, a “Library” folder will be

created in the specified folder, and a folder for each component will be created there.

In the “Save Library File” dialog box, you can specify another folder for saving library files, and save them there. Library files

that are saved in another folder also can be recalled by specifying the folder.

m Library Filenames

Because the library filenames are displayed in the [Recall Library] menu, use a filename that helps
you understand the contents of the parameter set in the file. When saving in the default folder, there
is no need to include the component name in the filename.

For example, when you are storing a parameter set in the stereo compressor library, the “Save
Library File” dialog will be displayed with the “C:\Program Files\YAMAHA\OPT Tools\DME
Designer\Editor\Library\Compressor\Compressor Stereo” folder selected. If you save in that folder,
the file you save will be displayed only in the [Recall Library” menu for stereo compressor
components only. It will not be displayed in any other library.

If you use a filename that makes it easy to understand the parameter contents or the conditions
under which they are used, you can select them without confusion when recalling.

Storing in the Library

The library is the place to store component editor parameters.

m Editor Window

1 Set the parameters to be stored in the library.

2 Click the [Store Library] button in the component editor.
The “Save Library File” dialog box will be displayed.

3 Enter the filename.
Select a filename that makes it easy to understand the contents of the parameter set.

4 Specify the folder for saving the file.
If you want the saved file displayed on the [Recall Library] menu, do not change the folder for
saving.

D Click the [Save] button.

Designer Window

Right-click a component or user module in the Designer window to show the contextual menu. Use
the [Store Component Library] command to store the library.

The menu that appears when the contextual menu [Store Component Library] command is clicked
is the same as the menu that appears when the Edit window [Store Library] button is clicked.
Specify a file name and save the file.
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Recalling a Library

The recall function reads stored parameters into the component editor.

m Editor Windows

You can recall libraries in the component editor, user control editor, and user module editor
windows by clicking the [Recall Library] button. When a library is recalled in an editor window, the
parameter set is recorded to the selected snap button.

1 Click the snap button ([A] through [D]) that will record the parameter set.

2 Click the [Recall Library] button in the component editor.
The [Recall Library] menu will be displayed.

3 Click the library name (filename) in the [Recall Library] menu.
The parameters in the library will be recalled.

m Designer Window

If you right-click on a component or user module in the design window, a context menu will be
displayed. You can recall a library using the [Recall Component Library] command.

If you click [Recall Component Library] in the context menu, the same menu is displayed as when
you click the [Recall Library] button in the editor window. If you select a library that is displayed in
the submenu, that library is recalled.

% Testcel S
Cpen File Dialoe...

Not only the library name, but also the effect type is displayed in the submenu that appears when
you right-click on an SPX component.

P T i phnee GEsen mmes e o pa bl

Feverb Hall ap - % Bl i T N s e i L

N1 oo AR A L e R R e 02 Reverb Room

D™ .. o ot e o T Rl T

03 Reverb Stage

04 Reverb Plate

05 Early Ref,
» %

. S n. Y W e . W S 36 Delay

37 Delay -» ER.

35 Delay + Reverb
39 Delay - Reverb
....................... m 40 Distortian - > Delay

Ll STRCK  ASIVE G B T oo File Dislog., L MU Filer

42 Steren Reverb
43 M. Band Dyna.
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m Recalling a Library Stored in a Folder Other Than the Default

Libraries not stored in the default folder do not appear on the [Recall Library] menu. You must
specify the file you want in order to recall it.

1 Click the [Recall Library] button in the component editor.
The [Recall Library] menu will be displayed.

2 Click the [Recall Library] menu [Open File Dialog].
The “Open” dialog box will be displayed.

Open E

Look in: |@ Comprezsor Stereo ﬂ ¥ '

My Fecent
Documents

f

Desktop

¥

Iy Documents

El

=

tdy Computer

Eﬁ

Iy Metwork File: name: | ﬂ Open |
Flaces
Filas of type: |Libra|y File[* o) j Cancel

3 Move to the correct folder and select a library file.

4 Click the [Open] button.
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Creating Parameter Links

You can group controls (parameters) and link their parameters. You can create parameter link groups
and add controls to them in the component editor. Parameter link settings are made in the Parameter
Link window. For information about parameter links and the Parameter Link window, see “Parameter
Link” (page 81).

A parameter can belong to one group only. Furthermore, only parameters of the same type can be grouped.

m Creating Parameter Links

If you right-click on a control, a context menu will be displayed.
The [Add Parameter to Parameter Link] - [Global Link]/[Local Link] — [Add Group] commands
create new groups. Controls can be added by right-clicking.

m Adding Controls to a Group

If you right-click a control in the component editor, a context menu will be displayed. You can
create groups or add controls using commands in the [Add Parameter to Parameter Link]
submenu. Groups that do not have the same type of parameters will be grayed out and cannot be
selected.

Global Link

The group names for global link groups are displayed in the [Global Link] submenu. When you
click a group name, a control is added to the group.
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Local Link

The group names for local like groups are displayed in the [Local Link] submenu. When you click a
group name, a control is added to the group.

m Adding Multiple Controls

You can select multiple controls in Design Mode. When multiple controls are selected, multiple
parameters can be added to a group simultaneously.

Creating Component Links

The same types of parameters can be linked between the same types of component included in a
group. Component groups can be created using the component editor, and components can be
added to the group as required. Parameter linking is set up via the Parameter Link window. Refer to
“Parameter Link” on page 81 for information on the Component Link/Parameter Link window.

SPX components and SP2060 units do not support component linking.

m Creating a New Group

Right-click a component in the component editor to display the contextual menu. [Add Component to
Component Link] - [Add Group] creates a new group.

Design Mode
Pk Hold

Clerem Al Ecber Warndowrs:
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m Add Components to a Group

Right-click a component in the component editor to display the contextual menu. [Add Component to
Component Link] - [group name] adds to an existing group. Groups that are not of the same type will
be grayed out and cannot be selected.
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Types of Components

Component Groups

When the Configuration window and User Module window are made active, a component list is
displayed in the Toolkit window, and you can use the [Component List] on the [Tools] menu.
Components can be separated into groups based on types. In the Toolkit window, component groups
are displayed as folders. Some of the groups in the Toolkit window are further divided into subgroups.
Click the [+]/[-] buttons to the left of the folders to display the components.

| - EiCrozzover
+-E1Croggover Processor
+-E1Crozgover Processorll

+-EiLong
Group (- E1Short )
§53 1RDIT —
-2 Output
-- 33 Output
-3 4 Dutput
-- 35 Dutput
-- 36 Dutput
-7 Output
-- 38 Output

[=-EDynamics
&j--DCnmpander
=B Compressar
- EMono
L. Steren
E-EDe-Esser
- EMono
L. Steren
E-EDucker

- EMono

L. FSteren
+- B Expander

Component

When the User Module window is active, [User Module] is not present on the menu.
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In the Designer window [Tools] menu — [Component List] menu, component groups are displayed as

submenu items.

The items with small rightward-facing triangles are groups. Those without triangles are components.

i Designer

frsia Parts List

Zone Manager..

Device Group Manager.

Crossover
Crossover Processor

Crossover Processorll

Gonfiguration Manager... GrOUp
Sawve Uszer Module.. [wnamics 1 Output \
Uzer Module Manaeer.. EQ 2 Output
[ show Sisna) Delay Fader 3 Output
B Fteedback Suppreszor i Outzut
WE Probe Monitor ::tjr 5 Output Component
Manitor ing Faint List - 8.0umet
8 7 Output
dit Mode f:\xer & Output
Sheet,. an
Prohibit Diaganal Connectiors Rauter
Grid Source Selector
;rmw Speaker Processor
Ean " SPX
Picture
Export DXF... Test
Preferences. Box
Ellipze
NOTE
When the User Module window is active, [User Module] is not present in the menu.
Component List
DMESI-C/
Group P DME64N | DME24N | DME80-C/ | SP2060
DEMd4io
Crossover 2 Way a 0 0
3 Way 0 0 0
4 Way a 0 0
5 Way a O 0
6 Way a 0 0
Crossover Processor 2 Way 0 0 0
3 Way a 0 0
4 Way a O 0
5 Way a 0 0
6 Way 0 0 0
Crossover Processor |l 2 Way a O 0
3 Way a O 0
4 Way g g 0
5 Way 0 0 0
6 Way a 0 0
Delay Long 1 Output O O O 0 ()
2 Output a 0 0
3 Output a 0 0
4 Output a O 0
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Group

Component
Variations

DMEG64N

DME24N

DMESI-C/
DME8o-C/
DEM4io

SP2060

Delay

Long

5 Output

O

6 Output

7 Output

8 Output

Short

1 Output

2 Output

3 Output

4 Output

5 Output

6 Output

7 Output

8 Output

Dynamics

Compander

CompanderH

Mono

Stereo

CompanderS

Mono

Stereo

Compressor

Mono

Stereo

De-Esser

Mono

Stereo

Ducking

Mono

Stereo

Expander

Mono

Stereo

Gate

Mono

Stereo

Limiter

Mono

Stereo

EQ

GEQ

Mono

7 Band

15 Band

31 Band

Stereo

7 Band

15 Band

31 Band

PEQ

Mono

2 Band

3 Band

4 Band

6 Band

I I v e I v I A A |

o I e A e e I e e A |

o e A e e e A e A e A I

8 Band

O

O

O

Stereo

2 Band

O

O

O

3 Band
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Group

Component
Variations

DMEG64N

DME24N

DMESI-C/
DME8o-C/
DEM4io

SP2060

EQ

PEQ Stereo

4 Band

O

6 Band

8 Band

Fader

1 Channel

2 Channel

4 Channel

8 Channel

12 Channel

16 Channel

g|lo|jo|jgjo|o|g|g

Feedback Suppressor

Filter

BPF

Mono

Stereo

HPF

Mono

Stereo

LPF

Mono

Stereo

Notch

Mono

Stereo

Programmable BPF

Mono

Stereo

Programmable HPF

Mono

Stereo

Programmable LPF

Mono

Stereo

Meter

1 Channel

2 Channel

4 Channel

8 Channel

12 Channel

16 Channel

Miscellaneous

Oscillator

Mono

Wav File Player

Mixer

Auto Mixer

2 Channel

4 Channel

8 Channel

12 Channel

16 Channel

Delay Matrix | 2 Input

2 Output

4 Qutput

8 Output

12 Output

e A e I e A A v I A |

e e e I A |

g|o|jog|jgjo|jo|jgjg|o|jojg|lo|ojgjg|o|ojg|lo|o|jg|lg|o|o|jg|lo|lo|jg|g|o| g
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Group

Component
Variations

DMEG64N

DME24N

DMESI-C/
DME8o-C/
DEM4io

SP2060

Mixer

Delay Matrix

2 Input

16 Output

O

4 Input

2 Output

4 Qutput

8 Output

12 Output

16 Output

8 Input

2 Output

4 Output

8 Output

12 Output

16 Output

Matrix Mixer

2 Input

1 Output

2 Output

4 Input

1 Output

2 Output

4 Output

8 Input

1 Output

2 Output

4 Qutput

8 Output

12 Input

1 Output

2 Output

4 Qutput

8 Output

12 Output

16 Input

1 Output

2 Output

4 Output

8 Output

12 Output

16 Output

32 Input

16 Output

32 Output

I e I e e v A v

e e e e A e e e e e A I A I

64 Input

32 Output

64 Output

Pan

LCR

1 Channel

2 Channel

4 Channel

8 Channel

12 Channel

16 Channel

e A e I e A A v I A |

o|lo|jo|jg|lo|o

o|lo|o|g|lo|o
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Group

Component
Variations

DMEG64N

DME24N

DMESI-C/
DME8o-C/
DEM4io

SP2060

Pan

LR

1 Channel

O

2 Channel

4 Channel

8 Channel

12 Channel

16 Channel

Surround

3-1

5.1

6.1

Router

1 Input

2 Output

4 Qutput

8 Output

12 Output

16 Output

2 Input

2 Output

4 Output

8 Output

12 Output

16 Output

4 Input

2 Output

4 Output

8 Output

12 Output

16 Output

8 Input

2 Output

4 Output

8 Output

12 Output

16 Output

12 Input

2 Output

4 Qutput

8 Output

12 Output

16 Output

16 Input

2 Output

4 Output

8 Output

12 Output

16 Output

I I I A e A I I I |

I e e I e A e I o I |

o e e e e e A e e A A e e e s I I A |

Source Selector

3 Position

1 Channel

O

O

O

o)

4 Position

1 Channel
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Component e
Group np DMEG64N DME24N DME80-C/ | SP2060
Variations .
DEMd4io
Source Selector 4 Position 2 Channel O O 0
6 Channel a O 0
8 Position 1 Channel a O 0
2 Channel a O 0
6 Channel O O 0
16 Position 1 Channel a O 0
*
Speaker Processor 1 Way 0 0 0 ae)
*
2 Way 0 0 0 ae)
*
3 Way 0 0 0 o)
*
4 Way 0 0 0 ae
*
5 Way 0 0 0 o)
*
6 Way 0 0 0 o)
SPX ad a
Slot Slot In Component
Editor . . .
Slot Out
Component Editor - . .
Cascade Cascade In o)
Component Editor
Cascade Out )]
Component Editor
Analog Input/Output Analog Input ae o)
Component Editor
Analog Output o) ac)
Component Editor
SP2060 Input/Output SP2060 Input 0e)
Component Editor
SP2060 Output o)
Component Editor
CobraNet Input/Output CobraNet Input 0(%)
Component Editor
CobraNet Output o)
Component Editor
MY-Card Component Editor 0 0
of each card
Remote Controlled Head Amp Component Editor 0 0 0

of each device

(*) Parameter edit only
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Crossover

Separates input signals into multiple frequency channels and outputs them. The following five types of
components are available in the Crossover group: 2 Way, 3 Way, 4 Way, 5 Way, and 6 Way.
Crossover components have a single input and multiple outputs.

© Crossover o Crossoven(2) 0 0 Crossover(3) 0 0 Crossoven(d) - - Crossover(S)
2ifay LT [ 4y | 5Wiay . [ EWay
M1 HIGHLT - [1IN1 HIGHLT - C1IN1 HIGHLT - [1IN1 HIGHLT - C1IN1 HIGH
Lo ] - MIDL] - HIGH-MIDL] - HIGH-MID L] - HIGH-MID
2% LOw L= b 1L L= I O MIC
1 - 3% g Lo ] - LOww L= b 10
........... o 3% 4 SUB-LOW L
..................... . 51 SuB-Lowy
5%

Double-click a component to display the component editor for it.

Crossover component

e rossover

DME Designer Owner’s Manual

351



Chapter 6 Component Guide

Name Function

@ | Crossover Curve Displays the level of each frequency band,

distinguished by color.
Section Parameter Setting Range Function

® | Input Level -0 to +10 dB Sets the input signal level.

©® | Output Level -0 to =0 dB Sets the output signal level for each
frequency band.

(4) Mute ON/OFF Mutes the output signal level for each
frequency band.

(5) Phase ON/OFF Reverses the phase of the output signal for
each frequency band.

O | Frequency 20 Hz to 20 kHz Sets the cross frequency between each
frequency band.

@ |LPF Type Thru Sets the attenuation for each octave and the

6 dB/Oct filter type.
12 dB/Oct AdjustGe [THRU] turns off the filter.
12 dB/Oct Butrwrth

12 dB/Oct Bessel

12 dB/Oct Linkwitz

18 dB/Oct AdjustGc

18 dB/Oct Butrwrth

18 dB/Oct Bessel

24 dB/Oct AdjustGe

24 dB/Oct Butrwrth

24 dB/Oct Bessel

24 dB/Oct Linkwitz

36 dB/Oct AdjustGe

36 dB/Oct Butrwrth

36 dB/Oct Bessel

48 dB/Oct AdjustGe

48 dB/Oct Butrwrth

48 dB/Oct Bessel

48 dB/Oct Linkwitz

(8] Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency.

(9] Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gce) is selected
for [Type], this sets the gain for the cutoff
frequency.

® | HPF Type Thru Sets the attenuation for each octave and the

6 dB/Oct filter type.
12 dB/Oct AdjustGe [THRU] turns off the filter.
12 dB/Oct Butrwrth

12 dB/Oct Bessel

12 dB/Oct Linkwitz

18 dB/Oct AdjustGe

18 dB/Oct Butrwrth

18 dB/Oct Bessel

24 dB/Oct AdjustGe

24 dB/Oct Butrwrth

24 dB/Oct Bessel

24 dB/Oct Linkwitz

36 dB/Oct AdjustGe

36 dB/Oct Butrwrth

36 dB/Oct Bessel

48 dB/Oct AdjustGe

48 dB/Oct Butrwrth

48 dB/Oct Bessel

48 dB/Oct Linkwitz

(11] Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency.

(12) Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gce) is selected
for [Type], this sets the gain for the cutoff
frequency.
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The number of output channels varies according to the component variation.

2 Way Low/High

3 Way Low/Mid/High

4 Way Low/Low-Mid/High-Mid/High

5 Way Sub-Low/Low/Low-Mid/High-Mid/High

6 Way Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Set the attenuation curve for the lowest band and the middle bands with the Low Pass Filter (LPF) and
High Pass Filter (HPF), and the highest band with HPF. Each frequency band has its own color, with
Low being red, Mid being green, and so on. These correspond to the colors of the lines on the graph.

m Graphic Control Points

The graph control points show [Output Level] and [Frequency]. As you modify the parameters
using the knobs and edit boxes, the control points move. Also, as you drag the points, the [Output
Level] and [Frequency] parameters reflect the changes you make.

™= Crossover

You can adjust the [Output Level] parameter by vertically dragging the control point in the center of
each curve.

Changing the [Output Level] Parameter

You can adjust the [Frequency] parameter by horizontally dragging the control point at the
intersection of the curves for each frequency band.
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(: (:

Changing the [Frequency] Parmeter

m LFP/HPF
[Type] sets the attenuation slope and the filter type for the LPF and HPF. The selected items are
displayed on the buttons. Clicking these buttons displays a menu. Combinations of six slope types
and four filter types are available. [6dB/Oct], [12dB/Oct], [18dB/Oct], [24dB/Oct], [36dB/Oct], and
[48dB/Oct] set the attenuation per octave. A low value produces gentle attenuation. A large value
produces sudden attenuation.

Type

"= Crossover

Thru
edBOct
12dB/0ct AdjustGe
12dB/Ock Butrwrth
12dB/Ock Bessel
12dE)Oct Linkwitz
15dE)Oct Adjustiac
™20 el £ el - o = 15dBJOct Butrwrth
Input. i Hish-Hid 18dB/Oct Bessel
24dBj0ct AdjustGe
24dBj0ct Butrwrth
24dBjOct Bessel
24dBjiOck Linkwitz
36dEjOct AdjustGe
36dB/Ock Butrwrth
36dB/Oct Bessel
48dEjOct AdjustGe
48dE/Oct Butrwrth
45dBjOct Bessel
[ v 48dB{Oct Linkwitz

* THRU
No filter is applied. There is no attenuation, which produces a level line at all frequencies.

» AdjustGc (Adjustable Gc)
With this setting, you can adjust Gc (gain on the cutoff frequency) between -6 dB and +6 dB.
If you set -3 dB it becomes a Butterworth filter. If you set -6 dB, it becomes Linkwitz-Riley filter.
When you select Adjustable Gc, the Gc knob is displayed.

* Butrwrth (Butterworth)
This filter has the most general characteristics. The pass band is flat and the gain for the
cutoff frequency is -3 dB.
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» Bessel
For curves where phase characteristics are important, Bessel has gentler attenuation than
Butterworth, and there is little distortion of the waveform when square waves are passed
through.

¢ Linkwitz (Linkwitz-Riley)
As second-order filters, the sum of the output voltages for LPF and HPF have a gain of O dB
across the entire band. The pass band is flat, but the cutoff frequency gain is -6 dB.

Butterworth

Linkwitz-Riley EGSSGI

DME Designer Owner’'s Manual 355



Chapter 6 Component Guide

Crossover Processor

A crossover processor consists of a crossover, delay, parametric equalizer, and compressor. After the
input signal is processed by the crossover, effects of the delay, parametric equalizer, and compressor
are applied to each frequency band. The following two types are available in the Crossover Processor
group: Crossover Processor and Crossover Processor |l.

Crossover Processor

The following five types of components are available in the Crossover Processor group: 2 Way, 3 Way,
4 Way, 5 Way, and 6 Way. Crossover processors have a single input and 2 to 6 outputs.

© Crossover Processor Crossover Processor(2) Crossover Processor(3) Crossover Processor(4) Crossover Processor(5)

Double-click a component to display the component editor for it. Band numbers may vary depending
on the component, but they share a common configuration in the component editor.

If you click the [Crossover], [Compressor], [PEQ], or [Delay] button in the [Navigator] section, an
editor for the crossover, compressor, parametric equalizer, or delay will be displayed in a separate
window. A separate component editor will open for each output channel (such as Low or Mid) when

you click on the compressor, parametric equalizer, or delay.

Snar

L i ol

Component editor for Crossover Processor

Section Parameter Setting Range Function

© | Navigator Crossover - This opens the crossover editor window.

(2] Delay -- This opens the delay editor window.

(3) PEQ - This opens the parametric equalizer editor
window.

(4] Compressor -- This opens the compressor editor window.

O | Input Level -0 to +10 dB Sets the input signal level.

O | Output Level -0 to +10 dB Sets the output signal level for each
frequency band.

(7) Mute ON/OFF Mutes the signal for each frequency band.

(8] Phase ON/OFF Reverses the phase of the output signal for
each frequency band.

356 DME Designer Owner’s Manual




Chapter 6 Component Guide

The output number varies according to the component variation.

2 Way Low/High

3 Way Low/Mid/High

4 Way Low/Low-Mid/High-Mid/High

5 Way Sub-Low/Low/Low-Mid/High-Mid/High

6 Way Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Set the attenuation curve for the lowest band and the middle bands with the Low Pass Filter (LPF) and
High Pass Filter (HPF), and the highest band with HPF. Each frequency band has its own color, with
Low being red, Mid being green, and so on. These correspond to the colors of the lines on the graph.

m Crossover

When you click the [Crossover] button for the crossover processor, it opens the crossover editor
window.

[Crossover Processor-Crossover] editor window

= Grossover Processor - Grossoverd

— it

Hizh-Mid

DME Designer Owner’s Manual

357



Chapter 6 Component Guide

358

Name

Function

@ | Crossover Curve

Displays the level of each frequency channel,
distinguished by color.

Section

Parameter

Setting Range

Function

® | Frequency

20 Hz to 20 kHz

Sets the cross frequency between each
frequency band.

© |LPF

® 0

Type

Thru

6 dB/Oct

12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

O |HPF

09

Type

Thru

6 dB/Oct

12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.
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m Delay

When you click the [Delay] button for the crossover processor, it opens the delay editor window.
Here you can set the delay for each frequency band.

[Crossover Processor - Delay] editor window

= Crossover Process... |:]|E|®
F = g

Parameter Setting Range Function

© | Delay ms: 0 to 500 Sets the delay time.
Sample: the range
depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends
on the Frame value.
Beat: the range depends
on the Beat value.

O |Level -0 to £0 dB Sets the output signal level for each channel

® |On ON/OFF Turns delay ON.

O | Mute ON/OFF Mutes the signal for each frequency band.

© | Delay Scale ms Selects the units for setting the delay time. The
Sample selected button will light up, and the units in the [Delay]
Meter edit box will change.
Feet If [Beat] is selected, use the knob to set the BPM
Frame (beats/minute).
Beat

Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 81 for information on parameter

linking.
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m Parametric Equalizer

When you click [PEQ] button for the crossover processor, it opens the parametric equalizer editor
window. Here you can make parametric equalizer settings for each frequency band.

[Crossover Processor-PEQ] editor window

& Crossoyer Processor : PEQ{High)

Name Function
© |PEQCurve Displays the PEQ curve.
Parameter Setting Range Function
O | Type PEQ Select the filter type from a menu.

L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct

HPF
LPF
0 Q 0.1t0 16.0 Sets the frequency band width for each band.
O | Frequency 20 Hz to 20 kHz Sets the frequency for each band.
O | Gain -18 dBto +18 dB Sets the gain for each band.
@ | Bypass ON/OFF Turns ON bypass for each band.
© |PEQOn ON/OFF Turns the PEQ ON.
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m Compressor

When you click the [Compressor] button for the crossover processor, it opens the compressor
editor window. Here you can make compressor settings for each frequency band.

[Crossover Processor-Compressor] editor window

= Grossover Processor : Gompressor(H... |S|E|E]

o
Name Function
© | Compressor Curve Displays results graphically. The horizontal axis is the
input signal level, and the vertical axis is the output
level.
® | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to +0 dB Sets the threshold value.
© | Ratio 1:1 10 c0:1 Sets the compression ratio.
0O | Knee HARD, 1,2, 3,4,5 Sets the way compression is applied.
© | Attack 0to 120 ms Sets the attack time.
O | Release 441 kHz: 6 msto 46 s Sets the release time.
48 kHz: 5msto 423 s The setting range may very, depending on the
88.2 kHz: 3 msto 23 s operating frequency.
96 kHz: 3msto21.1s
© | Gain +0 dBto +18 dB Sets the output gain.
® |On ON/OFF Turns the compressor ON. When you turn this button
OFF, the compressor is bypassed.
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Crossover Processor Il

The following five types of components are available in the Crossover Processor Il group: 2 Way, 3
Way, 4 Way, 5 Way, and 6 Way. Crossover processor |l components have a single input and 2 to 6
outputs.

© Crossover Processor b Crossover Processor I(2) Crossover Processor I3 Crossover Processor 4 Crossover Processaor IS

L [Ty L [ 3Ry

- [N HIGHL] - - - [1IN1 HIGH
] Lol - - - M0
. A%, Coe Ly
] Ead] 5%

Double-click a component to display the component editor for it. The number of bands may vary
depending on the component, but they share a common configuration in the component editor.

There are input and output level meters in the upper part of the window. If you click the [Crossover],
[Delay], [PEQ], or [Compressor] button in the [Navigator] section, an editor for the crossover, delay,
parametric equalizer, or compressor will be displayed in a separate window. A separate component

editor will open for each output channel (such as Low or Mid) when you click on the delay, parametric

equalizer, or compressor.

Crossover Processor Il

= Crossover, Processor 1

High-Mid

4 te [EIEE]

Delas
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Name Function
© | Input Meter Displays the input signal level.
©® | Output Meter Displays the output signal level.
Section Parameter Setting Range Function
©® | Input Gain -0 to +10 dB Sets the input signal level.
(4] Mute ON/OFF Mutes the input signal.
© | Output Gain -0 to +10 dB Sets the output signal level for each
frequency band.
(6] Mute ON/OFF Mutes the output signal for each frequency
band.
@ | Navigator Crossover - This opens the crossover editor window.
(8] Delay -- This opens the delay editor window.
(9] PEQ - This opens the parametric equalizer editor
window.
(10) Compressor -- This opens the compressor editor window.
Crossover
When you click the [Crossover] button for the crossover processor, it opens the crossover editor

window.

Crossover Processor Il component editor

= Crossover Processor I1: Crossoverd

R
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Name Function
@ | Crossover Curve Displays the level of each frequency band,
distinguished by color.
Section Parameter Setting Range Function
® | Frequency 20 Hz to 20 kHz Sets the cross frequency between each
frequency band.
©® | Polarity Normal/Inverted Reverses the output signal phase for each
frequency band.
O | Mute ON/OFF Mutes the signal for each frequency band.
This is linked to the Mute setting in the
original window. The display appears as a
dotted line when muted.
O |LPF Type Thru Sets the attenuation for each octave and the
6 dB/Oct filter type.
12 dB/Oct AdjustGc | [THRU] turns off the filter.
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz
(6) Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency.
(7) Ge -6 dBto 6 dB When [Adjustable Gc] is selected for [Type],
this sets the gain for the cutoff frequency.
O |HPF Type Thru Sets the attenuation for each octave and the
6 dB/Oct filter type.
12 dB/Oct AdjustGe | [THRU] turns off the filter.
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz
(o] Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency.
(10) Gce -6 dBto 6 dB When [Adjustable Gc] is selected for [Type],
this sets the gain for the cutoff frequency.

DME Designer Owner’s Manual




Chapter 6 Component Guide

m Delay

When you click the [Delay] button for the crossover processor, it opens the delay editor window.
Here you can set the delay for each frequency band.

. = Crossover Process .. |Z]|E|EJ

=

[mz]

Delay

Parameter Setting Range Function

© | Delay ms: 0 to 500 Sets the delay time.
Sample: the range depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends on the Frame value.
Beat: the range depends on the Beat value.

@ | Level -00 t0 +0 dB Sets the output signal level for each

channel.

® |On ON/OFF Turns delay ON.

O | Delay Scale ms Selects the units for setting the delay
Sample time. The selected button will light up,
Meter and the units in the [Delay] edit box
Feet will change.
Frame If [Beat] is selected, use the knob to
Beat set the BPM (beats/minute).

Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 81 for information on parameter

linking.
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m Parametric Equalizer

When you click the [PEQ] button for the crossover processor, it opens the parametric equalizer
editor window. Here you can make parametric equalizer settings for each frequency band.

= Crossover Processor - PEQ(High}

Name Function

© | PEQCurve Displays the PEQ curve.
Parameter Setting Range Function

O | Type PEQ Select the filter type from the menu.

L.SHELF 6 dB/Oct

L.SHELF 12 dB/Oct

H.SHELF 6 dB/Oct

H.SHELF 12 dB/Oct

HPF

LPF
® [Q 0.11t016.0 Sets the band width of each band.
O | Frequency 20 Hz to 20 kHz Sets the frequency of each band.
O | Gan -18 dBto +18 dB Sets the frequency gain for each band.
O | Bypass ON/OFF Turns ON bypass for each band.
© |PEQOn ON/OFF Turn the PEQ ON.
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Compressor

When you click the [Compressor] button for the crossover processor, it opens the compressor
editor window. Here you can make compressor settings for each frequency band.

Chapter 6 Component Guide

213 10
Name Function
© | Compressor Curve Displays results graphically. The horizontal axis is the
input signal level, and the vertical axis is the output
level.
@ | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to =0 dB Sets the threshold value.
© | Ratio 1:1 10 00:1 Sets the compression ratio.
0O | Knee HARD, 1,2, 3,4,5 Sets the way compression is applied.
© | Attack 0to 120 ms Sets the attack time.
© | Release 441 kHz: 6 ms to 46 s Sets the release time.
48 kHz: 5msto 423 s The setting range may vary, depending on the
88.2kHz: 3msto23s operating frequency.
96 kHz: 3msto 21.1s
© | Gain +0 dBto +18 dB Sets the output gain.
® |[On ON/OFF Turns the compressor ON. When you turn this button

OFF, the compressor is bypassed.
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Delay

This is a multi-tap delay that provides independent delay and level control for each output. You can
specify the delay time in milliseconds, samples, meters, feet, time code frames, or number of beats.
Within the delay group, there are two subgroups called Long and Short. Each has a different setting

range for the delay.

Delay Long

Delay long components are available with from one to eight outputs. Each has a single input and from
one to eight outputs.

* Delay-long - 0

Delay-Longi2) - - Delay-Long(3) - -

Delay-Lang(4) - -

[T Output [ Z Output [ 3 Output . J] & Output .
< [1IN1 ouT1 - [1IN1 auT1 - [1IN1 ouT1 - [1IN1 auT1 1
) 1% . ouTzl]- ouTzl]- ouTzl]-
| . 1% . ouT3l] - ouT3fd-

B . 1% . auTar]-

- [1IN1

© v Delay-Long(8) -
| [ ot .

ouTi1[] -
ouTz[] -
ouTal] -
ouTar] -
ouTs[] -
ouTe[] -
ouTr L] -
ouTal] -
3%

Double-click a component to display the component editor for it. Only the number of outputs in each
component is different. The other parts are the same.

Delay Long Component Editor

= Delay—Lone

Mute

3 Outrut

Section Parameter Setting Range Function
© | Delay All Bypass | ON/OFF Bypasses from input to output.
® | Input Level -0 10 +0 dB Sets the input signal level.
(3] Mute ON/OFF Mute the input signal.
O | Delay Tap Delay ms: 0 to 1300 Sets the delay time.
Sample: the range depends | There are two edit boxes, displaying
on the Fs value. milliseconds and the units selected for [Delay
Meter: O to 446.7 Scale].
Feet: 0 to 1465.4
Frame: the range depends on
the Frame value.
Beat: the range depends on
the Beat value.
(5) Level -0 to +0 dB Sets the output signal level for each channel.
(6) On ON/OFF Turns ON each channel’s delay.
(7) Mute ON/OFF Turns ON muting for each channel’s output.
© | Delay Scale ms Selects the units for setting the delay time.
Sample The selected button will light up, and the
Meter units in the [Delay] edit box will change.
Feet If [Beat] is selected, use the knob to set the
Frame BPM (beats/minute).
Beat
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Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 81 for information on parameter
linking.

Delay Short

Delay short components are available with from one to eight outputs. Each has a single input and from
one to eight outputs.

© Delsy-Short - - - - Deley-Shorti2y - - Delay-Short(3y - - Delsy-Short(4r - -

o [T Output | [ 2 Outpet [ F 0Pt L[ F ot
CCING OUTALT-[IING QUTALI-CIINY QUTALI-LIIN1 OUTH
. 1% . ourzl]- ouT2L] - ourtz
1% ouTa ouTts
........... d % N1
 Delay-Shorl(gy
T OutpLt

- L1INA ouTd
ouT2
ouTs[]-
ouT4L] -
ouTs

Double-click a component to display the component editor for it. Only the number of outputs in each
component is different. The other parts are the same.

Delay-Short component editor
= Delay-Short

[mz1 L) A
[ms] B.68

& Output 1861 <271bHx

Section Parameter Setting Range Function
© | Delay All Bypass | ON/OFF Bypasses from input to output.
® | Input Level -0 to +0 dB Sets the input signal level.
(3] Mute ON/OFF Mute the input signal.
O | Delay Tap Delay ms: 0to 130 Sets the delay time.
Sample: the range depends | There are two edit boxes, displaying
on the Fs value. milliseconds and the units selected for [Delay
Meter: 0 to 44.7 Scale].
Feet: 0to 146.5
Frame: the range depends on
the Frame value.
Beat: the range depends on
the Beat value.
(5) Level -0 to =0 dB Sets the output signal level for each channel.
(6) On ON/OFF Turns ON each channel’s delay.
(7) Mute ON/OFF Turns ON muting for each channel’s output.
O | Delay Scale ms Selects the units for setting the delay time.
Sample The selected button will light up, and the
Meter units in the [Delay] edit box will change.
Feet If [Beat] is selected, use the knob to set the
Frame BPM (beats/minute).
Beat
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Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 81 for information on parameter
linking.

Dynamics

Components in the dynamic group adjust the dynamic range of the sound. There are eight types of
components, each of which is available in mono channel and stereo channel versions. The eight types
are: compander hard, compander soft, compressor, de-esser, ducking, expander, gate, and limiter.

m Keyln
All components in the dynamic group, except the de-esser, have Keyln input. This is used as a
trigger source that activates the effects of the component.

CompanderH - - - CompanderH(2) - - - - - Compressor - Compressor(2) © -
Tone " [ Steren © [ heno © [ Steren :
N1 OuT1L]- LML OUTIL| LR 1| ouTA0] - LML OUTILL] -
KEYIN -LJIM1R OUT1R - - - LIKEYIN -LJINIR OUTARL] -

1% - CIKEYIN ° 0o 1% - LIKEYIN @
2% 2%

The trigger source is set in the [Keyln] section of the component editor.

e Compressor

v LREBEOTH
KEYIM

[KeyIn] Section

The currently selected trigger source is displayed on the button. Click the button and select the
trigger source from the menu.

Mono channel Stereo channel

v LREBOTH

KEYIN

[SELF]
Sets the input signal as the trigger source for mono channel components.

[LVIR]
Sets the left or right input signal as the trigger source for stereo channel components.
[LR BOTH]

Sets both the left and right input signals as the trigger source for stereo channel components.
The strongest input signal will be the trigger source, whether from the left or right channel.

[KEYIN]
The Keyln input will be the trigger source.
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Compander

The compander combines the effects of a compressor and an expander. A compressor compresses
signals that exceed the threshold, while the expander reduces signals that fall below the threshold.
There are two compander groups, CompanderH (compander hard) and CompanderS (compander
soft). Within each group, there are mono channel and stereo channel companders.

Mono channel companders have one input, one output, and one Keyln input. Stereo channel
companders have two inputs, two outputs, and one Keyln input.

CompanderH CompanderS

CompanderH CompanderH(2) . P A
. [ Mono . Stereo ] Co;g:;de’rs Co;rtrz:a;:asﬁ)

IN1 auT1 1 INIL  QUTALL] - . 1 .

EREL - R

[LUSD | [ =i 29 || - |1% KEYI
i : : o ’I -
Stereo channel Stereo channel
Mono channel Mono channel

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

The compander hard and compander soft differ in the compression ratio of their fixed expander. The
expander compression is expressed by the straight portion of the lower-left part of the compander
curve. The compression ratio of the compander hard is large. The slope is also large. The
compression ratio of the compander soft is small, with a gentle compression. The parameters in the
component editor are the same.

CompanderH Mono component editor CompanderS Stereo component editor

™ Com EGT

Companderd  Mana
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Name Function
© | Compander Curve Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.
@® | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to =0 dB Sets the threshold value.
© | Ratio 1:1 10 00:1 Sets the compression ratio.
0O | Width +1 dBto +90 dB Sets the width of the expander.
@ | Attack 0to 120 ms Sets the attack time.
© | Release 441 kHz: 6 ms to 46 s Sets the release time.
48 kHz: 5msto 423 s The setting range may very, depending on the
88.2 kHz: 3msto 23 s operating frequency.
96 kHz: 3msto21.1s
O | Gain -18 dB to +0 dB Sets the output gain.
@ |Keyln Mono SELF Selects the trigger source from a menu. The
KEYIN currently selected trigger source is displayed on the
button.
Stereo L
R
LR BOTH
KEYIN
® [On ON/OFF Turns the compander ON.
A s 4. /7
420 Ratio=4:1  ~
Width=25
+10
0
o
S -10 4 4
T 20 e
(0] /I/
T 304 S
> 4 1
8 a0 A
3 S
0 }: :\Threshold=—25dB
—-60 // | : :
-70 —//// : : :
I I | I I : I I I I I ;
0

—70 -60 -50 —40 -30 -20 -10

Input Level (dB)
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Compressor

Compresses signals that exceed a threshold. Narrows the dynamic range of the signal, making it
easier to mix or record signals with a wide dynamic range such as vocals or piano music. Both mono
channel and stereo channel compressors are provided.

Mono channel compressors have one input, one output, and one Keyln input. Stereo channel
compressors have two inputs, two outputs, and one Keyln input.

© Compressar - Compressarz)
hano .. | Stereo
N1 ouT4 INAL  OUTAL|
KEYIN - -LlINIR OUT1R
1% - - LIKEYIN
2%

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.

Compressor component editor

= Compressor
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Name Function
© | Compressor Curve Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.
® | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to +0 dB Sets the threshold value.
© | Ratio 1:1 t0 o0:1 Sets the compression ratio.
0O | Knee HARD, 1,2, 3,4,5 Sets the way compression is applied.
@ | Attack 0to 120 ms Sets the attack time.
© | Release 441 kHz: 6 msto 46 s Sets the release time.
48 kHz: bms to 42.3 s The setting range may very, depending on the
88.2 kHz: 3msto 23 s operating frequency.
96 kHz: 3msto21.1s
© | Gain +0 dBto +18 dB Sets the output gain.
® | Keyln Mono SELF Selects the trigger source from a menu. The
KEYIN currently selected trigger source is displayed on the
button.
Stereo L
R
LR BOTH
KEYIN
® |On ON/OFF Turns the compressor ON.
A e
+20 //
10 Ratio=2:1 ///
o, Al
o) ’ !
B -104--------------- 2\ :
) Knee=Hard 7 . !
5 B Eiiay | : 1
= 304 ! | :
> ! 1
£ 40 | ! i
3 : ! |
7 L Threshold=-20dB
-60 ! H H
—70 : : :
I I I I I I I : I : :
—70 —60 -50 —40 -30 -20 -10 0 +10 +20
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De-Esser

Compresses the signal above a specified frequency. The de-esser controls sibilant (hissing) sounds
included in speech that are produced by the letter “S.” Both mono channel and stereo channel de-
essers are provided.
Mono channel de-essers have one input and one output each. Stereo channel de-essers have two
inputs and two outputs each.

Desser - -0 - Defsser) -

Mona Stereo

N1 ouTd[]- -ClNIL OUTILL] -
2% + -LHN1R OUTARL] -
o 205 J

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.

De-Esser component editor

Snar

W

T
o - n || aea || wea

) ¢ 9
Name Function
© | De-Esser Curve Displays results graphically. The horizontal axis is the
input signal level, and the vertical axis is the output
level.
@ | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to +0 dB Sets the threshold value.
© | Ratio 1:1 10 00:1 Sets the compression ratio.
0O | Knee HARD, 1,2, 3,4,5 Sets the way the de-esser effect is applied.
@ | Attack 0to 120 ms Sets the attack time.
© | Release 441 kHz: 6 msto 46 s Sets the release time.
48 kHz: 5msto 423 s The setting range may very, depending on the
88.2 kHz: 3msto 23 s operating frequency.
96 kHz: 3msto21.1s
© | Gain +0 dB to +18 dB Sets the output gain.
@ | Frequency 80 Hz to 10 kHz Sets the minimum signal frequency for compression.
® | On ON/OFF Turns the de-esser ON.
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Ducking

Attenuates the output a particular amount, when an input signal exceeds its threshold. Both mono
channel and stereo channel duckers are provided.

Mono channel duckers have one input, one output, and one KeylIn input. Stereo channel duckers have
two inputs, two outputs, and one Keyln input.

Ducking' c c - Duckingi2) « © + -
hana ... .| Stereo ?
1M1 ouTa[]- - - -CHHIL QuUTIL
KEYIN - - - - [LlNIR OUTHR

1% - - - - LIKEYIN
W ol 19

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.

Ducking component editor

Sowmee BN

Duckina
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Name Function
© | Ducking Curve Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.
@® | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to +0 dB Sets the threshold value.
© | Range -70dB to +0 dB Sets the amount by which the level is reduced.
O | Attack 0to 120 ms Sets the attack time.
© | Hold 441 kHz: 0.02msto 2.13 s Sets the hold time.
48 kHz: 0.02ms to 1.96 s The setting range may very, depending on the
88.2 kHz: 0.01 ms to 1.06 s operating frequency.
96 kHz: 0.01 ms to 981 ms
O | Decay 441 kHz: 6 msto 46 s Sets the decay time.
48 kHz: 5msto 423 s The setting range may very, depending on the
88.2 kHz: 3 msto 23 s operating frequency.
96 kHz: 3msto21.1s
©O© | Keyln Mono SELF Selects the trigger source from a menu.
KEYIN The currently selected trigger source is displayed
on the button.
Stereo L
R
LR BOTH
KEYIN
® |[On ON/OFF Turns the ducking ON.
A 7
+20 ! L
+10 -} ' ///
| s’
0+ I L,
) |
T -10 Threshold=-20dB | .
E 20— ——— N
9 30 Range=-25dB
= ]
£ —40
S N __f__ -
o -50 :
-60 !

—70 —60 -50 —40 -30 —20 -10 0 +10 +20
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Expander

Widens the dynamic range of the signal. Low-level signals such as noise are diminished. Both mono
channel and stereo channel expanders are provided.
Mono channel expanders have one input, one output, and one KeylIn input. Stereo channel expanders
have two inputs, two outputs, and one Keyln input.

Iono

INA
- LIKEYIN

Stereo
ouTd

© Expander - - - - - Expanderi2y - - -

IN1L  OUT1L
-LJINAR OUTIRL] -
KEYIN

2%

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.

Expander component editor

£ Expander

Snar

W T

Name Function
© | Expander Curve Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.
@ | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to =0 dB Sets the threshold value.
© | Ratio 1:1 t0 o0:1 Sets the compression ratio.
0O | Knee HARD, 1,2, 3,4,5 Sets the way the expander is applied.
O | Attack 0to 120 ms Sets the attack time.
© | Release 441 kHz:. 6 msto 46 s Sets the release time.
48 kHz: 5msto 423 s The setting range may very, depending on the
88.2kHz: 3msto 23 s operating frequency.
96 kHz: 3msto21.1s
© | Gain +0 dBto +18 dB Sets the output gain.
@ | Keyln Mono SELF Selects the trigger source from a menu. The
KEYIN currently selected trigger source is displayed on the
button.
Stereo L
R
LR BOTH
KEYIN
® | On ON/OFF Turns the expander ON.
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Gate

Attenuates signals that are lower than the threshold level. Both mono channel and stereo channel
gates are provided.

Mono channel gates have one input, one output, and one Keyln input. Stereo channel gates have two
inputs, two outputs, and one Keyln input.

CGete o GaterZ)
Wono " Stereo
N1 ouT1 INAL  OUT1L
KETIN . IN1R OUT1R
1% - KEYIN
- 2%

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.

Gate component editor
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Name Function
© | Gate Curve Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.
@ | Gain Reduction Meter Displays the gain reduction attenuation.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to +0 dB Sets the threshold value.
(5) Range -70 dB to +0 dB Sets the amount by which the level is reduced.
0O | Attack 0to 120 ms Sets the attack time.
@ | Hold 44.1KkHz: 0.02mst02.13 s Sets the hold time.
48 kHz: 0.02 ms to 1.96 s
88.2 kHz: 0.01 msto 1.06 s
96 kHz: 0.01 ms to 981 ms
O | Decay 441 kHz: 6 msto 46 s Sets the decay time.
48 kHz: 5msto 423 s The setting range may very, depending on the
88.2kHz: 3msto 23 s operating frequency.
96 kHz: 3msto21.1s
O | Keyln Mono SELF Selects the trigger source from a menu. The
KEYIN currently selected trigger source is displayed on the
button.
Stereo L
R
LR BOTH
KEYIN
® |On ON/OFF Turns the gate ON.
A .
+20 :
+10 :
o- |
) |
S -10 Threshold=—20dB |
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Limiter

Signals above the threshold are compressed at an «:1 ratio, preventing output of signals that exceed
the threshold level. Mono channel and stereo channel components are provided.

Mono channel components have a single input and output plus a key input, while stereo channel
components have two inputs and outputs and a key input.

Chapter 6 Component Guide

Double click the component to open the component editor. Mono channel and stereo channel
components have the same parameters.

= Limiter.

Limites

Limiter component editor

on

Name Function
© | Limiter Curve Displays the limiter response in graph form. The
horizontal axis represents input signal level and the
vertical axis represents output level.
@ | Gain Reduction Meter Displays the amount of gain reduction.
©® | Output Meter Displays the output signal level.
Parameter Setting Range Function
O | Threshold -54 dB to £0 dB Sets the threshold value.
© | Attack 0to 120 ms Sets the attack time.
0O | Release 441 KHz: 6 msto 46 s Sets the release time. The range varies according
48 kHz: 5 mst0 423 s to the operating frequency.
88.2 kHz: 3msto 23 s
96 kHz: 3msto 21.1s
O | Keyln Mono SELF The trigger source can be selected from this menu.
KEYIN The currently selected source is displayed in the
button.
Stereo L
R
LR BOTH
KEYIN
® |[On ON/OFF Turns the limiter ON.
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Equalizer (EQ)

The equalizer boosts or cuts the levels of specified frequencies. The EQ group contains graphic
equalizers (GEQ) and parametric equalizers (PEQ).

The frequency bands in the graphic equalizer are fixed. The graphical interface lets you visually check
the gain of each frequency. There are three different types of equalizers, each with a different number
of frequency bands. Mono channel and stereo channel equalizers are available for each type.

With the parametric equalizer, you can freely adjust the frequency bands, their amplitudes, and
bandwidths. There are six different types of parametric equalizers, each with a different number of
frequency bands. Mono channel and stereo channel equalizers are available for each type.

Graphic Equalizer (GEQ)

Boosts or cuts signals within the specified frequencies. The mono group contains 7 band, 15 band,
and 31 band mono channel components. The stereo group contains 7 band, 15 band, and 31 band
stereo channel components.

Mono channel GEQs have one input and one output each. Stereo channel GEQs have two inputs and
two outputs each.

A= GEQ-Mono(2) - - W GEG-Mona(3) - - q

Mono channel

TFEC-Stare 2T TECFSTErEal T

Stereo channel

Double-click a component to display the component editor for it. The number of bands varies
depending on the component, but all share a common configuration in the component editor.
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Component editor for GEQ

166 £28 1.8

TR B

E.1 a.aa -5.08 -18.68 -15.08 -3.88 a.a8

f 3.88 13 3.6 615 377 @I
@ HRF @LF‘F @ ufrut

Name Function
© | Input Meter Displays the input signal level.
® |EQCurve Displays the equalizer effect.
©® | Output Meter Displays the output signal level.
Section Parameter Setting Range Function
O | Equalizer Bypass ON/OFF Bypasses each bands in the GEQ equalizer
section.

(5] Gain Set by [Range]. Sets the output gain for its band.
(6) GEQ ON ON/OFF Turns the GEQ ON.
(7) Range +15 Selects the gain adjust width.

+12

+6

-24
(3] EQ Flat -- Returns the faders of all bands to 0dB.
© | Input Level -0 to +10 dB Sets the input signal level.
(10) Phase ON/OFF Reverses the phase of the input signal.
® | HPF Frequency 20 Hzto 20 kHz | Sets the HPF cutoff frequency.
(12) Bypass ON/OFF Turns bypass ON.
® |LPF Frequency 20 Hz to 20 kHz | Sets the LPF cutoff frequency.
(14) Bypass ON/OFF Turns bypass ON.
® | Notch Frequency 20 Hz to 20 kHz | Sets the notch filter frequency.
(16} Q: 0.11t063.0 Sets the width of the frequency band that will

be changed by the filter.

@ Bypass ON/OFF Turns bypass ON.
® | Output Level -0 to +0 dB Sets the signal level.
(19) On ON/OFF Turns output ON.
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m EQ Graph [Bypass] Button
A number for each frequency band is displayed on these buttons. When you click the button, it
lights up and the bypass turns ON. When you turn this ON, bypassed sound (unchanged sound) is
output. When you turn this OFF, the sound is output with effects applied.

Bypass ON Bypass OFF

Parametric Equalizer (PEQ)

Boosts or cuts signals within specified frequencies. In both the Mono group and Stereo group there
are 2 band, 3 band, 4 band, 6 band, and 8 band components available.

Mono channel PEQs have one input and one output each. Stereo channel PEQs have two inputs and
two outputs each. The number of bands varies depending on the component, but all share a common
configuration in the component editor.

Double-click a component to display the component editor for it. The number of bands varies
depending on the component, but all share a common configuration in the component editor.

PEQ component editor

b EQ-Stereo
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Name Function
© |EQCurve Displays the equalizer effect.
You can change the parameter by dragging
the control point with the mouse.
Section Parameter Setting Range Function
® | Input Level -0 to +10 dB Sets the input signal level.
(3) Phase ON/OFF Reverses the phase of the input signal.
O | Equalizer Type PEQ Select the filter type from the menu.
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF
(5) Q 0.1t0 16.0 Sets the band width for each frequency
band.
(6) Frequency 20 Hz to 20 kHz Sets the frequency for each band.
(7] Gain -18dBto +18 dB Sets the level of the frequency that will be
changed.
(8] Bypass ON/OFF Turns ON bypass for each band.
© | Equalizer PEQ ON ON/OFF Turns the PEQ ON
@® | Output Level -0 to =0 dB Sets the output signal level.
(11) On ON/OFF Turns output ON.
m Filter Type

Various types of curves are available for changing the level. Click the [Type] button and select the
type from the menu.

« PEQ

This is a general parametric equalizer.

* L. SHELF (Low Shelving)
There is no sound attenuation at low frequencies. The sound is attenuated at a constant rate

from the cutoff frequency towards the higher frequencies. The attenuation rate per octave can
be set to [6 dB/Oct] or [12 dB/Oct].

* H.SHELF (High Shelving)
There is no sound attenuation at high frequencies. The sound is attenuated at a constant rate
from the cutoff frequency towards the lower frequencies. The attenuation rate per octave can
be set to [6 dB/Oct] or [12 dB/Oct].

« HPF

This is a high-pass filter (Q=0.7). Attenuates the low frequencies with a gentle curve (12 dB/

Oct).
« LPF

This is a low-pass filter (Q=0.7). Attenuates the high frequencies with a gentle curve (12 dB/

Oct).
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Controls the output level for each channel. Fader components are available for 1, 2, 4, 8, 12, and 16
channels.

* Fader- - - - - Faderi2) - - - - * Fader(3) - = - ¢ Fadertd) - - - - - Fader(s) - = - - FadertB) - - = - -
1 Channel ! 2 Channel .| 4 Channel 4 & Channel . | 12 Channel 4 16 Channel
1M1 ouTH - LN ouT1 - LJINA ouTH1 - LN ouT1 - LJINA ouTH1 - LN ouT1

1% -L1INzZ ouTz2L] - LNz ouTz] - [z ouT20] - LNz ouTz] - [z ouTZ2

1% - LIING outs[] - ClNz ouTaL] - LlINS outz] - ClINS auTs

1N ouT 1N ouUTH

INS ouTs IND ouTS

ING OuTE ING ouTe

INT ouTt? INT auTy

INg ourts INg ouTs

| ouTtal]- Cline ouTa

IN10 OUT10[L] - CJIN1O - QUT10

IN11 OUT14 LNt ouTd

IN12  OUuT12[]1-[JIN12 QUT12

3% SLJINIS S QUTA3

IN14 OUT14|

................................................... e HuE
............... e ShE
................................................... o

Double-click a component to display the component editor for it. The number of channels varies, but
all components share a common configuration in the component editor.

Fader component editor

Fader 16 Channel

Parameter Setting Range Function
© | Phase ON/OFF Reverses the phase of the output signal for each
channel.
® |On ON/OFF Turns ON each channel’s output.
©® | Fader -0 to +10 dB Sets the output signal level for each channel.
O |Fade ON/OFF Sets fade during scene recall ON or OFF.
m [Fade]

Sets the action of the fader when there is a large change in its position during scene recall. When
you turn this ON, the fader moves gradually to the position after the jump. If you turn this OFF, it
immediately jumps to the parameters saved in the recalled scene.

See “The ‘Scene Manager’ Dialog Box” (page 70) for details about settings for the components to
be faded and the time period when the [Fade] is On.
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Feedback Suppressor

The Feedback Suppressor reduces feedback components of the signal.

%= Feedback Supp... EE|E|

SOFT HARD

Feedback S

Parameter
© | Mode Speech Selects the type of input signal to be processed.
Select this mode when the
input source is speech.
Music
Select this mode when the
input source is music.
©® | Suppression Lebel |0 ~9 Specifies the amount of feedback reduction. Higher
values produce greater feedback reduction.
Further, the amount of pitch changed produced by the
effect is displayed in cents.
©® | Bypass ON/OFF Turns bypass on.
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Filters

A filter passes specific frequencies and attenuates all others.

There are seven types of filters available in the filter group: band pass filter (BPF), high pass filter
(HPF), low pass filter (LPF), notch filter (Notch), programmable BPF, programmable HPF, and
programmable LPF.

Band Pass Filter (BPF)

The band pass filter passes the signal from a specified frequency band, while attenuating frequencies
outside that band. There are two types of BPF components: mono channel and stereo channel. Mono
channel BPFs have one input and one output. Stereo channel BPFs have two of each.

BPF BFF(2)

. [ Mano . [ Steren ]

- L1IN4 ouTH - - [LJIN1IL OUTALL] -
1% IN1R OUT1R

\ 9 ] 1% T -

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

BPF component editor

Section Parameter Setting Range Function
© | Input Level -0 to +10 dB Sets the input signal level.
(2) Phase ON/OFF Reverses the phase of the input signal.
©® |BPF Frequency 20 Hz to 20 kHz | Sets the center frequency.
(4] Q: 0.1t0 16.0 Sets the band width of a frequency band.
(5) Bypass ON/OFF Turns bypass ON.
O | Output Level -0 to £0 dB Sets the output signal level.
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High Pass Filter (HPF)

The high pass filter passes frequencies in the signal that are higher than a specified frequency, while
attenuating lower frequencies in the signal. There are two types of HPF components: mono channel
and stereo channel. Mono channel HPFs have one input and one output. Stereo channel HPFs have

two of each.

© HPFF -

e

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

HPF component editor

Section Parameter Setting Range Function
© | Input Level -0 to +10 dB Sets the input signal level.
(2) Phase ON/OFF Reverses the phase of the input signal.
® | HPF Frequency 20 Hz to 20 kHz | Sets the cutoff frequency.
(4] Slope 6 dB/Oct Sets the attenuation for each octave.
12 dB/Oct
(5) Bypass ON/OFF Turns bypass ON.
O | Output Level -0 10 +0 dB Sets the output signal level.
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Low Pass Filter (LPF)

The low pass filter passes frequencies in the signal that are lower than a specified frequency, while
attenuating higher frequencies in the signal. There are two types of LPF components: mono channel
and stereo channel. Mono channel LPFs have one input and one output. Stereo channel LPFs have

two of each.

S LPF - - -

LPF@) -

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

LPF component editor

Section Parameter Setting Range Function
© | Input Level -0 t0 +10 dB Sets the input signal level.
(2) Phase ON/OFF Reverses the phase of the input signal.
® |LPF Frequency 20 Hzto 20 kHz | Sets the cutoff frequency.
(4) Slope 6 dB/Oct Sets the attenuation for each octave.
12 dB/Oct
(5) Bypass ON/OFF Turns bypass ON.
@ | Output Level -0 10 +0 dB Sets the output signal level.
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Notch Filter (Notch)

The notch filter attenuates the signal within a specified frequency band, while passing frequencies
outside that band. There are two types of notch filter components: mono channel and stereo channel.
Mono channel notch filters have one input and one output. Stereo channel notch filters have two of

each.

o (ke 2 ¢ 0o o MaotchZ)

Stereo
-CIIN1L QUTILL] -

-LHNIR OUTARLT -
. 05 .

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

Notch component editor

Section Parameter Setting Range Function
© | Input Level -0 10 +10 dB Sets the input signal level.
(2) Phase ON/OFF Reverses the phase of the input signal.
©® | Notch Frequency 20 Hzto 20 kHz | Sets the center frequency.
(4] Q: 0.1t0 63.0 Sets the band width of the frequency band
that will be changed
(5) Bypass ON/OFF Turns bypass ON.
@ | Output Level -0 10 +0 dB Sets the output signal level.
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Programmable BPF

The band pass filter passes the signal from a specified frequency band, while attenuating frequencies

outside that band. With the programmable band pass filter you can set the filter type and the slope
between the frequency band that is passed and the band that is cutoff.

There are two types of programmable BPF components: mono channel and stereo channel. Mono

channel programmable BPFs have one input and one output. Stereo channel programmable BPFs

have two of each.

BPF - Progr BPF(2) -

. [ Steren -
ouT1 IN1L  OUTAL|
1% - -ClIN1R OUTIRL] - - -
L 29 oo d

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

Programmable BPF component editor

= Programmable BPF

Section Parameter

Setting Range

Function

Input Level

-0 to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

HPF Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

00

Type

Thru

6 dB/Oct

12 dB/Oct AdjustGe
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

(6] Bypass

ON/OFF

Turns bypass ON.
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Section

Parameter

Setting Range

Function

(= JN

LPF

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

Type

Thru

6 dB/Oct

12 dB/Oct AdjustGe
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

Bypass

ON/OFF

Turns bypass ON.

e 6

Output

Level

-0 0 +0 dB

Sets the output signal level.
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Programmable HPF

The high pass filter passes frequencies in the signal that are higher the specified frequency, while
attenuating lower frequencies in the signal. With the programmable high pass filter you can set the
filter type and the slope between the frequency band that is passed and the band that is cutoff.
There are two types of programmable HPF components: mono channel and stereo channel. Mono
channel programmable HPFs have one input and one output. Stereo channel programmable HPFs
have two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

Programmable HPF component editors

o Programmable HPF E\E”z|

Froarammatla HFF

Section

Parameter

Setting Range

Function

Input

Level

-0 10 +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

HPF

® 00

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

Type

Thru

6 dB/Oct

12 dB/Oct AdjustGe
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGe
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGe
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

Bypass

ON/OFF

Turns bypass ON.

©9

Output

Level

-0 t0 +0 dB

Sets the output signal level.
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Programmable LPF

The low pass filter passes frequencies in the signal that are lower than the specified frequency, while
attenuating higher frequencies in the signal. With the programmable low pass filter you can set the
filter type and the slope between the frequency band that is passed and the band that is cutoff.
There are two types of programmable LPF components: mono channel and stereo channel. Mono
channel programmable LPFs have one input and one output. Stereo channel programmable LPFs

have two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.

Programmable LPF component editor

ogrammable LPE

Section

Parameter

Setting Range

Function

Input

Level

-0 t0 +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

LPF

00

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

Type

Thru

6 dB/Oct

12 dB/Oct AdjustGe
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGe
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGe
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGe
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

Gce

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gce) is selected
for [Type], this sets the gain for the cutoff
frequency.

Bypass

ON/OFF

Turns bypass ON.

(2N~

QOutput

Level

-0 to +0 dB

Sets the output signal level.
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Meter

Displays signal levels. Meter components are available with 1, 2, 4, 8, 12, and 16 channels.

Meter(@y © - o Meter(3} < © Meter(dy © o Meter(s) <

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.

Meter component editor

2 2 4 5 B 7 8 9 18 11 1 12 WM 15 1%

Name Function

© | Meter Displays signal levels for each channel.
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In the Miscellaneous group, there are the Oscillator subgroup and the Wav File Player.

Oscillator

The Oscillator subgroup contains a monochannel oscillator component. The oscillator generates sine
waves at fixed frequencies of 100 Hz, 1 kHz, and 10 kHz, a variable frequency sine wave, pink noise,

and burst noise.

: Ozcillatar - - - -

hiono

Double-click a component to display the component editor for it.

Oscillator component editor

Dscillator  Mono

Section Parameter Setting Range Function

© | Wave Form Sine 100 Hz Selects the frequency and waveform that will
1 kHz be generated. Only one of the six [Sine] and
10 kHz [Noise] buttons can be selected.
Vari

(2] Noise Pink
Burst

(3) Frequency 20 Hz to 20 kHz | When [Vari] is selected for [Sine], this sets

the frequency of the generated sine wave.

O | Output Level -0 10 +6 dB Displays the signal level.

(5) On ON/OFF Turns ON the oscillator.

(6] Meter -- Displays the output signal level.

Pink Noise

A standard signal used for sound measurement.
This sound covers a frequency range of 20 Hz to 20 kHz. As the frequency doubles, the energy of
the sound is cut in half. The sound level is equal at all frequencies.

Burst

Outputs pink noise continuously.
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Wav File Player

The Wav File Player is a component for playing Wave files. Only one Wav File Player component can
be arranged for each single DME unit.

If you switch the effect type for SPX components while playing Wave file by Wav File Player, drop-outs in the sound played in
the Wav File Player may occur.

When a Wave file is played back while the DME is set to operate at 88.2 kHz or 96 kHz, only the OUT1 output of the Wav File
Player will be delivered via the Left channel. There will be no output from OUT2.

© Wav File Player - -

Double-click the component to display the component editor for it.

Wav File Player component editor

%_W’M File Plg?f_er_ T — E@E]

<. InFut Waw File Plager

Section Parameter | Setting Range Function

© | Ex Input Level -0 to 0 dB Sets the input level from an input port. Only effective
when “External Input” is selected as the playback file.

® | Wav File Player | Play 001 to 100 Selects and displays the playback file.
Only files set in the DME unit in which this component
is placed by the Wav File Manager can be selected.

(3) List - Open the Wav File Manager to display a list of files set
in the DME unit in which this component is located.
This list functions as a play list.

(4] <4< - Selects the previous file in the play list.

(5) > | - Selects the next file in the playsuit.

(6) | 2 - Plays the selected Wave file. Mute is turned OFF
when “External Input” is selected.

(7) | - Stops playback of the Wave file. Muted when

“External Input” is selected.

Playback will be stopped if synchronization is carried out during playback.
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Mixer

The Mixer group contains the Auto Mixer, Delay Matrix, and Matrix Mixer.

Auto Mixer
There is a noise gate for each input channel, which passes only signals that exceed a specified
threshold. There are five mixer types, each with a different number of inputs.

g Auto Mlxer e Auto Mlxer(Zj . Auto Mlxer(ﬁ) . Auto Mlxer(4j . Auto Mlxer(s)

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor. The auto
mixer component editor consists of two sections: input channels and master output.

Auto Mixer component editor

Auto Mixer 16 Channel
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Section Parameter Setting Range Function

© | Input Channels | Phase ON/OFF Reverses the phase of each channel’s
input signal.

(2] Gate Indicator -- When the gate is open, the light turns
green. When the gate is closed, the light
turns yellow.

(3) Threshold -54 dB to +0 dB Sets the threshold value for each gate.

(4) Hold 44.1 kHz: 110 mto 2.13 s | Sets the gate hold time.

48 kHz: 101 mto 1.96 s The setting range may vary, depending
88.2 kHz: 55.1 mto 1.06 s | on the operating frequency.
96 kHz: 50. 6m to 981 m

(5] Decay 441 kHz: 110 mto 46 s Sets the speed for closing the gate.

48 kHz: 101 mto 42.3 s The setting range may vary, depending
88.2 kHz: 55 mto 23 s on the operating frequency.
96 kHz: 51 mto21.1s

(6] Solo ON/OFF Turns solo ON. If Solo is engaged for
even one channel, all non-Solo channels
will be muted.

(7] On ON/OFF Turns ON each channel’s input.

(5] Fader -0 to +10 dB Sets the input signal level for each
channel.

© | Master Output | Gain Correct ON/OFF The output gain will be adjusted
according to the number of channels
being mixed.

(10) On ON/OFF Turns ON each channel’s output.

(11] Master -0 to +10 dB Sets the output signal level.
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Delay Matrix

This is a matrix mixer that allows you to set an independent delay time and level adjustment for each
output. There are three groups of delay matrix, based on the number of inputs: 2 Input, 4 Input, and 8
Input. In each of the three groups there are five mixers available with 2, 4, 8, 12, or 16 outputs, for a
total of 15 components.

© Delay Matriz - - Delery Matrixf2) - - Delay Matri=(3) - - Delay Matrix(4) - - Delay Matrix(S) -

. [ Zinput 2 Guf . Zinput 12 Output [T 2 Input 16 Ot

- LIIN1 ouTe IN1  OUT4L]- C1IN1 ouT4[]

-CiMz ouTz 1Nz OuT2[]-CliNz ~ ouTz[]

2% ouT3 ouT3]
ouT4 ouT4]
ouTS ouTs[]
ouTE ouTE]
ouT? ouT7 ]
Du% DUT8: 2 Input
ouT10 ouT100]
ouT11 ouT110]
ouTI2 ouT12[]
B% ouT12[0]

ouT140]
ouT150]

QUT16

7%

Dielary Matrix() Delay Matrix(7) Dielary Matrix(E) Delay Matrix(3) Dielary Matrix( 160
. Finput 12 Output [T & Input 16 OuipLs
1M1 QuUT1L]- CJiM1 ouT1[]
IN2  OUT2 N2 OuT2[]
INZ  OUT3 N3 ouT3[]
IN4  OUT4 N4 OUT4L]
T5 uTsL]
ouTE ouTE]
ouT? ouTz7 ]

ouTS ouTs

ouTg ouTa] 4 Input

ouT10 ouT100]
ouT11 ouT110]
ouT12 ouT12[]
ouT120]
ouT140]
ouT150]

ouT16E

2%

- Delay Matring11) -+ Delay Matrinf12) - Delay Matrix(13) © Delay Matrix14) - Delay Matrix(15)"
& It 2 Gy B Input & Culplt | [T Input 8 o FInput 12 Output [T 5 Input 16 Ot
N1 ouT1 IN1  OUTH N1 ouT1 IN1  OUTH N1 ouT1[]
N2 ouTz 1Nz OuTz[] - CliNz  OuT2 1Nz OuTz2[]-CJiNz ~ ouTz[]
IN3 IN2  OUT3[]-CIINZ  OUT3 INZ  OUT3L]-LCIINZ  OUT2[]
N4 14 OuT4 N4 OUT4 IN4  OUT4[]-[JINd  OUT4[]
IN5 INS IN5  OUTS INS IN5  OUTSL]
ING ING IN§  OUTE IN§  OUTSL]
INT IN7 INF  OUT? INT  OUT7L]
[ INg -CliMe outs N2 ouTE

5% g% 144 QuTaL] 8 Input

: ouT100]
ouT11[0]
ouT120]
ouT130]
ouT140]
ouT15[0]
QUT1E
26%

Double-click a component to display the component editor for it. The number of input and output
channels varies depending on the component, but all share a common configuration in the
component editor.

The delay matrix component editor consists of four sections: input, output, matrix, and block. The
[Master] buttons in the [Input] and [Output] sections display windows where you can make master
input and output settings. Delay and level for each channel are set in separate windows that display
four channels each.

Delay Matrix component editor

EE Delay Matrix

Delay Matri; 2 Input 16 Qutput
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Section Name Function

@ | Input Master Opens the Input Master window.

©® | Output Master Opens the Output Master window.

©® | Matrix Delay meters Displays output level and delay time for each output

Output level meters channel. Clicking here displays the Crosspoint window.

O | Block On Turns ON output for all channels in the Crosspoint
window. Lights the [ON] button (does not change the
delay matrix component editor).

(5) Off Turns OFF output for all channels in the Crosspoint
window (does not change the delay matrix component
editor).

(6] Nominal Resets all output levels in the Crosspoint window,
making them 0 dB. The delay settings are not changed.

Q Minimum Resets all output levels in the Crosspoint window,
making them - dB. The delay settings are not
changed.

m Matrix (Delay Meter/Output Level Meter)
The upper row has delay meters, while the middle row has output level meters. You can view

parameters for all output channels at once.

Delay Meter

Output Level Meter

01 I = - L

When you click the output channel number on the matrix, the [Delay Matrix - All Inputs to One
Output] editor window opens. When you click the input channel number on the left side of the
matrix, the [Delay Matrix - One Input to All Outputs] editor window opens.

Click to open the [Delay Matrix - All Inputs
to One Output] editor window.

Click to open the [Delay Matrix - One Input
to All Outputs] editor window.

Delay Matrix

20| e

2 Input 12 Outrut

The matrix is divided into groups. For the 2 Input matrix, each group has two input channels and
four output channels. For the 4 Input matrix, each group has four input channels and four output
channels. Groups in matrixes with more than four inputs are the same as for the 4 Input matrix.
When you place the mouse pointer over a group, its channel numbers are highlighted. Click to
open the [Delay Matrix - Crosspoint] editor window.
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Click to open the “In 1-4 x
Out 1-4” Crosspoint window. 5-8” Crosspoint window. open the “In 1-2 x Out 1-4”

®m Input Master

Chapter 6 Component Guide

Ma;
2% v T

Click to open the “In 5-8 x Out For 2 input matrix, click to

Crosspoint window.

If you click the [Input Master] button in the delay matrix component editor, it will open the [Delay
Matrix - InputMaster] editor window. Here you can turn the master input for each channel ON and
OFF and set the level.

[Delay Matrix - InputMaster] editor window

5= Delay Matrix : InputMaster®

r

Delay Matrix 2 Ineut & Output

Section Parameter Setting Range Function

© | Input Phase ON/OFF Reverses the phase of each channel’s signal.

(2] Level -0 t0 +10 dB Sets the level of the signal from each channel’s
input.

(3) Solo ON/OFF Turns ON solo for each channel. If Solo is engaged
for even one channel, all non-Solo channels will be
muted.

(4] On ON/OFF Turns ON each channel’s input.

© | Block On -- Turns ON input for all channels in the Input Master
window. When turned ON, the [On] button lights up.

(6) Off -- Turns OFF input for all channels in the Input Master
window.

(7) Nominal -- Resets all input signal levels in the Input Master
window, making them 0 dB.

(8] Minimum -- Resets all input signal levels in the Input Master
windows, making them - dB.
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m Qutput Master

If you click the [Output Master] button in the delay matrix component editor, it will open the [Delay
Matrix - OutputMaster] editor window. Here you can turn the master output for each channel ON
and OFF and set the level.

= Delay Matrix : OutputMaster8

= L

L1 5.8

L .68

[Delay Matrix - OutputMaster] editor window

EEE

Block

B8

Section Parameter Setting Range Function

© | Output Meter -- Displays the output signal level for each channel.

(2) Level -0 t0 +10 dB Sets the output signal level for each channel.

(3) On ON/OFF Turns ON each channel’s output.

O | Block On -- Turns ON output for all channels in the Output
Master window. When turned ON, the [On] button
lights up.

(5) Off -- Turns OFF output for all channels in the Output
Master window.

(6) Nominal - Resets all output signal levels in the Output Master
window, making them O dB.

(7) Minimum -- Resets all output signal levels in the Output Master
window, making them -co dB.
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m All Inputs to One Output

When you click the output channel number on the matrix, the [Delay Matrix - All Inputs to One
Output] editor window opens. All input channels and one output channel are displayed. The output
channel is the one you have clicked on in the delay mixer component editor.

= Delay Matrix : InputAllToOutputXs

e

Oelay Matrix

8 Ineut 8 Outrut

Chapter 6 Component Guide

— ]

Section Parameter Setting Range Function

© | Bus Send Level | Delay 0 to 500ms Sets the delay time for each input channel.

(2) Level -0 to +10 dB Sets the output signal level for each input channel.

(3) On ON/OFF Turns ON the output for each input channel.

O | Output Channel -- Displays the selected output channel. Select
another channel from a menu.

(5) On ON/OFF Turns ON the output for the channel displayed in
the window.

(6) Meter -- Displays the output signal level of the channel
displayed in the window.

© | Block On -- Turns ON all channel inputs. When turned ON, the
[On] button lights up.

(5] Off - Turns OFF all channel inputs.

(o) Nominal - Resets all of input signal levels, making them 0 dB.

(10) Minimum -- Resets all of input signal levels, making them - dB.

Output Channel Switching

The [Delay Matrix - All Inputs to One Output] editor window displays the output channel clicked on
in the delay matrix component editor. The [Channel] buttons in the [Output] section of the [Delay
Matrix - All Inputs to One Output] editor window switch the channel group that is displayed in the
window.

= Delay Matrix : InputlIToOutputXs8
e — —

—— )

Delay Matri 8 InFut & Output

If you make the delay matrix component editor active while the [Delay Matrix - All Inputs to One
Output] editor window is displayed, and then click another output channel, that channel group will
be displayed in the [Delay Matrix - All Inputs to One Output] editor window.

One [Delay Matrix - All Inputs to One Output] editor window is displayed for each delay matrix
component editor.
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m One Input to All Outputs

When you click the input channel number on the left side of matrix, the [Delay Matrix - One Input to
All Outputs] editor window opens. One input channel and all output channels are displayed. The
input channel is the one you have clicked on in the delay mixer component editor.

= Delay Matrix : InputXToOutputAll8

——

InFut

Oielay Matei

H.8H B.86 886

InFut & Outrut

.88

EB®

o.ae B.ae

Section Parameter Setting Range Function

© | Input Channel -- Displays the selected input channel. Select another
channel from a menu.

(2) Phase ON/OFF Reverses the phase of the input signal.

(3] Level -0 to +10 dB Sets the input signal level.

(4] Solo ON/OFF Turns solo ON. If Solo is engaged for even one
channel, all non-Solo channels will be muted.

(5) On ON/OFF Turns input ON.

@ | Bus Send Level | Delay 0to 500 ms Sets the delay time for each output channel.

(7] Level -0 t0 +10 dB Sets the signal level for each output channel.

(8] On ON/OFF Turns ON the output for each output channel.

© | Block On -- Turns ON all channel outputs. When turned ON, the
[On] button lights up.

(10) Off - Turns OFF all channel outputs.

(11) Nominal - Resets all output signal levels, making them 0 dB.

(12) Minimum -- Resets all output signal levels, making them - dB.

Input Channel Switching

The [Delay Matrix - One Input to All Outputs] editor window displays the input channel for the
channel number clicked on in the delay matrix component editor.

The [Channel] buttons in the [Input] section of the [Delay Matrix - All Inputs to One Output] editor
window switch the channel group that is displayed in the window.

= Delay Matrix : InputXToOutputAlld

- —

tolnPut 8
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Chapter 6 Component Guide

If you make the delay matrix component editor active while the [Delay Matrix - One Input to All
Outputs] editor window is displayed, and then click another input channel, that channel will be
displayed in the [Delay Matrix - One Input to All Outputs] editor window.

One [Delay Matrix - One Input to All Outputs] editor window is displayed for each delay matrix

component editor.

Crosspoi nt [Delay Matrix - Crosspoint] editor window

If you click a level meter in the delay
matrix component editor, that group's
[Delay Matrix - Crosspoint] editor
window will be displayed. Turns the
input channels ON and OFF and sets
their levels. Just like the delay matrix
component editor, the input channels
are arranged vertically while the output
channels are arranged horizontally.

AR

Delay Matriz 8 InFut 8 Outrut 1BAIA (2F1aH2

Section Parameter Setting Range Function

© | Input Channel -- Switches to another channel group.

® | Output Channel - Switches to another channel group.

©® | Bus Send Level | Delay 0to 500 ms Sets the delay time for each crosspoint.

(4] Level -0 10 +10 dB Sets the output signal level for each crosspoint.

(5) On ON/OFF Turns ON output for each crosspoint.

O | Block On -- Turns ON output for all channels in the Crosspoint
window. The [On] button lights up.

(7] Off -- Turns OFF output for all channels in the Crosspoint
window.

(8] Nominal -- Resets all output signal levels in the Crosspoint
window, making them 0 dB.

(9] Minimum -- Resets all output signal levels in the Crosspoint
window, making them -co dB.
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Channel Group Switching

The [Delay Matrix - Crosspoint] editor window displays four channels each for Input and Output.

It displays the channel group you click on in the delay matrix component editor. The [Channel]
buttons in the [Input] and [Output] sections of the [Delay Matrix - Crosspoint] editor window switch
the channel group that is displayed in the window.

Dutput
Channel

Input.
Channal

L

[Input] section [Output] section
[Channel] menu [Channel] menu

If you click another channel group when the delay matrix component editor is active and an [Delay
Matrix - Crosspoint] editor window is displayed, that channel group will be displayed in the open
[Delay Matrix - Crosspoint] editor window.

Only one [Delay Matrix - Crosspoint] matrix window is displayed for each delay matrix component
editor.

Matrix Mixer

In the matrix mixer, the input channels and output buses are arranged in a checkerboard
configuration. You can adjust the group balance for each output bus. There are 24 components in the
in the Matrix Mixer group, each with different numbers of input and output channels. There are seven
groups based on the number of inputs, as follows: 2 Input, 4 Input, 8 Input, 12 Input, 16 Input, 32
Input, and 64 Input.

Matrixtdizer - - - - MatrioMixer() - - - MatrixcMicer(3) Matrie Mixer(d) - - hatrixhicer(S) - - -

Wstric et ©  MatrichbeertT) - MatrbcMiser(s) MetrisMizert@) - 0o

MatrbcMixert10)-  Matrix Mixer11)- - MatrboMiert12) -~ Matricbixer(13) - airix Mixer14)

s ut ut g ot
. . O]
ut

Wariz M9y - Matrix Mixert20)

MetriMixert15)-  Matrix Mixert18) - MatrbcMixer(17)  Metrix Mixer(1)

If a 64 input 64 output Matrix Mixer component or a 64 input 32 output Matrix Mixer component is placed in the DME64N
configuration window, no other components can be used even though the resource meter does not reach 100%.
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Double-click a component to display the component editor for it. The number of input and output
channels varies depending on the component, but all share a common configuration in the

component editor.

The matrix mixer component editor consists of four sections: input, output, matrix, and block. The
[Master] buttons in the [Input] and [Output] sections display windows where you can make master
input and output settings. The level for each channel is set in separate windows that display four

channels each.

Matrix Mixer component editor

& Input & Output

On
off
Nominal
Minimurm

Section Name Function

© | Input Master Opens the Input Master window.

® | Output Master Opens the Output Master window.

©® | Matrix Output level These meters display the output level for each channel.
Clicking here displays the Crosspoint window.

O | Block On Turns ON output for all channels in the Crosspoint window.
Lights the [ON] button (does not change the matrix mixer
component editor).

(5) Off Turns OFF output for all channels in the Crosspoint window
(does not change the matrix mixer component editor).

(6) Nominal Resets all output levels in the Crosspoint window, making
them 0 dB.

(7) Minimum Resets all output levels in the Crosspoint window, making
them -0 dB.
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m Matrix (Output Level)

In the matrix, you can view levels for all output channels at once. The level will be grayed out when
the corresponding channel is set to Off.

Output level

When you click an output channel number on the matrix, the [Matrix Mixer - All Inputs to One
Output] editor window opens. When you click the input channel number on the left side of the
matrix, the [Matrix Mixer - One Input to All Outputs] editor window opens.

d
Fecall

Block

Click to open the [Matrix Mixer - All
Inputs to One Output] editor window.

=1

0n
off
Homindl

Click to open the [Matrix Mixer - One e

. . 3 f
Input to All Outputs] editor window. InFut

W
i
L ok
- — = . ——
- = —
.-

Matriz Mi<er 8 InFut 8 Output

The matrix is divided into groups, each with four input channels and four output channels. When
you place the mouse pointer over a group, its channel numbers are highlighted. Click to open the
[Matrix Mixer - Crosspoint] editor window.

g Gl
-4

S e e

- = -
- - —ry =—

Click to open the “In 1-4 x Out 5-8”
[Matrix Mixer - Crosspoint] editor window
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® |Input Master

If you click the [Input Master] button in the matrix mixer component editor, it will open the [Matrix
Mixer - InputMaster] editor window. Here you can turn the master input for each channel ON and
OFF and set the level.

[Matrix Mixer - InputMaster] editor window

5 Matrix Mixer - InputMaster8

Nominal
Minimum

Section Parameter Setting Range Function

© | Input Phase ON/OFF Reverses the phase of each channel’s signal.

(2] Level -0 t0 +10 dB Sets the signal level from each channel input to the
output bus.

(3) Solo ON/OFF Turns ON solo for each channel. If Solo is engaged
for even one channel, all non-Solo channels will be
muted.

(4] On ON/OFF Turns ON each channel’s input.

© | Block On -- Turns ON input for all channels in the Input Master
window. When turned ON, the [On] button lights up.

(6) Off -- Turns OFF input for all channels in the Input Master
window.

Q Nominal -- Resets all output signal levels in the Input Master
window, making them 0 dB.

(5] Minimum - Resets all output signal levels in the Input master
window, making them -c dB.
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m Output Master Window

If you click the [Output Master] button in the matrix mixer component editor, it will open the Output
Master window. Her you can turn the master output for each channel ON and OFF and set the level.

[Matrix Mixer - OutputMaster] editor window

5= Matrix Mixer : QutputMaster8
 a— —

on
off
Hominal
B.88 g B.ag Bea B.B8 B.an B.88 B.88 Minimum

XX

18811 (271bHD

Section Parameter Setting Range Function

© | Output Meter -- Displays the output signal level for each channel.

(2) Level -0 10 +10 dB Sets the output signal level for each channel.

(3] On ON/OFF Turns ON each channel’s output.

O | Block On -- Turns ON output for all channels in the Output
Master window. When turned ON, the [On] button
lights up.

(5) Off -- Turns OFF output for all channels in the Output
Master window.

(6] Nominal - Resets all output signal levels in the Output Master
window, making them O dB.

(7) Minimum -- Resets all output signal levels in the Output Master
window, making them -co dB.
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m All Inputs to One Output

When you click the output channel number on the matrix, the [Matrix Mixer - All Inputs to One
Output] editor window opens. All input channels and one output channel are displayed. The output
channel is the one you have clicked on in the matrix mixer component editor.

= Matrix Mixer : Input AllToOutputX8
T il ——

8 InFut & Outrut

Section Parameter Setting Range Function

© | Bus Send Level | Level -0 t0 +10 dB Sets the output signal level for each input channel.

(2) On ON/OFF Turns ON the output for each input channel.

©® | Output Channel -- Displays the selected output channel. Select
another channel from a menu.

(4] On ON/OFF Turns ON the output for the channel displayed in
the window.

(5) Meter -- Displays the output signal level of the channel
displayed in the window.

O | Block On -- Turns ON all channel inputs. When turned ON, the
[On] button lights up.

(7] Off - Turns OFF all channel inputs.

() Nominal - Resets all input signal levels, making them O dB.

(9] Minimum -- Reset all input signal levels, making them -co dB.

Output Channel Switching

[Matrix Mixer - All Inputs to One Output] editor window displays the output channel clicked in the

matrix mixer component editor. The [Channel] buttons in the [Output] section of the [Matrix Mixer -
All Inputs to One Output] editor window switch the channel group that is displayed in the window.

= Matrix Mixer : Input AllToOutputXg
o s —

B.a8 B.88 B.a8 588

18E1 (271hHy

If you make the matrix mixer component editor active while the [Matrix Mixer - All Inputs to One
Output] editor window is displayed, and then click another output channel, that channel group will
be displayed in the [Matrix Mixer - All Inputs to One Output] editor window.

One [Matrix Mixer - All Inputs to One Output] editor window is displayed for each matrix mixer
component editor.

DME Designer Owner’s Manual

413



Chapter 6 Component Guide

m One Input to All Outputs

When you click the input channel number on the left side of the matrix, the [Matrix Mixer - One Input
to All Outputs] editor window opens. One input channel and all output channels are displayed. The

input channel is the one you have clicked on in the delay mixer component editor.

= Matrix Mixer : InputXToOutputAll8
— — —

Section Parameter Setting Range Function

© | Input Channel - Displays the selected input channel. Select
another channel from a menu.

(2] Phase ON/OFF Reverses the phase of the input signal.

(3] Level -0 10 +10 dB Sets the input signal level.

(4] Solo ON/OFF Turns solo ON. If Solo is engaged for even
one channel, all non-Solo channels will be
muted.

(5) On ON/OFF Turns input ON.

© | Bus Send Level Level -0 t0 +10 dB Sets the signal level for each output channel.

(7) On ON/OFF Turns ON the output for each output channel.

© | Block On -- Turns ON all channel outputs. When turned
ON, the [On] button lights up.

(9] Off - Turns OFF all channel outputs.

(10] Nominal - Resets all output signal levels, making them
0 dB.

(11) Minimum - Resets all output signal levels, making them
-0 dB.

Input Channel Switching

The [Matrix Mixer - One Input to All Outputs] editor window displays the input channel for the
channel number clicked on in the matrix mixer component editor.

The [Channel] buttons in the [Input] section of the [Matrix Mixer - All Inputs to One Output] editor
window switch the channel group that is displayed in the window.

= Matrix Mixer : InputXToOutputAlls
e — —

In 1
Channel

3 InPut 8 Output 18EN (2F1bH:

If you make the matrix mixer component editor active while the [Matrix Mixer- One Input to All
Outputs] editor window is displayed, and then click another input channel, that channel will be
displayed in the [Matrix Mixer - One Input to All Outputs] editor window.

One [Matrix Mixer - One Input to All Outputs] editor window is displayed for each matrix mixer
component editor.

414
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m Crosspoint

If you click a level meter in the matrix mixer component editor, the output crosspoint window for the
group will be displayed. Turns the input channels ON and OFF and sets their levels. Just like the
matrix mixture component editor, the input channels are arranged vertically while the output

channels are arranged horizontally.

Chapter 6 Component Guide

[Matrix Mixer - Crosspoint] editor window

&= Matrix Mixer : CrossPointdx4

InPut
Channe
i

18811

Section Parameter Setting Range Function

© | Input Channel - Switches to another channel group.

® | Output Channel -- Switches to another channel group.

©® | Bus Send Level | Level -o0 t0 +10 dB Sets the output signal level for each crosspoint.

(4] On ON/OFF Turns ON output for each crosspoint.

© | Block On -- Turns ON output for all channels in the Crosspoint
window. When turned ON, the [On] button lights up.

(6] Off -- Turns OFF output for all channels in the Crosspoint
window.

(7] Nominal -- Resets all output signal levels in the Crosspoint
window, making them 0 dB.

(8] Minimum -- Resets all output signal levels in the Crosspoint

window, making them -co dB.

DME Designer Owner’s Manual

415



416

Chapter 6 Component Guide

Channel Group Switching

The [Matrix Mixer - Crosspoint] editor window displays four channels each for Input and Output.
It displays the channel group that was clicked on in the matrix mixer component editor. The
[Channel] buttons in the [Input] and [Output] sections of the [Matrix Mixer - Crosspoint] editor
window switch the channel group that is displayed.

[Input] section [Output] section
[Channel] menu [Channel] menu

If you click another channel group when the matrix mixer component editor is active and an [Matrix
Mixer - Crosspoint] editor window is displayed, that channel group will be displayed in the open

[Matrix Mixer - Crosspoint] editor window.
Only one [Matrix Mixer - Crosspoint] matrix window is displayed for each matrix mixer component

editor.
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Pan

The Pan group contains the following subgroups: LCR, LR, and Surround.

m Pan Nominal Position

Component editors contain the “Pan Nominal Position” parameter.
The button for that parameter displays its current setting. Clicking the button displays a menu with
[Center] and [LR], which are used to set the pan 0 dB reference.

Center (Center Nominal)
Uses the center volume as a reference, setting it as 0 dB. The LR speakers are -3 dB.

LR (LR Nominal)
Uses the LR speaker volumes as a reference, setting them as 0 dB. The center volume is +3 dB.

LCR

In the LCR component, one input is divided into left, center, and right outputs. The number of outputs
is triple the inputs. Components are available with 1, 2, 4, 8, 12, and 16 channels.

T Pan-LCR(41 " - Pan-LER(Z) - - - - PanLoR(E- - - -
. [ 1 Channel . [ 8 Channel J_ 12 Channel J_ . [ 1& Channel J_ .
~L1IN1 OuTALL] - C1IN1 OUTILL] - LMY ouTILL] - [1IN1 OuT1LL] -
| ouTq1cl] - [JIN2  OUTACL]- [1IN2 ouTq1cl] - [JIN2  OUTACL] -
| QuTARL] - [JING  OUTARL] - CIINZ QuTiRL] - [JING  OUTARL] -
1 1% -LlINg ouTZLL] - C1INg OuUT2LL] - C1iNgd OUTZL[] -
| <LINS ouT2CL] - [1INS ouTzcl]-[JINs  OUT2CL] -
CPanlcR(z)c - - - LCJING  OUTZR[-CJING  OUT2R[T-[JINS  OUT2RET-
| T hannel - LJINT OUTELL] - CIINT QuTSLL] - [IIN7 OuTELL] -
INg  DUT3C[]-[]INS ouT3C]-[]INg  OuT3C[]-
IN1 OuTqLL] - ouT2rR[]- [1IN9 ouT2RL] - [JIN9  OUT3R[]-
IN2 auTi1cL] - OuTALL] - CJIM10 OUT4ALL] - []IM10 ouT4L[] -
QuTIRL] - OuT4C[]-[1IN11 OuTacl] - [1IN11 OuTac[] -
ouT2L[0] - ouT4rR[]-[ClIN12 OUT4R[] - [JIN12 OUT4R[] -
ouT2c0 - OUTSLL - DUTSLLT - CJIN13  OUTSLL -
ouTzR[] - ouTsC[] - QuTscl] - [JIN14 OUTSCL] -
1% QUTSR[] - QuTsRL] - [JIN1S OUTSRL] -
| . OuTELL] - OUTELL] - [1IN16 OUTELL] -
CPanleR( auTschd - ouTsCr - auTschd -
. BEEEE . QUTBR[] - QuTsR] - QUTBR[] -
oUT7LE] - QUT7LL] - oUT7LE] -
oUTILL] - ouT7CL - oUT7CE - ouT7CL -
N2 OUTACL] - auTIRL] - ouT7RE] - auTIRL] -
INZ  DUTAR[] - ouTSL[ - ouTSLL] - ouTsL[ -
N4 OUTZL[T] - ouTac[] - ouTach] - ouTsc[] -
ouT2C[] - QuTsR[] - OUTSRL] - OuTsRL] -
OuT2R0] - 19 T - DUTAL[] - ouTaL] -
OUT3LLT - . - ouTac] -
- - OuTaR[d -
C]- [l OUTI0LLT -
C1 0- ouT0ed -
O] 01 QUT10R[] -
- OUTIMLLT -
O]~ oUT1ICL] -
- OuTA4R -
- ouT12L[T -
- QuTizcd -
. OUT1ZR[] -
DUT13L[T -
QuT12c -
QUT13R -
OUT14L[T -
ouT14cd -
QuT14R[d -
OUT15LLT -
oUTISCLT -
OUTA5R -
OUT1ELLT -
QuTiecd -

COUT1GR

2%

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.

DME Designer Owner’s Manual 417



Chapter 6 Component Guide

LCR component editor

188t

Parameter Setting Range Function
©® [CSR 0to 100% Sets the ratio for sending the center signal to LR.
® |Pan L63 - Center - R63 Sets LR orientation.
© | Pan Nominal Position Esnter Selects the nominal position from a menu.

LR

Separates a single input into left and right outputs. Components are available with 1, 2, 4, 8, 12, and

16 channels.
Pan-LR Pan-LR(4] Pan-LR(5) Pan-LR(E)

. [ 1 Channel . [ & Channel 12 Channel J_ . [ 18 Channel J_ .
- [1IN1 QUTALL] - C1IN1 ouTiL IN1 auTILL] - C1IM1 ouTqLL] -
QUT1R IN2 QUTAR IN2 OuT1R[] IN2 auTqRL]
! 1% - L1ING ouTzL INZ ouTzLL] - C1ING ouTzL] -
b F aOuTZR INg  OUT2RL]-L[]IN4 OUTZRL]-
L ouTzL INS QuUTZLL] - [1ING OuTILL] -
QUT3IR INE OuTaR[] ING QuT3IR[]
ouT4L IN7 ouTaLl] - C1IN7 ouT4L[] -
auT4R IN2  OUT4RL]-L[]IN2 OUT4R[]-
ouTsL IND QUTSLL] - [1IN2 QuUTSLL] -
QUTSR IN10 OUTSR L] IN10 OUTSR[]
OUTEL IN11 OUTSLL] - CJIN11 DUTSLL] -
auTER IN12Z OUTERL]- [1IM12 OUTBRL]-
ouTyL QuUTFLL] - [JIM12 OUT7LL] -
QUT?R QuTFRL] IN14 OUT7RL]
ouTsL ouTsLL]-ClIN1S OUTSLL] -
auTsR OuTER[]-LJIN1E OQUTSRL] -
1% ouTaL] - DUTaL[] -
QuUTaR[] QuTaR[]
........... oUTIOLL] - ouT10LE] -
........... OUTAORLT - OUTAORLT -
---------- OUTA1LLT - OUT11LLT -
QuT11R[] QUT11RE]
-------- oUT1ZLLT - oUT1ZLL] -
........... QuUT12R0] - OUTAZRLT -
........... 26 T - OUTI3LL] -
QUT43R[]
............................... ouTi4LL] -
............................... OUTA4RL] -
............................... OUT15LL] -
QUTI5RL]
............................... OUTIBLL] -

............................... QUTHER

............................... 2o

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.

Pan component editor

Pan-LR ¥ Channel

418

Parameter Setting Range Function
© |Pan L63 - R63 Sets the LR orientation.
@® | Pan Nominal Position Center Selects the nominal position from a menu.
LR
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Surround

There are three types of surround pan components in the Surround subgroup: 3-1, 5.1, and 6.1.
The surround pan component editor has a two-dimensional surround pan graph where you can set the
location of the sound image.

Surround 6.1 component editor

Chapter 6 Component Guide

Name

Location,
Setting Range

Function

© | 2D Surround Pan Graph -- Sets the sound image orientation. You can
move the sound image by clicking and
dragging.

© | Speaker L Left L63 F63 Clicking here moves the sound image to the

o Button Center C F63 button location.

(4] R Right R63 F63

(5] Ls Left Surround L63 R63

(6) Bs Back Surround C R63

(7) Rs | Right Surround R63 R63

(8] LFE | Low Frequency -- Indicates that there is a sub woofer. Clicking

Effect (Sub Woofer) makes the LFE level 0 dB. The sound image

does not move by clicking.

© | Left-Right Position L63 - C-R63 | Displays the LR sound image.

@ | Front-Back Position L63-C -R63 Displays the front-back sound image.

You can set the sound location using the mouse in the two-dimensional surround pan graph.
The sound image location is displayed at the bottom of the two-dimensional surround pan graph, but
numbers cannot be entered there.
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Dragging
You can move the control by dragging it with the mouse.

"2 Surround

Click
If you click within the graph, the control point will move to that position.

"2 surround = Surround

Snar
Lo bl

Click

Speaker Button

If you click any speaker button besides the [LFE] button, the control point will jump to that
speaker’s position.

"= Surround = Surround

Surround 61 Surround 61
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m Surround 3-1

Chapter 6 Component Guide

Surround 3-1 has four channel surround pan, with three channels in front, and one in the rear. There

is one input and four outputs.

© Surround

C1IN1

= o
° oD — @
a LHH T @

Double-click a component to display the component editor for it.

Surround 3-1 component editor

™= Surround

Surround  3-1

1BARY

Section Name/Parameter Setting Range Function
© | 2D Surround 2D Surround -- Sets the sound image orientation. You can
Pan Graph Pan Graph move the sound image by clicking and

dragging.

(2] Speaker Button - Clicking here moves the sound image to the
button location.

©® | Position Left-Right Position | L63 - C - R63 Displays the LR surround location.

(4] Front-Back Position | F63 - C - R63 Displays the front-back surround location.

© | Divergence Front 0to 100% Sets the ratio for sending the front-center
signal to front L and front R.

© | Pan Nominal Position Center Selects the nominal position from a menu.

LR
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m Surround 5.1

Surround 5.1 has surround pan with three channels in front, two in the rear, and one sub woofer
channel. There is one input and six outputs.

] Surround(2)

Double-click a component to display the component editor for it.

Surround 5.1 component editor

"= Surround

Ll

Surround 5

184E

Section Name/Parameter Setting Range Function
@ | 2D Surround 2D Surround -- Sets the sound image orientation. You can
Pan Graph Pan Graph move the sound image by clicking and

dragging.

(2] Speaker Button -- Clicking here moves the sound image to the
button location.

©® | Position Left-Right Position | L63 - C - R63 Displays the LR surround location.

(4) Front-Back Position | F63 - C - R63 Displays the front-back surround location.

© | Divergence Front 0to 100% Sets the ratio for sending the front-center
signal to front L and front R.

O |LFE Level -0 t0 +10 dB Sets output level to the sub woofer.

@ | Pan Nominal Position Center Selects the nominal position from a menu.

LR

422
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m Surround 6.1
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Surround 6.1 has surround pan with three channels in front, three in the rear, and one sub woofer
channel. There is one input and seven outputs.

Double-click a component to display the component editor for it.

Surround 6.1 component editor

"= Surround

Snar

W B T

Section Name/Parameter Setting Range Function
© | 2D Surround 2D Surround -- Sets the sound image orientation. You can
Pan Graph Pan Graph move the sound image by clicking and

dragging.

(2] Speaker Button - Clicking here moves the sound image to the
button location.

©® | Position Left-Right Position | L63 - C - R63 Displays the LR surround location.

(4] Front-Back Position | F63 - C - R63 Displays the front-back surround location.

© | Divergence Front 0to 100% Sets the ratio for sending the front-center
signal to front L and front R.

(6) Rear 0to 100% Sets the ratio for sending the rear-center
signal to rear L and rear R.

@ |LFE Level -0 to +10 dB Sets output level to the sub woofer.

© | Pan Nominal Position Center Selects the nominal position from a menu.

LR
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Router

The router assigns inputs to outputs. Each of the six router groups has a different number of inputs.
The groups are 1 input, 2 input, 4 input, 8 input, 12 input and 16 input. Each group has five
components, with 2, 4, 8, 12, and 16 outputs.

1 Input 8 Input
ML PesigEner  AAMLE RIES Reouter(TE) * © - Roulertts) © o Routerttd) © - & Router(20) Y
; : Tt 12 S
N1
Router(2)
| [ TTed 4 0
IN1 ouTe
ouT2)
ouT3
ouTy|
1%
2 Input 12 Input
Router(8) - - - - * Router(8) - * - - Router(8) - * - * - Router(10) Routeri21) Router(22) Router(23) Fouter(24) FRouleri25)
Tt 2 O Tt 8 Ul . [T 2 npat T2 0uful [T 2 Inpat 16 Cuut T2 200t [ 12inew S0 [[T2Inpt 8 Omut [T 721G 12 Ofpit [ T2 1ngu 16 Offeit
N1 auT1 INT ouT1 IH1 ouTi IH1 ouTi - LMt ouTh . QuT1L - LIINA .
IN2 ouTz IN2Z ouT2 IN2 ouT2 INZ ouTz2 N2 auTz
1% ouTa[L] - ouTaf] - ouTE N3 ouT:
QuT4| ouT4| ouTH NG ouT4|
Router(7y® « * - ouTsd - ouTs0d - ouTs I
OUTEL] - OuUTEL] - OUTE INE
QuT? ouT? ouT? N7
ouTe ouTs ouTs INg
1% uTa
INg
gie gire
IHN11 CliN11 ouT140]
SUniz o N1z CliNz  oUT12[]
oUT14 i 03
QuT1S
ouTIe
1%
4 Input 16 Input
Router(11) Router(13) Router(14) Router(15) Router(26) - - - - Router(27) -~ - Rower(28) - - - - Router(28) - - - - Router(30) -
] Y it i TE oW 200l [ 16 Input & Owbul [ 16 Tt 8 Cuiut [T 76 Tnput 12 Okt [ 16 Tnput 16 Offoist
INT ouT1 IH1 ouTi IH1 ouTi INT ouT1
IN2Z ouTz IN2 ouT2 INZ ouTz2 IN2Z ouT2
INZ - [Nz ouTE IN3 ouTE INZ ouT=
ING N4 ouT4| 1IN ouTH ING QuT4|
ING INS INS ouTS ING ouTs
ING ING ING OUTE ING OUTE
- Router(t2) © IN7 IN7 IN7  OUT7 N7 OUTT
N2 N2 INg ouTs N2 ouTe
# Input 4 Outy I IH IN3 I ouTa
1M1 ouTe IN10 IN10 IN10 INTD QUT10
INZ ouTz2 N1 IH11 IN11 IN11 OUTA4
IN2 ouTs IN12 IH12 IN1Z IN12  DUT1Z
N4 ouT4| IN13 IN13 IN1Z IN1Z QUT1Z
1% N1 N1 N1 IN1d OUTA4
IN1S IN15 IN15 IN1S  QUT15
IN1E IN18 IN1G IN1E QUT1G
1% 1% 1% 2%

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.

utput.

R EOGEIE

1E] [ilrels}
_[olo/ola/o/aa)

trut. r i L 16 InFut 16

Routers let you route signals from various [Input] locations by connecting them to various [Output]
locations.

One output can be connected to one input only. A single input can be output to multiple channels, but
multiple inputs cannot be output over a single channel. In other words, you can distribute the inputs,
but you cannot mix them. You cannot setup routing for more signals than the number of output
channels.
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m Routing Settings

To change an assignment, click at the position where the desired input and output channels
intersect. When the mouse pointer is moved over a cell, the input and output channels are
highlighted, and a red line is displayed connecting them. Click to set routing for that position. If
another output channel has been assigned to the clicked input channel, the original assignment

will not be cleared. If another input channel has been assigned to the clicked output channel, the
original assignment will be cleared.

Not Cleared Cleared

m Clearing Routing Settings

If you click the dot that indicates routing, the routing indicated by that dot will be cleared and the
dot will be erased.

2l aim@ine L

N
m
87

Router 12 InPut 12 OutPut
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Source Selector

This component selects a single input source from multiple input sources.

“Position” is the number of input sources, and “Channel” is the number of channels included in the
source. For example, a “4 Position 2 Channel” component allows you to select a single 2-channel
source from four 2-channel input sources.

3 Position and 16 Position components are all 1 Channel types, while 1, 2, and 6 Channel versions of 4
Position and 8 Position components are provided.

© Source Selector - -

Source Selector(2) W

i Source Sefector(4)

IN1-1 OUT-1
- LJINZ-1 [
- L1INZ-1

I Posfion 1 CRannE |
0%

. Source Saectorts)_ s

4 Postion T CHannel .

Source Selector(B) - -

o Source Sefector()

4 Posttion & CHannel. .
IN1-1  DUT-1

INt-2 ouT-20]- - - - -
N2 OUT3

IN1-4  OUT-4

IN1-5  DUT-5

IN1-&  OUT-
IN2-1

IN2-Z

IN2-3

INz-4

IN2-5

INZ-6

INZ-1

IN2-2

IN3-3

INz-4

N5

IN3-G

INa-1

INg-2

IN3-2

INg-4

INA-5

ING-E

8 Position T CHanne! .
IN1-1 OUT-A[]- - -
INz-1

B Posttion 2 CHannzl .
N1 QUT-AL] -
N1z OUT-2]

16 Position 1 ghannel | .
IN1-1 OUT-4[]- - - -
INZ-1 B
INZ-1
INg-1
IN5-1
ING-1
IN7-1
INS-1
ING-1

Double-click a component to open the component editor. The component editor is the same for all
types, the only difference being the number of sources.

Source Selector Component

= Source Select..

= Source Selecto

= Source Select... D

The Source Selector connects the selected input to the output. For example, if you select [1] for a 4
Position 2 Channel component, IN1-1 will be connected to OUT-1 and IN1-2 will be connected to
OUT2. If you select [2] IN2-1 will be connected to OUT-1 and IN2-2 will be connected to OUT2.
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Speaker Processor

The Speaker Processor is a crossover processor that includes APF (All Pass Filter), horn EQ, and
limiter functions. Six component types are available: 1 Way, 2 Way, 3 Way, 4 Way, 5 Way, and 6 Way.
Speaker Processor components have one input and one or multiple outputs.

: Speaker'Processor : Speaker'Processor(?) Speaker'Processor(B_) Speaker'Processor(A}) Speaker'Processor(S_) Speaker'Processor(B_): ;

ey . PEWEy O [EWEy ) . [ EeEy L PEwEy ] L PEWEE

N1 OUTAL). CJINT WIGHLI- o [JNA  WIGHLI- -[JIN1  HISHLI: CJIN1 HIGHLD. -CJiN1  HiGH

' Lo HIgH-pID

7% . MID

VR Y A Ly
.................................. S
............................................. 1_3;{*

Double-click a component to open the component editor.

Speaker processor Component (1]
= Speaker Processor

Library Hame [

Hish Dutr B
Delaw Limiter

Hizh-Hid 0
Delaw o Limiter

Low-Mid
el T3 ! i Cifieer

Low

Oelay i e _ Limiter
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Name Function
© | Library name Displays library name.
@® | Crossover response (phase) Crossover phase response, color coded for
output channel.
©® | Crossover response (level) Crossover level response, color coded for
each output channel.
O | Input meter Displays the input signal level.
© | Output meter Displays the output level for each band.
@ | Crossover Curve Display Button Turns crossover curve display for each
output channel on or off.
Section Parameter Range Function
@ | Delay Delay ON/OFF Applies delay to the crossover response.
O |PEQ PEQ ON/OFF Applies PEQ to the crossover response.
© | Navigator Input Level -0 to +10 dB Specifies the input signal level.
(10} Crossover - Opens the crossover editor window.
(11] Delay - Opens the delay editor window.
® PEQ - Opens the parametric equalizer editor
window.
® Output Level -0 to +10 dB | Sets the output level from each output
channel.
(1) Mute ON/OFF Mutes the output of each output channel.
(15 Limiter - Opens the limiter editor window.
Different numbers of channels are provided by each component variation.
1 Way ALL
2 Way Low/High
3 Way Low/Mid/High
4 Way Low/Low-Mid/High-Mid/High
5 Way Sub-Low/Low/Low-Mid/High-Mid/High
6 Way Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Each frequency band has its own color, with Low being red, Mid being green, and so on.
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m Graph Control Points
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The crossover level control points indicate [Output Level] and [Frequency]. The control points will
move in response to [Output Level] changes made via the knobs or edit boxes. The [Output Level]
and [Frequency] parameters can also be changed by directly dragging the control points.
Changes to the [Frequency] parameter are shown on the crossover phase response graph.

= Speaker Processor

Librara Hame [

Hizsh
Deiad

Hizh-Mid
Delay

Low-Mid feTda

Low
Delay

Limiter

Limiter

Limiter

Limiter

The control point in the center of the graph can be dragged vertically to change the [Output Level]

parameter.

Hizh
Hiah-Mid
Low-Mid

L

Delay

belas

DElas

Oelay

((

The [Output Level] parameter changes.

Control points at the intersections between the frequency bands can be dragged horizontally to

change the [Frequency].

The crossover phase response will change.
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m Crossover

Click the Speaker Processor [Crossover] button to open the crossover editor window.

[Speaker Processor - Crossover] editor window

= Speaker Processor : Crossoverd

Hiah-Mid

Section | Parameter Range Function
© | Polarity Normal/Inverted Inverts the polarity of each output channel.
O | Mute ON/OFF Mutes the output of each output channel.
This parameter is linked to the Mute setting in
the original window.
® | Frequency 20 Hz to 20 kHz Sets the crossover frequency between output
channels.
The display appears as a dotted line when
muted.
O |LPF Type Thru Sets the roll-off slope and filter type for each
6dB/Oct octave.
12dB/Oct AdjustGe The filter is bypassed when [Thru] is
12dB/Oct Butrwrth selected.
12dB/Oct Bessel
12dB/Oct Linkwitz
18dB/Oct AdjustGc
18dB/Oct Butrwrth
18dB/Oct Bessel
24dB/Oct AdjustGe
24dB/Oct Butrwrth
24dB/Oct Bessel
24dB/Oct Linkwitz
36dB/Oct AdjustGe
36dB/Oct Butrwrth
36dB/Oct Bessel
48dB/Oct AdjustGe
48dB/Oct Butrwrth
48dB/Oct Bessel
48dB/Oct Linkwitz
(5) Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency.
(6] Ge -6 dBto +6 dB Sets the cutoff frequency gain when the
[Type] setting is [AdjustGc] (Adjustable Gc).
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Section Parameter Range Function

© | HPF Type Thru Sets the roll-off slope and filter type for each
6dB/Oct octave.

12dB/Oct AdjustGe The filter is bypassed when [Thru] is
12dB/Oct Butrwrth selected.

12dB/Oct Bessel
12dB/Oct Linkwitz
18dB/Oct AdjustGe
18dB/Oct Butrwrth
18dB/Oct Bessel
24dB/Oct AdjustGe
24dB/Oct Butrwrth
24dB/Oct Bessel
24dB/Oct Linkwitz
36dB/Oct AdjustGe
36dB/Oct Butrwrth
36dB/Oct Bessel
48dB/Oct AdjustGe
48dB/Oct Butrwrth
48dB/Oct Bessel
48dB/Oct Linkwitz

(5] Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency.
(o] Ge -6 dBto +6 dB Sets the cutoff frequency gain when the
[Type] setting is [AdjustGc] (Adjustable Gc).
m Delay

Click the Speaker Processor [Delay] button to open the window. Delay can be set independently
for each output channel.

[Speaker Processor - Delay] editor window

= Speaker Processor._. |ZJ|E|[XJ
= = =-

Parameter Range Function
© | Delay ms: 0 to 500 Sets the delay time.
Sample: the range Two edit boxes show milliseconds and the unit
depends on the Fs value. | specified in the [Delay Scale] section.
Meter: 0to 171.8 Sets the output level for each band.

Feet: 0 to 563.6

Frame: the range depends
on the Frame value.

Beat: the range depends
on the Beat value.

® |On ON/OFF Turns delay ON.

©® | Delay Scale ms Selects the delay time units. The selected button will
Sample light and the [Delay] edit box will change accordingly.
Meter When [Beat] is selected the knobs can be used to
Feet adjust BPM.
Frame
Beat
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Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 81 for information on parameter
linking.

m Parametric Equalizer

Click the Crossover Processor [PEQ] button to open the window. Parametric equalization is
provided for each crossover band.

[Speaker Processor - PEQ)] edit window

= Speaker Processor : PEQ{Hizh)

Gain
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Name Function
© | Crossover response (phase) Shows crossover phase response.
©® | Crossover response (level) Shows crossover level response.

Parameter Range Function
® | Type PEQ Select a filter type from the menu.

L.SHELF 6dB/Oct

L.SHELF 12dB/Oct

H.SHELF 6dB/Oct

H.SHELF 12dB/Oct

HPF

LPF

APF T 1st

APF! 2nd

Horn EQ™
O |B/W 0.023 ~ 6.672 Sets the octave bandwidth for each band.
O Q 63.0 ~ 0.10 Sets the Q for each band.

0O | Frequency 20 Hz to 20 kHz Sets the frequency for each band.
© | Gain -18 dB to +18 dB Sets the gain for each band.

O | Bypass ON/OFF Bypasses the PEQ for each band.
©® |PEQOn ON/OFF Turns PEQ ON.

*1 APF: The APF (All Pass Filter) is a filter that passes all frequency bands while affecting only the phase. Used to match the

phase of the crossover bands.

APF 1st shifts the phase from 0° to 180°, while APF 2nd shifts the phase from 0° to 360°. APF 2nd also allows Q adjustment.

*2 Horn EQ: CD (Constant Directivity) horn speakers exhibit a roll-off in high-frequency level.
Horn EQ is provided to compensate for this roll-off. For this reason the gain can only be set to higher than 0dB, and the

frequency higher than 500Hz.
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m Limiter

Click the Speaker Processor [Limiter] button to open the window. Limiter settings are provided for

each output channel.

[Speaker Processor - Limiter] Editor Window

= Speaker Processor : Limiter{High) [Z”E”g|

Name Function
© | Limiter Curve A graphic representation of limiter response. The
horizontal axis represents input level, and the vertical
axis represents output level.
® | Gain Reduction Meter Displays the amount of gain reduction.
© | Output Meter Displays the output level.
Parameter Range Function
O | Threshold -54 dB to +0 dB Sets the threshold level.
O | Attack Fast Sets the attack time.
Mid
Slow
Manual (0 to 120ms)
O | Release Fast Sets the release time.
Mid With the [Fast], [Mid], or [Slow] settings the optimum
Slow value is automatically set based on the longest
Manual wavelength audio signal received by the limiter.
(44.1kHz: 6ms to46s
48kHz: 5ms to 42.3s
88.2kHz: 3ms to 23s
96kHz: 3ms to 21.1s)
®@ |On ON/OFF Turns the limiter ON. The limiter is bypassed when the
button is turned OFF.
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SPX

SPX is an effect component that supports many different effect applications, such as reverb, delay,
and modulation effects, along with complex combinations of multiple effects. Although the SPX
component is a single component, it encompasses 43 effect types.

When you change the effect type, right-click the SPX component to display the context menu, click
[Recall Component Library], then select the effect type from the [Effect Type] submenu.

SRR mowe mowe SPRENEmes oGP e e SRR v
fReverb Hall N Dyna. Fiter | . . | Delay -= Reveth, | Stereo Rever_
1M1 auTH - - L1INA auTA < L1INA ouTA 1M1 auTHA

IM2 auTz

INZ2 ouTZ{1- - [1INZ QuT2L] - - [1INZ ouTZ[

o

t.

Double-click this component to display the component editor for

SPX component editor

Effect Name [ Reverb Hall 1 Tuwre [ Reverb Hal i Outrut

5 3 3
Name/Parameter Function
© | Input Meter Displays the input signal level.
® | [Mix Balance] Control Adjusts the balance between the fundamental tone and the effect tone.
© | [Bypass] button When turned ON, the input signal is output without change.
O | Output Meter Displays the output signal level.
© | Other Parameters Other parameters vary according to the effect type.
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Other effect parameters vary according to the selected effect type, as shown below.

Effect Type Parameter Setting Range Function
Reverb Hall Rev Time 0.3t099.0s Reverb time
Reverb Room " — -
Reverb Stage Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
Reverb Plate Hi.Ratio 0.1t01.0 High-frequency reverb time ratio
gqulﬂ?%gﬁi,t\r’é%m, Lo.Ratio 0.1to2.4 Low-frequency reverb time ratio
stage, and plate Diff. 0to 10 Reverb diffusion (left-right reverb spread)
b simulations, . S :
;ellvv?/?th %g}tés ions Density 0to 100% Reverb density
E/R Dly 0.0to 100.0 ms Delay between early reflections and reverb
E/R Bal. 0to 100% Balance of early reflections and reverb (0% = all
reverb, 100% = all early reflections)
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Gate Lvl OFF, -60 to 0 dB Level at which gate kicks in
Attack 0to 120 ms Gate opening speed
Hold 44.1kHz: 0.02ms to 2.13s Gate open time
48kHz: 0.02 ms to 1.96s
88.2kHz: 0.01ms to 1.06s
96kHz: 0.01ms to 981ms
Decay 44 .1kHz: 6.0ms to 46.0s Gate closing speed
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Early Ref. Type S-Hall, L-Hall, Random, Revers, | Type of early reflection simulation
One input, two Plate, Spring
output early : - -
reflections. RoomSize 0.1t0 20.0 Reflection spacing
Liveness 0to 10 Early reflections decay characteristics (0 = dead,
10 = live)
Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
Diff. 0to 10 Reflection diffusion (left-right reflection spread)
Density 0to 100% Reflection density
ER Num. 1t019 Number of early reflections
FB.Gain -99 to +99% Feedback gain
Hi.Ratio 0.1t0 1.0 High-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Gate Reverb Type Type-A, Type-B Type of early reflection simulation
R Gat : - -
Oi\tleeirnsgut,étlv?o RoomSize 0.1t0 20.0 Reflection spacing
output early Liveness 0to 10 Early reflections decay characteristics (0 = dead,
reflections with 10 = live)
gate, and early : — -
reflections with Ini.Dly 0.0 t0 500.0 ms Initial delay before reverb begins
reverse gate. Diff. 0to 10 Reflection diffusion (left-right reflection spread)
Density 0to 100% Reflection density
ER Num. 1t0 19 Number of early reflections
FB.Gain -99 to +99% Feedback gain
Hi.Ratio 0.1t01.0 High-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Mono Delay Delay 0.0t0 2730.0 ms Delay time
One input, one : -
s FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
82}2“ basic repeat feedback, minus values for reverse-phase
Y. feedback)
Hi.Ratio 0.1t0 1.0 High-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
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Effect Type Parameter Setting Range Function
Stereo Delay Delay L 0.0 to 1350.0 ms Left channel delay time
Two input, two - :
output basic stereo Delay R 0.0 to 1350.0 ms Right channel delay time
delay. FB.Gain L -99 to +99% Left channel feedback (plus values for normal-
phase feedback, minus values for reverse-phase
feedback)

FB.Gain R -99 to +99% Right channel feedback (plus values for normal-
phase feedback, minus values for reverse-phase
feedback)

Hi.Ratio 0.1t0 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Mod.Delay Delay 0.0 to 2725.0 ms Delay time
One input, two : -

' FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
output basic repeat feedback, minus values for reverse-phase
delay with feedback)
modulation.

Hi.Ratio 0.1t01.0 High-frequency feedback ratio

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0to 100% Modulation depth

Wave Sine, Tri Modulation waveform

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Delay LCR Delay L 0.0t0 2730.0 ms Left channel delay time
One input, two :
output 3-tap delay Delay C 0.0 t0 2730.0 ms Center channel delay time
(left, center, right). | Delay R 0.0 t0 2730.0 ms Right channel delay time

Delay FB 0.0t0 2730.0 ms Feedback delay time

Level L -100 to +100% Left channel delay level

Level C -100 to +100% Center channel delay level

Level R -100 to +100% Right channel delay level

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Hi.Ratio 0.1t0 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Echo Delay L 0.0 to 1350.0 ms Left channel delay time

Two input, two - -

output stereo delay Delay R 0.0 to 1350.0 ms Right channel delay time

with crossed FB.Dly L 0.0to 1350.0 ms Left channel feedback delay time
feedback loop. - -

FB.Dly R 0.0 to 1350.0 ms Right channel feedback delay time

FB.Gain L -99 to +99% Left channel feedback gain (plus values for normal-
phase feedback, minus values for reverse-phase
feedback)

FB.Gain R -99 to +99% Right channel feedback gain (plus values for
normal-phase feedback, minus values for reverse-
phase feedback)

L->R FBG -99 to +99% Left to right channel feedback gain (plus values for
normal-phase feedback, minus values for reverse-
phase feedback)

R->L FBG -99 to +99% Right to left channel feedback gain (plus values for
normal-phase feedback, minus values for reverse-
phase feedback)

Hi.Ratio 0.1t01.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Chorus Freq. 0.05 10 40.00 Hz Modulation speed

Two input, two > - -

output chorus AM.Depth 0 to 100% Amplitude modulation depth
effect. PM.Depth 0 to 100% Pitch modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

LSHF 21.2 Hz t0 8.00 kHz Low shelving filter frequency

LSH G -12to +12dB Low shelving filter gain

EQF 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQG -12to +12 dB EQ (peaking type) gain

EQQ 10.0t0 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12to +12dB High shelving filter gain
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Effect Type Parameter Setting Range Function
Flange Fregq. 0.05 to 40.00 Hz Modulation speed
gﬁ%hqeghtgvéoeffect. Depth 0to 100% Modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Wave Sine, Tri Modulation waveform
LSHF 21.2 Hz t0 8.00 kHz Low shelving filter frequency
LSHG -12to +12dB Low shelving filter gain
EQF 100 Hz to 8.00 kHz EQ (peaking type) frequency
EQG -12to +12 dB EQ (peaking type) gain
EQQ 10.0t0 0.10 EQ (peaking type) bandwidth
HSHF 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12 dB High shelving filter gain
Symphonic Freg. 0.05 to 40.00 Hz Modulation speed
g‘&vﬁ)g‘tps%tg’ﬁom . | Depth 0to 100% Modulation depth
effect. Mod.Dly 0.0 to 500.0 ms Modulation delay time
Wave Sine, Tri Modulation waveform
LSHF 21.2 Hz t0 8.00 kHz Low shelving filter frequency
LSHG -12to +12dB Low shelving filter gain
EQF 100 Hz to 8.00 kHz EQ (peaking type) frequency
EQG -12to +12 dB EQ (peaking type) gain
EQQ 10.0t0 0.10 EQ (peaking type) bandwidth
HSHF 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12 dB High shelving filter gain
Phaser Freg. 0.05 to 40.00 Hz Modulation speed
gg&m&gg‘é o | Depth 0to 100% Modulation depth
phaser. FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Offset 0to 100 Lowest phase-shifted frequency offset
PHASE 0.00 to 354.38 degrees Left and right modulation phase balance
Stage 2,4,6,8,10, 12,14, 16 Number of phase shift stages
LSHF 21.2 Hz to 8.00 kHz Low shelving filter frequency
LSH G -12to +12dB Low shelving filter gain
HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12dB High shelving filter gain
Auto Pan Fregq. 0.05 to 40.00 Hz Modulation speed
gnvgahqpaujfc}\ggnner. Depth 0to 100% Modulation depth
Direction I|§3<_>R’ L->R, L<-R, Turn L, Turn | Panning direction
Wave Sine, Tri, Square Modulation waveform
LSHF 21.2 Hz t0 8.00 kHz Low shelving filter frequency
LSHG -12to +12 dB Low shelving filter gain
EQF 100 Hz to 8.00 kHz EQ (peaking type) frequency
EQG -12to +12 dB EQ (peaking type) gain
EQQ 10.0t0 0.10 EQ (peaking type) bandwidth
HSHF 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12 dB High shelving filter gain
Tremolo Freg. 0.05 to 40.00 Hz Modulation speed
gﬁ%mgrﬁ‘g’l‘g Depth 0to 100% Modulation depth
effect. Wave Sine, Tri, Square Modulation waveform
LSHF 21.2 Hz t0 8.00 kHz Low shelving filter frequency
LSHG -12to +12 dB Low shelving filter gain
EQF 100 Hz to 8.00 kHz EQ (peaking type) frequency
EQG -12to +12 dB EQ (peaking type) gain
EQQ 10.0t0 0.10 EQ (peaking type) bandwidth
HSHF 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12 dB High shelving filter gain
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Effect Type Parameter Setting Range Function
HQ.Pitch Pitch -12 to +12 semitones Pitch shift
Squdj?%%ht—végality Fine 750 to +50 cents Pitch shift fine
pitch shifter. Delay 0.0 to 1000.0 ms Delay time
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Mode 1t010 Pitch shift precision
Dual Pitch Pitch 1 -24 to +24 semitones Channel #1 pitch shift
E(Jvtophntppﬂ’tvc}wws?hifter. Fine 1 -50 to +50 cents Channel #1 pitch shift fine
Pitch 2 -24 to +24 semitones Channel #2 pitch shift
Fine 2 -50 to +50 cents Channel #2 pitch shift fine
Level 1 -100 to +100% Channel #1 level (plus values for normal phase,
minus values for reverse phase)
Pan 1 L63 to R63 Channel #1 pan
Level 2 -100 to +100% Channel #2 level (plus values for normal phase,
minus values for reverse phase)
Pan 2 L63 to R63 Channel #2 pan
Delay 1 0.0 to 1000.0 ms Channel #1 delay time
FB.Gain 1 -99 to +99% Channel #1 feedback gain (plus values for normal-
phase feedback, minus values for reverse-phase
feedback)
Delay 2 0.0 to 1000.0 ms Channel #2 delay time
FB.Gain 2 -99 to +99% Channel #2 feedback gain (plus values for normal-
phase feedback, minus values for reverse-phase
feedback)
Mode 1t0 10 Pitch shift precision
Rotary Rotate STOP, START Rotation stop, start
gﬂglﬂ??&térty © Speed SLOW, FAST Rotation speed (see SLOW and FAST parameters)
speaker simulator. | Slow 0.05 to 10.00 Hz SLOW rotation speed
Fast 0.05 to 10.00 Hz FAST rotation speed
Drive 0to 100 Overdrive level
Accel 0to 10 Acceleration at speed changes
Low 0to 100 Low-frequency filter
High 0to 100 High-frequency filter
Ring Mod. Source OSC, SELF Modulation source: oscillator or input signal
g‘&vtophqerg'gtwo Osc.Freq. 0.0 to 5000.0 Hz Oscillator frequency
modulator. FM Freq. 0.05 to 40.00 Hz Oscillator frequency modulation speed
FM Depth 0to 100% Oscillator frequency modulation depth
Mod.Filter Freg. 0.05 to 40.00 Hz Modulation speed
gnv%hqpr;’gémgﬁ on | Depth 0to 100% Modulation depth
filter. Phase 0.00 to 354.38 degrees Left-channel modulation and right-channel
modulation phase difference
Type LPF, HPF, BPF Filter type: low pass, high pass, band pass
Offset 0to 100 Filter frequency offset
Reso. 0to 20 Filter resonance
Level 0to 100 Output level
Distortion DST.Type DST1, DST2, OVD1, OVD2, Distortion type (DST = distortion, OVD = overdrive)
One input, two CRUNCH
g#tGDCL):‘t distortion Drive 0to 100 Distortion drive
Master 0to 100 Master volume
Tone -10to +10 Tone
N.Gate 0to 20 Noise reduction
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Effect Type Parameter Setting Range Function
Amp Simulate AMP.Type STK-M1, STK-M2, THRASH, Guitar amp simulation type
One input, two MIDBST, CMB-PG, CMB-VR,
output guitar amp CMB-DX, CMB-TW, MINI, FLAT
simulator. DST.Type DST1, DST2, OVD1, OVD2, Distortion type (DST = distortion, OVD = overdrive)
CRUNCH
Drive 0to 100 Distortion drive
Master 0to 100 Master volume
Bass 0to 100 Bass tone control
Middle 0to 100 Middle tone control
Treble 0to 100 High tone control
Cab Dep 0to 100% Speaker cabinet simulation depth
EQF 100 to 8.0 kHz EQ (peaking type) frequency
EQG -12to +12 dB EQ (peaking type) gain
EQQ 10.0t0 0.10 EQ (peaking type) bandwidth
N.Gate 0to 20 Noise reduction
Dyna.Filter Sense 0to 100 Sensitivity
Two input, two : -
output dynamically Direction UP, DOWN Upward or downward frequency change
controlled filter. Decay 44.1kHz: 6.0ms to 46.0s Filter frequency change decay speed
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Type LPF, HPF, BPF Filter type
Offset 0to 100 Filter frequency offset
Reso. 0to 20 Filter resonance
Level 0to 100 Qutput Level
Dyna.Flange Sense 0to 100 Sensitivity
Two input, two : :
output dynamically Direction UP, DOWN Upward or downward frequency change
controlled flanger. | Decay 44.1kHz: 6.0ms to 46.0s Decay speed
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Offset 0to 100 Delay time offset
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
LSHF 21.2 Hz to 8.00 kHz Low shelving filter frequency
LSHG -12to +12 dB Low shelving filter gain
EQF 100 Hz to 8.00 kHz EQ (peaking type) frequency
EQG -12to +12dB EQ (peaking type) gain
EQQ 10.0t0 0.10 EQ (peaking type) bandwidth
HSHF 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12 dB High shelving filter gain
Dyna.Phaser Sense 0to 100 Sensitivity
Two input, two —
output dynamically Direction UP, DOWN Upward or downward frequency change
controlled phaser. | Decay 44 1kHz: 6.0ms to 46.0s Decay speed
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Offset 0to 100 Lowest phase-shifted frequency offset
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Stage 2,4,6,8,10, 12,14, 16 Number of phase shift stages
LSHF 21.2 Hz t0 8.00 kHz Low shelving filter frequency
LSH G -12to +12 dB Low shelving filter gain
HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency
HSH G -12to +12dB High shelving filter gain
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Effect Type Parameter Setting Range Function
Rev+Chorus Rev Time 0.3t099.0s Reverb time
Squdj?ﬁ)g\t/étr\goand Ini.Dly 0.0 10 500.0 ms Initial delay before reverb begins
chorus effects in Hi.Ratio 0.1t01.0 High-frequency reverb time ratio
parallel. Diff. 0to 10 Spread
Density 0 to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev/Cho 0to 100% Reverb and chorus balance (0% = all reverb, 100%
= all chorus)
Freq. 0.05 to 40.00 Hz Modulation speed
AM.Depth 0to 100% Amplitude modulation depth
PM.Depth 0to 100% Pitch modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
Wave Sine, Tri Modulation waveform
Rev->Chorus Rev Time 0.3t099.0s Reverb time
ooqusjrt]?g\t/étrgoand Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
chorus effects in Hi.Ratio 0.1t0 1.0 High-frequency reverb time ratio
series. Diff. 0to 10 Spread
Density 0to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev Bal. 0to 100% Reverb and chorused reverb balance (0% = all
chorused reverb, 100% = all reverb)
Freg. 0.05 to 40.00 Hz Modulation speed
AM.Depth 0to 100% Amplitude modulation depth
PM.Depth 0to 100% Pitch modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
Wave Sine, Tri Modulation waveform
Rev+Flange Rev Time 0.3t099.0s Reverb time
(?ur}g&??g\t/étr\goand Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
flanger effects in Hi.Ratio 0.1t0 1.0 High-frequency reverb time ratio
parallel. Diff, 0to 10 Spread
Density 0to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev/Flg 0to 100% Reverb and flange balance (0% = all reverb, 100%
= all flange)
Freq. 0.05 to 40.00 Hz Modulation speed
Depth 0 to 100% Modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Wave Sine, Tri Modulation waveform
Rev->Flange Rev Time 0.3t099.0s Reverb time
(?ur}g&??g\t/étr\goand Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
flanger effects in Hi.Ratio 0.1t0 1.0 High-frequency reverb time ratio
series. Diff. 0to 10 Spread
Density 0to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev Bal. 0 to 100% Reverb and flanged reverb balance (0% = all
flanged reverb, 100% = all reverb)
Freq. 0.05 to 40.00 Hz Modulation speed
Depth 0 to 100% Modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Wave Sine, Tri Modulation waveform
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Effect Type Parameter Setting Range Function
Rev+Sympho. Rev Time 0.3t099.0s Reverb time
Squdj?ﬁ)g\t/étr\goand Ini.Dly 0.0 10 500.0 ms Initial delay before reverb begins
symphonic effects | Hi.Ratio 0.1t01.0 High-frequency reverb time ratio
in parallel. Diff. 0to 10 Spread
Density 0 to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev/Sym 0to 100% Reverb and symphonic balance (0% = all reverb,
100% = all symphonic)
Freq. 0.05 to 40.00 Hz Modulation speed
Depth 0to 100% Modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
Wave Sine, Tri Modulation waveform
Rev->Sympho. Rev Time 0.3t099.0s Reverb time
ooqusjrt]?g\t/étrgoand Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
symphonic effects | Hi.Ratio 0.1t0 1.0 High-frequency reverb time ratio
In series. Diff. 0to 10 Spread
Density 0to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev Bal. 0to 100% Reverb and symphonic reverb balance (0% = all
symphonic reverb, 100% = all reverb)
Freg. 0.05 to 40.00 Hz Modulation speed
Depth 0to 100% Modulation depth
Mod.Dly 0.0 to 500.0 ms Modulation delay time
Wave Sine, Tri Modulation waveform
Rev->Pan Rev Time 0.3t099.0s Reverb time
(?ur}g&??g\t/étr\goand Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
autopan effects in | Hi.Ratio 0.1t0 1.0 High-frequency reverb time ratio
parallel. Diff, 0to 10 Spread
Density 0to 100% Reverb density
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Rev Bal. 0 to 100% Reverb and panned reverb balance (0% = all
panned reverb, 100% = all reverb)
Freq. 0.05 to 40.00 Hz Modulation speed
Depth 0 to 100% Modulation depth
Direction ||§<_>R' L->R, L<-R, Turn L, Turn | Panning direction
Wave Sine, Tri, Square Modulation waveform
Delay+ER. Delay L 0.0 to 1000.0 ms Left channel delay time
oour}%LIth]%Lglég\/Ngnd Delay R 0.0 to 1000.0 ms Right channel delay time
early reflections FB.Dly 0.0 to 1000.0 ms Feedback delay time
effects in parallel. FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Hi.Ratio 0.1t01.0 High-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
DIy/ER 0to 100% Delay and early reflections balance (0% = all delay,
100% = all early reflections)
Type S-Hall, L-Hall, Random, Revers, | Type of early reflection simulation
Plate, Spring
RoomSize 0.1t0 20.0 Reflection spacing
Liveness 0to 10 Early reflections decay characteristics (0 = dead,
10 = live)
Ini.Dly 0.0 t0 500.0 ms Initial delay before reverb begins
Diff. 0to 10 Spread
Density 0to 100% Reverb density
ER Num. 1t0 19 Number of early reflections

DME Designer Owner’s Manual




Chapter 6 Component Guide

Effect Type Parameter Setting Range Function
Delay->ER. Delay L 0.0 to 1000.0 ms Left channel delay time
One input, two : .
output delay and Delay R 0.0 to 1000.0 ms Right channel delay time
early reflections FB.Dly 0.0 to 1000.0 ms Feedback delay time
effects in series. FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Hi.Ratio 0.1t0 1.0 High-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
DLY.BAL 0to 100% Delay and early reflected delay balance (0% = all
early reflected delay, 100% = all delay)
Type S-Hall, L-Hall, Random, Revers, | Type of early reflection simulation
Plate, Spring
RoomSize 0.1t0 20.0 Reflection spacing
Liveness 0to 10 Early reflections decay characteristics (0 = dead,
10 = live)
Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
Diff. 0to 10 Spread
Density 0to 100% Reverb density
ER Num. 1t0 19 Number of early reflections
Delay+Reverb Delay L 0.0 to 1000.0 ms Left channel delay time
One input, two - -
output delay and Delay R 0.0 to 1000.0 ms Right channel delay time
reverb effects in FB.Dly 0.0 to 1000.0 ms Feedback delay time
parallel. FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Delay Hi 0.1t01.0 Delay high-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Dly/Rev 0to 100% Delay and reverb balance (0% = all delay, 100% =
all reverb)
Rev Time 0.3t099.0s Reverb time
Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
Rev Hi 0.1t01.0 High-frequency reverb time ratio
Diff. 0to 10 Spread
Density 0to 100% Reverb density
Delay->Reverb Delay L 0.0 to 1000.0 ms Left channel delay time
One input, two - -
output delay and Delay R 0.0 to 1000.0 ms Right channel delay time
reverb effects in FB.Dly 0.0 to 1000.0 ms Feedback delay time
series. FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Delay Hi 0.1t01.0 Delay high-frequency feedback ratio
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
Dly.Bal 0 to 100% Delay and delayed reverb balance (0% = all
delayed reverb, 100% = all delay)
Rev Time 0.3t099.0s Reverb time
Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins
Rev Hi 0.1t01.0 High-frequency reverb time ratio
Diff. 0to 10 Spread
Density 0to 100% Reverb density
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Effect Type Parameter Setting Range Function
Dist->Delay DST.Type DST1, DST2, OVD1, OVD2, Distortion type (DST = distortion, OVD = overdrive)
One input, two CRUNCH
gﬁtdpgte%?gfté%?s in Drive 0to 100 Distortion drive
series. Master 0 to 100 Master volume
Tone -10to +10 Tone control
N.Gate Oto20 Noise reduction
Delay 0.0to 2725.0 ms Delay time
FB.Gain -99 to +99% Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)
Hi.Ratio 0.1t01.0 High-frequency feedback ratio
Freq. 0.05 to 40.00 Hz Modulation speed
Depth 0to 100% Modulation depth
Dly.Bal 0to 100% Distortion and delay balance (0% = all distortion,
100% = all delayed distortion)
Multi.Filter Type 1 HPF, LPF, BPF Filter 1 type: high pass, low pass, band pass
gﬁv%hq%%;\gg Type 2 HPF, LPF, BPF Filter 2 type: high pass, low pass, band pass
multi-filter (24 dB/ | Type 3 HPF, LPF, BPF Filter 3 type: high pass, low pass, band pass
octave). Freq. 1 28.0 Hz to 16.0 kHz Filter 1 frequency
Freq. 2 28.0 Hz to 16.0 kHz Filter 2 frequency
Freq. 3 28.0 Hz to 16.0 kHz Filter 3 frequency
Level 1 0 to 100 Filter 1 level
Level 2 0 to 100 Filter 2 level
Level 3 0 to 100 Filter 3 level
Reso. 1 Oto20 Filter 1 resonance
Reso. 2 Oto20 Filter 2 resonance
Reso. 3 Oto20 Filter 3 resonance
Stereo Reverb Rev Time 0.3t099.0s Reverb time
gﬁv%hqpsfgrte\go Rev Type Hall, Room, Stage, Plate Reverb type
reverb. Ini.Dly 0.0to 100.0 ms Initial delay before reverb begins
Hi.Ratio 0.1t0 1.0 High-frequency reverb time ratio
Lo.Ratio 0.1t02.4 Low-frequency reverb time ratio
Diff. 0to 10 Reverb diffusion (left-right reverb spread)
Density 0to 100% Reverb density
E/R Bal. 0to 100% Balance of early reflections and reverb (0% = all
reverb, 100% = all early reflections)
HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency
LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
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Effect Type Parameter Setting Range Function
M.Band Dyna. Low Gain -96.0to0 +12.0 dB Low band level
Two input, two : : -
output 3-band Mid Gain -96.0 to +12.0 dB Mid band level
dynamics Hi. Gain -96.0t0 +12.0 dB High band level
processor, with Presence 10to +10 For iti i i
g - positive values, the threshold of the high band is
mg::”%%ﬂcst%g and lowered and the threshold of the low band is
rgneterin for each increased. For negative values, the opposite will
band 9 occur. When set to 0, all three bands are affected
) the same.
Cmp.Thre -24.0dB t0o 0.0 dB Compressor threshold
Cmp.Rat 1:1 to 20:1 Compressor ratio
Cmp.Atk 0to 120 ms Compressor attack
Cmp.Rel 44.1kHz: 6.0ms to 46.0s Compressor release time
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Cmp.Knee Otob Compressor knee
Lookup 0.0to 100.0 ms Lookup delay
Cmp.Byp ON/OFF Compressor bypass
L-M XOver 21.2 Hz to 8.00 kHz Low/mid crossover frequency
M-H XOver 21.2 Hz to 8.00 kHz Mid/high crossover frequency
Slope -6 dB, -12dB Filter slope
Ceiling -6.0 dB to 0.0 dB, OFF Specifies the maximum output level
Exp.Thre -54.0 dB to -24.0 dB Expander threshold
Exp.Rat 1:1to oo:1 Expander ratio
Exp.Rel 44.1kHz: 6.0ms to 46.0s Expander release time
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Exp.Byp ON/OFF Expander bypass
Lim.Thre -12.0 dB t0 0.0 dB Limiter threshold
Lim.Atk 0to 120 ms Limiter attack
Lim.Rel 44.1kHz: 6.0ms to 46.0s Limiter release time
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s
Lim.Byp ON/OFF Limiter bypass
Lim.Knee Otob Limiter knee
Low ON/OFF Low band solo
Mid ON/OFF Mid band solo
High ON/OFF High band solo
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Slot

m SlotIn

The Slot In Component only has outputs. 4, 8, and 16 channel types are provided.

Right-click the component and select [Open Slot In Component] from the contextual menu to open the
component editor. The component editor is the same for all types.

8 9 1 1 1213 W15k

Name

Function

@ | Meter

Shows the signal level for each channel.
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m Slot Out

The Slot Out component has only an input. There are three types of Slot In components: four-
channel, eight-channel, and 16 channel types.

The component editor can be displayed by right-clicking the component, then clicking [Open Slot Out

Component Editor] on the displayed context menu.

Slot Out component editor

OFF OFF OFF OFF OFF OFF OFF OFF
1 2 5 ¥ 5 3 i ¥ g ] il 1 e 1 T

uteut 18 Channel Slot No. i

Parameter Setting Range Function
© | Phase ON/OFF Reverses the phase of the output signal for each
channel.
® |On ON/OFF Turns ON each channel's output.
©® | Delay 0to 24 Samples Sets the delay time.
O |Level -0 to =0 dB Sets the output level.
© | Dither Off Sets the quantization bit rate for conversion.
2
24
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Cascade

m Cascade In

The Cascade In Component only has outputs.
Only the DMEB4N has a Cascade In component, which can be displayed by checking [Show
Cascade Port] in the DME Device Properties dialog box.

Right-click the component and select [Open Component Editor] from the contextual menu to open the
component editor. The component editor is the same for all types.

= Gascade Input

T8 3 1 1 12 13 M 15 16 17 18 13 28 2

Name Function

© | Meter Shows the signal level for each channel.
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m Cascade Out

The Cascade Out Component only has inputs.

Out

Chapter 6 Component Guide

Right-click the component and select [Open Component Editor] from the contextual menu to open the
component editor. The component editor is the same for all types.

= Gascade Qutput

15 16 7

Name

Function

@ | Meter

Shows the signal level for each channel.
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Analog Input and Output

In the DME24N/DMES8i-C/DME80-C/DME4io-C configuration window, there are [Analog Input] and
[Analog Output] blocks.

W OUTE

m Analog Input
Double-click [Analog Input] to display the component editor for it.

The DME24N, DMES8i-C and DME4io-C have analog inputs. The DME24N and DMES8i-C have eight analog inputs, while the
DME4io-C has four.

Internal Head Amp component editor

Internal Head Ame OMEZYN HA-AD

Right-click the component and select [Open Input Component
Editor] from the contextual menu to open the component editor.

= oo EIO

Parameter Setting Range Function
©Q | +48 ON/OFF Turns ON phantom power (+48V).
O | Gain +10 to -60 dB Sets the head amp gain.

m Analog Output

Double-click [Analog Output] to display the component editor for it. The displayed parameters are
the same as for Slot Out component editor.
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The DME24N, DME8o-C and DME4io-C have analog outputs. The DME24N and DMES8i-C have eight
analog outputs, while the DME4io-C has four.

SP2060 Input and Output

The SP2060 configuration window includes [SP2060 Input] and [SP2060 Output] blocks.

m SP2060 Input

Either double-click [SP2060 Input] or select [Open Component Editor] from the contextual menu that
appears when the component is right-clicked to open the editor.

SP2060 Input Component Editor

= SP2060 Input

InFut. Mute

Mute

Input Mute

Mute

10884 CETIHHD

Name/Parameter Range Function

© | Input Select Analog IN A/B Selects the input signal(s).
Selects analog input channels A and B
as the input signal sources.

Analog IN A/A

Selects analog input channel A as the
source for both input signals.

Digital IN L/R

Selects digital input channels L and R
as the input signal sources.

Digital IN L/L

Selects the digital L input channel as the
source for both signals.

® | Input Level -0~ +10 dB Set the input signal level for the
corresponding input channel.

© | Meter - Display the input signal level for the
corresponding input channel.

O | Mute ON/OFF Mute the input of the corresponding input
channel.
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CobraNet Input and Output

The DMES8i-C/DME8o-C/DME4io-C configuration window includes [CobraNet Input] and [CobraNet
Output] blocks.

m CobraNet

Either double-click [CobraNet Input]/[CobraNet Output] or select [Open CobraNet Editor] from the
contextual menu that appears when a component is right-clicked to open the editor.

CobraNet Input/Output Component Editor

InFut
InFut 5

InFut &
InFut 7
InFut

Section Name/Parameter Range Function

© | Setting from this Window Disable/Enable | When “Disable” is selected settings made via
the CobraNet network take priority. When
“Enable” is selected settings made from the
DME Designer take priority.*

® | High Sampling | Input Format Double Channel| Selects the format for 88.2/96 kHz sampling
Mode Single rates.
Linked to Output Format.
Output Format Double Channel| Selects the format for 88.2/96 kHz sampling
Single rates.
Linked to Input Format.
® | Bundle Input 0 ~ 65279 Specifies the input bundle number.
Number
Output 0 ~ 65279 Specifies the output bundle number.
O | Serial Rx OFF, 1 ~ 15 Specifies the serial receive channel.
Channel
Tx OFF, 1 ~15 Specifies the serial transmit channel.
© | Properties Bit Length Bit Off Specifies the output bit rate.
16bit Output is muted when “Bit Off” is selected.
20bit
24bit
(6] Latency 5.33ms Specifies the latency.
2.67ms
1.33ms
(7] Advanced - Opens the “Advanced Settings” window.

* Select “Disable” if you intend to make settings via the CobraNet network using the CobraNet Manager, for example. In such
cases selecting “Enable” may result in incorrect settings.
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Refer to “DMEB8i-C/DME80o-C/DME4io-C Owner's Manual” for mote information on CobraNet.

“Advanced Settings” Window

= GobraMNet : Advan._._ Q@@

m

Channel Fer Bundle

InFut 8 Output

Conductor Prioritd

Initializat all Parameters

Section Name/Parameter Range Function
o Channel per Bundle Input 1,2,4,8 Specifies the number of channels per
input bundle (*1).
Output 1,2,4,8 Specifies the number of channels per
output bundle (*1).
Conductor Priority Auto Sets the conductor priority.[255] is the
(2) 0~ 255 highest priority.[Auto] means [32] on
DMES8i-C/DME80o-C/DME4io-C
Initialization of All Execute - Resets all settings to their default values.
© | Parameters A confirmation dialog box will appear.
Only available when online.(*2)

(*1) Fewer channels may be available, depending on the settings. Refer to the “MY16-Cll Owner's Manual” or “DMES8I-C/

DMEB80-C/DME4io-C Owner's Manual” for details.

(*2) All internal parameters will be set to factory presets as well as parameters that can be set via editor.
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MY-Card

This shows the input and output for the card inserted into the DME expansion slot. The following
components are available, depending on the card types:

Input Format/Output Format

This is the /O mode for high sample rate operation (88.2/96 kHz).

In the Double Channel Mode, high sampling rate data (88.2/96 kHz) is transmitted and received by
two channels, each channel handling the digital audio data at half the sampling rate. For this reason
the total number of available channels is halved, and even-numbered channels are unavailable.

In the Double Speed Mode digital audio data is transmitted and received at the current high sampling
rate (88.2/96 kHz).

In the Single Mode digital audio data is transmitted and received at half the current high sampling rate
(88.2/96 kHz).

Setting Examples

Operation clock of related equipment The DME operation clock Input Format/Output Format
88.2/96 kHz (Double Channel) 88.2/96 kHz Double Channel
88.2/96 kHz (Double Speed) Double Speed
44 1k/48Kk Single

When the MY card word clock is used as the master word clock, Double FS determines whether the
speed of that word clock is to be doubled and used as the DME clock. The Double Fs setting is only
available the word clock from an MY Card is used.
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Double-click the block to display the component editor for it. This editor can be used for generic MY
card editing, but some parameters are not available. Use a card specific editor when available.

= MY-0thers

InFut
UutpPut

B{(=]E

Oouble Fz

Parameter

Setting Range

Function

© | Input Format

Double Channel
Double Speed
Single

Selects the format for 88.2/96 kHz.

® | Double Fs

ON/OFF

When ON the speed of the word clock from the MY
Card is doubled. Only displayed when this card is
functioning as the word clock master.

©® | Output Format

Double Channel
Double Speed
Single

Selects the format for 88.2/96 kHz.

m MY8-AE96S

Double-click the block to display the component editor for it.

MY8-AE96S component editor

"= MYB-AE96S

EEX

Hiak Samrlina Mode

InFut Farmat
Outrut Format

DOUELE SPEED
OOUELE SFPEED

Oouble F=

Samrlina Rate Conwerter

0n On an

172 i o/E

0n

Parameter

Setting Range

Function

© | Input Format

Double Channel
Double Speed

Selects the format for 88.2/96 kHz.

® | Double Fs

ON/OFF

When ON the speed of the word clock from the MY
Card is doubled. Only displayed when this card is
functioning as the word clock master.

©® | Output Format

Double Channel
Double Speed

Selects the format for 88.2/96 kHz.

O | Sampling Rate
Converter

ON/OFF

Turns the sampling rate converter ON.
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m MY16-AE/MY8-AE96/MY8-AE/MY8-AT/MY8-TD/MY16-TD/MY16-AT
Double-click the block to display the component editor for it.

Example: MY 16-AE component editor

)

== MY16-AE

InFut
tutrut F WWELE CHANMEL:

Double Fz

Parameter

Setting Range

Function

© | Input Format

Double Speed
Double Channel
Single

Selects the format for 88.2/96 kHz. For MY8-AE96, the
setting range is Double Speed/Double Channel. For
other cards, it is Double Channel/Single.

® | Double Fs

ON/OFF

When ON the speed of the word clock from the MY
Card is doubled. Only for MY16-AE/MY8-AE96/MY 16-
TD. When On is set for the MY8-AE96, the Input Format
is Double Channel. When Off is set, the input format is
Double Speed. Only displayed when this card is
functioning as the word clock master.

©® | Output Format

Double Speed
Double Channel
Single

Selects the format for 88.2/96 kHz. For MY8-AE96, the
setting range is Double Speed/Double Channel. For
other cards, it is Double Channel/Single.
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® MY16-C

Double-click the block to display the component editor for it.

MY16-C component editor

Ineut 1/ 8
Ineut. 2

5

NHEL (Double Fs

NHEL

Bundle Number-

Outrut 1

znath
Latenca

Section

Parameter

Setting Range

Function

Setting Priority

Setting Priority

Hardware/
Software

The MY16-C switch settings take priority when
“Hardware” is selected, and the DME Designer
settings take priority when “Software” is
selected.

High Sampling
Mode

Input Format

Double Channel
Single

Selects the format for 88.2/96 kHz sampling
rates.
Linked to Output Format.

Double FS

ON/OFF

When turned ON the speed of the MY card word
clock output is doubled. Only available when
the card is set as the word clock master.

Output Format

Double Channel
Single

Selects the format for 88.2/96 kHz sampling
rates.
Linked to Input Format.

Bundle Number | Input 0 to 65279 Sets the input bundle number.
Output 0to 65279 Sets the output bundle number.
Serial Channel | Rx OFF, 1-16 Sets the serial channel for the receive side.
Tx OFF, 1-16 Sets the serial channel for the send side.
Properties Bit Length Bit Off Sets the bit rate for output. Mutes the signal if
16 bit [Bit Off] is set.
20 bit
24 bit
Latency 5.33 ms Sets the delay.
2.67 ms
1.33ms

The parameters will not link immediately when Setting Priority is switched.

Please edit another parameter after switching Setting Priority.
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MY16-CllI

Double click to open the component editor.

458

InFut
InFut 5

Section Name/Parameter Range Function

@ | Setting from this Window Disable/Enable When “Disable” is selected settings
made via the CobraNet network take
priority. When “Enable” is selected
settings made from the DME Designer
take priority.*

@® | High Sampling | Input Format Double Channel Selects the format for 88.2/96 kHz

Mode Single sampling rates.

Linked to Output Format.

Double FS ON/OFF When turned ON the speed of the MY
card word clock output is doubled. Only
available when the card is set as the
word clock master.

Output Format Double Channel Selects the format for 88.2/96 kHz

Single sampling rates.
Linked to Input Format.
©® |Bundle Input 0 ~ 65279 Specifies the input bundle number.
Number
Output 0 ~ 65279 Specifies the output bundle number.
O | Serial Rx OFF, 1 ~ 15 Specifies the serial receive channel.
Channel
Tx OFF 1~5 Specifies the serial transmit channel.
© | Properties Bit Length Bit Off Specifies the output bit rate.
16bit Output is muted when “Bit Off” is
20bit selected.
24bit
(6] Latency 5.383ms Specifies the latency.
2.67ms
1.33ms
(7] Advanced - Opens the “Advanced Settings”
Window. Refer to “Advanced Settings”
Window on page 453 for details.

* Select “Disable” if you intend to make settings via the CobraNet network using the CobraNet Manager, for example. In such
cases selecting “Enable” may result in incorrect settings.

Refer to the “MY16-Cll Owner's Manual” or “CobraNet Manager Lite for YAMAHA Owner's Manual” for mote information on
CobraNet.
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Remote Controlled Head Amp

Chapter 6 Component Guide

There are AD824 and AD8HR components arranged in the zone window.

m AD824

Controls the Yamaha A/D converter AD824. The AD824 is an eight channel analog to digital

converter.

Double-click the component to display the component editor for it.

If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click

(page 204).

AD824 component editor

Section Parameter Setting Range Function
© | Gain +48 ON/OFF Turns ON phantom power (+48V).
(2] Gain +10 to -62 dBu Sets the head amp gain.
©® | Word Clock 48 kHz Sets the operating frequency for the Word Clock.
441 kHz
BNC
Slot
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m AD8HR
Controls the Yamaha A/D converter AD8HR. The AD8HR is an eight channel analog to digital

converte

r.

Double-click this component to display the component editor for it.

If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click

(page 204).
AD8HR component editor
olled Head Ame  ADSHR
Section Parameter Setting Range Function

©Q | Gain +48 ON/OFF Turns ON phantom power (+48V).

(2] HPF ON/OFF Turns output ON.

(3] Frequency 20 to 600Hz Sets the cutoff frequency.

(4) Gain +10 to -62 dBu Sets the head amp gain.

© | Word Clock 96 kHz Sets the operating frequency for the Word
88.2 kHz Clock.
48 kHz
441 kHz
Word Clock In
Digital Out A

Double Speed
Double Channel

Selects the operation for 88.2/96 kHz.
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Component Glossary

Adjustable Gc (AdjustGc)

One type of filter characteristic. With this setting, you can adjust Gc (gain on the cutoff frequency)
between -6 dB and +6 dB. If you set -3 dB it becomes a Butterworth filter. If you set -6 dB, it becomes
Linkwitz-Riley filter.

Components: Crossover, Crossover Processor, Crossover Processor Il, Programmable BPF,
Programmable HPF, Programmable LPF, Speaker Processor

Attack (Attack Time)

In dynamic components, sets the time period for compressing or expanding the signal after the
component operates. As the attack time is made faster, compression or expansion becomes more
instantaneous. As it is made slower, the initial attack part of the sound will not be compressed or
expanded.

Components: Crossover Processor, Compander, Crossover Processor Il, Compressor, De-
Esser, Ducking, Expander, Gate, Limiter, Speaker Processor

Bessel

One type of filter characteristic. For curves where phase characteristics are important, Bessel has
gentler attenuation then Butterworth, and there is little distortion of the waveform when square waves
are passed through.

Components: Crossover, Crossover Processor, Crossover Processor Il, Programmable BPF,
Programmable HPF, Programmable LPF, Speaker Processor

Butterworth (Butrwrth)

One type of filter characteristics. This filter has the most general characteristics. The pass band is flat
and the gain for the cutoff frequency is -3 dB.

Components: Crossover, Crossover Processor, Crossover Processor Il, Programmable BPF,
Programmable HPF, Programmable LPF, Speaker Processor

Bypass

Passes the signal without changing it. When you turn this ON, bypassed sound (unchanged sound) is
output. When you turn this OFF, the sound is output with effects applied.

Components: Crossover Processor, Crossover Processor Il, GEQ, PEQ, BPF, HPF, LPF, Notch,
Programmable BPF, Programmable HPF, Programmable LPF, Speaker Processor, SPX

Decay (Decay Time)

Sets the time period until gain returns to normal after a trigger signal level falls below the threshold
value.
Components: Ducking, Gate, Auto Mixer

Delay

Sets the time period by which a signal is delayed.
Components: Crossover Processor, Crossover Processor I, Delay Long, Delay Short, Delay
Matrix, Speaker Processor, SPX, Slot Output, Unit Output
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Delay Scale

Sets the units used for specifying the delay time.
Components: Crossover Processor, Crossover Processor I, Delay Long, Delay Short, Speaker
Processor

Divergence

Sets the ratio for sending the center signal to LR. When 100 percent is set, the signal will be sent to LR
only. When zero percent is set, the signal is sent to center only.
Components: LCR, Surround 3-1, Surround 5.1, Surround 6.1

Fade

Sets the action of the fader when there is a large change in its position during scene recall.

When you turn this ON, the fader moves gradually to the position after the jump. If you turn this OFF, it
immediately jumps to the parameters saved in the recalled scene.

Component: Fader

Frequency

Sets a frequency. In the de-esser, this sets the lowest frequency of the signal to be compressed when
the component is operating. In the BPF, HPF, and LPF filters, this sets the cutoff frequency. In the
graphic equalizer, it is also used as the frequency band button.

Components: Crossover, Crossover Processor, Crossover Processor Il, De-Esser, GEQ, PEQ,
BPF, HPF, LPF, Notch, Programmable BPF, Programmable HPF, Programmable LPF, Oscillator,
Speaker Processor, SPX, Remote HA

Gain

Sets the amplification factor for the entire signal level.
Components: Crossover Processor, Crossover Processor Il, Compander, Compressor,
De-Esser, Expander, GEQ, PEQ, Auto Mixer, Speaker Processor, Remote HA, Analog Input

Gain Correct

In the Auto-Mixer, automatically controls the output level for the number of open channels. In
situations, where multiple microphones are used, feedback may occur because many channels are
open at the same time. Feedback can be avoided by using gain correct.

Component: Auto Mixer

Hold (Hold Time)

Sets how long the gate stays open or the ducking remains active once the trigger signal has fallen
below the threshold level.
Components: Ducking, Gate, Auto Mixer, SPX

Keyiln

Turns an input signal connected to a component's Keyln port into a trigger that activates the
component. You can select the trigger source in components that have Keyln ports.
Components: Compander, Compressor, Ducking, Expander, Gate, Limiter
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Knee

In compressors, de-essers, and expanders, sets the way in which compression or expansion will be

applied after the signal exceeds the threshold. The following range of settings is available: HARD, 1,

2,3,4,5.

If Hard is set, the signal level changes to a straight line following the specified slope when the trigger
signal exceeds the threshold.

If a value between 1 and 5 (5 = softest) is specified, the curve gradually changes when the threshold
is exceeded, producing a more natural sound.

Components: Compander, Compressor, Ducking, Expander, Gate, Limiter

LFE (Sub Woofer Speaker)

This is a special speaker for playing back low frequency sounds.
Component: Surround 5.1, Surround 6.1

Linkwitz-Riley (Linkwitz)

One type of filter characteristics. As second-order filters, the sum of the output voltages for LPF and
HPF have a gain of ObB across the entire band. The pass band is flat, but the cutoff frequency gain is
-6 dB.

Components: Crossover, Crossover Processor, Crossover Processor Il, Programmable BPF,
Programmable HPF, Programmable LPF, Speaker Processor

Pan

Sets the distribution ratio of the input signal between right and left.
Components: LCR, LR, SPX

Pan Nominal Position

Sets the 0 dB reference for pan. There are two selections available, [Center] and [LR] (LR Nominal).
Center nominal uses the center volume as a reference. The means the center volume is 0 dB, and the
LR speakers are -3 dB.

LR nominal uses the LR speaker volume as the reference. The means the LR speaker volume is 0 dB,
and the center is +3 dB.

Components: LCR, LR, Surround 3-1, Surround 5.1, Surround 6.1

Phase

Reverses the phase of the signal. If you turn this ON, signal is inverted. If you turn this OFF, the signal
is not inverted.

Components: Crossover, Crossover Processor, GEQ, PEQ, BPF, HPF, LPF, Notch,
Programmable BPF, Programmable HPF, Programmable LPF, Fader, Auto Mixer, Delay Matrix,
Matrix Mixer, Slot Output, Unit Output

Q

Sets the frequency bandwidth that will change the sound. As the value gets larger, the width gets
narrower and the curve becomes steeper.

In the parametric equalizer, this sets the frequency width where the gain will be cut or boosted. When
Q is widened, the gain is boosted or cut along a wide range centering on the frequency set by the
frequency setting, resulting in a large change in the tone quality. When Q is narrowed, only a specific
frequency is boosted or cut.

Components: Crossover Processor, Crossover Processor Il, GEQ, PEQ, BPF, Notch, Speaker
Processor, SPX
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Range

Set for Ducking and Gate. Sets the amount by which the level is reduced when signal is ducked/
gated. It can be set within the range of -70 to 0 dB. At -70 dB the entire signal above the threshold
value is cut. At 0 dB, there is no effect.

Components: Ducking, Gate

Ratio

Sets the ratio of change in the output signal level with respect to the input signal level.

At 1:1, there is no compression.

At 2:1, when a trigger signal level that exceeds the threshold changes by 10 dB, the output level will
change by 5 dB.

Components: Crossover Processor, Crossover Processor Il, Compander, Compressor,
De-Esser, Expander, SPX

Release (Release Time)

Sets the time period until gain returns to normal after a trigger signal level falls below the threshold
value and operation of a component ceases.

If the release time is short, the sound will seem like it is jumping (the ear will notice the change)
because the gain suddenly returns to normal. If the release is set too long, compression might not be
applied properly because the next high level signal will be input before the gain returns to normal from
the previous high. It's a good ideal to try an initial release time setting in the range of 0.11 t0 0.5
milliseconds.

Components: Crossover Processor, Crossover Processor Il, Compander, Compressor,
De-Esser, Expander, Limiter, Speaker Processor, SPX

Slope

In a high pass filter (HPF) or low pass filter (LPF), this sets the attenuation amount for each octave.
A large value results in rapid attenuation. Clicking the [Slope] button displays a menu.

You can select [6 dB/Oct] or [12 dB/Oct] in the HPF or LPF.

In the crossover that is part of the crossover processor, in the stand-alone crossover, the
programmable BPF, the programmable LPF, and the programmable HPF, you can select from [6 dB/
Oct], [12 dB/Oct], [18 dB/Oct], [24 dB/Oct], [36 dB/Oct], and [48 dB/Oct].

Component: HPF, LPF

Threshold

Sets the signal level that causes the component to operate.
Components: Crossover, Crossover Processor, Crossover Processor Il, Compander,
Compressor, De-Esser, Ducking, Expander, Gate, Limiter, Auto Mixer, Speaker Processor, SPX

Width

Sets how much lower the level must be than the threshold level for the expansion effect to begin.
When the trigger signal level changes by 2 dB with the expansion ratio of the expander set at 5:1, the
output level will change by 10 dB.

In the compander, if the width is set at 90 dB, the expander effect will be essentially be turned OFF.
Component: Compander
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Options

The ICP1, CP4SW, CP1SF, and CP4SF controllers are optionally available for remote external control of
the DME The ICP1 connects via Ethernet, while the CP4SW, CP1SF, and CP4SF connect via the GPI

interface.

ICP1 settings and operation

This controller connects to the DME series via Ethernet. Like the DME series, each ICP1 unit has it’s

own IP address. With a display that replicates the display on the DME series, the ICP1 allows
comprehensive, familiar control from remote locations.

ICP1 Controls

C@vAMAHA h
—2 g g N HOME SCENE
O 0O O
(1] (12]
0 Od O d
F4/UTILITY F5 F6/MUTE CANCEL ENTER
—O0 (5 {6
| coar;s&ﬁgz)
I I

O [F1] Key

When the Main display is showing this button calls the Parameter Edit display for the User Defined

Button in the upper left corner of the display.
When the Utility display is showing it has the same function as the Left button.

@ [F2] Key

When the Main display is showing this button calls the Parameter Edit display for the middle User

Defined Button in the upper part of the display.
When the Utility display is showing it has the same function as the Up button.

O [F3] Key

When the Main display is showing this button calls the Parameter Edit display for the User Defined

Button in the upper right corner of the display.
When the Utility display is showing it has the same function as the right button.

O [F4/UTILITY] Key

When the Main display is showing this button calls the Parameter Edit display for the User Defined
Button in the lower left corner of the display. If this button is pressed and held for longer than

2 seconds when the Main display is showing the Utility display will appear. Pressing the [F4] button
while the Utility display is showing sequentially steps through the various Utility pages.
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@ [F5] Key

When the Main display is showing this button calls the Parameter Edit display for the middle User
Defined Button in the lower part of the display.

When the Utility display is showing it has the same function as the Down button.

O [F6/MUTE] Key

When the Main display is showing this button calls the Parameter Edit display for the User Defined
Button in the lower right corner of the display.
If this button is pressed and held for more that 2 seconds the Mute display will appear.

@ [HOME] Key

Directly recalls the home (main) display. If pressed while the main display is showing the [HOME]
button steps through the User Defined Button display pages (page 470).

O [SCENE] Key

Calls the scene recall display (page 471). Calls the scene store confirmation display if pressed and
held from longer than 2 seconds (page 471). The indicator will light green while the scene recall/
store display is showing.

© [CANCEL] Key
Closes the window on the display.

@ [ENTER] Key
Confirms and enters a value or setting.

® Display

Displays scene information and device parameters.

@ Dial
Adjusts the value of selected parameters. The ICP1 dial functions in the same way as the DMEG4N/
24N dial.
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Main Display

The Main display will appear in a few seconds after
the power is turned on. The Main display shows
information about the current scene.

Nothing will appear on the display if no scene data is stored in
the DME series scene memory (this is the case when the unit is
initially shipped, for example).

@
|eue|1 ILE'-I'E|2 |[ﬂ!§!
X

gWScene 001

[Scenel [Scene? |
e

000

@ Scene Information

The current scene number and name. Scene names
can be entered by using the DME Designer
application.

A maximum of 12 one-byte (Roman) characters can
be displayed in a scene name. When “two-byte”
characters are to be used for languages such as
Japanese, the total number of displayable characters
is reduced accordingly.

When the power is turned on the last scene selected
before the power was turned off is automatically
recalled.

@® User Defined Button Names

Displays the User Defined Button. The User Defined
Button is specified by using the DME Designer
application.

A maximum of 24 buttons can be made available for
user control, but only six buttons can be shown in any
one display page. Press the [HOME] key to switch to
other available button pages. A maximum of 8 one-
byte (Roman) characters can be displayed in a
parameter name. When “two-byte” characters are to
be used for languages such as Japanese, the total
number of displayable characters is reduced
accordingly.

Parameters are selected for editing by using [F1]/[F2/
[F3]/[F5] keys to select the parameter, and then
pressing [ENTER].

© Page Scroll Bar

The scroll bar provides an indication of which
parameter page is currently being displayed. 4 pages
are available, and the scroll bar moves one position to
the right each time the [HOME] key is pressed and a
new page of parameters is selected, and then back to
the leftmost position after the rightmost position has
been reached.
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@ Edit Indicator

If a parameter is changed after recalling a scene,
“EDIT” will appear in the display.

©® Mute Indicator
Shows the current mute ON/OFF status.

:':I - Mute ON

[¥] : Mute OFF

@ Output Level Indicator

Displays the current output level in 10 increments.
The longer the “bar,” the higher the output level.

@ Panel Lock Icon

This icon appears when the panel lock function is
turned ON.

EI : Panel Lock ON (Panel controls locked)

Panel Lock

The panel controls can be “locked” to prevent
accidental mis-operation.

To activate the panel lock function simultaneously
press and hold the [HOME] and [ENTER] keys for
longer than 2 seconds.

The panel lock icon will appear on the Main display
when the panel is locked.

ILevel1 |Level? [T
EDIT

ILINMScene 001

)=

Panel Lock can be disengaged by pressing the
[CANCEL] key for longer than 2 seconds.

You can select whether or not the panel lock function is
automatically engaged when the unit is initially turned
on. This selection can be made via the Utility display
“Lock” page (refer to the page 474).
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Parameter Edit Displays

Parameter Edit displays will appear when the
[SCENE], [F6/MUTE] or other key is pressed to allow
scene changes, level adjustment, and other settings
to be edited as required. Parameter Edit displays are
also used to edit utility parameters.

In most cases the desired parameter edit page can
be accessed by selecting the item you want to edit in
the appropriate display by using the [F1]/[F2/[F3]/[F5]
keys and then pressing the [ENTER] button.

There are basically three types of parameters that can
be accessed via a Parameter Edit display:

Numeric values

Lists

ON/OFF switches

Numeric Parameters

Numeric parameters can be edited in a number of
ways, and depending on the parameter a fader, knob,
or minimum and maximum values may appear to the
left of the numeric value.

A Numeric Value with a fader

o (5]

| Fader3-Level |

o yff | 000 |

— dE

o

A Numeric Value with a Knob
? (5)

PED1-A-Gain )

) 000 |

—15@a  15@a dE

| I—

o

®

@ Name of parameter selected for editing
@ Fader

® Knob

@ Minimum and maximum values

@ Current value

Some Parameter Edit displays have just one numeric
parameter, while other may have two or more.
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Parameter Edit Display with One Numeric
Parameter

1 LCD Contrast
50

f, C (50

1. Numeric values can be changed by
rotating the dial. Dial rotation produces an
immediate, corresponding change in the
selected value.

4

{1LED Contrast i

=

2. Press the [ENTER] key to close the
Parameter Edit display after the value(s) have
been edited as required.

Parameter Edit Display with Multiple
Numeric Parameters

| Info [Het | DisF | Lock [r

Z
0| JP-dddress -
Li{|=2]) G5 - Eal - wez

y/k

MACST=4 T

1. Use the [F1)/[F2/[F3]/[F5] keys to select the
value to be edited.

mAMAHA
Info [ Met DisFk | Lock [

0

| IP_Address B
Lif | =2 - iE2 {[Eea]) eez|
L]

MA

L




2. Rotate the dial to edit the value as
required.

¥

| Info [Het | DisF | Lock [

0
0| 1P Address — B

Lif |2 (&2 ([E2E]) wez

7,

MA [= | —

3. Repeat step 1 to select the next value to
be edited, use the dial to edit as required, and
repeat until all values have been edited as
required.

4. When all values have been edited, press
the [ENTER] key. A confirmation window will
appear: press [ENTER] one more time to
confirm the edits and close the window.

ENTER

Are »ou sSure 7
Mesr: EMTER Ker
‘Mo CAMCEL ke

¥

ENTER

Coanfikm

You can close the window without changing any values by
pressing the [CANCEL] key rather than the [ENTER] key.
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List Parameters

List parameters allow you to make one selection from
a list of possibilities.

Rotate the dial to scroll up or down the list. In some
cases the centermost item on the display will be
always highlighted as the list is scrolled, and in others
the same item will remain highlight as the list is
scrolled up or down.

List Parameter with Scrolling Highlight

1Link Hode

1 HGEHSE-T =

1. Use the dial to scroll up or down the list.
As you scroll the highlighted selection will
remain highlighted, and will scroll up or down
with the list.

2. Press the [ENTER] key to highlight the
centermost item on the display.

In some cases a confirmation dialog will appear when the
[ENTER] key is pressed. If this occurs press the [ENTER] key
a second time to continue.

3. Press the [ENTER] key to select the
highlighted item and close the window.
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ON/OFF Parameters

Parameters that are either ON or OFF are edited via
this type of display (e.g., Mute Parameter Edit display
in “Mute Switching” on page 470).

1. Rotate the dial clockwise to select ON, or
counterclockwise to select OFF

2. Press enter to confirm the selection and
close the window.

Parameter Edit displays will also appear when the
[SCENE], [F6/MUTE] or other key is pressed.

These allow scene changes and other settings to be
edited as required.

Editing User Defined Button

1. If the Main display is not showing, press
the [HOME] key to recall it.

2. Press the [HOME] key until the page
containing the parameter to be edited
appears.

3. Use the [F1]/[F2/[F3]/[F5] keys select the
parameter to be edited.

The Parameter Edit display for the selected User
Defined Button will appear.

User Defined Button can be of all three types: numeric, list,
and ON/OFF.

4. User Defined Button as required.

Refer to “Parameter Edit Displays” on page 468 for
editing procedures.

Any changed User Defined Button values will be lost if the
power is turned off or if scenes are changed. To preserve the
changed values, store the scene data.
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Mute Switching
Turns the DME series output mute function ON or OFF.

1. Press the [F6/MUTE] key for longer than 2
seconds.
The Mute Parameter Edit display will appear.

Hute
@ i3 E
S —

2. Select Mute ON or OFF.

The mute function is turned on or off as described in
“ON/OFF Parameters” on page 470.

All outputs in the device group, including the [PHONES] jack,
are muted.




Scene Recall

This procedure recalls a new scene (refer to
page 468).

1. Press the [SCENE] button.
The Scene Recall display will appear.

Scene Recal |

001 BEH_Control ler l
002 Convention_Center |

L S TTTTITT L=

2. Select a new scene.

Scenes are selected as described in the “List
Parameters” section on page 469.

Scene FI!IE'DII-II |
001 BGN_Controller
002 Convention_Center

[+ ]
L S TTTTITT L=

3.Press the [ENTER] button.
A confirmation window will appear.

Caritf iFm

Are waou Sure F
“Mesz: EMTER Ked
“Hor  CHAMCEL ke

— Lppnnnmnn =

4. Press the [ENTER] button again.
The new scene will be selected.

|[Router1-]Router?-|Routers-|
Ennvent on_C m

|Rout erd-|Fader1-L|Fader?-L]

If head amplifier parameters are included in the recalled
scene data, the head amplifier settings will be changed
accordingly.
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Scene Store

Stores the current scene data for later recall.

1. Press the [SCENE] button for longer than
2 seconds.
A confirmation window will appear on the display.

11 1]

RO =ore store 1r3-|
Are Yol sSure T ME
ez EMTER Ke H
Mo CAMCEL Kew | =

2-L|

2. Press the [ENTER] key.

This stores the scene data in the current scene
memory.

Press the [CANCEL] key if you want to abort the scene store
operation.
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Utility Displays
Most basic ICP1 functions can be accessed via the Utility Display.

Items accessible via the Utility display

Page Item Description Manual Page
Info Current status and settings for the devices basic parameters. page 473
Label Name display.
Version The device’s current version number.
Net Current status and settings for the Ethernet network. page 473
Device Group | Displays current status whether the device is device group master or not.
IP Adr. Current status and setup for the device’s IP address.
Master ID Displays and sets the device group master host address.
Link Mode Current status and setup for the [NETWORK] connector.
MAC Adr. Displays the device's MAC address.
Disp Current status and setup for the display mode, etc. page 474
LCD Contrast | Current status and setup for display panel contrast.
LCD Backlight | Current status and setup for the display panel backlight.
Lock Current status and setup for panel lock and related functions. page 474
Utility Current status and setup for the Utility display settings.
Panel Lock Current status and setup for the ICP1's power-on panel lock status.
Boot
Panel Lock Current status and setup for the panel lock target.
Target
User Defined Panel lock and setup for each page of user-defined parameters.
Lock
Misc Current status and setup for settings not included in other pages. page 475
Scene Store Current status and setup for scene store accessibility.
Last Mem. Indicates whether the previous memory contents will be retained when the
Resume unit is restarted.
Event Current status whether an event schedule setup in the DME Designer will be
Scheduler executed or not.
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Utility Display Operation

The general procedure for operating the Utility
displays is outlined below.

1. Press the [F4/UTILITY] Key for longer than
2 seconds from the Main display to go to the
Utility display.

2. Press the [F4/UTILITY] Key as many times
as necessary until the desired parameter
page appears.

3. Use the [F1)/[F2/[F3]/[F5] keys to select
the parameter you want to edit.

4. Press the [ENTER] key.

This either confirms a selection or edit, or calls the
appropriate parameter edit page.

Info Page
[ Tnfo | Het | OisF | Lock [
Q@ Mome C 1
O versionCUz-@e 1
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Network Settings (Net) Page

Shows the Ethernet network address and other
parameters.

Info [Het |LDisF | Lock [F

0—— Device arourlSlque ]

O — IF Adr- [(2Z.165- 686, aEZ|
O toster ID 19%. 168 B0 (BEF]

- Link Mode [{BBERSE-TX
— HAC RAdr- [@@RGDEZSHHGE0]

@ Device Group
Indicates whether or not the device is functioning as
the device group master.

Device Group status of ICP1 is fix to “Slave.’

@ IP Adr.

This is the device's IP address.

Edit using the “Numeric Parameters” editing
procedure described on page 468.

| Info [Het | DisF | Lock [r

_IP Address

([=2- (&l - [ewel]- GEsl
—Frr Lm|

Network Address Host Address

The network addresses of devices in the same device group
must be the same.

The date and time (@) and the internal battery status (@) are
not shown on the ICP1 control panel display.

© Label

Shows the user ID. The user ID can be changed via
the DME Designer application running on a computer
connected to the unit.

The label can not be changed from the ICP1 controls.

@ Program Version
This is the current firmware version number.

® Master ID

Displays and sets the device group master host
address.

O Link Mode

Shows the status of the [NETWORK] connector. The
[NETWORK] connector can be set to operate in
“10Base-T” or “100Base-TX” mode.

10Base-T: The [NETWORK] connector is
compatible with 10Base-T operation.
100Base-TX: The [NETWORK] connector is
compatible with 100Base-TX operation.

Edit using the “List Parameters” editing procedure
described on page 469.

© MAC Adr.

This is the device’s MAC (Media Access Control)
address.
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CNOTE |

The MAC address is also known as the Ethernet address,
and is an independent address assigned to all Ethernet
devices. No two devices anywhere in the world can have
the same address.

Display Setup (Disp) Page

Provides access to a number of display parameters.

| Info | Het [ Oisr | Lock [r
QLo contrast Ez1=
o

Back | ight

@ LCD Contrast

The current LCD contrast setting. This parameter can
be adjusted from 0% through 100%.

Edit using the “Numeric Parameters” editing
procedure described on page 468.

@ LCD Backlight

Specifies LCD backlight operation. Two settings are
available: “ON,” and “OFF.”

ON: The display is continuously lit.

OFF: The display lights when a control is operated,
and will go out 10 seconds after panel operation
ceases.

Edit using the “List Parameters” editing procedure
described on page 469.
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Security Setup (Lock) Page

Panel loc

k and related settings.

(1 5
O
(3 5

0_

| Info | Met

| ODisF [ Lock [F

CHE ity
~Pane |Lock oot

—Parne | Lock Target kew onlw ]

Fa3e

i 4
UserDefihed LOoCk [DFFOFF|OFFOFH

L | ock
Ll oSk

| d

@ Utility
The lock status for the Utility display settings. This
parameter can be set to “Unlock” or “Lock.”

Unlock: The Utility display can be accessed without
a password.

Lock: A password must be entered to access the
Utility display.

When “Lock” is selected a password entry window will
appear when the [F4/UTILITY] key is pressed to
access the utility pages.

| Info | MHet
ﬁt Password

-{[00000000

I.|
UserDefined Lock [OFF|OFF|OFF|OFF]

| DisF

Use the [F1] and [F3] buttons to position the cursor,
and the dial to enter the desired character at the
cursor location. When all of the password’s characters
have been entered as required press the [ENTER]
key.

The password will also be required when switching
from the “Unlock” mode to the “Lock” mode.

ot

Password security and management is very important!
If you forget your password the unit cannot be operated!
If you forget your password contact the system
administrator.

If the password become unrecoverable for some reason
and you need to unlock the system, please contact your
Yamaha representative.




@ Panel Lock Boot

Determines whether or not panel lock will be on when
power to the device is turned on. This parameter can
be set to “Unlock” or “Lock.”

Unlock: Panel lock is OFF when power to the
device is turned on.

Lock: Panel lock is ON when power to the device is
turned on.

® Panel Lock Target

Displays the controls (control functions) to be affected
by panel lock. Panel Lock Target status of ICP1 is fix
to “Key Only.”

See page 467 for details on how to use the Panel lock
feature.

O User Defined Lock

Sets the lock status individually for each of the four
User Defined Button pages.

ON: The corresponding User Defined Button will
not appear on the display.

OFF: The corresponding User Defined Button will
appear on the display.

To change the settings use the [F1] and [F3] keys to
move the cursor to the setting for the desired page,

the press the [ENTER] button to alternately turn the

setting “ON” and "OFF.”

The User Defined Button are accessed as described in
the “Parameter Edit Display” section on page 468.
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Miscellaneous Setup (Misc)
Page

This page includes parameters not available in any
other page.

| Misc | | |
L Soene Store

0
e}_mLﬂEt Mem- Fesune DO 1
o

rEwvent Scheduler CON |

@ Scene Store

Determines whether or not scene store operations are
allowed. This parameter can be set to “Enable” or
“Disable.”

Enable: Scene store operations are allowed.
Disable: Scene store operations are prohibited.

Edit using the “List Parameters” editing procedure
described on page 469.

See page 471 for scene store procedure.

This setting applies to individual devices only. Even if one
ICP1 unit is set to “Disable,” scene store operations will be
possible via another DME series in the same device group
that is set to “Enable.”

® Last Mem. Resume

This parameter displays whether the ICP1 will recall
the current scene when started up, or whether the
memory contents at the time the unit was turned off
will be recalled.

ON: The memory contents at the time the unit was

turned off will be recalled at startup.

OFF: The current scene will be recalled at startup.

The Last Men. Resume status can not be changed
from ICP1 controls.

® Event Scheduler

Displays the current status of an event schedule setup
in the DME Designer will be executed or not.

ON: The event will be executed.

OFF: The event schedule will not be executed.
Edit using the “List Parameters” editing procedure
described on page 469.

The event schedule status can not be changed from the ICP1
controls.
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Initializing the ICP1

Follow the steps below to initialize the internal
memory: You can select one of the following
initialization types:

* Initializing the current scene backup [CURRENT
BACKUP]

* Initializing all user settings (excluding the libraries)
to the factory settings [WITHOUT LIB.]

* Initializing all settings to the factory settings
[FACTORY SETUP]

When the internal memory is initialized, all data
stored in the memory will be lost. Use caution when

CaUToN. You execute this function.

1. Turn off the power to the ICP1.

2. Plug the PA-300 AC adaptor while holding
down the [SCENE] and [ENTER] buttons.
Release keys after YAHAMA logo disappears.
The Initialization display appears.

3. Press the [F2]/[F5] keys to select a type of
initialization.

To cancel the initialization operation, select “==> Exit Diag
Mode” and confirm the cancellation. Alternatively, simply turn
off the power to the ICP1.

Initialize DME:
Deletes all user settings except component data.The
Utility settings will be set to default values.

Delete All Data:

Component data will be deleted. The Ultility settings
will be set to default. After initialization, transfer
necessary components from DME Designer.

==> Exit Diag Mode:
Leaves this screen and restarts.

4. Press the [ENTER] key.

Do not turn off the power during initialization. Doing so
can damage the device.
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Troubleshooting

For the latest information about DME Designer, visit the Yamaha pro audio site at

http://www.yamahaproaudio.com.

Symptom

Possible Causes

Corrective Actions

A compile error occurs during
synchronization.

DSP total resource consumption has
exceeded the upper limit.

Delete unneeded components.

The wiring between components is
connected from multiple output terminals
to a single input.

Change the connections so that a single
output is connected to a single input
terminal. Using a matrix mixer or similar
component, gather multiple outputs into
one signal.

Cannot place component. Cannot place
wiring.

You are in online status.

Execute [Go Off-line] on the
synchronization screen to go into offline
status.

The Designer window in not in edit mode.

Place a checkmark next to [Edit] on the
[Tool] menu.

The currently logged on user is restricted
from editing.

Logoff, then log in again as a new user,
or as the Administrator. If edit restrictions
are required for a user, place a check in
the [Security] - [Edit] checkbox

A user module is not displayed on the
list.

The [File] menu - [Preference] -
[ContentsFolder] has been changed, or
the “User Module” folder has been
moved.

Check that there are user module files
(.umf) in the “ContentsFolder” and “User
Module” folders.

Cannot switch configurations in the
Navigator Window.

While online, you cannot not switch to a
configuration different from the current
scene.

If you can switch between scenes, you
will be able to switch configurations.

The user module window does not open,
even when a user module is double-
clicked.

This is a user module saved by selecting
[Open] - [User Module Design
Window].

Open the save dialog, select [Open] -
[User Module Editor], and resave the
user module.

No editor displays after right-clicking on
a card component, and selecting [Open]
from the context menu.

Some cards do not have editors.

No special corrective action.

The message “Reset Config...” is
displayed for a long time in the message
area of the “Synchronization” dialog box.

This is not abnormal. If many scenes are
entered into the DME, processing takes
time.

Wait until processing finishes.

Cannot set the monitor output.

This is because channels connected with
wiring cannot be used as monitor output.

Select an unconnected channel.

Poor meter response.

A large number of DME units displaying
meters in the same device group.

e Close or minimize the component
editor window to reduce the dumber of
DME displays.

¢ Divide the device group containing
DME units displaying meters.

The MIDI Setup toolbar will not be
displayed.

Stored in the minimized task tray.

Right-click the MIDI Setup icon in the
task tray then click [Show].
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